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All	Rights	Reserved

The	entire	rights	of	the	content	found	in	this	eBook	are	reserved	with	the	publisher.	The
replication	 or	 republication	 of	 any	 part	 of	 this	 book	 in	 any	 form,	 or	 by	 any	 mean,
electronic,	mechanical,	photocopied,	recorded,	scanned	or	otherwise,	is	strictly	prohibited
without	getting	the	consent	from	the	author	of	the	book.	Any	such	action	that	comes	to	the
notice	of	publisher	is	punishable	by	law.

Notes	to	the	Reader:

The	author	of	the	book	does	not	contradict	any	other	information	found	about	the	subject
of	this	book	on	any	other	source.	This	eBook	is	solely	for	educational	purposes	and	should
be	 taken	 as	 such.	 The	 author	 takes	 no	 responsibility	 for	 any	 misappropriation	 of	 the
contents	 stated	 in	 this	 eBook	 and	 thus	 cannot	 be	 held	 liable	 for	 any	 damages	 incurred
because	of	it.

While	 the	 author	 of	 this	 book	 has	made	 utmost	 efforts	 to	 obtain	 updated	 and	 accurate
information	contained	herein,	the	author	or	the	publisher	of	the	book	cannot	be	held	liable
for	any	damage	or	loss	caused	by	the	content	of	this	book.	The	author	of	the	book	does	not
warranty	 the	 accuracy	 of	 the	 contents	 and	 disclaim	 all	 warranties	 with	 respect	 to	 the
information	contained	herein,	its	accuracy	and	applications.

The	advice	presented	 in	 this	book	may	not	be	 suitable	 for	everyone.	This	book	 is	not	a
substitute	for	professional	advice	and	should	not	be	taken	as	such.	Neither	the	author	nor
the	 publisher	 of	 this	 book	 is	 engaged	 in	 rendering	 professional	 services.	 If	 expert
assistance	and	guidance	is	needed,	then	professional	help	should	be	sought.

	





O
INTRODUCTION

fficially	 released	 in	 January	 2013,	 the	 latest	 version	 of	 Excel	 2013	 took	 the
market	by	its	amazingly	easy-to-user	interface	and	incredibly	advanced	features.
It	is	no	longer	a	simple	spreadsheet	calculator.	Microsoft	Excel	has	evolved	into

a	 full-fledged	 software	 that	 can	 be	 applied	 to	 any	 aspect	 of	 life,	 let	 it	 be	 academic,
personal	or	business.

So	what	do	you	intend	to	use	Excel	for?	To	maintain	your	shopping	list?	Or	perhaps	some
office	work	 like	 financial	analysis,	 statistics,	payroll,	billing	etcetera?	Well,	Excel	 is	not
just	limited	to	these	basic	functions.	It	is	a	lot	more	than	what	you	think	it	is.

Excel	allows	you	to	make	user	forms,	generate	and	sort	through	unending	data	lists,	create
interactive	charts	and	graphs	and	much	more.	There	is	no	limit	to	what	Excel	can	do.	And
whatever	the	limitations	were	in	the	previous	versions	have	now	been	removed	in	Excel
2013.

Excel	2013	 is	 a	marvel.	You	will	be	amazed	 to	 learn	what	wonders	 it	 can	do.	However
none	of	the	Excel	features	will	provide	you	any	benefit	if	you	don’t	know	how	to	use	it.
Excel	2013	is	definitely	miraculous	but	it	does	not	perform	miracles	on	its	own.	You	need
to	make	a	few	clicks	to	make	the	miracles	happen.	This	is	where	this	book	intervenes.	It
tells	you	all	there	is	to	know,	in	the	easiest	way	possible	about	this	enigmatic	software.

But	before	you	move	on	to	find	out	what	this	book	contains,	you	need	to	know	if	this	book
is	for	you.





Is	This	Book	for	You?

The	Excel	Master	Guidebook	Series	offers	a	detailed	walkthrough	on	all	the	basic	as	well
as	the	advanced	features	of	Excel	2013.	It	is	designed	for	all	types	of	users.	Whether	you
are	a	beginner,	intermediate	or	advanced	user,	this	book	has	something	to	offer	to	all.

	 	 	 	 	 	 	It	serves	as	an	excellent	guide	for	users	who	are	new	to	Excel	and	are	trying	it
for	the	first	time.	It	contains	everything	that	a	beginner	needs	to	know.		

	 	 	 	 	 	 	If	you	have	a	little	know-how	of	Excel,	this	book	will	teach	you	the	advanced
usage	of	Excel	2013	and	ways	to	adapt	it	to	your	own	needs.	

	 	 	 	 	 	 	The	books	contains	numerous	advanced	techniques	and	exclusive	tips	that	will
make	the	advanced	users	explore	Excel	all	over	again.	The	examples	presented	in
this	book	are	surely	going	to	make	your	experience	of	Excel	more	exhilarating	than
ever.

	





How	This	Book	Is	Organized?

The	 Excel	 Master	 Guidebook	 Series	 consist	 of	 seven	 books,	 each	 containing	 several
chapters.	 Following	 is	 a	 brief	 description	 of	 each	 part	 to	 give	 you	 an	 idea	 of	what	 the
books	contain.

Book	I:	Getting	Familiar	with	Excel	2013

This	 part	 introduces	 you	 to	 the	 new	 and	 advanced	 features	 of	 Excel	 2013.	 The	 second
chapter	of	this	part	sheds	light	on	the	basic	layout	and	procedures	of	Excel.	You	will	also
find	 some	 handy	 and	 exciting	 tips	 on	 customizing	 your	 Excel	 and	 making	 it	 more
powerful.

Book	II:	The	Basics	Explained

This	book	contains	walkthroughs	 and	 tips	on	 the	basic	 applications	of	Excel	2013.	You
will	 learn	how	 to	work	on	a	workbook,	protect	your	worksheets,	 formatting	 techniques,
working	with	templates,	printing	worksheets	and	much	more!

Book	III:	Formulas	and	Functions

This	book	talks	about	the	most	popular	and	valuable	feature	of	Excel;	that	is,	the	formulas
and	 functions.	 From	 the	 basics	 of	 entering	 formulas,	 to	 simple	mathematical	 functions,
array	formulas	and	advanced	statistical	functions,	this	book	covers	all	you	need	to	know	to
excel	at	Excel’s	formulas.	The	last	chapter	of	this	book	gives	you	some	real	handy	tips	on
making	an	error	free	worksheet.	

Book	IV:	Chart	and	Graphics

This	book	covers	extensively	the	colorful	charting	and	other	exciting	pictorial	features	of
Excel.	 You	 will	 discover	 some	 exclusive	 tricks	 on	 using	 Excel’s	 graphical	 tools	 and
Sparkline	graphics.

Book	V:	Data	Management	and	Analysis

This	book	introduces	you	to	 the	powerful	data	analysis	 tools	of	Excel.	You	will	 learn	to
work	with	the	handy	What-If	Analysis	tool,	the	extensive	data	lists	in	Excel,	the	valuable
Pivot	Table	and	much	more!					

Book	VI:	Working	With	Macros	and	VBA	Programming

This	book	introduces	you	to	the	Excel’s	amazing	macro	recorder.	We	have	talked	in	detail
about	 the	 recorder’s	mechanism	and	applications.	You	will	 also	 learn	how	 to	keep	your



important	 and	 frequently	 needed	macros	 at	 hand,	 so	 that	 you	 can	 use	 them	 easily	 and
quickly.	 This	 book	 also	 talks	 about	 the	 basic	 and	 common	 applications	 of	 the	 official
programming	language	of	excel,	Visual	Basic	for	Applications.	You	will	learn	how	to	use
the	Visual	Basic	editor	to	create	and	edit	macros.	The	second	chapter	in	this	part	tells	you
about	a	very	exciting	and	handy	feature	of	VBA;	that	is,	its	ability	to	let	you	create	user
defined	functions	in	Excel.

Book	VII:	Shortcuts	&	Function	List

This	 book	 contains	 an	 extensive	 list	 of	 keyboard	 shortcuts	 to	 perform	different	 tasks	 in
Excel.	There	is	also	a	list	of	all	the	functions	built-in	Excel	2013.	



Know	the	Important	Icons

You	will	find	the	following	icons	throughout	the	book.	These	are	used	to	make	the	book
more	readable	and	get	your	attention	to	the	important	points.

This	icon	represents	a	practical	tip,	something	that	will	make	Excel
easier,	 interesting	 and	 far	 more	 enjoyable.	 It	 indicates	 a	 more
efficient	 way	 of	 doing	 the	 task	 at	 hand.	 You	 will	 find	 several
unique	shortcuts	and	other	handy	tips	in	front	of	this	icon.		

	

This	 icon	 denotes	 a	 tidbit	 that	 applies	 to	 the	 subsequent	 topic.
Make	sure	you	don’t	skip	the	note	and	read	it	before	moving	on.
It	is	fundamental	to	understanding	the	subsequent	topic	and	may
help	you	master	the	task	at	hand

	

	

This	 icon	 represents	 a	 cautionary	 note.	 It	 is	 placed	with	 functions
that	can	cause	problems	 if	you’re	not	careful.	Make	sure	you	read
and	understand	it	thoroughly	or	else	you	might	end	up	losing	your
data	or	mixing	up	the	entire	operation.
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BOOK	I:	GETTING	FAMILIAR	WITH	EXCEL

2013

his	book	takes	you	on	a	detailed	tour	of	Excel	2013.	The	first	chapter	introduces
you	 to	 the	new	and	advanced	 features	of	Excel	2013	 that	were	not	borne	by	 its
predecessors.	It	is	highly	recommended	that	you	go	through	this	part	thoroughly

even	if	you	have	been	using	Excel	in	the	past.	This	will	not	only	freshen	up	your	concepts
but	you	will	learn	some	handy	and	interesting	tips	on	customizing	your	Excel	and	making
it	more	powerful.

AT	A	GLANCE

							Chapter	1:	What	is	New	in	Excel	2013?

							Chapter	2:	Excel	2013	–	The	Basics

							Chapter	3:	Customizing	Your	Excel	2013

							Chapter	4:	Loading	Your	Excel	2013
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Chapter	1:	What	is	New	in	Excel	2013?

icrosoft	Excel	is	by	far	the	most	widely	used	spreadsheet	software	in	the	world.
A	 countless	 number	 of	 spreadsheet	 software	 have	 been	 launched	 since	 the
advent	 of	MS	Excel,	 yet	 it	 has	 always	maintained	 its	 position	 as	 the	world’s

most	popular	spreadsheet	software.		

As	 you	may	 already	 know	 that	 Excel’s	 forte	 lies	 in	 performing	 numerical	 applications;
however	with	 the	recent	 few	upgrades	 the	world’s	 favorite	numeric	software	has	proven
itself	 to	be	equally	helpful	 in	non-numeric	 functions.	You	 can	make	graphs,	manipulate
text	data,	draw	exquisite	diagrams,	create	user	forms	and	much	more.

Excel	has	always	been	the	most	preferred	spreadsheet	software.	There	are	several	reasons
behind	 this	popularity,	 the	most	 important	one	among	which	 is	 that	Microsoft	has	never
stopped	 improving	 Excel.	 Every	 upgrade	 has	 brought	 some	 innovative	 and	 advanced
features,	thereby	keeping	excel	always	a	step	ahead	the	competition.

The	latest	version	that	was	released	in	2013	has	been	one	of	successful	updates	of	Excel.	It
contains	a	number	of	highly	advanced	and	innovative	features;	briefed	as	follows.

Following	 is	 just	 a	 brief	 overview;	 these	 features	 are	 explained	 in	 advance	 in	 the
upcoming	chapters.

Quick	Analysis	Tools:	As	the	name	suggest,	the	Quick	Analysis	Toolbar	gives	you	quick
access	to	the	data	analysis	and	other	formatting	tools.

Flash	Fill:	 This	 feature	 of	 Excel	 2013	 performs	 several	 functions,	 the	most	 popular	 of
which	is	that	it	completes	your	work	for	you.	It	constantly	compares	the	data	as	you	type
and	 as	 soon	 as	 it	 detects	 a	 similar	 pattern,	 it	 offers	 to	 finish	 what	 you	 were	 typing.
Moreover,	Flash	Fill	also	helps	you	combine	data	in	multiple	rows	and	columns.

Advanced	Chart	Formatting	Tools:	Excel	2013	contains	some	very	high-tech	formatting
tools	that	makes	it	pretty	easy	to	modify	your	charts.

Timeline:	If	your	data	contains	dates,	you	can	use	the	Timeline	feature	to	filter	the	data	to
your	desired	date	range.

Improved	Table	Slicers:	Table	 slicers	were	 there	 in	Excel	2010	as	well.	However	 then
they	can	just	be	used	in	combination	with	the	pivot	tables.	In	excel	2013,	this	limitation
has	been	removed.	You	can	now	use	table	slicers	with	other	types	of	data	tables	as	well.				

Additions:	 Excel	 2013	 contains	 numerous	 new	 animations,	 sophisticated	 templates	 and



other	useful	functions	that	weren’t	there	in	its	predecessors.				

One	Worksheet	Interface:	 In	 the	previous	versions	of	Excel,	each	workbook	contained
multiple	worksheets.	 In	 excel	 2013,	 every	workbook	contains	 a	 single	 sheet	 and	has	 its
own	window.				

Recommended	 Graphics:	 Excel	 now	 provides	 recommended	 pivot	 tables	 and
recommended	 charts.	 Just	 like	 flash	 fill,	 it	 detects	what	 you	 are	 doing	 and	 recommend
tables	accordingly.	

Powerful	 Add-Ins:	 There	 are	 several	 new	 and	 useful	 add-ins	 including	 Power	 View,
PowerPivot	and	Inquire.	

Automatic	Data	Labels:	You	can	now	create	data	labels	that	updates	automatically	with
text.

	

	





I
Chapter	2:	Excel	2013	–	The	Basics	

n	this	chapter,	you	will	learn	the	basic	features	and	applications	that	are	a	must	 for
every	Excel	user.	Do	not	skip	this	chapter	even	if	you	have	some	basic	knowhow	of
Excel.	This	will	not	only	give	you	a	head	start	but	you	are	also	going	to	find	some

very	useful	tricks	and	techniques.	

Exploring	the	Workbook	and	Worksheets

The	work	that	you	do	in	Excel	is	carried	out	in	a	workbook	file,	normally	represented	by
the	 .xlsx.	 As	 already	 said,	 each	workbook	 contains	 one	worksheet.	 If	 you	want	 to	 add
more	worksheets,	click	the	plus	icon	located	at	the	bottom	of	your	workbook.

Each	worksheet	contains	infinite	number	of	cells	and	each	cell	can	hold	a	numeric	value,
text	or	formula.	Moreover,	a	worksheet	also	features	an	invisible	drawing	layer	that	carries
the	charts,	images	and	other	forms	of	graphics.	

Now	before	 you	 actually	 start	working	 on	 the	worksheets,	 it	 is	 important	 to	 familiarize
yourself	with	 the	 excel	workspace.	Figure	1.2	 is	 the	 image	of	 a	workbook	 containing	 a
single	worksheet.	All	the	important	tabs	and	elements	of	Excel	are	marked	on	the	image,
followed	by	a	brief	description	of	all	the	items.

	



Name	Box:	This	displays	 the	name	of	 the	active	or	currently	selected
cell

Ribbon:	Most	 of	 the	 excel	 tools	 and	 commands	 can	 be	 found	 on	 the
ribbon

Customize	Quick	Access	Toolbar:	The	Quick	Access	Toolbar	contains
all	 the	 commonly	 used	 commands.	 You	 can	 click	 this	 tiny	 button	 to
customize	 your	 quick	 access	 toolbar	 and	 add/remove	 tabs	 in	 it	 as	 per



your	preference

Formula	 Bar:	 This	 bar	 displays	 the	 formula/value	 carried	 by	 the
current	cell

Launch	Help:	Click	this	button	to	launch	the	Microsoft	system	help

Ribbon	Display	Options:	Click	this	tiny	button	to	reveal	the	3	options
of	displaying	ribbon

Row	Number:	Rows	are	labeled	in	numbers,	ranging	from	1	to
1,048,567

Column	Letter:	Columns	are	labeled	in	terms	of	alphabets,	ranging
from	A	to	XFD

Vertical	Scrollbar:	Move	it	up	and	down	to	scroll	the	worksheet
vertically

Horizontal	Scrollbar:	Move	it	left	and	right	to	scroll	the	worksheet
horizontally

Page	View	Options:	You	can	view	your	worksheet	in	3	different
modes,	namely	the	page	break	preview,	normal	view	and	the	page
layout

Zoom	Control	Buttons:	Use	these	buttons	to	zoom	in/zoom	out	your
worksheet

Sheet	Tabs:	Each	tab	display	the	name	of	the	respective	worksheet

New	Sheet	Button:	Click	this	button	to	add	a	new	sheet	to	the	current
workbook

Sheet	Tabs	Scrollbar:	Use	this	bar	to	scroll	the	sheet	tabs.	Right-click
the	sheet	tabs	scrollbar	to	view	the	list	of	all	the	worksheets

Status	Bar:	It	displays	the		status	of	your	current	project,	such	as	the



range	of	selected	cells,	messages,	the	status	of	Num,	Cap	and	Scroll
Lock

Active	Cell	Indicator:	This	shows	the	currently	active	cell	

Hide	Ribbon	Button:	Click	this	button	to	hide/unhide	the	ribbon

Table	2.1	-	Description	of	Figure	2.1

	

Click	 a	 row	 number	 or	 column	 letter	 to	 select	 the	 entire	 row	 or
column	respectively.

	

Navigating	In	a	Worksheet

A	 worksheet	 contains	 rows	 represented	 by	 numeric	 values	 and	 columns	 labeled	 by
alphabets.	 	Each	row	and	column	consists	of	 innumerous	cells,	each	cell	having	 its	own
unique	name	that	is	stated	in	the	name	bar.

As	you	will	see	that	one	cell	 is	always	enclosed	by	a	dark	border.	This	cell	 is	called	the
Active	Cell.	Only	the	active	cell	accepts	the	keyboard	inputs	and	values	and	at	any	given
time,	there	is	only	one	active	cell.	If	you	want	to	enter	any	formula	or	value	in	any	cell,
first	you	need	to	make	it	active.

	

It	 is	 assumed	 that	 the	 reader	uses	 traditional	keyboard	or	mouse	 to
work	on	excel.	Thus	the	commands	and	navigation	tips	mentioned	in
this	chapter	do	not	apply	on	devices	having	a	touch	interface

	

There	are	several	ways	of	navigating	through	a	worksheet.

If	you	are	using	a	keyboard,	you	can	use	the	standard	arrow	keys	to	move	around	the
worksheet.	Here	are	a	few	common	Excel	navigation	keys	along	with	their	functions.

Left	Arrow:	Click	the	left	arrow	on	your	keyboard	to	move	the	active	cell	to	the	adjacent
cell	column	on	the	left



Right	 Arrow:	 Click	 the	 right	 arrow	 on	 your	 keyboard	 to	 move	 the	 active	 cell	 to	 the
adjacent	cell	column	on	the	right

Up	Arrow:	Click	the	Up	Arrow	on	your	keyboard	to	move	the	active	cell	up	one	row

Down	Arrow:	Click	the	Down	Arrow	on	your	keyboard	to	move	the	active	cell	down	one
row

Page	Down:	Click	 the	Page	Down	on	your	keyboard	 to	move	 the	active	cell	down	one
screen

Page	Up:	Click	the	Page	Up	on	your	keyboard	to	move	the	active	cell	up	one	screen

Alt	+	Page	Down:	Click	this	combination	on	your	keyboard	to	move	the	active	cell	one
screen	to	the	right

Alt	 +	 Page	 Up:	 Click	 this	 combination	 on	 your	 keyboard	 to	 move	 the	 active	 cell	 one
screen	to	the	left

Ctrl	+	Home:	Click	this	combination	on	your	keyboard	to	jump	to	cell	A1

Ctrl	 +	 Page	 Down:	 Click	 this	 combination	 to	 activate	 the	 next	 worksheet	 in	 your
workbook

Ctrl	 +	 Page	 Up:	 Click	 this	 combination	 to	 activate	 the	 previous	 worksheet	 in	 your
workbook

Turn	ON	the	Scroll	Lock	 to	move	around	 the	worksheet	without
moving	the	active	cell.

	

Suppose	you	want	to	view	the	next	screen	without	moving	the	active	cell.	Just	turn	on	the
Scroll	Lock	and	press	Ctrl	+	Right	Arrow.	When	you	want	to	jump	back	to	the	active	cell,
hit	Ctrl	+	Backspace.

If	you	are	using	a	mouse,	you	just	need	to	click	a	particular	cell	to	make	it	active.	You
can	use	the	mouse	wheel	to	scroll	up	and	down	the	worksheet.	If	you	mouse	doesn’t	have
a	mouse	wheel,	use	the	Excel	scrollbar	instead.

You	 can	 also	 use	 the	mouse	 to	 zoom	 in/out	 of	 the	worksheet.	 There	 are	 three	ways	 of
doing	so,

1.	 You	can	magnify	or	shrink	the	view	of	your	worksheet	by	using	the	zoom	in	and



zoom	out	button	respectively.

2.	 Press	and	hold	the	Ctrl	key	on	the	keyboard,	at	the	same	time	run	the	mouse	wheel
to	zoom	in	and	out.

3.	 Go	 the	File	 >	Options.	Then	 select	 the	Advanced	 option	 and	 place	 a	 tick	mark
next	to	the	Zoom	on	Roll	with	IntelliMouse	box.	Now	you	don’t	need	 to	hold	 the
Ctrl	 button.	 You	 can	 zoom	 in	 and	 out	 the	 worksheet	 just	 by	 rolling	 the	 mouse
wheel.

	

Scrolling	 the	worksheet	 with	mouse	 does	 not	move	 the	 active
cell.	You	need	to	click	a	cell	in	order	to	make	it	active.

	

	

Introducing	the	Infamous	Ribbon

If	you	have	some	knowhow	about	Excel,	you	must	be	familiar	with	the	legendary	Excel
ribbon	that	sent	a	roar	of	appreciation	in	the	IT	industry	the	first	time	it	was	introduced	in
Excel	 2007.	 It	 was	 a	 drastic	 change	 in	 Excel’s	 user	 interface.	 Though	 it	 wasn’t
customizable	 at	 that	 time,	 it	 was	 an	 instant	 success.	 The	 same	 ribbon	 was	 made
customizable	in	Excel	2010	and	is	now	made	further	advanced	in	Excel	2013.

The	Ribbon	 replaced	 the	 traditional	menus	 and	 tools	 and	 combines	 them	all	 in	 a	 set	 of
tabs.	 It	 is	 located	 by	 default	 at	 the	 top	 of	 the	workbook.	 The	 Ribbon	 is	made	 up	 of	 a
number	of	 tabs,	 each	containing	 sets	of	different	commands,	 tools,	 functions	and	dialog
box	launchers.

Figure	2.2	is	the	image	is	of	a	Ribbon,	except	for	the	File	tab.	The	File	tab	is	not	part	of
the	 ribbon.	Clicking	 it	will	 take	 open	 up	 another	 screen	 known	 as	 the	Backstage	View
(more	about	the	backstage	view	later	in	this	chapter).	3

To	go	back	 to	your	worksheet,	 click	 the	back	 arrow	 located	 at	 the	 top	of	 the	backstage
screen.

	



You	can	hide	 the	ribbon	or	make	it	visible,	 it	 is	up	 to	you.	As	you	can	see	 in	 the	above
image,	 the	 title	 bar	 of	 the	workbook	 contains	 a	 tiny	button	known	as	 	 	Ribbon	Display
Options.	 Click	 it	 to	 reveal	 the	 three	 ribbon	 display	 options	 and	 toggle	 the	 ribbon’s
visibility.

	

If	you	have	hidden	the	ribbon	and	want	it	to	become	visible	only	when
you	need	to	use	it,	Hit	Ctrl	+	F1	 to	 reveal	 it	 temporarily.	 It	will	stay
visible	as	long	as	the	cursor	is	anywhere	over	the	ribbon.	The	Ribbon
will	disappear	as	soon	as	you	click	anywhere	else	on	the	worksheet.

	

What’s	In	the	Ribbon?

The	 Ribbon	 is	 the	 gateway	 to	 using	 Excel.	 It	 contains	 all	 that	 Excel	 has	 to	 offer.	 The
features	and	tools	are	all	categorized	into	a	number	of	tabs,	briefed	as	follows.

Home	Tab:	It	contains	the	most	commonly	needed	and	used	tools	of	Excel.	For	example,
the	 basic	Clipboard	 tools,	 style	 and	 formatting	 commands,	 editing	 tools,	 cell	 alignment
and	more.

Insert	Tab:	As	 the	name	suggests,	 this	 tab	contains	commands	 to	 insert	different	 things
such	as	tables,	graphs,	charts,	symbols	etcetera.

Page	Layout	Tab:	Select	this	tab	to	modify	the	overall	look	of	worksheet	such	as	margins,
orientation,	colors,	background	and	some	print	area	settings.				

Formulas	Tab:	 This	 tab	 contains	 all	 the	 formulas,	 error	 trapping	 tools,	 formula	 editing
tools	and	watch	window.	

Data	Tab:	All	the	data	management	and	analysis	commands	are	contained	in	this	tab.	You
can	also	use	this	tab	to	sort	and	filter	the	data	lists.

Review	 Tab:	 Select	 this	 tab	 to	 use	 the	 spell	 checking	 tools,	 MS	 office	 translator	 and



thesaurus.		It	also	contains	the	protection	and	track	changes	commands.

View	Tab:	As	the	name	suggests,	this	tab	allows	you	to	view	your	worksheet	in	different
manners.	 It	 contains	commands	 to	hide/reveal	 the	gridlines,	zoom	 in/zoom	out,	 freezing
panes	and	more.

The	 above	 explained	 tabs	 are	 present	 by	 default	 in	 every	 ribbon.	 Some	 ribbons	 also
contain	additional	tabs,	resulting	from	activating	macros	and	installing	add-ins.

Add-Ins	Tab:	The	add-ins	tab	is	visible	in	two	scenarios,

1.	 If	you	install	any	add-ins

2.	 If	you	open	a	workbook	saved	in	the	older	version.	Since	the	traditional	menus	are
not	present	in	Excel	2013,	all	these	appear	in	the	add-ins	tab.

Developer	 Tab:	 This	 tab	 contains	 commands	 and	 tools	 that	 are	 normally	 used	 for
advanced	programming.	The	Developer	Tab	is	hidden	by	default.	If	you	want	to	make	it
visible,	perform	the	following	steps	on	Excel.

1.	 Select	Files

2.	 Select	Options	>	Customize	Ribbon

3.	 On	the	right	side,	you	will	find	Customize	the	Ribbon	section.	Under	this	heading,
there	 will	 be	 a	Developer	 Checkbox.	 Place	 a	 checkmark	 next	 to	 the	 Developer
checkbox.	This	should	reveal	the	Developer	Tab	on	the	Ribbon.	

Improved	Contextual	Tabs

Apart	from	the	tabs	briefed	above,	Excel	also	contains	contextual	tabs.	It	was	there	in	its
previous	 versions	 as	 well;	 however	 the	 latest	 version	 comes	 with	 smarter	 context
sensitivity.

When	 you	 click	 on	 any	 object	 of	 your	 worksheet,	 all	 the	 content	 related	 tools	 and
commands	 appears	 in	 the	 ribbon.	 Suppose	 you	 generate	 a	 graph	 in	 Excel	 2013.	 Now
whenever	you	will	click	the	graph,	Excel	will	combine	all	the	tools	that	you	may	need	to
work	on	that	graph	and	will	make	them	available	in	the	Ribbon.

	



	

Take	the	above	image	as	an	example.	As	soon	the	line	chart	is	clicked,	all	the	needed	tools
are	made	available	in	the	ribbon	under	the	tab	of	Chart	Tools.	The	Green	Highlighted	Tabs
in	the	above	image	are	contextual	tabs.	You	can	also	say	this	as	the	automatic	customized
ribbon,	 as	 all	 the	 tools	 you	 need	 to	 work	 on	 the	 particular	 object	 are	 automatically
gathered	in	one	place.		

The	Use	of	Ribbon	for	Keyboard	Users

It	may	seem	to	you	that	the	ribbon	can	be	used	by	mouse	only.	However	this	is	not	true.
Ribbon	is	as	friendly	to	the	keyboard	users	as	it	is	to	the	mouse	users.	All	you	need	to	do
is	hit	the	Alt	key.	It	will	display	a	different	letter	on	each	tab.	Press	the	particular	letter	on
your	keyboard	 to	select	 the	corresponding	 tab.	There	you	will	 see	a	different	 letter	over
each	command.	Hit	the	letter	on	your	keyboard	to	select	the	corresponding	command.

	

The	above	image	shows	what	happens	when	you	hit	Alt.

Now	press	the	H	key	to	select	the	Home	tab,	I	key	to	open	the	Insert	Tab,	P	key	to	open
the	Page	Layout	Tab	as	so	on.



Suppose	you	hit	the	H	key.	Figure	2.4	shows	what	happens	after	you	pressed	the	H	key.

	

As	you	can	see	in	Figure	2.5,	the	Home	Tab	is	opened	and	there	is	a	different	letter	over
each	 command.	 You	 just	 need	 to	 hit	 the	 particular	 letter	 on	 your	 keyboard	 to	 use	 the
respective	command.			



Meet	the	Quick	Analysis	Tool

One	of	 the	 top	additions	 to	 the	newest	member	of	 the	Excel	clan	 is	 the	Quick	Analysis
Tool.	It	is	a	small	menu	that	pops	up	every	time	you	select	a	range	of	more	than	one	filled
cell.	The	Quick	Analysis	Tool	combines	the	commonly	used	commands	of	Excel	and	put
them	beside	the	selected	range.

The	primary	reason	behind	the	heightening	popularity	of	the	Quick	Analysis	Tool	is	that	it
solves	 the	 commonly	 faced	 issue	 that	 occurs	 when	menus	 or	 commands	 on	 the	 ribbon
drop	down	and	obscure	the	cells	you	are	working	on.

Figure	2.6	-	Quick	Analysis	Tool

A	tiny	icon	will	appear	at	the	lower	right	corner	as	soon	as	you	select	a	range	of	cells.	It	is
the	icon	pointed	by	the	red	arrow	in	the	above	image.	You	need	to	click	this	icon	in	order
to	reveal	the	Quick	Analysis	Tool.

As	illustrated	in	Figure	2.6,	the	Quick	Analysis	Tool	is	like	a	mini	ribbon	containing	the
commands	for	formatting,	charts,	total,	tables	and	sparklines.



Introducing	the	Backstage	View

In	Excel	2007,	Microsoft	removed	the	traditional	File	button	that	used	to	reside	on	top	of
the	Excel	workbook.	 It	 replaced	 the	 file	 command	with	 the	Microsoft	 button.	However
due	 to	 the	 increasing	demand	 and	popularity	 of	 the	 former,	 it	was	 added	back	 in	Excel
2010	which	remains	to	be	there	in	the	2013	version	as	well.	Also	the	office	button	next	to
the	file	tab	is	gone.

Another	major	difference	with	regards	to	the	file	tab	in	Excel	2013	is	that	now	it	does	not
contain	the	typical	menu	or	dialog	box.	The	File	tab,	located	at	the	extreme	left	side	of	the
ribbon,	takes	to	an	entirely	new	screen	known	as	the	Backstage	View.

Following	is	the	image	of	a	backstage	view.

Figure	2.7	-	Backstage	View			

As	 you	 can	 see,	 it	 contains	 the	 familiar	 File	menu	 commands	 along	with	 several	 other
options	and	settings.

Clicking	the	arrow	button	located	at	the	top	left	of	the	backstage	view	will	take	you	back
to	the	worksheet.

The	 items	on	 the	 left	 side	are	 the	old	 file	menu	commands.	Here	you	will	 also	 find	 the
Account	 command	 to	 change	 the	 settings	 for	 your	Microsoft	 account.	Clicking	Options
will	launch	a	separate	dialog	box	of	the	Excel’s	options.				

The	extreme	right	side	of	the	backstage	view	contains	the	properties	and	other	information



about	the	underlying	workbook.

In	 between	 the	 left	 and	 right	 side	 are	 some	 additional	 options.	 Here	 you	 will	 find
commands	 to	 protect	 your	 workbook,	 inspect	 your	 worksheets,	 manage	 the	 different
versions,	explore	the	browser	view	options	and	more.

Using	the	Dialog	Box

A	 lot	 of	 excel	 tabs	 and	 commands	 launches	 a	 dialog	 box,	 which	 contains	 further
commands	pertaining	to	the	main	tab.

For	example,	 if	you	select	Insert	>	Pivot	 table,	 it	will	open	up	a	dialog	box	containing
further	options	related	to	the	Pivot	Table.	Following	is	the	image	of	the	dialog	table	that
we	are	talking	about.

Figure	2.8	-	Example	of	a	Dialog	Box

There	are	two	types	of	dialog	boxes,	in	terms	of	their	workability.	

Modal	Dialog	Box

While	using	Excel,	you	must	have	come	across	small	windows	asking	you	to	either	click
OK	or	Cancel	or	any	other	stated	action.	These	are	alert	dialog	boxes.	They	appear	mostly
to	alert,	notify	or	warm	about	an	error.

	

When	 a	modal	 dialog	 box	 pops	 up,	 it	 freezes	 your	worksheet	 you



cannot	do	anything	on	it	until	you	close	the	dialog	box

	

Click	OK	to	accept	the	suggested	action	or	click	Cancel	to	dismiss	the	dialog	box	without
taking	any	action.	

	

Hit	Esc	 to	 simply	 close	 a	modal	 dialog	 box	without	 taking	 any
action	with	regards	to	the	dialog	box	.

	

Modeless	Dialog	Box

This	type	of	dialog	box	does	not	still	your	worksheet	till	you	take	any	action.	It	works	like
a	 ribbon	or	 toolbar.	 It	 stays	on	your	worksheet	but	does	not	 freeze	 it.	You	can	continue
working	on	your	worksheet	 as	well	make	any	changes	you	want	 in	 the	dialog	box.	The
changes	that	you	make	in	the	dialog	box	will	take	effect	immediately.

Following	is	the	example	of	modeless	dialog	box.

Figure	2.9	-	Example	of	a	Modeless	Dialog	Box

As	you	can	see,	it	is	a	Find	and	Replace	Dialog	Box.	You	can	leave	this	box	open	while
you	work	on	the	worksheet.	Whatever	value	you	find	and	replace	 in	 the	dialog	box	will
take	effect	on	the	worksheet.

Get	To	Know	the	Task	Panes

Task	pane	is	another	very	exciting	feature	of	Excel.	It	was	there	in	the	previous	versions	as
well	but	the	task	pane	in	Excel	2013	is	far	more	advanced	and	comprehensive.

Task	 pane	 launches	 automatically	 in	 response	 to	 certain	 functions	 and	 commands.	 	 For



example,	if	you	want	to	format	a	picture	in	Excel	2013,	right-click	the	particular	picture
and	select	Format	Picture.	This	will	open	the	Format	Picture	task	pane	on	the	worksheet,
as	illustrated	below.	

Figure	2.10	-	Example	of	A	Task	Pane

The	 Format	 Picture	 Task	 pane	 which	 is	 located	 at	 the	 extreme	 right	 contains	 all	 the
commands	you	may	need	to	edit	the	underlying	picture.	As	you	can	see,	there	are	four	tabs
in	the	Format	Picture	Task	pane.	The	tabs	are	located	at	the	top	of	the	pane.	Clicking	on
the	tab	will	reveal	further	commands	and	formatting	options.

When	you	are	done	using	the	task	pane,	click	the	X	icon	located	at	the	upper	right	corner
of	the	pane.			

	

To	navigate	 the	task	pane	with	keyboard,	open	the	task	pane	and
then	hit	F6.	You	can	now	use	the	arrow	keys,	the	tab	key	and	the
spacebar	to	work	around	the	task	pan.

	

By	default,	the	task	pane	opens	up	at	the	right	side	of	the	worksheet.	If	you	want	to	move
it	anywhere	else,	simply	click	the	title	bar	of	the	pane	and	drag	it	to	your	desired	location.	

Excel	remembers	the	location	where	the	task	pane	was	opened	last.	So
if	you	change	the	position	of	any	task	pane,	it	will	launch	at	the	same
position	every	time	you	use	it



	



Feel	Free	to	Seek	Help

Excel	 is	a	very	comprehensive	and	valuable	software	however	one	cannot	deny	 the	 fact
that	 it	 is	pretty	much	complex	as	well.	No	matter	how	many	books	and	guides	you	read
about	 it,	you	may	get	stuck	in	a	circular	error	or	any	unheard	feature.	Then	there	 is	 this
unending	list	of	formula	that	you	cannot	possibly	remember	all.

While	using	Excel,	there	will	be	times	when	you	would	need	to	try	some	new	function	or
an	advanced	formatting	feature	or	a	programming	command.	You	don’t	have	to	explore	a
big	fat	guide	every	time	you	need	help	with	Excel.	The	efficient	Microsoft	help	system	is
always	there	at	your	assistance.				

The	 help	 system	of	Excel	 2013	 is	 pretty	 comprehensive	 as	well	 as	 interactive.	 It	 offers
assistance	in	several	ways,	the	most	quick	and	easy	one	being	the	ScreenTips.

ScreenTips	 contains	 short	 description	 of	 the	 pertinent	 feature.	 To	 display	 a	 ScreenTip,
simply	take	your	cursor	over	to	the	command	or	feature	on	the	ribbon	or	any	other	tab.

Take	 the	 following	 image	 as	 an	 example.	 As	 soon	 as	 the	 cursor	 rests	 on	 the	 Margin
Command,	the	ScreenTip	containing	the	application	of	this	command	is	displayed.

	

Figure	2.11	-	ScreenTip	to	Adjust	Margins

As	 you	 can	 see,	 the	 ScreenTip	 contains	 a	 very	 concise	 description	 of	 the	 Margin
Command.	 If	you	are	 satisfied	with	 this	 information,	 click	Tell	me	more	 to	 learn	more
about	it.	

ScreenTips	are	not	only	available	 for	 the	 ribbon	 tabs	and	commands.	You	can	also	 find



them	in	some	dialog	boxes	for	example	the	Options	Dialog	box.

To	display	these	ScreenTips,	click	the	File	Tab	>	Options.	Here	you	will	see	 that	many
icons	contain	a	small	“i”	in	front	of	them.	Resting	your	cursor	on	this	“i”	will	display	the
ScreenTip	of	the	underlying	item,	as	illustrated	in	the	image	below.

Figure	2.12	-	“i”	ScreenTips

Likewise,	ScreenTips	are	available	in	many	other	dialog	boxes.

If	you	don’t	want	to	see	the	ScreenTips,

1.	 Click	File	Tab	>	Options

2.	 Select	General	

3.	 On	the	left	hand	side,	you	will	find	an	item	by	the	name	of	ScreenTip	Style.	Next
to	 this	 item	 is	 the	 drop	down	 list	 for	 the	ScreenTip	 settings.	You	 can	 activate	 or
deactivate	the	ScreenTips	from	this	drop	down	menu.

ScreenTips	just	contains	the	brief	description	about	the	pertinent	feature.	It	does	not	help
you	 with	 errors	 and	 other	 advanced	 functions.	 If	 you	 need	 more	 information,	 hit	 the
question	mark	icon	(?)	located	at	the	top	right	of	your	Excel	screen.	Doing	so	will	launch
the	help	dialog	box,	as	shown	in	the	image	below.

For	keyboard	users,	hit	F1	to	open	the	Microsoft	Help	Dialog	box.

	



Figure	2.13	-	Excel	Help	Dialog	Box

You	 can	 search	 for	 anything	 you	want	 regarding	Excel.	 If	 you	 don’t	 find	what	 you	 are
looking	for	in	the	given	heads,	you	can	type	for	in	the	search	bar	located	at	the	top	of	the
help	dialog	box.

Refer	 to	 Appendix	 “List	 of	 Keyboard	 Shortcuts”	 to	 learn	 the	 keyboard	 shortcuts	 for
Microsoft	Help	related	commands.		

You	 can	 seek	 online	 help	 only	 when	 you	 are	 connected	 to	 the
internet.	In	case	your	internet	connection	is	inactive,	the	help	dialog
box	will	 contain	 the	 offline	 help	 topics.	The	offline	 help	 system	 is
also	 very	 comprehensive.	 However	 the	 online	 one	 contains	 more
updated	solutions	and	information.		
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Chapter	3:	Customizing	Your	Excel	2013	

o	far	we	have	introduced	to	the	popular	features	of	Excel	2013.	Now	before	we	get
on	 the	usage	of	 these	 features,	here	 is	another	very	 interesting	 thing	 for	you	and
that	is	customization.

Excel	 contains	 infinite	 number	 of	 features.	 There	 may	 be	 some	 features	 that	 are	 quite
advanced	 but	 you	 need	 to	 use	 them	 pretty	 often.	You	 can	 keep	 them	 handy	 by	 placing
them	in	the	Quick	Access	Toolbar.	And	it	is	not	just	the	toolbar	that	you	can	modify.	Just
like	you	personalize	your	desktop	and	keep	on	front	all	your	favorite	items,	you	can	do	the
same	with	your	Excel	2013	as	well.	

This	chapter	tells	you	how	you	can	customize	your	Excel’s	ribbon	and	your	Quick	Access
Toolbar	to	make	them	more	accommodating	and	convenient.

Tailoring	the	Quick	Access	Toolbar

The	Quick	Access	Toolbar	is	a	small	yet	a	very	powerful	feature	of	Excel.	It	contains	the
most	commonly	used	commands	and	items.	The	best	part	is	that	you	can	customize	your
toolbar	 to	 make	 it	 more	 valuable	 and	 handy.	 You	 can	 change	 its	 location,	 add/remove
icons	in	it	and	also	make	it	a	part	of	your	ribbon	to	free	up	some	screen	space.	

Playing	Around	With	the	Location

By	default,	the	Quick	Access	Toolbar	is	located	above	the	ribbon,	on	the	top	left	of	your
workbook,	as	shown	in	Figure	3.1.

Figure	3.1	-	Quick	Access	Toolbar	above	the	Ribbon

If	 you	want	 to	move	 this	 toolbar	 below	 the	 ribbon,	 click	 the	Customize	Quick	Access
Toolbar	 button	 (tiny	 downward	 arrow	 at	 the	 end	 of	 the	 toolbar)	 and	 then	 click	Show
below	 the	 Ribbon.	 This	 should	 move	 the	 Quick	 Access	 Toolbar	 below	 the	 ribbon	 as
shown	in	the	below	image.



Figure	3.2	-	Quick	Access	Toolbar	below	the	Ribbon

Loading	the	Toolbar

When	you	first	start	Excel,	there	will	be	three	tools	(Save,	Undo	and	Redo)	in	the	Quick
Access	Toolbar.	These	three	are	irrefutably	the	most	frequently	used	commands.	However
there	are	other	functions	too	that	are	used	quite	often	and	you	might	like	to	keep	some	of
them	readily	available	regardless	of	which	tab	or	ribbon	is	currently	opened.	

Since	the	Quick	Access	Toolbar	is	visible	all	the	times	no	matter	which	tab	is	expanded,	it
is	the	ideal	place	to	keep	your	favorite	commands.

There	are	two	ways	of	adding	commands	to	the	Quick	Access	Toolbar.			

The	first	way	allows	you	to	add	several	commands	together	to	the	Quick	Access	Toolbar.
To	 do	 so,	 click	 the	Customize	Quick	Access	 Toolbar	 button	 >	More	Commands.	 A
dialog	box	as	shown	in	the	image	below	will	open	up	on	your	screen.

Figure	3.3	-	‘Customize	the	Quick	Access	Toolbar’	Dialog	Box

As	you	can	see	there	is	a	long	list	of	commands	on	the	left	side	of	the	dialog	box.	Click
the	command	that	you	want	 to	place	in	the	quick	access	 toolbar	and	then	press	 the	Add



button	located	in	between.	Likewise,	you	can	add	other	commands	too.

The	second	way	is	more	convenient	if	you	cannot	find	a	particular	command	in	the	left-
hand	side	list.

Locate	 the	command	you	want	 to	add	 in	 the	 ribbon.	Right-click	 the	command	and	 then
click	Add	To	Quick	Access	Toolbar.

Figure	3.4	-	The	Add	to	Quick	Access	Toolbar	button	under	the	Insert	Tab

This	should	add	the	particular	command	to	your	Quick	Access	Toolbar.

How	to	Save	Your	Preferences?	

There	are	two	ways	of	saving	your	customized	Quick	Access	Toolbar.

Import/Export

The	 first	way	 is	by	 importing	or	exporting	 the	customization	 files.	 	This	method	allows
you	to	copy	your	customized	Quick	Access	Toolbar	on	every	computer	you	use.

To	do	so,	select	the	File	Tab	>	Options	>	Quick	Access	Toolbar.	There	on	 the	bottom-
right	you	will	 see	 the	 Import/Export	button.	 It	 enables	you	 to	 save	 and	 retrieve	 a	 file
containing	all	your	customizations	and	use	it	on	other	computers.

To	 save	 your	 customizations,	 click	 the	 Import/Export	 button	 >	 Export	 all
customizations.	A	dialog	box	will	open	up	on	the	screen	as	shown	below.



Figure	3.5	-	Saving	the	Customization	File	As	.exportedUI

Select	 the	 location	 on	 your	 computer	 to	 save	 your	 customization	 file.	 The	 files	will	 be
saved	as	Exported	Office	IU	file	(.exportedUI	extension)

You	can	copy	this	file	on	any	computer	you	want.

To	 retrieve	 your	 customization	 file,	 click	 the	 Import/Export	 button	 >	 Import
customization	file.	It	will	launch	a	separate	dialog	box	showing	files	with	the	extension
.exportedUI.	Select	the	particular	file	containing	your	customizations.

Figure	3.6	-	The	Import/Export	Button	for	Saving	and	Retrieving	Customization	File	

Attaching	To	A	Workbook

The	 second	 way	 of	 saving	 your	 customized	 Quick	 Access	 Toolbar	 is	 to	 attach	 it	 to	 a



workbook.	To	do	so,	select	 the	File	Tab	>	Options	>	Quick	Access	Toolbar.	Click	 the
Customize	Quick	Access	Toolbar	 drop-down	 list	 located	on	 the	 right	 side	 of	 the	 dialog
box.

Here	you	will	 find	 two	 types	 files;	your	customization	 file	 in	 the	 .exportedUI	extension
and	the	Excel	file	with	the	attached	toolbar.

The	same	dropdown	list	contains	two	categories,	namely	For	all	documents	(default)	and
For	[active	workbook	name];	illustrated	below.

Figure	3.7	-	The	Customize	Quick	Access	Toolbar	Drop-Down	List

If	you	select	the	first	option,	any	changes	you	make	in	the	Quick	Access	Toolbar	will	be
applied	to	all	the	Excel	files	in	your	computer.

If	you	select	 the	second	option,	whatever	commands	you	add	from	left	 to	right	side	and
other	customizations	you	make	will	be	applied	in	the	active	workbook	only.	In	this	case,
the	customizations	will	be	saved	and	reappear	every	time	you	open	the	active	workbook.

Undoing	What	You	Did	

If	 you	 think	 you	 have	 loaded	 your	 quick	 access	 toolbar	 with	 too	 many	 unnecessary
commands	and	needs	to	clean	it	up,	there	are	several	ways	to	do	that.

Resetting	The	Toolbar

To	reset	the	Quick	Access	Toolbar	of	only	one	workbook,	select	the	File	Tab	>	Options	>
Quick	 Access	 Toolbar.	 Select	 the	 name	 of	 the	 particular	 workbook	 in	 the	 Customize
Quick	 Access	 Toolbar	 drop-down	 list.	 Hit	 the	 Reset	 button	 located	 right	 above	 the
Import/Export	button.	Here	you	have	 two	options,	you	can	either	 reset	 the	quick	access
toolbar	only	or	you	can	reset	all	the	customizations.

	



If	 you	 select	 Reset	 all	 customizations,	 it	 will	 not	 only	 restore	 the
Quick	 Access	 Toolbar’s	 default	 settings	 but	 will	 also	 reset	 all	 the
customizations	that	you	made	in	ribbon.	

	

Figure	3.8	-	The	Reset	Button	to	Restore	the	Default	Quick	Access	Toolbar

If	you	 select	For	all	documents	 (default)	 in	 the	Customize	Quick	Access	Toolbar	drop-
down	list	and	then	hit	the	Reset	button,	it	will	restore	the	customizations	of	all	the	excel
files	saved	in	the	computer.

	

Removing	Individual	Commands

If	you	don’t	want	to	reset	the	entire	Quick	Access	Toolbars	and	just	want	to	remove	a	few
commands,	 right-click	 the	 particular	 command	 on	 the	 Quick	 Access	 Toolbar	 and	 hit
Remove	from	Quick	Access	Toolbar.	

Figure	3.9	-	Removing	A	Command	From	the	Quick	Access	Toolbar

Tailoring	the	Ribbon



It	is	not	only	the	Quick	Access	Toolbar	that	you	can	customize.	You	can	also	modify	the
ribbon	 as	 per	 your	 convenience.	 You	 can	 add	 new	 tabs	 in	 your	 ribbon,	 relocate	 the
commands	and	tabs	and	much	more.	

How	You	Can	Add	Custom	Tabs	To	Your	Ribbon?	

First,	let’s	see	how	you	can	add	new	tabs	to	your	ribbon.

1.	 Select	the	File	Tab	>	Options	>	Customize	Ribbon

Keyboard	 shortcut	 to	 open	 the	Customize	Ribbon	 tab	 of	 the	 Excel
Options	dialog	box:	Hit	Alt	then	F	then	T	then	C

2.	 You	will	see	that	all	the	commands	are	listed	on	the	left	hand	side	and	all	the	main
tabs	on	the	right	side.	Select	the	tab	after	which	you	want	to	add	the	new	tab.

3.	 Click	the	New	Tab	button	located	right	beneath	the	Main	Tabs	in	the	Customize	the
Ribbon	list	box.

4.	 Excel	inserts	a	New	Tab	(Custom)	beneath	the	main	tab	selected	in	the	first	step.	As
shown	below,	this	new	tab	consists	of	one	New	Group	(Custom).

5.	 Now	add	all	the	commands	you	want	in	this	new	group.	To	add	a	command,	simply
select	a	command	on	the	left	box	and	hit	the	Add	button	located	in	between	both
sides.	When	 adding	 commands,	 there	 are	 several	 categories	 you	 can	 select	 from
such	 as	 Popular	 Commands,	 Commands	 Not	 in	 the	 Ribbon,	 All	 Commands,
Macros,	Office	Menu,	All	Tabs,	Main	Tabs	and	so	on.	You	can	select	any	of	these
categories	 from	 the	 Choose	 commands	 drop-down	 list	 located	 above	 the
commands-containing	list	box.

6.	 As	you	can	see	in	Figure	3.10,	the	newly	added	commands	appear	under	the	new
group	(custom)	tab.	The	commands	are	displayed	in	the	left-to-right	order	in	which
they	will	appear	on	the	ribbon.	In	the	below	example,	the	Fill	Color	command	will
appear	on	the	extreme	left	side	in	the	new	ribbon,	followed	by	the	Font	command
and	so	on.	To	change	the	placement	of	the	commands,	simply	click	the	command
you	want	 to	relocate	and	hit	 the	arrow	buttons	 located	at	 the	extreme	right	of	 the
dialog	box.



Figure	3.10	-	Shifting	the	Position	of	the	Commands	in	the	New	Group	(Custom)

You	can	also	 rename	a	group	or	 tab	or	clicking	 the	Rename	button	and	 typing	 the	new
name	in	Rename	Dialog	Box.	Click	OK	when	you	are	done.

If	you	want	to	add	more	groups	to	this	new	tab,	hit	the	New	Group	button.	The	process	of
adding	commands	to	the	group	and	renaming	it	remains	the	same.	Likewise	you	can	add
other	tabs	as	well.

	

For	Keyboard	users,	Excel	automatically	assigns	shortcut	key	letters
to	all	the	new	tabs	and	groups.					

	



Managing	the	Ribbon’s	Tabs

If	you	do	not	like	the	default	layout	of	the	tabs	and	commands,	you	can	relocate	them	in
any	way	you	want.	Here	are	a	few	ways	to	customize	tabs	to	your	liking.

You	can	modify	the	order	 in	which	the	tabs	appear	on	the	ribbon.	To	do	so,	open
the	Customize	Ribbon	tab	of	the	Excel	Options	dialog	box.	Select	the	tab	you	want
to	relocate	and	then	click	either	the	up	or	the	down	arrow.	The	former	will	move	the
tab	to	the	left	on	the	ribbon;	the	latter	will	move	it	to	the	right.	Click	OK	once	you
are	done.

To	 hide	 certain	 tabs	 on	 the	 ribbon,	 open	 the	Customize	Ribbon	 tab	 of	 the	Excel
Options	dialog	box.	Remove	the	checkmarks	from	the	tabs	that	you	want	to	hide.
Click	OK	once	you	are	done.	To	reveal	the	hidden	tabs,	click	the	checkboxes.

To	remove	a	group	from	a	tab,	open	the	Customize	Ribbon	tab	of	the	Excel	Options
dialog	box.	Click	the	plus	sign	to	expand	the	particular	tab	and	select	the	group	you
want	 to	remove	from	it.	Hit	 the	Remove	button	located	right	underneath	the	Add
button.

It	 is	 not	 only	 the	 main	 tabs	 that	 you	 can	 modify.	 You	 can	 also	 customize	 the
contextual	tabs.	To	do	so,	first	open	the	Customize	Ribbon	tab	of	the	Excel	Options
dialog	box.	Select	 the	Tool	Tabs	 option	 on	 the	Customize	 the	Ribbon	drop-down
list.	 All	 the	 contextual	 tabs	 will	 be	 listed	 on	 the	 left	 side	 box.	 After	 this,	 the
procedure	to	relocate,	remove,	rename	or	add	a	group	or	tab	remains	the	same.

Saving	Your	Customizations	for	Later	Use

The	procedure	to	save	the	ribbon	customizations	in	a	file	so	that	they	can	be	used	on	other
computers	is	the	same	as	it	was	in	the	case	of	Quick	Access	Toolbar.

You	can	import	the	customization	file	and	then	export	it	on	any	computer	containing	Excel
2013.

	

If	 you	want	 to	 re-customize	your	 ribbon	but	might	want	 to	use
the	 current	 customization	 later	 on,	 simply	 import	 the
customization	 file	and	keep	 it	 saved	 in	your	computer.	Now	re-



customize	 your	 ribbon	 and	make	 any	 changes	 you	want.	When
you	 want	 to	 use	 the	 previously	 customized	 version	 of	 your
ribbon,	 just	 export	 the	 saved	 customization	 file	 and	 all	 your
previous	 customizations	will	 take	place.	Likewise	you	can	 save
as	many	customized	ribbons	as	you	want.			

	

You	 can	 also	 restore	 your	 customized	 ribbon	 and	 set	 it	 back	 to	 default.	 Go	 to	 the
Customize	Ribbon	tab	of	the	Excel	Options	dialog	box.	Hit	the	Reset	button	located	at	the
bottom	 right.	 Here	 you	 have	 two	 options.	 You	 can	 either	 select	 Reset	 only	 selected
ribbon	tab,	or	you	can	Reset	all	customizations.	The	latter	will	not	reset	your	ribbon	to
default	settings	but	will	also	undo	any	changes	you	made	in	the	quick	access	toolbar.	
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Chapter	4:	Loading	Your	Excel	2013

ustomizing	 the	Quick	Access	Toolbar	 and	Ribbon	 is	 not	 the	 only	way	you	 can
make	your	Excel	2013	more	effective	and	convenient	to	use.	You	can	install	Apps
and	Add-ins	too.

The	best	part	is	that	you	don’t	have	to	explore	any	site	for	Excel-compatible	apps	and	add-
ins.	The	Office	Store	is	loaded	with	these.

This	is	what	this	chapter	is	all	about.	It	tells	how	you	can	make	your	Excel	more	powerful
and	valuable	through	Apps	and	add-ins.

Installing	Apps

Apps	 are	 small	 yet	 advanced	 application	 programs	 that	 enhance	 the	 functionality	 of
certain	features	and	leads	to	greater	productivity.	The	Office	Store	is	full	of	Excel	related
Apps.	Most	of	them	are	free	of	cost,	whereas	a	few	are	offered	against	a	small	premium.

Following	is	the	process	to	install	apps	in	Excel	2013.

Select	 the	 Insert	 Tab	 >	Apps	 for	 Office.	 This	 will	 open	 a	 drop-down	 list.	 If	 you	 are
installing	apps	for	the	first	time,	the	Recently	Used	Apps	section	will	be	blank,	as	shown
below.

Figure	4.1	-	Apps	for	Office	Command	in	the	Insert	Tab

Click	See	All	to	open	the	Office	Store.	As	you	can	see	in	the	image	below,	there	are	two
tabs	on	top,	namely	My	Apps	and	Featured	Apps.

The	My	Apps	Section	contains	the	apps	that	you	have	already	downloaded	from	the	Office
store.	



Figure	4.2	-	Apps	for	Office	Dialog	Box

Click	Featured	Apps	to	visit	the	Office	Store.	As	you	can	see,	there	is	this	Editor’s	Picks
section	and	Recently	Added	section,	each	having	free	and	paid	apps.

If	you	are	not	interested	in	any	of	the	apps	displayed	upfront,	click	More	apps	next	to	the
Editor’s	Pick	section.	This	will	take	you	to	the	website	of	the	Office	Store	where	you	can
see	all	the	apps	available	for	Excel	2013.

This	is	how	the	Office	Store	Website	looks	like.

Figure	4.3	-	Website	of	the	Official	Office	Store

Click	on	any	app	to	know	about	its	functionality,	developer,	user	rating	and	price.	

Whether	you	liked	an	app	in	the	Editor’s	Pick	section,	the	Recently
Added	Section	or	the	Store	website,	the	procedure	to	install	the	apps
is	the	same.



To	install	any	app,	click	Add.	You	will	taken	to	another	page	containing	details	about	the
app	you	selected.

If	the	app	you	selected	is	free	of	cost,	you	will	be	taken	directly	to	the	download	page.	If	it
is	a	paid	app,	you	will	be	taken	to	a	page	where	you	need	to	fill	in	the	payment	details.	In
either,	follow	the	on-screen	instructions	to	complete	the	installation.	Once	the	installation
process	is	complete,	close	the	browser	and	return	to	Excel.

Now	you	can	use	the	downloaded	apps	in	any	of	your	worksheet.	To	do	so,

1.	 Open	the	Apps	for	Office	dialog	box	in	the	Insert	Tab.

2.	 Click	See	All	>	My	Apps

3.	 You	will	see	a	list	of	the	apps	you	have	downloaded.	Click	the	app	you	want	to	use
in	the	particular	worksheet.	Click	Insert	>	Enter.

	

If	you	don’t	 find	any	of	your	downloaded	apps	 in	 the	My	Apps	page,
Click	Refresh	 located	 at	 the	 top	 right	 of	 the	Apps	 for	Office	 Dialog
Box.

	

On	the	left	of	the	Refresh	button,	you	will	see	Manage	My	Apps.	Click	it	to	install	any
app	or	to	keep	tabs	of	your	installed	apps	for	Office	2013	and	SharePoint.

Some	apps	such	as	the	Mini	Calendar	and	the	Bing	Maps	open	up	in
the	 form	 of	 graphical	 objects	 that	 sways	 above	 the	 worksheet.
Others	 such	 as	 the	 QuickHelp	 Starter	 and	 Merriam-Webster
Dictionary	open	up	in	a	task	pane.

	

To	close	the	task	pane	apps,	hit	the	close	(x)	button	on	the	top	right	of	the	pane.	To	close
the	graphical	apps,	select	the	object	and	then	hit	the	Delete	key.	Doing	so	will	not	delete	or
uninstall	the	app,	it	will	only	close	it.

What’s	Up	With	The	Add-Ins?

Just	like	apps,	Add-Ins	are	small	programs	that	enhance	the	capabilities	of	several	Excel’s
inbuilt	 features.	 A	 lot	 of	 them	 are	 meant	 specifically	 to	 empower	 and	 modernize	 the



computational	abilities	of	Excel.

To	use	any	add-in	program,	it	must	be	installed	on	your	hard	drive	and	then	you	need	to
open	 it	 via	 the	Add-Ins	 dialog	 box.	Before	we	 elaborate	 further	 on	 this	 procedure,	 you
need	 to	know	 the	different	categories	of	add-ins	 that	are	already	 installed	 in	your	Excel
2013.

Automation	Add-Ins

The	 Automation	 Add-ins,	 commonly	 known	 as	 the	 Excel	 Add-Ins,	 are	 a	 group	 of
programs	 that	 enhance	 the	 computational	 and	 data	 analysis	 features	 of	 Excel.	 Euro
Currency	Tools,	Analysis	ToolPak,	Analysis	ToolPak	-	VBA	and	Solver	are	examples	of
Automation	Add-Ins.

Euro	Currency	Tools

As	 the	 name	 suggests,	 these	Add-Ins	makes	 it	 easier	 to	work	 on	 currency	 conversions.
You	 can	 use	 these	 add-ins	 to	 format	 your	 worksheet	 values	 as	 euro;	 then	 apply	 the
EUROCONVERT	function	to	convert	all	the	other	currencies	into	Euro.		To	use	the	Euro
Currency	Tools,	select	the	Formula	tab	on	the	ribbon	and	hit	the	Euro	Conversion	or	Euro
Formatting	buttons.

Analysis	ToolPak

This	 group	 of	 Add-Ins	 includes	 several	 more	 statistical,	 financial	 and	 engineering
functions	to	the	already	unending	list	of	Excel’s	functions.	You	can	load	these	add-ins	to
perform	a	variety	of	advanced	computational	and	statistical	analysis	operations	on	Excel.	

Analysis	ToolPak	-	VBA

This	 category	 of	Add-Ins	 is	 very	 popular	 among	VBA	 programmers.	 It	 allows	 them	 to
design	and	publish	their	own	statistical,	financial	and	engineering	functions	that	they	can
use	 in	 Excel.	 In	 other	 words,	 the	 Analysis	 ToolPak	 –	 VBA	 add-ins	 enables	 creating
customized	functions.		

Solver

The	 Solver	 Add-In	 helps	 you	 find	 a	 solution	 of	 What-If	 scenarios.	 It	 analyzes	 your
selected	range	of	cells	and	then	proposes	a	solution	that	satisfies	the	specified	constraints
and	optimizes	the	objective	value.

If	you	want	to	take	help	of	the	Solver	Add-in,	just	go	to	the	Data	Tab	and	click	the	Solver
button	located	in	the	Analysis	group.	Refer	to	chapter	29	to	learn	more	about	Solver.



Component	Object	Model	Add-ins

The	Component	Object	Model	Add-ins,	shortly	 read	as	COM	Add-ins	 improves	Excel’s
capabilities	to	manage	and	analyze	unending	data	lists	and	infinitely	large	amount	of	data.
Power	View,	PowerPivot	and	Inquire	are	examples	of	the	COM	Add-Ins.

Power	View

The	 Power	 View	 Add-Ins	 allows	 analysis	 and	 of	 interactive	 data	 and	 graphical
presentation	of	your	data	models.	It	also	facilitates	ad-hoc	data	queries.

PowerPivot

This	group	of	add-ins	allows	you	build	huge	and	complex	data	models.	It	also	extends	the
capabilities	of	the	DAX	(Data	Analysis	Expressions)	functions	to	ease	data	queries.	Refer
to	chapter	28	to	learn	more	PowerPivot.

Inquire

This	group	of	add-ins	makes	it	easier	to	analyze	a	workbook	in	order	to	understand	their
design,	identify	any	broken	links,	inconsistencies	and	formula	errors.	It	also	allows	you	to
compare	two	workbooks	to	identify	their	differences.		

All	 the	above	mentioned	add-ins	are	installed	in	Excel	2013,	however	they	are	activated
and	ready	to	use.

Following	 is	 the	 process	 of	 loading	 the	 add-ins	 in	 Excel	 and	 making	 them	 readily
available.

Click	File	to	open	the	backstage	screen;	then	select	Options	>	Add-Ins

Figure	4.4	-	The	Add-Ins	Dialog	Box	in	Excel	Options



As	you	can	see,	this	dialog	box	contains	the	names	of	all	the	add-ins	that	are	preinstalled
in	your	Excel,	along	with	location	and	type	of	each.		

At	the	bottom	of	this	window	is	a	Manage	drop-down	list	containing	the	type	of	Add-ins.
The	Excel	Add-Ins	is	selected	by	default.	If	you	want	to	load	any	or	all	of	the	COM	add-
ins,	expand	this	drop	down	list	and	select	COM	Add-Ins.

After	you	select	the	type	of	add-ins	you	want	to	load,	click	Go.

If	 you	 selected	 the	 Excel	 Add-Ins	 in	 the	 Manage	 drop-down	 list,	 the	 next	 dialog	 box
would	be	similar	to	the	image	below,

Figure	4.5	-	The	Automation	Add-Ins	Dialog	Box

If	it	was	COM	Add-Ins,	the	dialog	box	would	open	up.

Figure	4.6	-	The	COM	Add-Ins	Dialog	Box

In	either	case,	mark	the	check	boxes	for	each	add-in	that	you	want	to	load	and	use	in	your
Excel	2013.

Click	OK	once	you	are	done.



Go	back	 to	 your	workbook.	You	will	 find	 all	 your	 activated	 add-ins	 in	 their	 respective
tabs.

	

You	won’t	 find	all	 the	add-ins	at	one	place,	unless	you	customize
your	 ribbon	 and	 relocate	 all	 your	 favorite	 add-ins	 in	 one	 tab,	 By
default,	 the	 solver	 and	 Data	 Analysis	 Add-ins	 are	 located	 in	 the
Data	 Tab.	 Each	 of	 the	 COM	 Add-ins	 constitutes	 an	 entirely
separate	 tab	 on	 the	 ribbon.	 The	 extra	 financial,	 statistical	 and
engineering	functions	that	are	part	of	 the	Analysis	ToolPak	add-in
can	be	found	in	their	respective	groups	in	the	Formulas	Tab.

	

To	use	the	Analysis	ToolPak	additional	functions,	expand	the	Formulas	Tab	and	select	the
required	drop	down	list,	as	shown	below.

Figure	4.7	-	The	Analysis	ToolPak	Additional	Functions	in	the	Formulas	Tab

You	will	also	find	these	categories	in	the	dialog	box	that	opens	after	you	click	fx	on	 the
immediate	left	of	the	formula	bar,	as	illustrated	below.



Figure	4.8	-	The	Analysis	ToolPak	Additional	Functions	in	the	Insert	Function	Dialog	Box

Shortcut	to	Manage	the	COM	Add-Ins

You	don’t	have	to	go	all	the	way	to	the	backstage	screen	and	options	every	time	you	want
to	manage	 the	COM	Add-Ins.	Here	 is	a	 shortcut	 for	 that.	Select	 the	Developer	Tab	and
then	click	COM	Add-Ins.	This	will	launch	the	COM	Add-Ins	dialog	box.	Here	you	can
add/remove	the	COM	Add-Ins	as	needed.

The	Developer	Tab	does	is	not	visible	on	the	Ribbon	by	default.	You
need	 to	 change	 the	 settings	 in	 order	 to	 display	 this	 tab	 on	 your
ribbon.	To	do	so,	select	File	>	Options	>	Customize	Ribbon.	Tick
the	Developer	 Checkbox	 located	 in	 the	 right-hand	 side	 box.	 Click
OK	once	you	are	done.	This	should	make	the	Developer	Tab	visible
on	your	ribbon,	and	so	the	COM	Add-Ins	dialog	box.	

Third	Party	Add-Ins

The	Automation	Add-Ins	and	 the	COM	Add-Ins	are	not	 the	only	ones	 that	you	can	use.
There	World	Wide	Web	is	full	of	Excel	Add-Ins	that	you	can	download	and	then	load	in
your	Excel	2013.	Some	of	the	third	party	add-ins	are	free,	others	need	to	be	purchased.

Just	Google	for	third	party	Excel	add-ins	and	you	will	find	countless	vendors	offering	add-
ins	for	Excel	2013.	One	very	popular	 third	party	add-in	 is	Name	Splitter.	 If	you	entered
full	 names	 in	 single	 cell	 in	 a	data	 list,	 the	Name	Splitter	 if	 activated	will	 split	 the	 first,
middle	and	last	name	and	even	the	initials	and	put	them	in	separate	columns.		

When	purchasing	 third	party	 add-ins,	make	 sure	 the	 site	 is	 real
and	not	a	scam.	Visit	different	forums	that	talks	about	third	party



add-ins	 and	 verify	 the	 legitimate	 existence	 of	 the	 underlying
vendor	 before	 making	 any	 transaction,	 or	 in	 that	 case	 even
sharing	your	bank	or	credit	card	details	that	some	vendors	ask	for
guarantee	purpose.			
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BOOK	II:	THE	BASICS	EXPLAINED

p	 till	 now	we	 have	 talked	 about	 what	 makes	 Excel	 2013	 stand	 apart	 from	 its
predecessors	 and	 how	 can	 you	 make	 your	 Excel	 customized	 and	 even	 more
powerful	 than	 it	 already	 is.	Well,	 not	 it	 is	 time	 to	 actually	 get	 your	 hands	 on

Excel	2013	and	start	exploring	all	it	has	to	offer.

This	book	contains	walkthroughs	and	tips	on	the	basic	applications	of	Excel	2013.	It	tells
you	how	to	work	on	a	workbook,	protect	your	worksheets,	formatting	techniques,	working
with	 templates	 and	much	more!	This	 part	 is	 not	 only	 a	must	 for	 beginners	 but	 for	 also
those	who	have	some	experience	of	using	Excel.	You	will	 find	many	useful	 tips	 in	here
that	will	make	working	on	Excel	even	easier	and	far	more	interesting.	Moreover,	there	are
lots	of	new	basic	things	in	Excel	2013	that	weren’t	there	in	its	previous	versions.	
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Chapter	5:	Moving	Around	the	Worksheet

orksheet	is	the	core	element	of	Excel.	Whatever	work	you	do	on	excel,	whether
it	is	simple	mathematical	calculation	or	a	complex	data	operation,	it	is	done	on
the	 worksheet.	 Hence	 it	 is	 very	 important	 that	 you	 get	 comfortable	 and

proficient	on	working	the	worksheet.

While	 more	 about	 working	 on	 a	 worksheet	 is	 explained	 in	 the	 next	 two	 chapters,	 this
chapter	covers	the	basics	including	the	navigation	techniques	and	ways	of	selection.	Some
of	you	may	already	know	about	this	stuff	but	here	you	will	also	find	some	shortcuts	and
alternative	methods.		

Navigating	Regions

Before	you	learn	different	region	navigation	techniques,	you	need	to	know	what	actually	a
region	is.	A	region	is	a	rectangular	range	or	block	of	filled	cells.	For	more	understanding,
look	at	the	image	below.

Figure	5.1	-	Understanding	Regions

As	 you	 can	 see,	 there	 are	 4	 regions;	 highlighted	 with	 red	 for	 your	 understanding.	 The
region	comprises	of	only	consecutively	filled	cells.	As	soon	as	there	is	an	empty	row	or
column,	the	region	breaks.	In	figure	5.1,	the	four	regions	are	A3:D15,	A17:D18,	F3:G15
and	F17:G18.

Though	Cell	G18	is	an	empty	cell,	it	is	also	part	of	the	region	as	it	falls	in	that	rectangular
block.	The	active	cell,	that	is	A1,	is	a	one-cell	region.

Now	that	you	know	what	region	is,	let’s	learn	some	really	amazing	navigation	techniques.
These	 techniques	 will	 help	 you	 navigate	 around	 large	 regions,	 containing	 hundreds	 of
consecutively	filled	rows	and	columns.	You	cannot	just	scroll	up	and	down	every	time	you



need	to	get	to	the	bottom	of	a	1000-row	table.

Navigation	Tips	for	Keyboard	Users

Here	are	a	few	tips	to	move	around	a	region	with	your	keyboard.

Hit	the	Home	Key	to	jump	to	the	first	cell	of	the	current	row.

Hold	down	Ctrl	and	then	press	the	Home	key,	it	will	move	the	active	cell	to	Cell
A1.

To	jump	from	the	first	cell	of	the	region	to	the	last	cell	and	in	between,	just	press
and	hold	the	Ctrl	key	and	then	hit	any	of	the	arrow	keys	to	move	in	the	direction.
For	 example,	Ctrl	 + � 	 (right	 arrow	 key)	will	 take	 you	 to	 the	 right	 edge	 of	 the
underlying	region.	If	you	are	already	standing	at	the	right	corner	and	then	you	hit
Ctrl	+ � ,	it	will	take	you	to	the	last	cell	of	the	current	row	in	the	worksheet.	

Ctrl	+	End	will	take	you	to	the	last	cell	of	the	last	column	of	the	active	region.	For
example,	clicking	Ctrl	+	End	in	Figure	5.1	will	select	G18.

Hit	End	on	your	keyboard	followed	by	any	of	arrow	keys	to	move	to	the	last	rows
and	 columns	of	 the	 current	workbook	 in	 the	 respective	 direction.	 For	 example	 if
you	press	End	+ � ,	 it	will	 take	you	 to	 the	 last	cell	on	 the	 right	hand	side	of	 the
workbook.

Scroll	 Lock	 +	 Home	 will	 jump	 to	 the	 first	 cell	 of	 the	 current	 window	 of	 the
worksheet.

Scroll	Lock	+	End	will	jump	to	the	last	cell	of	the	current	window	of	the	worksheet.

Navigation	Tips	for	Mouse	Users

As	you	can	see	in	Figure,	there	is	a	dark	border	around	Cell	A1.	This	border	is	known	as
the	selection	rectangle.	Moving	 your	 cursor	 to	 any	 sides	 of	 the	 selection	 rectangle	will
change	the	cursor	into	a	4	pronged	arrow.	Double	clicking	at	this	time	will	move	the	active
cell	to	the	last	cell	of	the	region	and	in	between.

It	plays	the	same	function	that	the	Ctrl	+	Arrow	Key	combination	does	for	the	keyboard
users.		

Refer	 to	 Appendix	 “List	 of	 Keyboard	 Shortcuts”	 to	 learn	 the	 keyboard	 shortcuts	 for
navigating	worksheets.			



Learn	To	Select	Different	In	Patterns	

There	are	many	ways	other	than	the	traditional	click	and	drag	method	to	select	the	desired
cells.	You	can	select	a	cell,	a	range,	a	region,	adjacent	rows	or	columns	or	multiple	ranges
as	well.

	

There	 is	 a	 difference	 between	 a	 range	 and	 a	 region.	 The	 former
refers	 to	 a	 rectangular	 block	 of	 cells,	 it	 could	 be	 filled	 as	 well	 as
contain	empty	cells;	 the	latter	refers	to	a	rectangular	block	of	filled
cells	only

	

To	work	on	any	cell,	first	you	need	to	select	it	order	to	make	it	active.	You	can	do	so	by
simply	clicking	over	the	desired	cell.	You	can	select	one	or	more	ranges,	but	there	will	be
only	one	active	cell	at	a	time.	By	default,	the	active	cell	is	located	at	the	upper	left	corner
of	the	selected	range,	unless	you	move	it	to	any	other	cell.	

These	were	just	the	basics.	Now	let’s	explore	some	more	interesting	ways	of	selection.

Simple	Selection

The	 simplest	way	of	 selecting	 a	 range	or	 region	 is	 to	 bring	your	 cursor	 to	 the	 first	 cell
from	where	you	want	to	start	the	selection.	Then	click	and	drag	to	select	the	desired	range.

If	you	are	a	keyboard	user,	then	use	the	arrow	keys	to	move	the	active	cell	to	the	upper-
corner	of	the	desired	selection.	Then	hold	down	the	Shift	Key	on	your	keyboard	and	use
the	arrow	keys	to	drag	the	selection.	Release	the	Shift	key	once	you	are	done	selecting.

	

To	 select	 a	 range	of	 cells	using	both	keyboard	and	mouse:	Click	one
corner	of	 the	underlying	 range,	hold	 the	Shift	Key	on	your	keyboard
and	then	click	the	other	corner	other	corner	of	the	range.

	

The	purpose	of	 telling	you	 several	ways	of	 selecting	 ranges	 is	 that	you	 try	 all	 and	 then
settle	on	the	one	that	you	feel	is	most	handy.



There	is	another	way	to	select	large	worksheet	areas	and	ranges	containing	thousands	of
cells.	All	you	need	to	do	is	to	zoom	out	the	worksheet	to	expand	the	selection	area.

There	are	three	ways	of	zooming	in/out	the	worksheet.

1.	 Click	the	zoom	control	buttons	(+/-)	or	drag	the	zoom	slider	located	at	the	bottom
right	of	the	worksheet.

2.	 Hold	down	the	Shift	Key	and	spin	the	mouse	wheel

3.	 Click	 the	 percentage	meter	 right	 next	 to	 the	 zoom	 slider.	 This	 will	 open	 up	 the
Zoom	Dialog	box	containing	more	zooming	options.

Figure	5.2	-	Zoomed	Out	View	of	a	Worksheet	Along	With	the	Zoom	Dialog	Box

	

To	select	the	entire	worksheet	and	all	the	cells	in	it,	click	the	small	box
right	beneath	the	name	bar.

	

The	Dual	Role	of	Ctrl	+	A

Ctrl	 +	 A	 is	 a	 very	 famous	 and	 commonly	 used	 keyboard	 combination	 among	 the
MSOffice	 users.	 As	 you	 may	 already	 know,	 hitting	 this	 combination	 on	 the	 keyboard
selects	the	entire	content	on	the	word	document,	excel	worksheet	or	any	other	Office	file
that	is	currently	opened.

Well,	the	role	of	Ctrl	+	A	has	been	slightly	enhanced	in	Excel	2013.	It	can	perform	two
functions;



1.	 If	you	want	to	select	the	entire	worksheet,	move	the	active	cell	to	any	of	the	empty
cell	 on	 the	 worksheet	 and	 then	 press	Ctrl	 +	 A	 on	 your	 keyboard.	 In	 this	 case,
clicking	 an	 empty	 cell	 is	 necessary	 before	 you	 hit	 the	 specified	 keyboard
combination.

2.	 If	 you	 want	 to	 select	 any	 one	 region,	 take	 the	 cursor	 to	 any	 filled	 cell	 of	 the
particular	region	and	then	press	Ctrl	+	A	on	your	keyboard.	This	will	only	select
the	desired	region.		

Selecting	Multiple	Ranges

A	 multiple	 or	 noncontiguous	 range,	 more	 commonly	 known	 as	 the	 nonadjacent	 range
consists	of	two	or	more	ranges	that	are	not	next	to	each	other.

The	 following	 image	 is	 an	example	of	a	nonadjacent	 range.	As	you	can	 see,	 it	 contains
several	regions	as	well	empty	ranges.

Figure	5.3	-	A	Nonadjacent/	Multiple/	Noncontiguous	Range

To	select	a	multiple	range	with	the	mouse,	hold	down	the	Ctrl	key	and	drag	each	range
you	want.	Do	not	release	the	Ctrl	key	till	you	are	done	selecting	all	the	ranges.	The	upper
left	cell	in	the	lastly	selected	range	becomes	the	active	cell.	As	you	can	see	in	Figure	5.3,
Cell	F21	is	the	active	cell.

How	to	Select	Ranges	with	Mouse

If	you	want	to	select	a	few	entire	rows	or	columns,	press	the	Ctrl	key	and	then	one
by	one	click	 the	heading	of	 the	particular	 rows	and	columns.	The	first	cell	of	 the
last	selected	row	becomes	the	active	cell.



If	you	want	to	select	a	range	of	adjacent	rows	or	columns,	hold	down	the	Ctrl	key
and	click	the	heading	of	the	first	row	of	the	desired	range.	While	the	Ctrl	key	is	still
pressed,	click	the	heading	of	the	other	end	of	the	range.

	

For	 Mouse	 Users:	 To	 change	 the	 active	 cell	 without	 disturbing	 the
selection,	hold	down	the	Ctrl	key	while	the	selection	is	still	there	and
click	the	desired	cell	to	make	it	active.

	

How	to	Select	Ranges	with	Keyboard
To	 select	 an	 entire	 region,	 click	 over	 any	 filled	 cell	 in	 the	 particular	 region	 and
press	Ctrl	+	Shift	+	Spacebar													

Likewise,	 to	 select	 an	 entire	worksheet	with	 the	 keyboard,	 click	 over	 any	 empty
cell	on	the	worksheet	and	press	Ctrl	+	Shift	+	Spacebar													

To	select	an	entire	column,	click	over	any	cell	in	the	particular	column	and	hit	Ctrl
+	Spacebar

To	select	 an	entire	 row,	click	over	 any	cell	 in	 the	particular	 row	and	hit	 	Shift	+
Spacebar

If	you	want	to	select	several	adjacent	rows,	select	a	range	that	includes	cells	of	all
the	rows	 that	you	want	 to	select	 then	hit	Shift	+	Spacebar.	Suppose	you	want	 to
select	‘Row	3	to	Row	10’	in	Figure	5.3.	To	do	so,	first	you	need	to	select	at	least
one	 cell	 in	 each	 row	 from	 ‘Row	3	 to	Row	10’.	Next,	 press	Shift	 +	Spacebar	 to
select	all	the	desired	rows.		

If	you	want	to	select	several	adjacent	columns,	select	a	range	that	includes	cells	of
all	the	columns	that	you	want	to	select	then	hit	Ctrl	+	Spacebar.	Suppose	you	want
to	select	‘Column	C	to	Column	F’	in	Figure	5.3.	To	do	so,	first	you	need	to	select	at
least	one	cell	 in	each	column	from	‘Column	C	 to	Column	F’.	Next,	press	Ctrl	+
Spacebar	to	select	all	the	desired	columns.			

	

For	 keyboard	 users:	 To	 change	 the	 active	 cell	 without	 losing	 the
selection,	hit	Enter	to	move	down	one	cell,	hit	Shift	+	Enter	to	move



up	one	cell,	hit	Tab	 to	move	one	cell	 to	 the	 right,	hit	Shift	+	Tab	 to
move	one	cell	to	the	left.

	

Refer	 to	 Appendix	 “List	 of	 Keyboard	 Shortcuts”	 to	 learn	 more	 keyboard	 shortcuts	 for
some	selecting	cell(s).		



Selecting	Multi-sheet	Ranges

In	 addition	 to	 contiguous	 and	 noncontiguous	 ranges	 on	 the	 same	 worksheets,	 you	 can
select	 ranges	 across	multiple	worksheets	 as	well.	 Suppose	 you	want	 to	 apply	 a	 specific
formatting	in	Row1	and	Row2	of	Sheet	1	and	Sheet	3.

Here	is	how	you	can	do	this,

1.	 Select	Row1	and	Row2	in	Sheet	1

2.	 Hold	down	the	Ctrl	key	and	select	the	Sheet	3	tab.

3.	 Select	the	Home	tab	and	apply	the	desired	formatting.

Excel	will	apply	the	particular	formatting	style	to	all	the	selected	rows.	Likewise	you	can
format	similarly	the	columns	and	ranges	in	multiple	worksheets.

Find	and	Select

It	is	not	only	the	regions	and	ranges	that	you	can	select.	You	can	even	select	on	the	basis
of	the	type	of	data	in	the	cells,	formatting,	comments	and	several	other	elements.	The	Find
&	 Select	 drop	 down	 list	 at	 the	 extreme	 right	 of	 the	 Home	 tab	 contains	 many	 helpful
selection	commands.

Figure	5.4	-	The	Find	&	Select	Drop	Down	List

The	 top	 two	options;	namely	Find	and	Replace	works	 just	 like	 the	 traditional	MSOffice



Find	 and	 Replace	 feature.	 The	 five	 commands	 in	 the	 middle,	 from	 Formula	 to	 Data
Validation,	 are	 the	 most	 commonly	 used	 selection	 commands.	 They	 do	 as	 their	 name
suggests.

For	 example,	 the	 “Formulas”	 command	 selects	 all	 the	 cells	 containing	 any	 formula	 in
them.	Likewise,	the	“Conditional	Formatting”	command	finds	and	selects	all	the	cells	on
which	 there	 is	 any	 sort	 of	 Conditional	 Formatting	 applied.	 More	 about	 Conditional
Formatting	in	Chapter	14.

	

	

“Go	To”	Selection

The	 “Go	 To…”	 command	 in	 the	 Find	 &	 Select	 menu	 is	 another	 very	 helpful	 way	 of
selecting	different	elements	in	the	workbook.	The	most	basic	function	of	this	command	is
that	it	moves	the	active	cell	directly	to	the	desired	position.	Just	open	the	“Go	To”	dialog
box	and	enter	the	name	of	the	cell	you	want	to	jump	to.

	

Hit	F5	or	Ctrl	+	G	to	open	the	“Go	To…”	dialog	box	directly	without
expanding	the	‘Find	&	Select’	drop	down	list	

	

Other	than	the	basic	active	cell	selection,	 the	“Go	To”	command	performs	the	following
functions.

1.	 It	helps	you	select	big	range	of	cells.

For	example,	if	you	click	over	cell	A1,	launches	the	“Go	To”	dialog	box,	type	G100	and
then	hit	Shift	+	Enter	on	your	keyboard.	It	will	select	the	range	A1:G100.

2.	 It	helps	you	go	to	another	worksheet	in	the	same	workbook.

To	do	so,	launch	the	“Go	To”	dialog	box	and	type	the	name	of	the	worksheet	you	want	to
move	to,	followed	by	an	exclamation	mark.

Suppose	you	want	to	move	to	Cell	G5	of	worksheet	number	2.	Press	F5	on	your	keyboard
to	open	the	‘Go	To’	dialog	box	and	then	type	Sheet2!G5.	Hit	Enter	and	this	should	move
the	active	cell	to	the	desired	location.



3.	 It	helps	you	go	to	another	worksheet	in	another	workbook.

If	 you	 want	 to	 go	 to	 another	 worksheet	 in	 any	 other	 workbook	 than	 the	 one	 currently
opened,	open	the	Go	To	dialog	box	and	type	in	the	following	format:

[name	of	the	workbook]	worksheet!Cell	name

For	example,	to	move	to	cell	A1	in	worksheet	3	of	workbook	named	Budget	list,	open	the
‘Go	To’	dialog	box	and	type	in	the	following	command.

‘[Budget	list.xlsx]Sheet3’!A1

	

As	you	can	see	there	are	single	quotation	marks	enclosing	the	sheet
reference	 in	 the	 above	 command.	 You	 need	 to	 put	 in	 this	 if	 the
name	 of	 the	 workbook	 contains	 spaces.	 Conversely,	 don’t	 put
quotation	marks	if	there	are	no	space(s)	in	the	title	of	the	workbook

	

“Go	To	Special”	Selection

The	 “Go	 To	 Special”	 command	 in	 the	 Find	 &	 Select	 menu	 contains	 some	 additional
selection	 options.	 It	 is	more	 like	 the	 advanced	 search	 settings	 where	 you	 can	 find	 and
select	cells	that	meet	exact	specifications.

Figure	5.5	-	The	‘Go	To	Special’	Dialog	Box

As	you	can	see	in	the	above	image,	the	“Go	To	Special”	dialog	box	contains	some	of	the



“Go	To”	command	features	along	with	a	few	more.

After	you	select	any	command	in	the	“Go	To	Special”	dialog	box,	 it	highlights	 the	cells
that	meets	the	specified	requirements.	

If	you	select	a	range	of	cells	before	using	any	of	the	“Go	To	Special”
commands,	 it	 will	 highlight	 the	 desired	 cells	 within	 the	 selected
range	only

	

Following	is	a	brief	description	of	the	“Go	To	Special”	commands.

Comments:	It	selects	the	cells	containing	one	or	more	comments

Constants:	This	command	select	cells	containing	statistical	data	such	as	text	or	numbers;
it	does	not	select	cells	having	formulas.

Formulas:	It	selects	all	the	cells	containing	the	specified	type	of	formula.	This	selection
feature	 was	 there	 in	 the	 Find	 &	 Select	 menu	 as	 well.	 Clicking	 it	 there	 selects	 cells
containing	any	type	of	formula.	The	formula	command	in	the	“Go	To	Special”	dialog	box
allows	you	to	be	more	specific	in	your	selection.	You	can	specify	which	type	of	formulas
you	want	to	select.

Blank:	As	the	name	suggests,	it	selects	all	the	blank	cells	within	regions.

Current	Region:	It	is	another	way	of	selecting	the	entire	region.	Click	over	any	cell	of	the
region	you	want	to	select	then	go	for	the	current	region	command.	It	will	select	the	entire
region.

Current	 Array:	 Just	 like	 the	 Current	 Region	 command,	 the	 Current	 Array	 command
selects	the	entire	array	to	which	the	active	cell	belongs	to.	

Objects:	This	command	selects	all	the	graphical	objects	in	your	worksheet,	regardless	of
the	selected	region.

Row	Differences	and	Column	Differences:	These	 two	options	 are	 a	bit	more	 advanced
but	 are	 very	 useful	 once	 you	 get	 the	 hang	 of	 it.	Also	 known	 as	 the	 debugging	 options,
these	 two	 commands	 compare	 the	 values	 in	 the	 selected	 range	 of	 cells	 to	 identify	 the
inconsistencies.

You	need	to	select	a	range	of	cells	before	you	go	for	either	of	these	commands.	The	active
cell	serves	as	the	benchmark	for	comparison.



The	Row	Differences	command	compares	the	cells	in	the	selected	range	with	the	cells	in
the	same	column	as	the	active	cell.

Conversely,	 the	Column	Differences	 command	 compares	 the	 cells	 in	 the	 selected	 range
with	the	cells	in	the	same	row	as	the	active	cell.

In	 either	 case,	 it	 highlights	 the	 cells	 that	 are	 not	 similar	 to	 the	 benchmark	 cell.	 For
example,	if	the	benchmark	cell	contains	an	AVERAGE	formula.	Excel	will	select	all	the
cells	 that	 contains	 values	 and	 formulas	 other	 the	 AVERAGE	 formula.	 Or	 suppose	 the
benchmark	cell	is	an	empty	cell.	Excel	will	highlight	all	the	cells	in	the	selected	range	that
are	filled.	

In	 simple	words,	Row	Differences	 and	Column	Differences	 commands	 compare	 all	 the
cells	with	the	benchmark	cell	and	select	all	those	that	do	not	match	it.

Precedents	and	Dependents:	These	two	commands	help	you	to	identify	all	such	cells	that
either	 contains	 a	 formula	 or	 that	 are	 linked	 to	 any	 other	 formula.	 In	 other	 words,
Precedents	and	Dependents	select	cells	that	are	either	dependent	on	any	other	cell	or	vice
versa.

The	 best	 part	 about	 these	 commands	 is	 that	 they	 can	 be	 used	 on	 individual	 cells	 also.
Suppose	 there	 is	 a	 formula	 in	 Cell	 G6.	 To	 find	 out	 the	 cell	 upon	 which	 this	 formula
depends,	click	over	G6	then	select	the	Precedents	command.	It	will	highlight	the	cell	upon
which	the	G6	formula	depends.	

As	you	can	see	in	Figure	5.5,	there	are	two	sub	options	of	these	commands;	namely	Direct
Only	and	All	Levels.	By	default	the	first	option	is	selected,	whether	you	go	for	Precedents
or	Dependents.

If	you	select	Direct	Only,	Excel	will	 find	and	highlight	cells	 that	directly	 refer	 to	or	are
dependent	upon	active	cell.

If	 you	 select	 All	 Levels,	 Excel	 will	 find	 and	 highlight	 cells	 that	 are	 not	 only	 directly
dependent	on	the	active	cell	but	also	that	are	indirectly	linked	to	it.

	

If	 you	 are	 stuck	 in	 some	 highly	 pronged	 formula	 and	 are	 unable	 to
figure	 out	 its	 precedents	 or	 dependents,	 try	 the	Trace	Precedents	 and
Trace	 Dependents	 commands	 in	 the	 Formula	 Tab.	 Rather	 than
highlighting	 the	 linked	cells	 as	does	 the	 ‘Go	To	Special’	Commands,
the	Formula	 tab	 commands	 draws	 arrows	 showing	 the	 dependents	 or



precedents	 of	 the	 selected	 cell.	More	on	Trace	Precedents	 and	Trace
Dependents	in	Chapter	25

	

Last	Cell:	It	selects	the	lower-right	cell	in	the	active	area	of	the	worksheet,	regardless	of
the	selected	region.

Visible	Cells	Only:	As	the	name	suggests,	this	command	exclude	the	cells	in	hidden	rows
and	columns	from	the	selected	range.

Conditional	Formats:	This	command	highlight	the	cells	that	have	any	rules	of	conditional
formatting	applied	on	them.	It	works	the	same	as	the	Conditional	Formatting	Command	in
the	Find	&	Select	menu.			

Data	Validation:	 As	 you	 can	 see	 in	 Figure	 5.5,	 there	 are	 two	 sub	 options	 of	 the	 Data
Validation	Command.	If	you	go	by	the	“All”	option,	Excel	will	select	all	the	cells	to	which
any	sort	of	Data	Validation	is	applied	to.	If	you	select	the	“Same”	option,	it	will	select	the
cells	containing	the	same	Data	Validation	rules	as	the	active	cell.

The	Data	Validation	command	in	the	Find	&	Select	menu	performs	the	same	function	as
the	 “All”	 option	 explained	 above.	 Refer	 to	 Appendix	 “List	 of	 Keyboard	 Shortcuts”	 to
learn	the	keyboard	shortcuts	for	some	‘Go	To	Special’	commands.		
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Chapter	6:	What	Data	Can	You	Enter?

xcel	 is	 not	 just	 about	 numbers.	 It	 is	 about	 text,	 graphics,	 timelines,	 formulas,
special	characters	and	much	more.	You	can	work	on	different	 types	of	data	 that
are	explained	in	detail	in	this	chapter.	It	also	tells	how	to	work	with	special	types

of	 numeric	 values	 such	 as	 Date	 and	 Time	 in	 Excel.	 You	 will	 be	 amazed	 to	 see	 how
comprehensive	and	smartly	interactive	the	input	system	of	Excel	2013	is.

Learning	the	Different	Types	of	Data

An	 Excel	 workbook	 can	 carry	 countless	 number	 of	 worksheets	 and	 each	 worksheet
contains	 innumerous	 cells,	 17	 billion	 to	 be	 specific.	 It	 is	 these	 cells	 that	 contain	 all	 the
non-graphical	 data.	 The	 graphical	 data	 that	 includes	 charts,	 pictures,	 buttons	 and	 other
such	objects	are	contained	by	the	worksheet’s	invisible	draw	layer.

The	 non-graphical	 data	 is	 further	 divided	 into	 three	 types;	 namely	 text,	 numeric	 and
formula.	A	cell	can	hold	any	of	the	three	types,	briefed	as	follows.

Numeric	Data

As	 the	 name	 suggests,	 numeric	 data	 refers	 to	 a	 numeral	 or	 any	 quantity	 in	 terms	 of
numbers.	 It	 could	 be	 the	 sales	 revenue,	 the	 inventory	 count,	 contact	 number,	 the	 test
percentage	and	so	on.

Excel’s	numeric	values	and	results	of	formulas	are	precise	up	to	15
digits.	If	you	type	a	large	value	such	as	58,987,654,852,364,759,851
(20	 digits),	 Excel	 will	 only	 display	 the	 first	 15	 digits
(589,876,548,523,647),	 the	 rest	 will	 be	 replaced	 by	 zeros.	 This
normally	does	not	cause	much	of	a	problem	unless	you	are	entering	a
card	number	of	any	other	numeric	value	that	needs	to	stay	as	it	is.

	

How	to	Add	Large	Numeric	Values	

If	you	want	to	enter	numeric	values	containing	more	than	15	digits	that	you	do	not	want	to
be	changed,	you	need	to	enter	them	as	text.	There	are	two	ways	to	do	that.		

1.	 Before	entering	 the	value	 into	 the	cell,	go	 to	Home	 tab	and	select	Text	 from	 the
drop	down	list	located	above	the	Number	group;	as	illustrated	in	the	image	below.



Figure	6.1	-	Entering	Large	Numeric	Values	As	Text

2.	 Type	an	apostrophe	in	the	underlying	cell	followed	by	the	number.

Either	ways,	the	Excel	will	interpret	the	value	as	text	and	will	not	make	any	changes	to	it.	

	

Apart	 from	precision,	Excel	also	has	certain	 limitations	 in	 terms	of
how	large	the	numeric	value	can	be.	The	largest	positive	integer	that
Excel	 can	 hold	 is	 9.9E+307.	 Such	 large	 numbers	 are	 mostly
displayed	in	scientific	notations.	9.9E+307	mean	“9.9	times	10	to	the
307th	 power”.	 In	 other	 words,	 “99	 pursued	 by	 306	 zeros”.	 	 	
Likewise,	the	largest	negative	integer	that	a	cell	in	Excel	can	hold	is
–9.9E+307.

	

Text	Data

This	 type	 of	 data	 represents	 text	 values	 such	 as	 name	 of	 the	 students,	 file	 directory,
description	of	anything	and	so	on.

A	text	value	that	starts	with	a	number	is	considered	as	text	by	the	Excel.	For	example,	if
you	enter	 “50	 subjects”	 in	 a	 cell,	 it	will	 be	 taken	as	 text	by	 the	Excel.	As	a	 result,	 you
won’t	be	able	to	use	this	50	in	a	formula.	To	do	so,	write	‘50’	in	one	cell	and	‘subjects’	in
another.

	

	

Formulas



Formulas	are	the	core	element	and	primary	usage	of	the	spreadsheet.	You	can	maintain	a
list	of	employees	in	Word	as	well,	but	you	cannot	calculate	their	payroll	there.

Excel	 contains	 many	 flexible	 formulas;	 by	 flexible	 we	 mean	 you	 can	 modify	 them	 as
required.	You	can	merge	two	or	more	formulas	in	one	cell,	change	the	values	and	so	on.
Formulas	can	use	numeric	as	well	as	text	values.	However	the	latter	needs	to	enclosed	in
double	quotation	marks	in	the	formula.

When	you	enter	a	formula,	the	underlying	cell	displays	the	results	of	the	formula	and	not
the	formula	itself.	If	you	want	to	see	the	formula	or	modify	it,	move	to	the	underlying	cell
and	hit	F2	on	your	keyboard.	You	can	also	view	and	edit	the	formula	in	the	formula	bar.

Figure	6.2	-	Viewing	Formula	in	the	Cell	and	The	Formula	Bar

In	 the	 above	 image,	 the	 values	 highlighted	 in	 blue	 are	Text	 values.	The	 green	 ones	 are
numeric	values	and	the	orange	cells	contain	formulas.	Apparently	it	looks	like	the	orange
cell	 contains	 numeric	 data,	 however	 these	 are	 the	 results	 of	 the	 formula.	 In	 Figure	 6.2,
when	 the	 active	cell	was	moved	 to	one	of	 the	 formula	 cell	 (B6)	 and	F2	was	pressed,	 it
displayed	 the	 formula	 in	 the	 underlying	 cell.	 As	 you	 can	 see,	 the	 same	 formula	 also
appears	in	the	formula	bar.

Working	with	Numeric	Data

In	the	previous	section,	we	talked	about	the	different	types	of	values	that	you	can	enter	in
Excel.	Now	let’s	explore	the	techniques	for	entering	those	values.	

If	you	want	to	enter	a	numeric	value	into	any	cell,	click	over	the	underlying	cell	and	type
in	the	value.	Hit	Enter	or	move	to	any	other	cell.	The	value	that	you	enter	in	a	cell	will
also	appear	in	the	formula	bar	when	the	appropriate	cell	is	selected.

You	can	enter	any	integer,	currency,	decimal	points	or	any	other	type	numeric	value.	You



can	also	change	the	format	after	entering	any	number.	For	example,	if	you	enter	1000	and
then	 wants	 to	 change	 it	 to	 currency	 form,	 you	 can	 do	 so	 by	 selecting	 the	 appropriate
currency	from	the	currency	drop	down	list	in	the	Home	tab.	You	can	increase	or	decrease
decimal	 points	 and	 also	 add	 commas	 to	 separate	 thousands.	 Learn	more	 about	 number
formatting	in	Chapter	8.

	

If	 you	 want	 to	 enter	 a	 negative	 integer,	 precede	 the	 number	 with	 a
minus	sign	or	enclose	it	in	parentheses	(	).	

	
Working	with	Text	Data

Just	like	Excel	displays	the	numeric	value	of	a	cell	in	the	formula	bar,	so	it	does	the	text
value.	 But	 if	 the	 text	 value	 is	 exceptionally	 long,	 the	 formula	 bar	 displays	 a	 part	 of	 it
unless	you	increase	its	area.

There	are	two	ways	to	expand	the	formula	bar	and	view	the	full	text	in	it.

1.	 Take	the	cursor	to	the	bottom	edge	of	the	formula	bar	and	drag	it	down,	as	shown
below.

Figure	6.3	-	Increased	Height	of	the	Formula	Bar

2.	 Hit	Ctrl	+	Shift	+	U	 to	 toggle	 the	height	of	 the	 formula	bar.	 In	order	 to	use	 this
shortcut,	you	need	to	expand	the	formula	bar	at	least	once	using	the	first	method.
This	keyboard	combination	will	then	expand	the	formula	bar	to	the	previous	height
or	to	single	row-default	size.

You	 can	 enlarge	 the	 formula	 bar	 to	 view	 the	 full	 text	 but	 what	 happens	 to	 the
corresponding	 column?	When	 you	 enter	 a	 text	 value	 that	 takes	 up	more	 space	 than	 the
column	width,	either	of	the	two	things	may	happen.

1.	 If	the	cell	right	next	to	the	text-containing	cell	is	filled,	Excel	will	display	the	text



only	as	much	as	it	fits	in	the	pertinent	column.

2.	 If	the	adjacent	cells	are	empty,	Excel	will	split	the	display	into	the	adjoining	cells.
Remember	that	it	is	only	the	display	of	the	text	that	is	expanded	to	adjacent	cells.
The	value	itself	resides	in	one	cell	only.	So	if	you	want	to	make	any	changes	in	the
text,	you	need	to	click	the	underlying	cell	to	do	it.	The	adjacent	cells	just	contain
the	display	and	not	the	value,	actually	they	are	still	empty.

So	what	 if	 the	adjacent	cells	are	not	empty	and	still	you	need	 to	display	 the	entire	 text.
Well,	here	are	a	couple	of	things	that	you	can	try.

Decrease	the	size	of	the	font.

Wrap	the	text	into	multiple	lines	within	the	same	cell.	The	Wrap	Text	command	can
be	found	in	the	Alignment	group	of	the	Home	tab.

If	possible,	edit	the	text	to	make	it	shorter.

Increase	 the	width	of	 the	column.	You	can	do	so	by	right	clicking	 the	underlying
column	and	manually	entering	the	desired	width.	Or	you	can	drag	the	edge	of	the
column	to	expand	it.

	

Working	With	Special	Numeric	Data

Date	 and	 time	 values	 are	 a	 subtype	 of	 numeric	 data.	 Excel	 considers	 them	 as	 special
numeric	values	that	are	formatted	in	accordance	with	the	standard	date	and	time	pattern,
unless	specified	otherwise.

If	 you	 want	 to	 enter	 date	 or	 time	 in	 any	 cell,	 you	 need	 to	 understand	 the	 Excel’s
mechanism	in	this	regard.

First	 we	 will	 talk	 about	 Excel’s	 date	 management	 system	 which	 is	 based	 on	 serial
numbers.	 The	 earliest	 date	 that	 Excel	 recognizes	 is	 January	 1,	 1900.	 It	 carries	 a	 serial
number	“1”.	Likewise	January	1,	1900	has	a	serial	number	“2”	and	so	on.

Now	 you	 don’t	 have	 to	 learn	 all	 these	 serial	 numbers.	 This	 mechanism	 helps	 Excel
interpret	 dates	 in	 formulas.	You	 just	 need	 to	 enter	 the	 desired	 date	 in	 the	 standard	 date
format.

The	 default	 date	 format	 of	 Excel	 depends	 upon	 the	 regional	 date	 settings	 of	 your
computer.	For	example,	if	the	regional	date	format	of	your	computer	is	(Day/Month/Year),



then	you	need	to	follow	the	same	pattern	when	typing	in	the	date	in	any	cell.

	

You	 can	 change	 the	 date	 pattern	 in	 Excel	 without	 disturbing	 your
computer’s	date	settings.	To	do	so,	right	click	the	appropriate	cell	and
select	Format	Cells	>	Date.

Just	like	the	date	system,	the	time	system	of	Excel	is	also	based	on	serial	numbers.	This
one	 however	 is	 in	 decimals.	 For	 example,	 the	 serial	 number	 for	 noon	 (half	 day)	 is	0.5.
Again	 you	 don’t	 need	 to	 get	 in	 much	 detail	 about	 these	 serial	 numbers.	 Just	 enter	 the
desired	 time	 into	 the	 cell	 in	 the	 recognized	 format.	 You	 can	 change	 the	 time	 format
settings	by	right	clicking	the	appropriate	cell	and	selecting	Format	Cells	>	Time.

Refer	to	Chapter	19	to	learn	more	about	Date	and	Time	formatting	and	formulas.
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Chapter	7:	Working	a	Worksheet

ntering,	 editing,	 undoing	 and	 deleting	 data	 are	 the	 core	 activities	 of	 every
spreadsheet	 you	make.	Whether	 you	make	 a	 payroll	 system	 on	Excel,	 generate
graphs	and	charts	or	do	VBA	programming,	whatever	you	do	on	Excel	 requires

you	to	enter	the	relevant	data,	format	and	edit	it	and	delete	the	wrong	entries.

The	 preceding	 chapter	 has	 already	 covered	 the	 basics	 of	 data	 entry.	 This	 chapter	 talks
about	the	editing	and	deleting	part.	It	also	contains	some	practical	and	efficient	data	entry
tips.	This	may	seem	a	basic	chapter	to	some	of	you.	However	you	might	find	a	better	or
quicker	way	of	doing	something	in	Excel	that	you	do	frequently.

Editing	Entries

This	section	talks	about	the	editing	of	values	in	a	cell.	You	can	also
edit	the	formatting	of	the	cells	(explained	in	the	upcoming	chapters).
Editing	the	value	does	not	affect	the	formatting	and	vice	versa.	

	

There	are	several	ways	of	editing	values,	depending	upon	the	length	and	nature	of	data.	If
the	cell	contains	a	few	words	or	numbers	or	a	simple	formula,	you	can	easily	overwrite	it.
Just	move	to	the	underlying	cell	and	type	in	the	new	value.	This	strategy	however	is	not
recommended	if	the	cell	contains	lengthy	text	or	a	complicated	formula.

In	case	where	overwriting	the	data	is	not	feasible	or	may	take	up	a	lot	of	time,	you	may
want	to	consider	editing	it.

To	do	so,	just	select	the	cell	and	then	make	the	changes	in	the	Formula	bar.	What	edits	you
do	 in	 the	 formula	 bar	will	 simultaneously	 update	 in	 the	 corresponding	 cell.	Now	many
users	don’t	like	to	edit	in	the	Formula	bar.	They	rather	prefer	to	make	the	changes	directly
in	the	cell.	If	you	want	to	edit	this	way,	just	move	to	the	appropriate	cell	and	hit	F2.	For
mouse	users,	double	click	the	underlying	cell	and	make	the	changes.

	

If	you	want	 to	edit	 in	 the	cell	directly,	make	sure	 it	 is	enabled	 in
the	Excel	options.	To	do	 so,	 select	File	 >	Options	 >	Advanced.
There	you	will	an	“Allow	Editing	Directly	in	Cells”	option.	Make
sure	the	corresponding	box	is	check	marked.



	

Whenever	a	cell	is	in	the	edit	mode,	you	will	notice	that	the	two	icons	(X	and � )	in	the
formula	bar	are	activated.	These	are	illustrated	in	Figure	7.1.

Figure	7.1	-	Two	icons	in	the	Formula	Bar

Clicking	“X”	will	close	the	edit	mode	without	accepting	the	changes	made	in	the	cell.	The
keyboard	shortcut	for	this	tool	is	Esc

Clicking	“ � ”	will	accept	the	changes	and	then	close	the	editing	mode.	You	can	also	hit
Enter	on	your	keyboard	to	do	this.	

Deleting	Entries

If	 you	want	 to	 delete	 any	 entry,	 just	 click	 over	 the	 cell	 and	 hit	 the	Delete	 key	 on	 your
keyboard.	To	delete	more	than	one	cell,	select	the	range	of	cells	you	want	to	get	rid	of	and
then	press	Delete.	This	method	however	deletes	 the	content	of	 the	cell	only.	 It	does	not
clear	the	formatting.

For	advanced	deleting	options,	select	the	Home	tab	and	click	the	Clear	drop	down	list.	It
is	 the	small	pink	 tilted	eraser	 like	 icon	 located	 in	 the	Editing	group	of	 the	Home	tab,	as
shown	in	the	image	below.

Figure	7.2	-	The	‘Clear’	Drop	Down	List

As	you	can	see,	this	list	contains	six	options.

Clear	All	clears	everything	contained	within	the	cell.	This	includes	the	value,	formatting,
comments,	hyperlinks	and	any	other	objects.

Clear	Formats	clears	only	the	formatting,	leaving	behind	the	content	untouched.	.

Clear	Contents	 deletes	 the	content	only.	 It	does	not	disturb	 the	 formatting.	Pressing	 the



Delete	key	on	the	keyboard	gives	the	same	effect.

Clear	Comments	deletes	the	comment,	if	there	is	any	attached	to	the	selected	cell.

Clear	Hyperlinks	removes	the	hyperlink	leaving	behind	the	content.	It	does	not	delete	the
value	in	the	cell,	just	takes	away	its	hyperlink.	The	formatting	is	also	untouched.

Remove	Hyperlinks	works	similar	to	the	Clear	Hyperlinks	command.	However	it	removes
the	formatting	of	the	cell	as	well.

	

Playing	with	Special	Characters

Minus,	plus,	parentheses,	comma	and	few	characters	are	considered	as	special	values	by
Excel.	Entering	them	with	numeric	values	changes	the	nature	of	the	content.

Following	are	some	brief	guidelines	on	how	Excel	interprets	special	characters.	

	 	 	 	 	 	 	 If	you	want	 to	enter	a	 formula,	 it	must	begin	with	an	equals	 (=)	sign	or	else
Excel	will	consider	it	as	plain	numeric	or	text	value.

							A	plus	sign	has	no	value	for	Excel	if	entered	before	a	numeric	value.	However	if
a	formula	is	preceded	by	a	plus	sign,	it	is	equivalent	to	the	equals	(=)	sign.

							You	can	enter	commas	to	separate	thousands	in	numeric	values,	however	they	do
not	appear	in	the	edit	more.	For	example,	2,543,415	would	display	as	2543415	in
the	formula	bar.

	 	 	 	 	 	 	‘E’	or	‘e’	 in	numeric	values	represents	 the	exponent	of	scientific	notation.	To
enter	 a	 positive	 exponential	 number,	 put	 a	 plus	 sign	 (+)	 after	 ‘E’.	 For	 example,
3E+5	means	300,000.	Likewise	if	you	want	to	enter	a	negative	exponential	number,
put	a	minus	(-)	sign	after	‘E’.	For	example,	3E–5	means	0.00003.

							If	you	enter	a	dollar	sign	($)	followed	by	the	numeric	value,	it	will	automatically
be	 converted	 into	 the	 currency	 format,	 containing	 the	 dollar	 sign	 and	 comma
separators.

	 	 	 	 	 	 	Numeric	 entries	 that	 are	 preceded	 by	 a	minus	 sign	 (-)	 or	 those	 enclosed	 in
parentheses	are	considered	as	negative	values	by	Excel.

							If	you	enter	slash	(/)	between	numbers,	it	will	be	converted	into	the	Date	format
by	Excel.	 For	 example,	 if	 you	 enter	 5/13	 then	 depending	 upon	 the	 regional	 date
settings	of	your	computer,	Excel	will	either	convert	this	value	into	13-May	or	May



2013.		

							Slash	(/)	can	also	be	used	to	display	a	fraction,	however	to	make	sure	that	Excel
does	not	 interpret	 the	slash	(/)	as	a	date,	put	a	space	between	the	number	and	the
fraction.	For	example,	32	4/9.	As	you	can	see,	there	is	a	space	between	32	and	4/9.
This	way	it	won’t	be	considered	as	a	date	by	Excel.

	

If	you	want	to	enter	a	fraction	without	any	number,	begin	with	a	zero
and	a	space.	For	example,	if	you	want	to	enter	5/10	as	a	fraction	then
type	in	0	5/10	in	the	appropriate	cell.	This	way	it	won’t	be	considered
as	10th	May	by	Excel.		

	



Some	Valuable	Data	Entry	Tips

When	working	on	large	data	and	spreadsheets,	data	entry	may	get	boring.	Here	are	a	few
more	tips	that	will	make	data	entry	quicker	and	interesting	for	you.

Settings	for	Moving	Active	Cell

When	you	press	Enter	on	your	keyboard,	the	current	cell	automatically	moves	down	one
cell.	If	you	want	to	change	this	setting,	select	File	>	Options	>	Advanced.	There	the	first
checkbox	is	After	Pressing	Enter,	Move	Selection,	 followed	by	a	Direction	drop	down
list	containing	Down,	Right,	Up	and	Left;	as	shown	in	the	image	below.

Figure	7.3	-	Settings	for	Moving	Active	Cell

Make	sure	the	checkbox	is	marked	and	then	select	the	desired	direction.	For	example,	if
you	select	Right,	then	the	next	time	you	hit	Enter	on	your	keyboard,	the	current	cell	will
move	one	cell	to	the	right.

You	can	also	keep	this	option	turned	off	and	instead	use	the	arrow	keys
on	 your	 keyboard	 to	 move	 the	 active	 cell	 in	 the	 corresponding
direction.		

	

Magical	Trick	to	Enter	Decimal	Points

When	you	need	to	fill	large	spreadsheets	with	numeric	data	that	contains	decimal	points	at
fixed	places,	you	can	use	the	Auto	Decimal	feature	of	Excel	that	inserts	a	decimal	point
automatically	in	every	numeric	value	you	enter.		



To	use	this	tool,

1.	 Select	File	>	Options	>	Advanced

2.	 There	 on	 the	 second	 number	 you	 will	 find	 a	 checkbox	 labeled	 Automatically
Insert	a	Decimal	Point.	This	option	is	unchecked	by	default.

3.	 Tick	this	checkbox	and	enter	the	number	of	places	at	which	you	want	the	decimal
point	to	be,	as	shown	in	Figure	7.4.

4.	 Click	OK

5.	 Now	 go	 back	 to	 your	 worksheet	 and	 start	 entering	 the	 numeric	 values.	 If	 you
selected	two	decimal	places	in	the	settings,	entering	98756	into	a	cell	will	convert
into	987.56.	Likewise	whatever	value	you	enter	will	contain	a	decimal	point	before
two	places.		

6.	 Once	you	are	done	entering	the	decimal	values,	go	back	to	the	Advanced	settings
and	 unmark	 the	Automatically	 Insert	 a	Decimal	 Point	 checkbox.	Don’t	worry,
reverting	the	settings	won’t	affect	your	decimal	values.	The	ones	that	you	entered
while	the	Auto	Decimal	feature	was	activated	will	stay	as	is	with	decimal	points.

Figure	7.4	-	Activating	the	Auto	Decimal	Feature

	

Make	sure	you	deactivate	 the	Auto	Decimal	feature	as	soon	as	you
are	 done	 using	 it	 as	 it	 applies	 to	 all	 the	workbooks	 saved	 in	 your
computer	rather	than	the	one	currently	opened.	If	you	forgot	to	turn
off	 the	 feature	 and	 start	 working	 on	 any	 other	 workbook,	 it	 may



cause	confusion	and	mess	up	the	entire	data



Moving	Active	Cell	within	a	Range

If	 you	want	 to	 edit	 a	 specific	 range	 of	 cells,	 it	 is	 recommended	 to	 select	 it	 first	 before
making	any	entries	 in	 any	cell.	Doing	 so	will	 restrict	 the	 active	 cell	within	 the	 selected
range.

If	you	select	a	specified	range	of	cells	and	then	press	Enter,	the	active	cell	will	move	to	the
next	 cell	 within	 the	 range.	 When	 it	 will	 reach	 the	 last	 cell	 in	 the	 first	 column	 of	 the
selected	range,	it	will	jump	to	the	first	cell	of	the	next	row	and	so	on.

Figure	7.5	-	Movement	Pattern	of	the	Active	Cell	within	the	Selected	Range

Figure	 7.5	 shows	 how	 active	 cell	moves	within	 a	 selected	 region.	When	 the	 active	 cell
reaches	the	last	cell	 in	the	selected	range,	which	is	Cell	C15	in	the	above	image,	it	goes
back	 to	 the	 first	 cell	 of	 the	underlying	 range	on	pressing	 another	Enter.	No	matter	 how
many	times	you	press	enter,	the	active	cell	will	roam	within	the	selected	range,	unless	you
click	outside	the	range	or	hit	any	navigation	key.

To	move	back	a	cell,	hit	Shift	+	Enter.

Entering	Same	Value	in	Multiple	Cells

If	you	want	to	enter	the	same	value	in	more	than	one	cell,	there	are	three	ways	to	do	that.

1.	 You	can	copy	the	value	and	paste	it	 individually	in	all	 the	desired	cells.	However
this	 way	 of	 copying	 data	 is	 not	 feasible	 when	 you	 are	 working	 on	 large
spreadsheets	and	needs	to	copy	the	same	value	in	hundreds	of	cells.

2.	 Another	way	 is	 to	 enter	 the	value	 in	one	cell,	 then	 take	 the	 cursor	 to	 the	bottom



right	 edge	 of	 the	 underlying	 cell	 and	 click	 and	 drag	 it	 to	 the	 desired	 number	 of
cells.	 This	 method	 is	 appropriate	 for	 copying	 data	 in	 adjacent	 ranges	 and
consecutive	cells.	You	cannot	drag	 the	same	value	 into	a	noncontiguous	 range	or
cells	located	apart	one	another.

3.	 The	 third	and	best	way	to	copy	a	value	 into	multiple	cells	 is	Ctrl	+	Enter.	First,
select	the	range	of	empty	cells	where	you	want	to	enter	the	same	value.	By	default,
the	 active	 cell	will	 be	 the	 first	 cell	 of	 the	 selected	 range.	Do	not	 click	 anywhere
else,	 just	 select	 the	 range,	 enter	 the	 value	 and	 then	 hit	 Ctrl	 +	 Enter	 on	 your
keyboard.	This	should	insert	the	same	value	into	all	the	cells	of	the	selected	range.

	

Let	AutoFill	Do	Your	Work

AutoFill	is	one	of	the	most	handy	and	popular	feature	of	Excel.	It	helps	you	to	fill	data	in
a	series	of	cells.	It	uses	the	AutoFill	handle	to	do	this.

AutoFill	handle	is	a	small	box	located	at	the	lower	right	edge	of	the	active	cell,	as	shown
in	Figure	7.6

The	AutoFill	feature	is	pretty	easy	to	use.	All	you	have	to	do	is	click	and	AutoFill	handle
and	drag	it	to	copy	the	value	in	the	active	cell	to	the	desired	series	of	cell.	Take	a	look	at
the	Figure	7.6

Figure	7.6	-	The	AutoFill	Feature	and	the	Additional	AutoFill	Options	

In	this	image,	a	numeric	value	12345	is	entered	in	Cell	A2.	When	the	AutoFill	handle	of
this	cell	was	dragged	below,	 the	same	value	was	copied	 in	all	 the	cells	up	 to	which	 the
handle	was	dragged	to.	This	tool	can	be	used	to	copy	text	values	and	formulas	as	well.



AutoFill	handle	does	not	only	copy	the	same	value.	It	fills	a	consecutive	pattern	of	series
as	well.	 In	 Figure	 7.6,	 the	 first	 two	months	were	 entered	manually	 in	Cell	B2	 and	B3.
Then	both	 these	cells	were	selected	and	 their	combined	AutoFill	handle	was	dragged	 to
complete	the	series	of	months.

	

If	 the	AutoFill	 handle	 is	 not	 visible	 on	 your	worksheet,	 it	may	 be
turned	off.	To	turn	on	the	AutoFill	handle,	Select	File	>	Options	>
Advanced.	 There	 you	 will	 find	 a	 checkbox	 labeled	 Enable	 Fill
Handle	 and	 cell	 drag-and-drop.	 Place	 a	 tick	 mark	 next	 to	 this
check	box	to	enable	the	AutoFill	handle.

	

In	Figure	7.6,	there	is	a	small	box	pointed	by	the	red	arrow.	This	box	appears	when	you
drag	 the	AutoFill	handle.	Clicking	 this	will	open	up	additional	AutoFill	options	such	as
Copy	Cells,	Fill	Formatting	Only,	Fill	without	Formatting	and	so	on.	All	 the	options	are
self	explanatory.	For	example	if	you	just	want	to	copy	the	formatting	of	active	cell	and	not
the	value	itself,	click	Fill	Formatting	Only.	Likewise	clicking	Copy	Cells	will	copy	the
value	as	well	the	formatting	in	the	dragged	upon	cells.

Adding	a	Line	Break

If	you	want	to	enter	a	lengthy	text	value	in	a	cell	but	do	not	want	it	to	take	up	too	much	of
the	column	width,	you	can	add	a	Line	Break.	It	will	break	the	text	up	into	multiple	lines
within	the	same	cell.

To	enter	a	Line	Break,	press	Alt	+	Enter.	Doing	so	will	add	another	line	in	the	same	cell.
You	can	enter	a	line	break	after	you	have	entered	the	value	or	while	entering.

	

When	 you	 enter	 a	 Line	 Break,	 Excel	 automatically	 converts	 the
underlying	cell’s	formatting	into	Wrap	Text.	However	unlike	normal
text	wrap	the	one	that	you	do	by	clicking	the	Wrap	Text	icon	in	the
Home	tab,	this	one	gives	you	control	over	where	you	want	to	add	the
Line	Break.

	

If	 you	 want	 to	 remove	 a	 Line	 Break,	 bring	 the	 cell	 into	 the	 edit	 mode	 and	 go	 to	 the



insertion	point	of	 the	particular	Line	Break,	 then	hit	Delete	 on	your	keyboard.	The	 text
that	was	there	after	the	line	break	will	move	up	along	the	preceding	text.	

Automating	the	Data	Entry

AutoComplete	 is	 another	 very	 helpful	 feature	 of	 Excel.	 It	 automates	 the	 data	 entry	 by
remembering	your	entries	and	then	inserting	the	same	text	in	multiple	cells.

Suppose	you	entered	 the	word	Company	 in	a	cell.	Excel	 remembers	 it.	As	soon	as	you
will	enter	Co	 in	the	any	other	cell,	Excel	will	offer	to	fill	 in	Company	 there.	If	it	is	the
same	word	that	you	want	to	insert,	just	hit	Enter.

If	there	are	several	words	that	start	with	Co	and	the	word	offered	by	Excel	is	not	the	one
you	are	looking	for,	right	click	the	cell	and	select	Pick	From	Drop-down	List.	This	will
attach	a	drop	down	list	to	the	underlying	cell	containing	all	the	words	starting	with	Co	that
you	have	at	sometime	entered	in	the	same	worksheet

	

You	can	turn	off	the	AutoComplete	feature	by	selecting	File	>	Options
>	Advanced.	 Unmark	 the	 checkbox	Enable	 AutoComplete	 for	 cell
values.	

	

Refer	to	Chapter	17	to	learn	more	about	the	handy	AutoComplete	Feature.

Creating	Your	Own	Shortcuts

Just	like	the	AutoFill	and	AutoComplete,	the	AutoCorrect	feature	of	Excel	is	another	very
handy	tool.	It	allows	you	to	create	shortcuts	for	words	that	you	commonly	use,	so	that	you
don’t	have	to	type	them	again	and	again.

For	example,	if	you	are	making	a	spreadsheet	or	Excel	based	report	on	different	types	of
“environment	friendly	colorful	plastic	bags”	and	you	need	to	type	this	phrase	frequently,
you	can	create	an	AutoCorrect	shortcut	such	as	“efb”	or	“env”	or	any	other	abbreviation
that	you	can	easily	remember.	Suppose	you	created	env.	Now	whenever	you	type	env	in
any	 of	 the	 cell,	 the	AutoCorrect	 feature	will	 automatically	 change	 it	 into	 environment
friendly	colorful	plastic	bags.



To	setup	your	own	AutoCorrect	shortcuts:

1.	 Select	File	>	Options	>	Proofing

2.	 There	 you	 will	 see	 the	 AutoCorrect	 Options	 button.	 Click	 it	 to	 open	 the
AutoCorrect	dialog	box;	as	shown	in	Figure	7.7.

3.	 Make	sure	the	“Replace	Text	as	You	Type	checkbox”	is	marked.

4.	 Enter	 the	 original	word	 in	 the	Replace	 box	 and	 its	 desired	 shortcut	 in	 the	With
box.	Figure	7.7	illustrates	the	example	discussed	above.	Likewise	you	can	create	as
many	shortcut	entries	as	you	want.

Figure	7.7	-	Creating	A	Shortcut	Entry	Using	The	Autocorrect	Feature

The	AutoCorrect	 entries	 are	 applied	 to	 all	 the	Microsoft	 Office	 Applications.	 It	 means
whatever	shortcuts	you	create	in	Excel	will	work	in	MS	Word	and	other	MSOffice	apps	as
well,	and	vice	versa.

Refer	to	Appendix	“List	of	Keyboard	Shortcuts”	to	learn	the	keyboard	shortcuts	for	Data
Entry.			

	





F
Chapter	8:	The	Magical	Number	Formatting

ormatting	 is	 of	 numerous	 types;	 changing	 fonts,	 adding	 colors,	 shading,	 borders
and	 so	 on,	 all	 this	 comes	 under	 formatting.	However	 there	 is	 one	more	 type	 of
formatting	that	is	exclusive	to	Microsoft	Excel	only	and	that	is	number	formatting.

While	more	 about	 number	 formatting	 is	 explained	 in	 the	 upcoming	 headings,	 it	 simply
refers	to	changing	the	appearance	of	the	numbers	in	the	cells.

This	chapter	explains	in	detail	the	concept	of	number	formatting.	It	covers	the	categories
of	number	formatting,	different	methods	of	formatting	numbers	and	some	handy	shortcuts
as	well.

What	Is	Number	Formatting?

As	 just	 mentioned,	 Number	 Formatting	 is	 the	 process	 of	 modifying	 the	 appearance	 of
numeric	 values.	By	 appearance	we	mean	 comma	 separators,	 decimal	 points,	 percentage
sign,	 currency	 symbols	 and	 so	 on.	 The	 purpose	 of	 all	 this	 is	 to	make	 the	 values	more
understandable.

	

Number	 formatting	 just	 changes	 the	 look	 of	 the	 cells.	 It	 does	 not
affect	the	actual	underlying	values.

	

When	 you	 enter	 any	 numeric	 values	 in	 Excel,	 they	 are	 unformatted	 by	 default.	 They
represent	nothing	but	a	simple	string	of	numbers.	There	are	countless	ways	in	which	you
can	format	them,	as	explained	in	the	upcoming	section.

Get	To	Know	the	Main	Formatting	Categories

The	 innumerous	 ways	 of	 Number	 Formatting	 are	 classified	 into	 several	 categories,	 as
briefed	below.	

General:	Every	numeric	value	that	you	enter	in	a	cell	carries	a	general	format	by	default.
Normally,	it	refers	to	the	plain	string	of	numerals.	However	if	the	number	is	too	large,	the
general	format	is	automatically	converted	into	the	scientific	notation.

Number:	 This	 category	 of	 format	 is	mostly	 used	 to	 display	 precise	 values	 and	 decimal
points.	The	Number	Format	also	contains	the	option	to	add	comma	to	separate	thousands.
Another	very	interesting	thing	about	this	format	is	its	red	coloring	of	negative	values.	In



other	words,	if	you	enter	any	negative	values	or	values	enclosed	in	parentheses	and	then
apply	number	formatting	to	it,	all	the	negative	values	will	turn	red.

Currency:	As	the	name	suggests,	this	format	is	used	to	display	monetary	values.	Just	like
the	 number	 format,	 this	 one	 also	 contains	 the	 decimal,	 thousand	 separator	 and	negative
value-red	color	option.	

Accounting:	It	 is	similar	to	the	currency	format.	The	only	difference	between	the	two	is
that	the	Accounting	format	lines	up	the	currency	symbols	and	decimal	points	in	a	column.

Date:	This	format	turns	the	underlying	values	into	the	default	date	format.	The	best	thing
about	this	format	is	that	it	allows	you	to	select	your	native	date	format;	as	shown	in	Figure
8.1

Figure	8.1	-	Selecting	the	Location	and	Regional	Date	Format

Time:	 This	 format	 is	 used	 to	 represent	 time	 values.	 Just	 like	 the	Date	 format,	 this	 one
offers	options	to	select	your	country	based	recognized	date	format

Fraction:	It	allows	you	to	select	from	nine	different	fraction	based	formats.

Percentage:	If	this	format	is	applied	before	entering	a	value,	it	will	put	a	percentage	sign
in	front	of	any	value	you	enter	in	the	selected	cells.	It	also	contains	the	option	to	determine
decimal	places.	

It	 is	highly	 recommended	 that	you	apply	 the	percentage	 formatting
before	entering	the	values.	If	done	afterwards,	it	will	multiply	all	the



underlying	 values	 with	 100	 and	 then	 put	 a	 percentage	 sign	 with
them.	 For	 example,	 if	 you	 enter	 80	 in	 a	 cell	 and	 then	 apply
Percentage	 formatting	 to	 it,	 it	will	 change	 the	 value	 to	 8000%.	On
the	 other	 hand,	 if	 you	 would	 have	 changed	 the	 formatting
beforehand,	80	would	have	become	80%	and	nothing	more!

	

Scientific:	 Applying	 this	 format	 will	 change	 the	 value	 into	 scientific	 notations.	 For
example	if	you	enter	500,000	and	then	apply	this	formatting,	it	will	convert	the	value	into
exponential	form	(5.00E+0.5)

Text:	This	format	is	used	to	display	the	numeric	values	as	text.	Excel’s	numeric	values	are
precise	up	 to	only	15	digits.	 If	a	value	contains	more	digits,	 the	numerals	after	 the	15th
digit	are	replaced	by	zeros.	So	if	you	want	to	enter	a	numeric	value	containing	more	than
15	digits	that	need	to	stay	as	it	 is,	apply	Text	formatting	to	the	appropriate	cell	and	then
enter	the	value	in	it.

This	format	is	mostly	used	to	enter	credit	card	numbers	and	other	such	values.

Special:	This	category	contains	four	additional	formats,	including	Zip	Code,	Zip	Code	+4,
Phone	Number,	and	Social	Security	Number.

	

The	four	formats	are	only	available	for	some	particular	locations.	If
it	 does	 not	 appear	 in	 your	 location,	 just	 change	 the	 location	 to
English	(United	States)	and	all	the	four	formats	will	appear	in	the
dialog	box,	as	shown	in	Figure	8.2.		

	



Figure	8.2	-	Four	Types	of	Special	Formats

Custom:	This	option	allows	you	to	create	your	own	number	formats	that	are	not	available
in	any	other	category.	Customized	number	formatting	is	explained	in	detail	later	on	in	this
chapter.

When	a	cell	is	in	edit	mode,	it	displays	the	value	in	the	unformatted
state.	Same	is	with	formula	bar.	It	shows	the	value	in	is	unformatted
form.	However	this	rule	does	not	apply	to	date,	time	and	percentage
format.	 Once	 you	 apply	 any	 of	 the	 three	 mentioned	 formats,	 the
resulting	value	will	appear	this	way	in	the	edit	mode	as	well	as	the
formula	bar.

	
Different	Ways	of	Number	Formatting

Now	 that	 you	 know	 the	 different	 types	 of	 formatting	 that	 you	 can	 apply	 on	 numeric
values,	let’s	see	how	you	can	actually	perform	Number	Formatting	in	Excel.	

	

Make	 sure	 you	 select	 a	 cell	 or	 range	 of	 cells	 before	 applying	 any
type	of	formatting	to	it.	The	formatting	that	you	apply	works	on	the
selected	 cell(s)	 only.	 It	 is	 not	 applied	 on	 all	 the	 cells	 in	 the
worksheet,	unless	you	select	the	entire	worksheet	and	then	apply	the
desired	formatting	style.



	

Excel’s	Smart	Auto	Number	Formatting

There	are	several	ways	of	doing	number	formatting,	the	easiest	one	of	which	is	by	using
Excel’s	built-in	Auto	Number	Formatting	feature.	When	you	enter	any	value,	Excel	tries
to	identify	its	nature	and	formats	accordingly.	For	example,	if	you	enter	15.8	and	then	hit
the	 %	 key	 on	 your	 keyboard,	 Excel	 will	 automatically	 change	 it	 into	 percentage
formatting.	Likewise	 if	you	precede	a	value	with	a	dollar	 sign	 ($),	Excel	will	convert	 it
into	the	currency	format	and	add	commas	and	decimal	points	to	it.				

	

If	 you	 are	 entering	 numeric	 values	 and	 yet	 your	 values	 are	 not
automatically	 turning	 into	 the	 percentage	 format,	 select	 Home	 >
Options	 >	 Advanced.	 Locate	 the	 checkbox	 labeled	 as	 Enable
Automatic	Percent	Entry	and	put	a	tick	mark	in	it.

	

Handy	Shortcuts	for	Number	Formatting

Shortcuts	 always	make	ones	work	 easy	 and	 fun.	And	 like	 every	other	 feature,	 there	 are
keyboard	shortcuts	for	number	formatting	as	well.	

The	most	commonly	used	shortcuts	for	Number	Formatting	are	as	follows.

Keyboard	Shortcut Description

Ctrl	+	Shift	+	~ Apply	the	General	Format

Ctrl	+	Shift	+	$ Apply	the	Currency	Format	with	two	decimal	places

Ctrl	+	Shift	+	% Apply	the	Percentage	Format

Ctrl	+	Shift	+	! Add	two	decimal	places,	commas	and	minus	sign	(-)	for	negative	values	

Table	8.1	-	Common	Keyboard	Shortcuts	for	Number	Formatting

However	these	are	not	the	only	ones.	Refer	 to	Appendix	 for	 the	complete	 list	of	Number
Formatting	shortcuts.			



Number	Formatting	Via	Ribbon

The	 Home	 Tab	 in	 the	 Ribbon	 also	 contains	 the	 frequently	 used	 number	 formatting
commands.	You	will	 find	 them	 in	 the	Number	group	of	 the	Home	 tab,	 as	 shown	 in	 the
image	below.

Figure	8.3	-	Number	Formatting	Commands	in	the	Home	Tab

This	drop-down	list	contains	11	number	formats.	However	as	you	already	know,	these	are
not	 all	 the	 type	 of	 formats	 available	 in	 Excel.	 So	 if	 you	 could	 not	 find	 your	 required
number	 format	 here,	 click	More	Number	 Formats	 located	 at	 the	 bottom	 of	 this	 drop-
drown	list.		

Just	beneath	this	drop-down	list,	there	are	icons	for	the	five	most	commonly	used	number
formats,	as	shown	in	Figure	8.4

Figure	8.4	-	Icons	for	the	Five	Commonly	Used	Number	Formatting	Commands

Starting	from	the	left	in	the	above	image,	the	icons	are	for	currency,	percentage,	thousand
separator,	 increase	 decimal	 and	 decrease	 decimal.	 If	 you	 want	 to	 apply	 any	 of	 the
mentioned	formats,	just	select	the	underlying	cell(s)	and	click	the	respective	icon.	You	can
apply	formatting	before	as	well	as	after	entering	the	values.	However	the	former	is	highly
recommended	in	case	of	percentage	format.

Exploring	the	Comprehensive	Format	Cells	Dialog	Box



The	 drop-down	 list	 in	 the	 ribbon	 and	 the	 shortcuts	 do	 not	 contain	 all	 the	 Number
Formatting	options	Excel	has	to	offer.	The	Format	Cells	dialog	box	is	right	place	for	it.

There	are	four	ways	to	launch	the	Format	Cells	Dialog	box,	as	explained	below.

1.	 Right	click	the	selected	cell(s)	and	then	select	Format	Cells.

2.	 Press	Ctrl	+	1	on	your	keyboard

3.	 Click	the	small	downward	diagonal	arrow	located	at	the	bottom	right	corner	of	the
Number	group	in	the	Home	tab.

4.	 Open	 the	Number	Format	drop-down	 list	 in	 the	Number	group	 in	 the	Home	 tab,
then	click	More	Number	Formats	located	at	the	bottom	of	the	list.	

Make	sure	 to	select	 the	cell	or	 range	of	cells	 in	which	you	want	 to
apply	 the	 formatting	 before	 opening	 the	 Format	 Cells	 dialog	 box
through	any	of	the	ways.

	

In	the	Format	Cell	dialog	box,	all	the	formatting	categories	are	listed	on	the	left	hand	side.
Click	 a	 category	 to	 open	 its	 sub-options.	 At	 the	 bottom	 of	 the	 dialog	 box	 is	 the	 brief
description	of	the	format	category	that	you	select.

	

Figure	8.5	-	The	Format	Cells	Dialog	Box

The	value	beneath	Sample	shows	how	your	selected	value	will	look	like	after	applying	the



particular	formatting.	You	can	scroll	up	and	down	and	check	different	formats	till	you	find
the	one	you	are	looking	for.	Click	OK	once	you	are	done	selecting	the	desired	format.

Custom	Number	Formatting	

The	number	formats	of	Excel	are	very	comprehensive	and	elaborate.	You	will	find	a	built-
in	format	of	almost	every	type	you	need.	These	are	also	pretty	easy	to	use.	So	try	to	find
the	one	you	are	looking	for	in	the	already	available	ones.	In	case	if	you	are	unable	to	find
one,	you	can	always	create	your	own	format.	

	

Custom	 number	 formats	 are	 saved	 only	 in	 the	workbook	 in	which
you	 create	 them.	 To	 copy	 your	 custom	 formats	 to	 any	 other
workbook,	 copy	 the	 cell	 carrying	 the	 particular	 custom	 format	 and
then	paste	it	to	the	appropriate	cell	in	the	other	workbook.	

	

Learning	the	Custom	Format	Language

Custom	number	formatting	is	a	bit	complex.	It	has	its	own	set	of	codes	and	symbols	that
you	need	to	understand	before	you	try	making	a	format	of	your	own.

0	(zero)

Known	 as	 the	 Digit	 Placeholder,	 this	 symbol	 makes	 sure	 that	 the	 specified	 number	 of
digits	 are	 displayed	 in	 the	 underlying	 value.	 Now	 there	 could	 be	 either	 of	 the	 two
scenarios.

1.	 If	 a	 numeric	 value	 has	 lesser	 digits	 than	 the	 number	 of	 zeros	 specified	 in	 the
format,	then	this	digital	placeholder	displays	the	insignificant	zeros.	For	example,	if
you	create	a	format	0.00	and	the	value	is	0.58,	it	will	be	displayed	as	0.58.	On	the
other	 hand	 if	 the	 format	 is	 0.0000	 and	 the	 value	 is	 still	 0.58,	 then	 it	 will	 be
displayed	as	0.5800.

2.	 Conversely,	if	a	numeric	value	has	more	digits	than	the	number	of	zeros	specified
in	the	format,	it	rounds	of	the	value.	For	example	if	the	format	is	0.00	and	the	value
is	0.587,	it	will	be	displayed	as	0.59.	Likewise	if	the	format	is	0.0	and	the	value	is
0.587,	then	the	value	will	be	displayed	as	0.6

In	short,	the	purpose	of	the	0	digit	placeholder	is	to	equate	the	number	of	digits	in	a	value



to	the	number	of	zeros	in	the	format.	

?

Also	known	as	the	Digit	Placeholder,	this	symbol	hides	insignificant	values	and	displays
only	the	main	value.	Moreover,	this	placeholder	ensures	that	the	values	are	aligned	on	the
decimal	points.	For	example,	if	there	are	three	values	(1.25,	1.2	and	1.229)	and	all	 three
are	formatted	0.???,	then	they	will	be	aligned	as	1.2,	1.25	and	1.229	on	the	worksheet.	

You	can	use	this	digit	placeholder	for	fractions	that	have	varying	numbers	of	digits.	This
symbol	will	not	only	eliminate	 the	extra	 insignificant	zeros	 in	 individual	values	but	will
also	align	them	in	terms	of	their	decimal	points.

	

#

This	is	another	Digit	Placeholder.	It	works	almost	like	the	0	(zero)	placeholder	except	that
is	does	not	display	the	insignificant	zeros	if	the	value	has	lesser	digits	than	the	number	of
#	 specified	 in	 the	 format.	 You	 can	 also	 put	 thousand	 separators	 in	 this	 symbol.	 For
example,	#,###	means	that	Excel	should	put	a	comma	after	every	third	digit	to	the	left	side
of	the	decimal	point.

.	(Decimal	Point)

It	works	just	like	a	normal	decimal	point.	You	can	place	it	in	your	customized	format	to
determine	how	many	digits	you	want	to	the	left	and	right	of	the	decimal	point.

%

Known	as	the	percentage	indicator,	this	symbol	multiples	the	underlying	value	by	100	and
place	a	%	sign	next	to	it.		

,	(comma)

The	 basic	 usage	 of	 this	 symbol	 is	 to	 place	 thousand	 separators	 in	 the	 numeric	 values.
However	you	can	also	use	comma	to	round	a	value.	If	you	place	one	comma	at	the	end	of
a	format,	it	will	round	of	the	underlying	value	and	will	display	it	in	thousands.	Likewise,	if
you	place	 two	commas	at	 the	 end	of	 a	 format,	 it	will	 round	up	 the	value	 to	 the	nearest
million.

	

$	–	+	(	)	space



Add	any	of	 these	characters	 in	your	formula	 to	display	them	in	 the	value.	The	character
will	be	placed	at	the	same	position	where	you	entered	it	in	your	formula.	

\

Just	 like	 the	previous	symbols,	a	backslash	helps	you	 to	display	characters	 in	 the	value.
For	example,	if	a	cell	is	formatted	with	###\P,	the	value	in	the	formatted	cell	will	contain
a	P	with	it.	The	backslash	is	not	displayed	in	the	cell.

Do	not	use	a	backslash	to	display	any	of	these	characters:	$	–	+	(	)
space.	Just	put	them	as	it	is	in	the	formula	to	make	them	appear	in
the	pertinent	cell.

“Text”

It	 works	 just	 like	 backslash	 except	 for	 the	 fact	 that	 it	 displays	 all	 the	 text	 within	 the
quotation	marks	rather	than	just	one	character.	For	example	if	you	want	to	display	USD	in
a	cell	after	a	numeric	value,	you	can	format	it	with	###“USD”.	You	can	also	perform	the
same	function	with	a	backslash	but	in	that	case	you	would	have	to	put	a	backslash	before
each	character,	for	example,	###\U\S\D

/

This	Fraction	Format	symbol	is	used	to	display	a	number	in	a	fraction	format.

Just	 like	 the	 decimal	 places	 precision,	 you	 can	 also	 determine	 the
accuracy	of	a	fraction	value.	For	example,	if	0.415	is	formatted	with			#
?/?,	it	will	be	displayed	as	2/5.	However	if	you	format	the	same	value
with	#	???/???	then	it	will	be	displayed	as	83/200

	

[color]

It	displays	the	characters	in	the	specified	color.

[Color	n]

It	 displays	 the	 data	 entries	 in	n	 color	where	n	 is	 the	 number	 of	 color	 in	 Excel’s	 color
palette.	It	could	be	anywhere	in	between	0	–	56.			

*	(asterisk)

This	is	the	repetition	indicator.	It	repeats	the	next	character	in	the	format	as	many	times	as



required	to	fill	the	column	width.		You	can	put	only	one	asterisk	per	format.	

_	(underscore)

This	symbol	 is	used	for	alignment	purposes.	It	puts	space	equal	 to	 the	width	of	 the	next
character	in	the	format.		

	

@

This	is	a	text	placeholder.	If	a	cell	contains	a	text	value	and	is	formatted	with	this	symbol,
it	will	display	the	text	in	the	position	where	@	stands	in	the	format.	For	example,	if	a	cell
contains	Paul	and	is	formatted	with	“My	Name	is”@,	it	displays	as	My	Name	is	Paul	in
the	underlying	cell.	Text	placeholder	is	very	helpful	in	cases	when	you	need	to	display	the
same	 text	 in	 every	cell	with	 just	one	word	difference.	You	can	put	 the	 same	 text	 in	 the
format	and	the	different	words	in	the	formatted	cells.	

E–	E+	e–	e+	(Exponents)

If	 a	 format	 contains	 either	 of	 these	 symbols,	 it	 will	 display	 the	 value	 in	 the	 scientific
notation	format.	The	number	of	digit	placeholders	at	the	right	side	of	E	or	e	determines	the
minimum	 digits	 in	 the	 notation.	 E-	 and	 e-	 displays	 a	 minus	 sign	 before	 negative
exponential	values,	whereas	E+	and	e+	recognizes	the	nature	of	the	exponent	and	displays
a	plus	or	minus	accordingly.	



Codes	for	Creating	Date	and	Time	Custom	Formats

You	can	create	custom	formats	for	date	and	time	values	as	well.	But	for	that	you	need	to
learn	a	different	set	of	codes.

Code Description

d Display	the	day	number	without	leading	zeros	(1	-	31)

dd Display	the	day	number	with	leading	zeros	(01	-	31)

ddd Display	the	day	of	the	week	as	an	abbreviation	(Sun	-
Sat)

dddd Display	the	full	name	of	the	day	(Sunday	-	Saturday)

m Display	the	month	number	without	leading	zeros	(1	-	31)

mm Display	the	month	number	with	leading	zeros	(01	-	31)

mmm Display	the	name	of	the	month	in	abbreviated	form	(Jan	-
Dec)

mmmm Display	the	full	name	of	the	month	(January	-	December)

mmmmm Display	the	first	letter	of	the	month’s	name	(J	-	D)

yy Display	the	last	two	digits	of	the	year	(00	-	99)

yyyy Display	the	full	four-digit	year	number	(0000	-	9999)

h Display	the	hour	without	leading	zeros	(0	-	23)

hh Display	the	hour	with	leading	zeros	(00	-	23)

m Display	the	minute	without	leading	zeros	(0	-	59)

mm Display	the	minute	with	leading	zeros	(00	-	59)

s Display	second	without	leading	zeros	(0	-	59)

ss Display	second	with	leading	zeros	(00	-	59)

s.0 Display	second	and	tenths	of	a	second	without	leading
zero



s.00 Display	second	and	hundredths	of	a	second	without
leading	zero

ss.0 Display	second	and	tenths	of	a	second	with	leading	zero

ss.00 Display	second	and	hundredths	of	a	second	with	leading
zero

[	] Display	the	absolute	elapsed	time;	that	is,	it	display	hours
greater	than	24	and	minutes	or	second	greater	then	60

AM/PM	or	am/pm
Display	time	in	AM/PM	or	am/pm	respectively.	If	this	is
not	specified	in	the	formula,	Excel	display	the	time	using
the	24-hour	clock

A/P	or	a/p Display	time	in	A/P	or	a/p	respectively

Table	8.2	-	Codes	for	Creating	Date	and	Time	Custom	Formats

Creating	Custom	Format		

Now	 that	 you	 know	 the	 language	 of	 custom	 formatting,	 let’s	 see	 how	 you	 can	 actually
make	your	own	number	format.	There	are	two	ways	of	creating	customer	formats;	you	can
do	so	by	using	the	built-in	number	formats	or	using	the	4-part	custom	format	concept.

Using	Existing	Formats

The	easiest	way	of	creating	a	custom	format	is	to	build	on	the	built-in	Excel	formats.	Here
is	how	you	can	use	the	available	number	formats	as	the	starting	point	and	modify	them	to
make	one	of	your	own.

1.	 First,	type	a	numeric	value	in	an	empty	cell.	For	example,	0.259

2.	 Apply	the	appropriate	number	format	on	it.	By	appropriate	we	mean,	the	one	that
resembles	 the	 custom	 format	 you	 want	 to	 create.	 In	 this	 example,	 the	 fraction
format	is	applied.	This	changed	the	value	to	1/4.

3.	 Select	this	cell	and	then	open	the	Format	Cells	dialog	box.

4.	 Select	 the	 Custom	 category.	 Here	 you	 will	 see	 that	 format	 you	 selected	 is
highlighted	 in	 the	 list	 of	 formats.	The	 highlighted	 format	will	 also	 appear	 in	 the
Type	text	box	located	just	right	above	the	list	of	formats,	as	shown	in	Figure	8.6



Figure	8.6	-	The	Type	Text	Box	In	the	Custom	Format	Category

5.	 Edit	 the	 format	 as	 desired,	 in	 the	Type	 text	 box.	 You	 can	 use	 the	 custom	 format
symbols	explained	 in	 the	previous	section	 to	modify	 the	 format.	 In	 this	example,
we	added	two	more	digits	placeholders	to	the	format.	As	you	can	see	in	Figure	8.7,
putting	 placeholders	 increased	 the	 precision	 of	 the	 fraction	 value	 and	 now	 it
appears	as	223/861	in	the	underlying	cell.	

Figure	8.7	-	Creating	a	Custom	Format	Using	an	Available	Format

Click	Ok	to	confirm.	This	won’t	affect	the	original	format.	The	format	that	you	create	will
appear	at	the	bottom	of	the	list.

	

To	delete	a	custom	format:	Select	the	format	and	hit	the	Delete	button
located	 at	 the	 bottom	 right	 outside	 the	 formats	 list.	 Remember,	 you



cannot	delete	the	built-in	number	formats.

	
4-Part	Custom	Format

If	you	are	unable	to	find	a	resembling	number	format	to	customize,	you	can	create	one	of
your	own.	A	custom	format	can	have	up	to	4	sub-formats.	In	other	words,	you	can	make
four	different	formats	and	then	combine	them	in	all	one	single	format.

The	4-part	custom	format	is	meant	to	differentiate	four	different	types	of	values;	positive,
negative,	zero	and	text	values.	You	can	specify	as	many	as	four	formats;	just	make	sure	to
separate	the	sub-formats	with	semicolons.

Here	are	a	few	points	that	you	need	to	remember	while	creating	a	4-part	custom	format.

							If	you	specify	any	one	format,	Excel	will	apply	that	to	all	the	values	within	the
selected	range.

							If	your	custom	format	contains	two	parts,	the	first	applies	to	the	positive	values
and	zeros,	and	the	second	to	the	negative	values.

	 	 	 	 	 	 	If	you	specify	three	formats	within	your	custom	format,	the	first	applies	to	the
positive	values,	the	second	to	the	negative	values	and	the	third	to	the	zeros.

	 	 	 	 	 	 	 If	 you	 custom	 format	 contains	 four	parts,	 it	 is	 applied	 and	 interpreted	 in	 the
following	sequence:	Positive	values;	Negative	values;	Zero	values;	Text	value.	 In
other	 words,	 the	 first	 format	 applies	 to	 the	 positive	 values,	 the	 second	 to	 the
negative	values	and	so	on.

If	your	custom	format	contains	less	than	four	parts,	it	will	have	no
effect	on	the	text	values.

Table	8.3	illustrates	a	few	examples	of	custom	formatting.	The	first	column	contains	a	few
different	types	of	values,	the	second	column	contains	a	custom	format	and	third	one	shows
how	the	original	values	will	be	displayed	in	the	cell	after	the	respective	custom	format	is
applied	to	them.

Original	Cell	Entry Custom	Format Formatted	Value

5500 #,##0	“USD” 5,500	USD

987.569 _($(#,##0.00) $(987.57)



9876543215 #,##0 9,876,543,215

856 “Extension:“_### Extension:	856

8009985436 (###)	###-#### (800)	998-5436

42163956 ####-##-### 421-63-956

3/31/2014 mmmm-d,	yyyy March-31,	2014

Table	8.3	-	Examples	of	Custom	Formatting

Applications	of	Custom	Number	Format	

Custom	format	is	a	lot	more	than	just	a	few	examples	illustrated	in	Table	8.3	While	you
need	to	practice	making	different	formats	to	get	the	hang	of	custom	formatting	codes,	here
a	few	more	applications	along	with	examples	of	custom	formatting.

Creating	a	Null	Format

You	can	create	a	null	format	to	hide	the	values	in	a	worksheet.	All	you	have	to	do	is	type	a
semicolon	for	that	part	of	the	format.

Remember,	just	like	every	other	custom	format,	the	null	format	is	also	interpreted	in	the
following	order:

Positive	value	format;	Negative	value	format;	Zeros	format;	Text	value	format

For	example,	if	you	want	to	hide	negative	values,	zeros	and	text	from	a	selected	range	of
cells,	select	the	appropriate	range	and	format	it	with	###;;;

Three	semicolons	mean	 that	 it	hides	 the	 last	 three	 types	of	values	 in	 the	 selected	 range.
Likewise,	if	you	put	two	semicolons	in	the	starting	followed	by	the	format	for	zeros	and
text	values,	it	will	hide	the	positive	and	negative	values	within	the	selected	range	of	cells.	

	

To	display	only	text	values,	format	the	underlying	with	nothing
but	a	single	semicolon	(;).	To	hide	all	the	values,	format	with	;;;

	

The	null	format	only	hides	the	values	in	the	cells.	The	entries	are
still	visible	in	formula	bar.	To	learn	how	you	can	hide	the	values
in	cells	as	well	in	the	formula	bar,	refer	to	Chapter	16			



	

Colorful	Custom	Format

You	can	create	a	custom	format	 to	give	different	colors	 to	different	 types	of	values.	All
you	have	to	do	is	precede	the	appropriate	format	with	the	name	of	the	desired	color.	For
example,	 if	 you	 want	 to	 apply	 a	 red	 colored	 telephone	 number	 format	 to	 a	 string	 of
numeric	values,	edit	the	appropriate	cell	with	the	following	format:

[Red](###)	###-####

Likewise,	 if	 you	 have	 a	 spreadsheet	 full	 of	 mixed-up	 values	 and	 need	 to	 differentiate
positive,	negative,	zero	and	text	values,	select	the	entire	worksheet	and	type	the	following
format	in	the	custom	format	type	box:

[Red];[Green];[Blue];[Yellow]

The	above	custom	format	displays	all	the	positive	values	in	red,	negative	values	in	green,
zeros	in	blue	and	text	values	in	yellow.

You	do	not	necessarily	have	to	use	the	same	colors	in	your	custom	format.	You	can	select
from	the	 following	colors:	Yellow,	Black,	Cyan,	Magenta,	Green,	Blue,	Red	and	White.
You	can	also	specify	the	number	of	the	color.

	

If	you	specify	a	color	or	color	number	that	is	not	in	Excel’s	built-in
range	of	colors,	 it	produces	 the	specified	color	by	mixing	up	some
built-in	 shades.	 Such	 colors	 are	 called	 dithered.	 These	 colors	 are
good	for	shading	the	cells	but	done	work	very	well	for	coloring	the
values	and	lines.

	
	



Creating	Custom	Formats	To	Scale	Values

You	 can	 create	 custom	 formats	 to	 scale	 large	 values.	 For	 example,	 suppose	 you	 are
working	with	 large	 numbers	 such	 as	 1,500,000,000.	 If	 you	want,	 you	 can	 display	 these
numbers	 in	 thousands	 (1,500	 in	 this	 example).	The	underlying	value	would	 still	 remain
1,500,000,000	and	the	same	would	be	used	in	calculations.	The	formatting	only	makes	it
look	shorter	on	the	worksheet,	hence	taking	up	less	of	the	column	width.

Here	are	a	few	custom	formats	to	scale	down	numeric	values.

#,###,

It	 removes	 from	 the	 display,	 the	 last	 three	 digits	 to	 the	 left	 of	 the	 decimal	 place.	 For
example,	987654	displayed	as	987

#,###.00,

It	 removes	 from	 the	 display,	 the	 last	 three	 digits	 to	 the	 left	 of	 the	 decimal	 place	 and
rounded	to	two	decimal	places.	For	example,	987654	displayed	as	987.65

#,###,,

The	 above	 format	 displays	 the	 value	 in	millions	with	 no	 decimal	 places.	 For	 example,
987654321	displayed	as	987.

#,###.00,,

The	above	 format	displays	 the	value	 in	millions	with	no	decimal	places	and	 rounded	 to
two	decimal	places.	For	example,	987654321	displayed	as	987.65

#,###,,M

This	format	also	displays	the	value	in	millions	however	it	also	puts	an	M	with	the	value.
For	example,	987654321	displayed	as	987M

0”.”00

This	format	removes	from	the	display,	the	last	two	digits	to	the	left	of	the	decimal	place
and	rounded	to	two	decimal	places.	For	example,	9876	displayed	as	98.76.

Just	like	you	can	create	custom	formats	to	scale	down	values,	you	can	do	the	same	to	scale
up	as	well.	Here	are	a	few	custom	formats	to	scale	up	numeric	values.

#”,000”



This	format	displays	three	more	zeros	with	the	value.	For	example,	9	displayed	as	9,000

#”,000,000”	

This	format	displays	six	more	zeros	with	the	value.	For	example,	9	displayed	as	9,000,000
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Chapter	9:	Managing	Your	Worksheet

orksheet	is	the	face	of	the	Excel.	Whatever	work	you	do	on	Excel	is	done	on	a
worksheet.	 In	 the	previous	versions	of	Excel,	each	workbook	contained	 three
worksheets.	However	 in	Excel	2013,	every	workbook	contains	a	single	sheet

and	has	 its	 own	window.	So	 instead	of	 placing	 all	 the	work	 in	 one	worksheet,	 you	 can
create	a	different	one	for	each	element	for	your	project.

For	example,	if	you	are	maintaining	a	sales	record	of	your	store,	you	can	create	a	different
worksheet	 for	 every	 month	 and	 product,	 perhaps	 for	 every	 sales	 agent	 too.	 Multiple
worksheets	might	sound	complex	to	you	but	not	when	you	can	rename	each	of	them,	set	a
different	color	for	every	worksheet’s	label	and	so	on.		

This	chapter	covers	all	such	things	that	you	need	to	know	to	manage	your	worksheets.	It
gives	you	handy	tips	for	some	of	the	basic	worksheet	operations	along	with	some	colorful
and	interesting	tricks	for	managing	your	worksheets.

Adding	New	Worksheet

There	are	four	ways	of	adding	a	worksheet	to	a	workbook.

1.	 Click	the	plus	sign	located	at	the	right	side	of	the	last	sheet	tab.	This	will	add	a	new
sheet	to	the	active	workbook.	

2.	 Hit	Shift	+	F11	on	your	keyboard.	This	will	add	a	sheet	tab	to	the	left	of	the	current
worksheet.	

3.	 Right	click	the	sheet	tab	and	click	Insert.	This	will	open	the	Insert	dialog	box	on
the	 Excel	 screen.	 Select	 worksheet	 in	 the	 General	 tab	 and	 click	 OK.	 A	 new
worksheet	will	be	added	just	right	before	the	active	worksheet.

4.	 Select	the	Home	Tab.	Click	the	Insert	drop	down	list	and	select	Insert	Sheet.	This
will	add	a	new	worksheet	to	the	left	of	the	current	sheet.	

Deleting	a	Worksheet

If	you	have	added	a	worksheet	by	mistake	or	no	longer	need	one,	you	can	delete	it	very
easily.

There	are	two	ways	of	deleting	a	worksheet	from	a	workbook.

1.	 Open	 the	worksheet	you	want	 to	delete.	Go	 to	Home	 tab.	Select	Delete	Sheet	 in



the	Delete	drop	down	list.

Figure	9.1	-	Deleting	a	Worksheet	Using	the	Ribbon	Commands

2.	 Right	click	the	sheet	tab	and	click	Delete.

Figure	9.2	-	Deleting	a	Worksheet	by	Right-Clicking	the	Worksheet’s	Tab

Either	ways,	 if	 the	 underlying	worksheet	 contains	 any	 data,	 Excel	 asks	 you	 to	 confirm
once	again	if	you	want	to	delete	the	worksheet.	Click	Delete	if	you	surely	want	to	delete
it.	Click	Cancel	otherwise.

Figure	9.3	-	Confirmation	to	Delete	

If	 the	 worksheet	 is	 blank	 and	 never	 used	 before,	 Excel	 deletes	 it	 without	 asking	 for
confirmation.

You	can	also	delete	multiple	sheets	at	a	time.	To	do	so,	press	and	hold	the	Ctrl	key	and
one	by	one	select	all	the	tabs	you	want	to	delete.	The	selected	sheets’	names	are	bold	and
underlined.	Then	delete	by	either	of	the	abovementioned	ways.

To	delete	an	adjacent	group	of	sheets,	click	the	first	sheet	of	the	group,	hit	and	hold	Shift
on	your	keyboard	then	select	 the	last	 tab	of	 the	group.	Doing	so	will	select	all	 the	sheet



tabs	in	between.	Then	delete	using	either	of	the	two	methods.

	

Make	sure	the	worksheet	is	of	no	use	to	you	or	you	have	a	backup	of
the	 data	 before	 you	 delete	 any	worksheet.	Deleting	 a	worksheet	 in
Excel	cannot	be	undone.	You	won’t	be	able	 to	recover	a	worksheet
once	it	is	deleted.

	

Naming/Renaming	a	Worksheet

When	you	open	a	workbook	or	add	more	worksheets	 in	 it,	Excel	 labels	 them	with	 their
respective	number.	By	default,	worksheets	are	named	as	Sheet1,	Sheet2	and	so	on.	Now
these	 names	 are	 very	 plain	 and	 non-explanatory.	 So	 if	 you	 want,	 you	 can	 rename	 the
sheets	as	desired.

Renaming	worksheets	makes	it	easy	for	the	users	to	locate	data.	For	example,	it	is	easier
to	find	out	the	sales	glitch	in	a	particular	month	when	the	sheets’	are	renamed	as	months
rather	than	just	sheet	numbers.

There	are	two	ways	of	renaming	a	sheet;

1.	 Right	 click	 the	 sheet’s	 tab	 you	 want	 to	 rename	 and	 click	 Rename.	 This	 will
activate	the	edit	mode	of	the	sheet’s	tab	where	you	can	type	in	the	new	name.	Hit
Enter	once	done.

2.	 Double	click	the	appropriate	sheet’s	tab.	Type	in	the	new	name	and	press	Enter.

Note	that	the	sheet	names	cannot	exceed	31	characters.	You	can	add	spaces	in	the	names
but	you	cannot	use	the	following	characters	in	a	sheet’s	name:

*	Asterisk :	Colon \	Backslash

?	Question	Mark /	Slash [	]	Square	Brackets

	

Try	to	keep	a	short	name	as	it	would	consume	less	space	on	the	screen.	The	lengthier	the
name	is,	the	wider	the	tab	will	be	and	the	fewer	number	of	tabs	you	will	be	able	to	see	on
the	tab	list	without	scrolling.



Dragging	Worksheets

You	 can	 rearrange	 the	 worksheets	 in	 any	 order	 you	 want.	 For	 example,	 if	 you	 have	 a
separate	worksheet	for	each	employee’s	performance,	you	may	want	to	rearrange	the	tabs
in	alphabetical	order	to	make	it	easier	to	locate	any	particular	employee’s	worksheet.

You	can	also	make	a	copy	of	a	worksheet	in	the	same	workbook.	For	example,	if	you	have
made	 a	 performance	 appraisal	 sheet	 for	 an	 employee,	 you	 may	 want	 to	 use	 the	 same
template	for	all	the	employees	but	in	a	different	worksheet.	Excel	allows	you	to	copy	the
same	worksheet	as	many	times	as	you	want	in	the	same	workbook.	So	just	copy	the	same
performance	appraisal	 sheet	 for	every	employee	and	edit	 the	data	as	 required.	This	way
you	 won’t	 have	 to	 type	 the	 same	 template	 in	 every	 employee’s	 performance	 appraisal
worksheet.

There	 are	 several	 ways	 of	 rearranging	 and	 copying	 worksheets	 in	 Excel,	 as	 explained
below.

To	 move	 a	 worksheet,	 just	 click	 and	 hold	 the	 worksheet	 tab	 and	 drag	 it	 to	 the
desired	 location.	You	will	see	 that	 the	mouse	pointer	changes	 to	small	note	while
you	drag.	Take	this	pointer	to	the	desired	location	and	drop	it	there.

To	 copy	 a	 worksheet	 within	 the	 same	 workbook,	 press	 and	 hold	Ctrl	 on	 your
keyboard	 while	 you	 click	 and	 drag	 the	 appropriate	 worksheet	 to	 the	 desired
location.	 The	 original	worksheet	will	 stay	 in	 its	 place	while	 a	 copy	 of	 it	will	 be
created	in	the	position	where	you	dragged	it.	In	this	case,	the	small	note	like	pointer
will	carry	a	plus	sign	on	it.

Right	click	the	appropriate	worksheet	and	click	Move	or	Copy.	This	will	open	the
Move	or	Copy	dialog	box	as	shown	in	Figure	9.4.	As	you	can	see,	this	dialog	box
contains	the	names	of	the	all	worksheets	in	the	selected	workbook.	Just	select	the
worksheet	before	which	you	want	to	relocate	the	underlying	worksheet.
If	you	want	to	copy	a	worksheet,	click	the	checkbox	Create	a	copy	located	at	the
bottom	 of	 the	Move	 or	 Copy	 dialog	 box.	 The	 first	 two	methods	 are	 easier.	 The
dialog	box	is	normally	used	to	move	or	copy	the	worksheet	in	any	other	workbook,
as	explained	in	the	next	section.	

	

To	move	or	copy	a	group	of	worksheet	simultaneously,	press	and	hold
Ctrl	while	you	select	all	the	appropriate	worksheet	tabs.	Then	drag	the



group	to	the	desired	location.		

	

Relocating	Worksheets

It	 is	 not	 the	 same	workbook	where	you	 can	 copy	or	move	worksheets	 to.	You	can	 also
move	or	copy	a	worksheet	to	any	other	workbook.

	

To	move	or	copy	a	worksheet	to	any	other	workbook,	it	is	important
that	the	other	workbook	to	which	you	want	to	copy	is	also	open.

	

1.	 To	 relocate	 a	 worksheet	 to	 any	 other	 workbook,	 right	 click	 the	 appropriate
worksheet	and	click	Move	or	Copy.	This	will	open	the	Move	or	Copy	dialog	box
as	shown	in	Figure	9.4

Figure	9.4	-	The	Move	or	Copy	Dialog	Box

2.	 Click	the	To	Book	drop	down	list	and	select	the	target	workbook.	This	will	display
the	names	of	the	all	worksheets	in	the	selected	workbook.

	

The	To	Book	 drop-down	 list	does	not	 contain	 the	names	of	 all	 the
workbooks	on	your	system.	It	only	includes	the	workbooks	that	are
currently	open.	

	



3.	 Just	 select	 the	 worksheet	 before	 which	 you	 want	 to	 relocate	 the	 underlying
worksheet.	If	you	want	to	copy	the	worksheet,	click	the	checkbox	Create	a	copy
located	at	the	bottom	of	the	dialog	box.

When	 you	move	 or	 copy	 a	worksheet	 to	 any	 other	worksheet,	 the
custom	 formats,	 if	 any	contained	 in	 it,	 are	 also	copied	 to	 the	other
workbook.				

	

This	is	not	the	only	way	to	move	or	copy	worksheets	to	other	workbooks.	You	can	do	so
by	 the	Click	 and	Drag	method	 as	well.	 First,	 open	 both	 the	workbooks	 and	 then	 align
them	horizontally	on	the	screen.	Now	drag	the	worksheet	from	one	workbook	to	another.
If	you	want	to	copy	a	worksheet,	hold	down	the	Ctrl	key	on	your	keyboard	and	then	start
dragging.

	

To	align	the	workbooks	in	horizontal	panes,	minimize	all	the	windows
on	your	desktop	except	the	two	workbooks.	Right	click	your	desktop’s
taskbar	and	click	Show	windows	stacked.

	

Make	Your	Worksheet’s	Tab	List	Colorful

If	names	are	not	enough	to	differentiate	the	sheet	tabs,	you	can	also	color	them.	You	can
specify	a	different	color	for	each	tab.

To	change	the	color	of	a	sheet	tab,

1.	 Right	click	the	appropriate	tab

2.	 Select	Tab	Color	and	then	click	the	desired	color.



Figure	9.5	-	Coloring	the	Worksheet’s	Tabs

If	you	don’t	like	any	of	the	available	colors,	click	More	Colors	 located	at	the	bottom	of
the	color	palette.	To	remove	a	color	from	a	tab,	click	No	Color.	

	

This	operation	colors	the	tab	itself	and	not	the	font.	However	Excel
automatically	changes	the	color	of	the	font	to	make	it	visible	on	the
selected	 tab	color.	For	example,	 if	you	choose	black	color	 for	your
tab,	Excel	will	change	the	color	of	the	tab’s	name	font	to	white.
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Chapter	10:	Additional	Worksheet	Operations

he	previous	chapter	elaborated	 the	basic	operations	regarding	worksheets.	These
are	a	must	to	learn	if	you	plan	to	work	on	Excel.	However	there	is	a	lot	more	that
you	 can	 do	 than	 just	 managing	 worksheets.	 You	 can	 compare	 different

worksheets,	 split	 them	 up	 into	 different	 panes	 and	 so	 on.	 This	 chapter	 covers	 all	 such
advanced	operations.	 It	 also	 introduces	 you	 to	 the	 amazingly	 accommodating	 and	high-
tech	Watch	Window	of	Excel	2013.

Adjusting	the	View

When	you	open	a	workbook	for	 the	 first	 time,	by	default	 the	page	view	 is	set	 to	100%.
That	is	everything	you	see	on	screen	is	showed	at	100%	view.	You	can	zoom	in	and	zoom
out	to	magnify	or	shrink	the	view	respectively.	The	smallest	view	in	Excel	is	10%	and	the
largest	is	400%.

If	your	worksheet	contains	numerous	pages	and	ranges	spread	throughout	the	worksheet,
you	can	shrink	the	view	to	get	a	bird’s-eye	view	of	your	worksheet.	Conversely	you	can
zoom	in	to	make	out	the	tiny	codes	and	formulas.

	

Zooming	 in	 and	 zooming	 out	 the	 view	 of	 a	 worksheet	 does	 not
change	the	font	size,	formatting	or	printing	setup.	It	just	changes	the
view.

	

Figure	10.1	shows	a	worksheet	zoomed	out	to	10%.

Figure	10.2	shows	a	worksheet	zoomed	in	to	400%.



Figure	10.1	-	Worksheet	Zoomed	Out	To	10%

Figure	10.2	-	Worksheet	Zoomed	Out	To	400%

There	are	three	ways	of	changing	the	view	of	a	worksheet:

1.	 Press	and	hold	the	Ctrl	key	on	your	keyboard	and	spin	your	mouse	wheel	to	shrink
or	magnify	the	view.	

2.	 Click	and	drag	the	zoom	slider	located	at	the	bottom	right	of	your	worksheet.	Slide
to	the	right	side	to	zoom	in.	Slide	to	the	left	to	zoom	out.

3.	 Select	the	View	tab	on	the	ribbon.	Here	you	have	three	options	in	the	zoom	group;
namely	Zoom,	100%	and	Zoom	to	Selection.

If	you	select	100%,	it	will	revert	the	view	to	normal	if	was	changed.	

If	 you	want	 to	 see	 a	 particular	 range	of	 cells	 in	 one	pane,	 select	 it	 first	 and	 then	 select



Zoom	to	Selection.	Excel	will	change	the	view	to	fit	the	selected	range	in	the	window.	If
the	 selection	 is	 large,	 it	 will	 shrink	 the	 view.	 On	 the	 other	 hand,	 if	 the	 selected	 range
comprises	of	 few	cells	only,	 it	will	magnify	 the	view	 to	 fill	 the	 entire	window	with	 the
selected	cells.	In	short,	this	zooming	option	displays	the	selected	range	of	cells	only.

The	 third	 option	 in	 the	 View	 tab	 is	Zoom.	 Clicking	 it	 will	 open	 the	Zoom	 dialog	 box
where	you	can	specify	the	desired	percentage.	If	you	do	not	find	your	desired	view	percent
in	the	dialog	box,	simply	type	it	in	the	Custom	type	box.	The	Fit	Selection	round	checkbox
yields	the	same	effect	as	the	Zoom	to	Selection	command.

Figure	10.3	-	The	Zoom	Dialog	Box

	

If	you	zoom	in/zoom	out	a	worksheet,	it	will	change	the	view	of	the
current	 worksheet	 only.	 It	 won’t	 affect	 the	 display	 of	 other
worksheets	in	the	workbook.	As	a	matter	of	fact,	Excel	allows	you	to
set	different	a	zoom	percentage	for	every	worksheet.

	

The	 first	 time	 you	open	 a	 new	worksheet,	 its	 zoom	 factor	 is	 100%.	However	 once	 you
change	it,	it	will	stay	this	way	even	if	you	close	the	entire	workbook.	The	display	would
remain	the	same	every	time	you	open	the	particular	worksheet,	unless	you	change	it	again.
Excel	opens	up	on	the	last	changed	zoom	factor.

Same	Worksheet	–	Multiple	Windows

At	times,	you	may	need	to	compare	two	different	ranges	of	the	same	worksheet.	Or	you
may	want	to	modify	a	worksheet	and	observe	its	effect	on	any	other	worksheet	of	the	same
workbook.	In	either	case,	don’t	you	think	it	would	be	very	time	consuming	and	hectic	to



toggle	between	 two	 ranges	or	 two	worksheets	again	and	again.	Well,	Excel	2013	solves
this	issue	for	you.	It	allows	you	to	view	the	same	worksheet	in	two	different	windows	on
the	same	screen.

Or	you	can	also	view	two	different	worksheets	of	the	same	workbook	on	one	screen.	This
option	comes	very	handy	when	you	need	 to	compare	 two	 ranges	or	 in	cases	where	you
need	modify	the	values	in	one	sheet	and	analyze	its	effect	on	the	values	linked	in	any	other
worksheet.

In	either	case,	the	process	to	display	two	worksheets	or	two	ranges	of	the	same	worksheet
on	one	screen	is	the	same.

Select	the	View	tab	>	New	Window.

Excel	will	open	up	a	new	workbook	exactly	the	same	as	the	active	workbook.	Now	click
Arrange	All	located	right	beneath	the	New	Window	button	in	the	View	tab.

This	will	open	up	the	Arrange	Windows	dialog	box,	as	shown	in	Figure	10.4

Figure	10.4	-	The	Arrange	Windows	Dialog	Box		

Click	any	of	the	round	checkboxes	to	display	the	worksheets	in	the	desired	arrangement.
For	 example,	 if	 you	 select	Horizontal,	 it	will	 stack	 both	 the	workbooks	 horizontally,	 as
illustrated	in	Figure	10.5

If	you	select	the	Windows	of	Active	Workbook	checkbox,	Excel	will	arrange	windows	of
the	active	workbook	only.



Figure	10.5	-	Two	Same	Worksheets	Arranged	Horizontally

As	you	can	see	in	Figure	10.5,	two	same	worksheets	are	arranged	horizontally.	Notice	the
name	 in	 the	 Title	 bars.	 As	 you	 can	 see,	 Excel	 renames	 the	 titles	 when	 you	 view	 a
worksheet	 in	 multiple	 winos.	 It	 appends	 a	 colon	 and	 a	 number	 to	 each	 window;	 the
original	workbook	is	assigned	number	1	and	the	other	one	is	represented	by	number	2.

	

The	worksheets	 in	multiple	windows	are	 linked	 to	one	 another.	So
whatever	changes	you	make	in	one	are	automatically	updated	in	the
other.	Note	that	the	other	window	is	just	the	display	copy	and	closing
it	won’t	 affect	 the	original	workbook.	However	 the	changes	would
remain	there.

	

How	to	Compare	Worksheets

The	Arrange	Windows	feature	of	Excel	2013	is	very	helpful	if	you	want	to	compare	two
worksheets.	 Even	 more	 valuable	 is	 the	 View	 Side	 by	 Side	 feature	 that	 makes	 the
comparison	 easier.	 Apparently	 this	 feature	 arranges	 the	 open	 windows	 horizontally;
however	 it	 contains	 several	 other	 useful	 features	 that	 make	 comparing	 two	 windows
quicker	and	interesting.		



Here	is	how	you	can	use	the	View	Side	by	Side	feature,

First,	open	the	worksheets	that	you	need	to	compare.

Make	sure	the	two	worksheets	are	opened	in	separate	windows.	In	case
of	same	worksheets	of	the	same	workbook,	select	the	View	tab	>	New
Window	to	open	another	window	for	the	same	workbook,	as	explained
in	the	previous	section.

When	the	two	windows	are	opened	separately,	go	to	the	View	tab	and	select	View	Side	by
Side.	 You	 will	 find	 this	 command	 in	 the	Window	 group,	 represented	 by	 two-stacked
worksheets	icon,	as	shown	in	Figure	10.7

If	 there	 are	 only	 two	workbooks	 open,	 Excel	will	 align	 them	 horizontally	 on	 the	 same
screen.	But	if	more	than	two	Excel	windows	are	opened,	it	will	open	up	the	Compare	Side
by	Side	dialog	box	containing	the	names	of	the	open	workbooks.	Select	the	workbook	to
which	you	want	to	compare	the	active	one	with	and	press	OK.

Figure	10.6	-	The	Compare	Side	by	Side	Dialog	Box

So	far,	the	View	Side	by	Side	feature	works	similar	to	the	Arrange	Windows	feature.	The
difference	is	that	the	former	links	the	two	windows	together	in	such	a	way	that	scrolling	in
one	 of	 the	 windows	 scrolls	 the	 other	 window	 as	 well.	 If	 you	 want	 to	 turn	 off	 the
simultaneous	 scrolling,	 hit	 the	Synchronous	 Scrolling	 button	 located	 right	 beneath	 the
View	Side	by	Side	command.	The	Synchronous	Scrolling	command	is	switch	button	that
can	be	used	to	toggle	on/off	the	simultaneous	scrolling	feature.

If	you	have	relocated	the	windows	or	made	some	changes	in	their	arrangement	while	the
View	Side	by	Side	 feature	 is	On	and	now	you	want	 to	view	 them	back	 in	 the	horizontal
panes,	click	the	Reset	Window	Position	command	 located	 just	below	the	 	Synchronous
Scrolling	button.



Figure	10.7	-	Highlighting	Commands	for	Comparing	Worksheets	

To	revert	the	display	and	turn	off	the	side	by	side	feature,	simply	click	the	View	Side	by
Side	button	one	more	time.

	

The	View	Side	by	Side	feature	enables	manual	comparison.	It	does
not	point	the	differences	between	the	two	worksheets.	

	

How	to	Split	Worksheets	into	Different	Panes

The	Split	feature	of	Excel	is	another	way	of	viewing	on	one	screen,	the	different	parts	of	a
same	worksheet.	You	can	split	the	display	vertically	or	horizontally	or	both.	

Here	is	how	you	can	use	the	amazing	Split	feature,

First,	select	the	cell	where	you	want	the	split	to	occur

Now	go	to	the	View	tab	and	click	Split.	This	will	split	the	worksheet	into	four	panes,	as
shown	in	Figure	10.8

Figure	10.8	-	Showing	Split	Panes	

	



Split	occurs	at	the	active	cell.	In	Figure	10.8,	cell	H12	was	selected
so	the	split	occurred	there.	Likewise,	in	Figure	10.9,	the	active	cell	is
C6	so	the	split	occurred	there.

Figure	10.9	-	Showing	Split	Panes	at	a	Different	Location	of	Active	Cell	

Click	and	drag	the	pane	boundary	to	resize	individual	panes.

As	you	 can	 see	 in	both	 the	 images,	 every	pane	has	 a	different	 scrollbar.	You	can	 scroll
through	each	pane	and	work	on	four	different	parts	of	a	worksheet	at	the	same	time.

To	remove	the	split	panes,	simply	re-click	the	Split	button	in	the	View	tab.

Splitting	into	Freezing	Panes

Sometimes	 you	may	want	 to	 lock	 a	 certain	 rows	 and	 columns	 at	 their	 place	while	 you
scroll	 throughout	 the	worksheet.	This	 is	mostly	 required	when	you	write	a	heading	or	a
descriptive	text	in	the	first	row	or	column	and	want	it	to	stay	in	view	while	you	fill	up	data
against	it.

The	 difference	 between	 Split	 and	 Freeze	 Panes	 is	 that	 the	 former
gives	 you	 a	 scrolling	 bar	 for	 each	 pane.	 Since	 the	 purpose	 of	 the
latter	 is	 to	lock	a	certain	pane	so	that	 it	 is	displayed	throughout	the
worksheet,	it	does	not	give	separate	scroll	bar	for	the	frozen	panes.

	

To	freeze	panes,	select	the	cell	below	the	row	or	column	that	you	want	to	stay	on	screen
while	you	scroll	vertically	or	horizontally	respectively.	

Now	go	the	View	tab	and	click	the	Freeze	Panes	drop	down	list.



As	you	can	see	in	Figure	10.10,	there	are	three	freezing	commands.

Figure	10.10	-	Showing	the	Three	Freeze	Panes	Commands

Freeze	 Panes	 will	 freeze	 the	 rows	 and	 columns	 above	 the	 selected	 cell.	 The	 other
commands,	as	their	name	suggests,	freezes	the	top	row	and	column	respectively.

As	 shown	 in	 Figure	 10.11,	 the	 frozen	 rows	 columns	 are	 separated	 by	 dark	 lines.	 The
frozen	panes	remain	visible	no	matter	how	far	you	scroll	away	from	them.

Figure	10.11-	Showing	Frozen	Panes

As	you	can	see	in	Figure	10.11,	 the	active	cell	 is	B2	and	therefore	the	row	above	it	and
column	beside	is	split	into	a	pane	and	then	frozen.	If	scrolled	downwards,	all	the	columns
will	 scroll	 together	 but	 the	 top	 row	 (one	 containing	 the	 months)	 will	 stay	 visible
throughout.	Likewise,	when	scrolled	to	the	right,	all	the	rows	will	scroll	together	but	the
first	column	(one	containing	the	product	codes)	will	remain	visible	throughout.

To	unlock	the	frozen	panes,	select	View	Tab	>	Freeze	Panes	drop	down	list	and	then	click
Unfreeze	Panes.

	



If	you	want	to	split	and	freeze	both,	then	directly	click	the	Freeze
Panes	command.	This	splits	and	freezes	the	panes	simultaneously.
Likewise	clicking	it	back	will	remove	the	split	panes	and	unfreeze
the	locked	ones	at	the	same	time.		

	

As	 you	 can	 see	 in	 Figure	 10.11,	 the	 frozen	 pane	 boundaries	 are	 nothing	 but	 a	 darker
version	of	the	cell	borders.	In	cases	where	your	worksheet	is	full	of	values,	you	may	find	it
difficult	to	distinguish	the	frozen	panes.	To	make	the	frozen	panes	easier	to	view,	fill	them
with	any	color	of	your	choice.

Meet	the	Incredible	Watch	Window

At	times	you	may	need	to	monitor	a	value	as	you	work	on	other	cells.	For	example,	if	you
are	making	a	spreadsheet	report	on	the	effect	of	different	expenses	on	the	total	revenue	of
your	company.	You	want	to	check	the	effect	on	revenues	after	entering	or	modifying	any
expenditure	value.

Off	course	you	can	toggle	back	and	forth	to	the	cell	containing	the	revenue	but	don’t	you
think	 that	you	would	be	 too	 time	consuming?	How	about	 if	you	can	view	 the	particular
cell	 on	 the	 screen	 while	 you	 scroll	 throughout	 the	 worksheet?	 This	 is	 what	 the	Watch
Window	does.	If	enables	you	to	view	particular	cell(s)	on	the	screen	at	all	times.

	

	

To	use	the	incredible	Watch	Window,

Select	 the	Formula	Tab,	 there	 in	 the	Formula	Auditing	group	 you	will	 find	 the	Watch
Window	 button.	Click	 it	 to	open	 the	Watch	Window	Task	Pane,	 as	 illustrated	 in	Figure
10.12



Figure	10.12		-	The	Watch	Window

You	can	dock	it	to	any	side	you	want.	Just	drag	it	and	drop	it	to	the	desired	location.

To	 add	 cell(s)	 in	 it,	 Click	 Add	 Watch	 and	 then	 select	 the	 pertinent	 cell(s)	 on	 the
worksheet.

	

To	add	more	than	one	cell	in	the	Watch	Window,	hold	down	Ctrl	while
you	select	the	cells	in	the	worksheet.

In	Figure	10.13,	there	are	four	cells	in	the	Watch	Window.	This	window	will	stay	on	your
workbook	no	matter	how	far	away	cell	or	any	other	worksheet	you	scroll	to.	

Figure	10.13	-	Adding	Cells	in	the	Watch	Window

Once	you	add	a	cell	to	the	Watch	Window,	it	stays	even	after	you	close	the	pane.	It	will	be
there	every	time	you	open	the	Watch	Window	of	the	particular	workbook.	To	delete	a	cell
from	the	Watch	Window,	select	it	in	the	task	pane	and	hit	the	Delete	Watch	button.

	

If	you	want	 to	move	 to	any	of	 the	Watch	cells	 in	 the	worksheet,	 just
click	it	in	the	Watch	Window	pane	and	it	will	take	you	to	the	selected
cell.	

	





S
Chapter	11:	Learn	to	Work	with	Rows	and	Columns	

o	 far	 we	 have	 discussed	 the	 worksheet	 operations	 and	 features.	 Digging	 a	 bit
deeper	now,	each	worksheet	contains	1,048,576	rows	and	16,384	columns.

	

If	you	save	a	workbook	in	any	of	the	previous	versions	of	Excel
and	 then	 open	 it	 in	 Excel	 2013,	 it	 will	 be	 opened	 in	 the
compatibility	mode.	 Such	workbooks	 contain	 65,536	 rows	 and
256	columns.

	

If	you	want	to	increase	the	number	of	rows	or	columns	in	compatible
mode	 workbooks,	 save	 the	 workbook	 as	 .xlsx	 or	 .xlsm	 and	 then
reopen	it	in	the	specified	mode.

	

Every	individual	cell	is	a	part	of	a	row	and	column.	We	have	already	talked	in	detail	about
the	basic	operations	of	individual	cells.	This	chapter	covers	features	and	tips	that	involve
complete	rows	and	columns.	

After	going	through	this	chapter,	you	will	be	able	to	manage	the	rows	and	columns	in	your
worksheet.	You	will	learn	how	to	hide	and	unhide	them,	adjust	their	size	and	much	more.

	

How	to	Add	Rows	and	Columns

As	already	mentioned,	every	worksheet	contains	a	fixed	number	of	rows	and	columns	by
default.	You	cannot	increase	the	number	of	rows	or	columns	however	you	can	insert	them
to	make	room	for	additional	data.

Inserting	a	new	row	deletes	the	blank	row	from	the	bottom	of	the	worksheet	and	inserts	it
in	 the	 specified	 location.	Likewise,	 if	 you	 insert	 a	 column,	 the	 last	blank	column	 to	 the
right	is	removed	automatically.

	

You	cannot	insert	a	new	row	or	column	if	the	last	row	or	column	of



the	current	worksheet	is	filled,	respectively.

	

If	 the	 last	 row	or	 column	 is	 not	 blank,	Excel	 does	not	 allow	you	 to	 insert	 new	ones.	A
warning	dialog	box	pops	up	on	the	screen,	as	displayed	in	Figure	11.1

Figure	11.1	-	Warning	Box	on	Inserting	New	Row/Column	if	the	Last	Row/Column	is	not	Empty	

In	other	words,	having	an	empty	row/column	as	the	end	of	the	worksheet	is	a	prerequisite
for	having	new	ones.

The	number	of	blank	rows/columns	at	the	end	must	be	equal	or	more
than	 the	 number	 of	 rows/columns	 you	 want	 to	 insert	 in	 the
worksheet

	

There	are	several	ways	of	inserting	new	row(s):

	 	 	 	 	 	 	Select	an	entire	row,	right	click	and	select	Insert.	A	new	row	will	be	inserted
above	the	selected	row.

	 	 	 	 	 	 	To	add	multiple	rows	at	once,	select	as	many	rows	as	you	want	to	insert,	right
click	and	then	select	Insert.	This	will	insert	as	many	rows	as	you	selected.

							Move	the	active	cell	to	the	row	above	which	you	want	to	insert	a	new	row,	then
go	 the	Home	 tab.	 Click	 the	 Insert	 drop	 down	 list	 and	 then	 select	 Insert	 Sheet
Rows.

	 	 	 	 	 	 	Likewise,	 if	you	want	to	enter	multiple	rows,	select	 the	equivalent	number	of
cells	in	the	corresponding	column	and	then	select	Home	>	Insert	drop	down	list	>
Insert	 Sheet	 Rows.	 This	 will	 add	 new	 rows	 equal	 to	 the	 number	 of	 cells	 you
selected.

	 	 	 	 	 	 	Select	 cell(s)	 above	which	you	want	 to	 insert	new	 row(s).	Go	 to	Home	Tab.



Click	 the	 Insert	 drop	 down	 list	 >	 Insert	Cells.	 Then	 select	Entire	Row	 in	 the
dialog	box.	Click	OK	Click	OK.

	

The	aforementioned	were	ways	for	inserting	rows.	Following	are	for	inserting	columns.

	 	 	 	 	 	 	Select	an	entire	column,	 right	click	and	select	Insert.	A	new	column	will	be
inserted	to	the	left	of	the	selected	row.

							To	add	multiple	columns	at	once,	select	as	many	columns	as	you	want	to	insert,
right	click	and	then	select	Insert.	This	insert	new	columns	equivalent	to	the	number
of	columns	selected.

							Move	the	active	cell	to	the	column	on	the	left	of	which	you	want	to	insert	a	new
one.	Go	the	Home	tab.	Click	the	Insert	drop	down	list	and	then	select	Insert	Sheet
Columns.

	 	 	 	 	 	 	If	you	want	to	enter	multiple	columns,	select	the	equivalent	number	of	cells	in
the	 corresponding	 row	 and	 then	 select	Home	 >	 Insert	 drop	 down	 list	 >	 Insert
Sheet	 Columns.	 This	 will	 add	 new	 columns	 equal	 to	 the	 number	 of	 cells	 you
selected.

							Select	cell(s)	to	the	left	of	which	you	want	to	insert	new	column(s).	Go	to	Home
Tab.	Click	the	Insert	drop	down	list	>	Insert	Cells.	Then	select	Entire	Column	in
the	dialog	box.	Click	OK.

How	to	Add	Cells

If	you	don’t	want	to	add	entire	rows	or	columns,	you	can	add	just	a	few	cells	as	well.	Here
is	how	you	can	do	that.

Select	the	range	in	which	you	want	to	add	the	new	cells.

Select	Home	>	Insert	drop	down	list	>	Insert	Cells.	This	will	open	an	Insert	Dialog	box,
as	illustrated	in	Figure	11.2



Figure	11.2	-	The	Insert	Dialog	Box

To	insert	new	cells,	 the	existing	cells	must	be	shifted	either	 to	 the	right	or	down.	If	you
select	Shift	Cells	right,	 it	will	 insert	new	cells	to	the	left	of	the	selected	range	which	in
turn	will	shift	to	the	right.	Likewise	if	you	select	Shift	Cells	down,	it	will	insert	the	new
cells	above	 the	selected	 range.	The	number	of	new	cells	will	be	equal	 to	 the	number	of
selected	cells.

Click	OK	once	done.

How	to	Get	Rid	Of	Individual	Rows	and	Columns

If	 you	 have	 added	 any	 extra	 rows/columns,	 or	 you	 think	 that	 some	 of	 them	 contain
obsolete	unneeded	data,	you	can	delete	them	very	easily.

There	are	several	ways	of	deleting	rows	or	columns	in	a	worksheet;	as	briefed	below.

Select	the	entire	row(s)	or	column(s)	that	you	want	to	delete,	right	click	and	select
Delete.

To	delete	a	row,	move	the	active	cell	to	the	row	you	need	to	delete,	select	Home	tab
>	Delete	drop	down	list	>	Delete	Sheet	Rows.	If	you	want	to	delete	multiple	rows,
select	a	cell	in	each	row	and	then	click	Delete	Sheet	Rows	in	the	Delete	drop	down
list.

To	delete	a	column,	move	the	active	cell	 to	 the	column	you	need	to	delete,	select
Home	 tab	 >	 Delete	 drop	 down	 list	 >	 Delete	 Column	 Rows.	 Likewise,	 select
multiple	cells	to	delete	the	corresponding	columns	altogether.

	

If	 you	 have	 deleted	 a	 row	 or	 column	 by	mistake,	 press	Ctrl	 +	Z	 on
your	keyboard	or	click	the	Undo	button	on	the	Quick	Access	toolbar

	

How	to	Hide	Individual	Rows	and	Columns

At	times	you	may	want	 to	hide	some	rows	or	columns.	For	example,	while	showing	the
performance	 appraisal	 sheet	 to	 employees,	 there	 may	 be	 some	 values	 that	 you	 have
entered	 for	 your	 reference	 and	don’t	want	 the	 employees	 to	 see.	Or	 if	 your	 spreadsheet
needs	to	be	shared	with	multiple	users	whom	you	don’t	want	to	see	particular	details.	Or



you	may	need	to	print	some	particular	rows	and	columns	of	a	worksheet.

In	such	cases,	you	can	easily	hide	the	rows	and	columns	that	you	want	others	to	see	or	that
you	don’t	want	to	print.

When	you	use	the	arrow	keys	to	move	around	the	worksheet,	it	skips
the	hidden	rows	and	columns.	To	select	or	work	on	them,	you	need
to	unhide	them	first.

	

There	are	several	ways	of	hiding	row(s):

Select	the	row(s)	you	want	to	hide,	right	click	and	select	Hide.

Move	the	active	cell	to	the	row	you	need	to	hide,	select	Home	tab	>	Format	drop
down	list	>	Hide	and	Unhide	>	Hide	Rows.	 If	 you	want	 to	hide	multiple	 rows,
select	a	cell	in	each	row	and	then	click	Hide	Rows	in	the	Format	drop	down	list.

Place	 the	 cursor	 at	 the	 bottom	 border	 of	 the	 row	 you	want	 to	 delete	 and	 drag	 it
upward;	drag	till	the	height	is	zero.

Figure	11.3	-	Hide	and	Unhide	Commands	in	the	Ribbon

The	abovementioned	ways	were	for	hiding	rows.	The	following	are	for	hiding	columns.

Select	the	column(s)	you	want	to	hide,	right	click	and	select	Hide.

Move	 the	active	cell	 to	 the	column	you	need	 to	hide,	select	Home	 tab	>	Format
drop	down	list	>	Hide	and	Unhide	>	Hide	Columns.	If	you	want	to	hide	multiple
columns,	select	a	cell	in	each	column	and	then	click	Hide	Columns	in	the	Format
drop	down	list.



Drag	the	border	of	the	appropriate	column	to	the	left	till	its	width	is	zero.		

	

Excel	displays	a	small	space	in	the	heading	bar	in	place	of	the	hidden
rows	and	columns.

	

How	to	Unhide	the	Hidden	Rows	and	Columns

Use	either	of	the	following	methods	to	unhide	the	hidden	rows.

Drag	down	 the	small	 space	 in	 the	 row	heading	 to	 increase	 its	height	and	make	 it
visible.

Select	Home	tab	>	Format	drop	down	list	>	Hide	and	Unhide	>	Unhide	Rows

Select	 one	 entire	 row	 above	 and	 one	 below	 the	 hidden	 row,	 then	 right	 click	 and
select	Unhide.

To	unhide	the	hidden	columns,

Drag	 the	small	space	 in	 the	column	heading	 to	 the	right	 to	 increase	 its	width	and
make	it	visible.

Select	 Home	 tab	 >	 Format	 drop	 down	 list	 >	 Hide	 and	 Unhide	 >	 Unhide
Columns

Select	one	entire	column	to	the	left	and	one	to	the	right	of	the	hidden	column,	then
right	click	and	select	Unhide.

Adjusting	Width	and	Height

Sometimes	you	may	need	to	increase	or	decrease	the	width	and	height	of	a	column	or	row
respectively.	 For	 example,	 you	 can	 shorten	 the	 height	 of	 a	 row	 to	 fit	 more	 rows	 in	 a
printable	page.	Or	if	a	column	contains	serial	numbers	or	such	small	characters,	you	can
decrease	its	width	to	enhance	its	appearance.	Or	you	can	also	increase	the	height	a	row	to
highlight	the	headings	or	wrap	the	text	in	one	cell.			

Adjusting	Row	Height

In	Excel,	the	height	of	a	row	is	measured	in	pt	as	well	as	pixels	(1	inch	is	equal	to	72	pt)

The	height	of	a	row	by	default	is	15.00	pt	and	20	pixels.	This	height	can	vary	depending



upon	the	default	font	in	your	Excel.

For	 example,	 the	 default	 font	 of	 Excel	 is	 Calibri	 in	 size	 11.	With	 this	 font,	 the	 default
height	of	a	row	is	15	pt.	Now	if	you	have	set	a	different	font	in	your	Excel,	let’s	say	Times
New	Roman	in	size	14.	In	this	case,	the	default	height	of	each	row	will	be	18.75	pt	and	25
pixels.

In	short,	Excel	automatically	adjusts	the	height	of	a	row	in	accordance	to	the	font	type	and
size.	However,	if	you	want,	you	can	change	the	height	manually	as	well.	Following	are	a
few	ways	to	do	that.

Click	and	drag	the	bottom	edge	of	a	row	till	it	reaches	the	desired	height.

Move	the	active	cell	to	the	appropriate	row,	select	Home	tab	>	Format	drop	down
list	 >	Row	Height.	 Enter	 the	 desired	 row	 height	 in	 points.	 Click	OK.	The	Row
Height	Dialog	Box	 can	 also	be	opened	by	 selecting	 the	 entire	 row,	 right	 clicking
and	selecting	Row	Height.

Figure	11.4	-	The	Row	Height	Dialog	Box

To	change	the	height	of	multiple	rows	at	once,	select	them	together	and	then	enter
the	desired	height	in	the	Row	Height	Dialog	Box

At	times	you	use	different	fonts	and	formatting	throughout	the	row,	for	example,	the	first
cell	of	the	row	contains	a	text	value	in	larger	font	and	the	rest	are	formatted	with	smaller
fonts.	 In	 such	 cases,	 you	 can	have	Excel	 adjust	 the	height	 automatically.	There	 are	 two
ways	to	do	that,	as	listed	below.

Move	the	active	cell	to	the	appropriate	row,	then	select	Home	 tab	>	Format	drop
down	list	>	AutoFit	Row	Height

Double	click	the	bottom	border	of	the	underlying	row	

Either	ways,	Excel	will	adjust	the	selected	row’s	height	to	the	tallest	entry	in	the	row.	

Adjusting	Column	Width

In	 Excel,	 the	 width	 of	 a	 column	 is	 measured	 in	 units	 which	 equate	 to	 the	 number	 of



characters	of	a	monospaced	font	 that	will	 fit	 in	a	cell.	 It	 is	also	measured	in	pixels.	The
default	width	in	Excel	2013	is	8.43	and	64	pixels.	It	means	that	a	cell	by	default	can	carry
8.43	characters	of	a	monospaced	font.

	

If	 a	 numerical	 value	 is	 displayed	 as	 hash	 symbols	 (#),	 it	 means	 the
value	 is	 wider	 than	 the	 column’s	 width.	 In	 such	 cases,	 you	 need	 to
increase	 the	 width	 of	 the	 column	 to	 display	 the	 complete	 numerical
value.

	

Just	like	rows,	Excel	automatically	adjusts	the	width	of	a	column	in	accordance	with	the
number	of	characters	in	it.	However	you	can	change	the	width	manually	as	well.	

To	 change	 the	 default	 width	 of	 columns	 in	 your	 Excel,	 Select	Home	 tab	 >	Format	 >
Default	Width.	This	will	open	up	the	Standard	Width	dialog	box.	Enter	the	desired	width
in	units	and	hit	OK.	

Figure	11.5	-	The	Standard	Width	Dialog	Box

If	you	don’t	want	to	change	the	default	width	but	the	width	of	a	few	particular	columns,
follow	either	of	the	below	listed	ways.

Click	and	drag	the	right	edge	of	the	column	till	it	reaches	the	desired	width.

Move	 the	active	cell	 to	 the	appropriate	column,	 select	Home	 tab	>	Format	 drop
down	list	>	Column	Width.	Enter	 the	desired	column	width	 in	units.	Click	OK.
The	Column	Width	Dialog	Box	can	also	be	opened	by	selecting	the	entire	column
right	clicking	and	selecting	Column	Height.

To	 change	 the	width	 of	multiple	 columns	 at	 once,	 select	 them	 together	 and	 then
enter	the	desired	height	in	the	Column	Width	Dialog	Box

If	 you	 don’t	want	 to	 adjust	 the	width	manually,	 have	Excel	 do	 it	 for	 you.	You	 can	 use
either	of	the	following	ways.



Select	a	cell(s)	in	the	appropriate	column(s),	then	select	Home	tab	>	Format	drop
down	list	>	AutoFit	Column	Width

Double	click	the	right	border	of	the	underlying	column		

Either	 ways,	 Excel	 will	 adjust	 the	 selected	 column’s	 width	 to	 the	 widest	 entry	 in	 the
column.	

	

If	you	have	already	manually	changed	a	column’s	width,	Excel	will
no	longer	adjust	it	automatically.	You	need	to	change	it	manually	if
you	see	any	hash	symbols	in	it.	

	

	





Chapter	12:	Working	With	Cells	and	Ranges

You	have	already	learned	about	data	entry.	It	is	one	of	the	most	basic	things	one	needs	to
know	 in	order	 to	work	on	Excel.	However	 this	 is	not	 the	only	way	 to	 enter	values	 into
cells.	You	can	copy	and	move	values	 into	cells	 as	well.	You	can	 rename	your	cells	 and
attach	comments	to	them.	These	are	what	this	chapter	talks	about.

Not	only	one	or	 two,	 this	 chapter	 contains	numerous	ways	of	 copying	and	moving	data
between	 cells.	 You	 may	 learn	 some	 unique	 handy	 tips	 for	 filling	 in	 adjacent	 and
nonadjacent	 ranges.	 Moreover,	 you	 will	 get	 to	 know	 the	 amazing	 name	 manager	 and
commenting	feature.

Learn	to	Copy/Move	Ranges

While	 you	work	 on	Excel,	 you	may	 at	 times	 find	 it	 necessary	 to	 copy	 or	move	 certain
values.	For	example,	you	may	need	to	copy	a	payroll	 template	on	every	worksheet	or	at
multiple	places	in	the	same	worksheet.	It	makes	no	sense	to	retype	exactly	the	same	thing
again	and	again,	and	you	don’t	even	need	to!	Excel’s	copy	pasting	feature	enables	you	to
copy	or	move	values	from	one	cell	to	another.

	

The	major	difference	between	copying	and	moving	 is	 the	effect	on
the	source	of	data.	In	copying,	you	just	copy	the	selected	cells.	The
original	 data	 is	 unaffected.	 In	 moving,	 the	 selected	 data	 is	 first
removed	from	the	original	location	and	then	pasted	on	the	new	place.

Here	are	some	common	copy/pasting	operations	that	you	can	perform	in	Excel	2013.

Copying/moving	a	cell	to	another	location	in	the	same	or	different	worksheet.

Copying	a	same	value	in	a	range	of	cells.

Copying/moving	a	range	to	another	range	in	the	same	or	different	worksheet.

	

When	you	copy/move	a	cell,	not	only	the	underlying	value	is	copied
or	 moved	 but	 the	 formatting,	 comments,	 data	 validation	 and
conditional	formatting	is	copied/moved	as	well.	

	



When	you	select	cell(s)	to	copy,	the	selected	area	is	bordered	by	an	animated	dotted	line.
As	long	as	the	animated	line	is	there,	the	selected	cells	can	be	pasted.	Once	the	border	is
gone,	you	cannot	paste	them	unless	you	copy	them	again.	There	is	not	any	time	period	for
the	animated	border.	It	stays	there	till	you	hit	Esc	on	your	keyboard	or	start	working	on
any	other	cell.

	

When	 you	 paste	 cells,	 Excel	 first	 deletes	 the	 cells	 in	 the	 target
location	and	then	pastes	the	new	ones.	In	other	words,	it	overwrites
the	 cells	 without	 even	 warning	 you	 once.	 So	 if	 you	 find	 that	 you
have	pasted	cells	over	some	important	cells,	immediately	click	Undo
on	the	Quick	Access	toolbar	or	Ctrl	+	Z	on	your	keyboard	to	revert
the	pasting	operation.	

	

Since	copying	and	moving	are	one	of	the	most	commonly	performed	activities	on	Excel,
there	are	several	ways	for	it;	explained	as	follows.

Shortcut	Commands

The	first	way	of	copying	and	pasting	is	by	using	the	shortcut	menu	commands.

To	copy;	select	the	cell	or	range	of	cells	that	you	want	to	copy,	right	click	and	select	Copy.
Then	move	to	the	location	where	you	want	to	copy	them.	Right	click	again	and	select	the
first	icon	in	the	Paste	options;	as	shown	in	Figure	12.1

To	move;	select	the	cell	or	range	of	cells	that	you	want	to	move,	right	click	and	select	Cut.
Then	move	to	the	location	where	you	want	to	move	them.	Right	click	again	and	select	the
first	icon	in	the	Paste	options.	The	other	Paste	options	are	explained	later	on	the	in	this
chapter.

Instead	 of	 right	 clicking	 and	 then	 selecting	 Paste,	 just	 move	 to	 the
desired	location	and	hit	Enter	on	your	keyboard.	This	will	also	paste
the	 copied	 cells.	 However	 this	 method	 removes	 the	 animated	 dotted
line	as	well,	thereby	making	the	selected	cell(s)	unavailable	for	pasting
again.	So	use	this	way	only	if	you	want	paste	the	selected	data	once.

	



Figure	12.1	–	Showing	the	First	Icon	in	the	Paste	Options

Ribbon	Commands

You	can	copy/move	cell(s)	using	the	Ribbon	commands	as	well.	

1.	 To	copy;	select	the	cell(s)	you	want	to	copy.	Choose	Home	tab	and	click	the	copy
icon	located	in	the	clipboard	group.	The	said	icon	is	shown	in	Figure	12.2.

2.	 Now	go	to	the	location	where	you	want	to	copy,	choose	the	Home	 tab	and	select
the	 icon	 right	 beneath	 where	 it	 is	 written	 Paste.	 Or	 you	 can	 also	 move	 to	 the
destination	 cell	 and	 hit	 Enter	 to	 paste.	 The	 latter	 way	 of	 pasting	 removes	 the
copied	cells	from	the	clipboard,	hence	they	cannot	be	pasted	again.	

Figure	12.2-	Showing	the	Cut	and	Copy	Icon

To	move	a	cell	or	 range	of	cells,	 follow	 the	same	procedure	explained	above	except	 for
one	difference:	Instead	of	the	copy	icon,	click	the	Scissor-like	Cut	icon	in	step	1.	The	said
icon	is	shown	in	Figure	12.2

Advanced	Copying	Options	



The	copy	icon	in	the	clipboard	of	the	Home	tab	contains	a	drop	down	list	which	gives	you
two	options	to	copy	the	selected	cells.	The	first	option	is	the	simple	Copy	command	which
is	explained	in	the	previous	heading.	The	second	option	“Copy	as	Picture”	allows	you	to
select	the	cells	as	image.

Once	you	click	Copy	as	Picture	 in	 the	drop	down	list,	Excel	displays	 the	Copy	Picture
Dialog	box,	as	shown	in	Figure	12.3

Figure	12.3	-	Showing	the	Copy	Picture	Dialog	Box

Selecting	As	shown	on	screen	copies	the	data	with	Excel’s	borders.	When	you	will	paste
the	selected	data,	the	pasted	image	will	contain	the	gridlines.

Selecting	As	shown	when	printed	copies	the	data	without	the	Excel’s	borders.	So	when
you	will	paste	the	selected	data,	the	pasted	image	will	not	contain	the	gridlines.

Shortcut	Keys

You	can	also	copy	and	move	cells	using	the	traditional	MS	Office	copy	pasting	keyboard
shortcuts.

To	copy	cells:

1.	 Select	the	cell(s)	you	want	to	copy	and	hit	Ctrl	C

2.	 Move	to	the	destination	cell	and	hit	Ctrl	+	V

	

To	move	cells:

1.	 Select	the	cell(s)	you	want	to	move	and	hit	Ctrl	X

2.	 Move	to	the	destination	cell	and	hit	Ctrl	+	V

Drag	and	Drop



This	is	a	very	interesting	way	to	copy	and	paste	cells	in	Excel.	It	is	also	a	bit	different	than
others.	Unlike	other	ways	of	copying	and	moving,	this	one	does	not	save	the	information
on	the	clipboard.

The	best	thing	about	the	drag	and	drop	method	is	that	it	displays	a	warning	dialog	box	if	a
move	operation	tends	to	overwrite	the	existing	cells	at	the	new	location.

	

The	warning	dialog	box	only	appears	in	case	of	moving.	Excel	does
not	warn	you	if	a	copying	operation	is	overwriting	existing	cells.

	

Here	is	the	drag	and	drop	method	to	copy	cells	in	Excel:

1.	 Select	the	cell	or	range	of	cells	that	you	want	to	copy.

2.	 Hold	down	the	Ctrl	key	and	move	the	cursor	to	the	edge	of	the	selected	range.

3.	 When	the	cursor	reaches	the	edge,	you	will	notice	that	a	small	plus	sign	is	attached
to	 the	mouse	pointer.	At	 this	 point,	 click	 and	drag	 the	 selected	 range	 to	 the	 new
location.	Make	sure	the	Ctrl	key	is	pressed	all	the	time	while	you	are	copying	the
particular	range.

4.	 Release	 the	Ctrl	 key	 and	 the	mouse	 button	 after	 you	 have	 dragged	 the	 selected
cells.	 Excel	 will	 copy	 the	 particular	 range	 to	 the	 location	 while	 the	 underlying
cell(s)	will	still	be	there	in	their	original	location.	

The	process	to	move	a	cell	or	range	using	the	drag	and	drop	method	is	the	same	except	for
one	difference:	Here	you	do	not	need	to	press	the	Ctrl	key.	Just	select	the	cell(s),	move	the
cursor	to	the	edge	of	the	selected	range,	then	drag	and	drop	to	the	new	location.

	

If	 you	 are	 unable	 to	 use	 the	 drag	 and	 drop	 method,	 select	 File	 >
Options	 >	 Advanced.	 Put	 a	 checkmark	 on	 the	 checkbox	 labeled
Enable	Fill	Handle	and	Cell	Drag-and-Drop.	 Just	write	 below	 this
checkbox,	there	is	another	checkbox	labeled	Alert	before	overwriting
cells.	Make	sure	 it	 is	marked	as	well	or	else	Excel	will	not	alert	you
when	a	moving	operation	will	overwrite	existing	cells.				

	



Moving	To	Other	Sheets

It	is	not	only	the	same	worksheets	where	you	can	copy	or	move	cells.	All	the	copying	and
moving	methods	 explained	 in	 this	 book	 can	 be	 used	 to	 copy	 or	 move	 cells	 to	 another
worksheet	 as	 well,	 whether	 it	 is	 in	 the	 same	 workbook	 or	 other.	 Just	 make	 sure	 the
workbook	that	contains	the	new	location	is	open	before	you	select	 the	cell(s)	 to	copy	or
move.			

Apart	 from	 the	 other	 methods	 of	 copying,	 there	 is	 one	 exclusive	 way	 to	 copy	 cells	 in
between	worksheets	of	the	same	workbook.

1.	 First,	select	the	cell(s)	you	want	to	copy

2.	 Hold	down	the	Ctrl	key	and	select	the	sheet	tabs	of	the	worksheets	in	which	you
want	to	copy.

3.	 Select	Home	>	Fill	>	Across	Worksheets.	You	will	find	the	Fill	icon	in	the	Editing
group.	 It	 is	 the	downward	arrow	 icon	enclosed	 in	a	 square.	You	will	 find	 it	 right
above	the	pink	eraser	icon.

4.	 The	Fill	 Across	 Worksheets	 dialog	 box	 will	 open	 up,	 as	 shown	 in	 Figure	 12.4.
Select	Contents	if	you	just	want	to	copy	the	values;	Select	Format	if	you	want	to
copy	the	format	only;	Select	All	if	you	want	to	copy	both.

5.	 Click	OK	once	done.

Figure	12.4	-	The	Fill	Across	Worksheets	dialog	box

Excel	will	 copy	 the	 selected	 range	 at	 the	 same	 location	 in	 the	 selected	worksheets.	 For
example,	 if	 the	original	cells	occupied	 the	first	 five	cells	 in	Row1,	 then	 the	copied	cells
will	also	take	the	same	position	in	other	worksheets.	

This	method	allows	you	to	copy	a	range	in	more	than	one	worksheet
at	the	same	time.	For	example,	if	you	want	to	copy	cell(s)	in	Sheet1,
Sheet2	and	Sheet3,	 select	 the	cells	you	want	 to	copy	and	click	 the



sheet	 tabs	 of	 the	 corresponding	 worksheets	 while	 the	Ctrl	 key	 is
pressed.	After	 this,	 follow	 the	 same	 procedure	 as	 explained	 above
from	step	3	onwards.

	

You	need	to	be	careful	while	using	this	copying	procedure.	You	can
overwrite	important	data	in	other	worksheets	without	even	realizing.
So	 don’t	 forget	 to	 check	 the	 destination	 cells	 in	 the	 worksheets
before	 performing	 this	 operation.	 Make	 sure	 they	 are	 blank	 or
contain	unneeded	data.	Just	like	the	other	copying	methods,	this	one
does	not	warn	you	before	overwriting	existing	cells

	

Filling	In	Contiguous	Cells

Copying	values	and	 formulas	 to	adjacent	 cells	 is	 a	very	common	operation	 that	 is	done
very	frequently	in	Excel.	It	is	mostly	performed	while	copying	formulas.

	

When	 you	 copy/move	 a	 cell	 that	 contains	 a	 formula,	 it	 only
copies/moves	 the	 underlying	 formula.	 The	 cell	 references	 in	 the
formula	are	automatically	changed	in	pertinence	to	the	new	location.

Take	a	look	at	Figure	12.5	for	example.	In	this	worksheet,	Column	D	contains	the	sum	of
values	in	Column	B	and	Column	C.	Now	you	can	enter	a	sum	formula	for	every	product
but	that	would	be	very	time	consuming.	A	far	better	alternative	is	to	enter	formula	in	Cell
D2	and	then	copy	the	same	formula	in	all	the	cells	below	it.	As	you	can	see	in	the	image,
only	the	formula	is	copied	down	the	range.	The	values	are	not	same;	they	are	changed	in
relevance	 to	 the	 new	 location.	 Column	 E	 shows	 the	 formulas	 that	 are	 contained	 in	 the
corresponding	cells	in	Column	D.	This	is	how	the	formulas	are	changed	when	you	copy
them	down	in	adjacent	cells.



Figure	12.5	-	Example	of	Copying	Formula	in	Contiguous	Cells

Now	that	you	know	the	application	of	adjacent	cell	copying,	here	is	how	you	can	actually
perform	it.

Select	 the	range	in	which	you	want	 to	copy	including	the	cell	 that	you	want	 to	copy	(In
Figure	12.5,	it	is	Cell	D2	to	Cell	D8).	Now	perform	either	of	the	following	actions:

							To	copy	the	cell(s)	to	the	selected	range	below,	Select	Home	>	Fill	>	Down.	Or
you	can	also	hit	Ctrl	+	D	on	your	keyboard.

							To	copy	the	cell(s)	to	the	selected	range	to	the	right,	Select	Home	>	Fill	>	Right.
Or	you	can	also	hit	Ctrl	+	R	on	your	keyboard.

							To	copy	the	cell(s)	to	the	selected	range	above,	Select	Home	>	Fill	>	Up.

							To	copy	the	cell(s)	to	the	selected	range	to	the	left,	Select	Home	>	Fill	>	Left.

	

You	 can	 copy	 to	 adjacent	 cells	 using	 the	 AutoFill	 feature	 as	 well.
Select	the	cell	you	want	to	copy	and	drag	the	AutoFill	handle	to	the
destination	cells.	Or	you	can	also	double	click	the	AutoFill	handle	to
copy	the	value	or	formula	to	the	underlying	range.	

	

Pasting	From	the	Office	Clipboard

Whenever	you	copy	or	cut	any	cells	in	Excel,	they	are	saved	on	two	Clipboards;	namely
the	Windows	Clipboard	and	the	Office	Clipboard.

	

The	Clipboard	copy-paste	method	 is	not	valid	 for	“drag	and	drop”



and	“Filling	 in	Contiguous	Cells”	methods.	 If	you	copy	data	using
any	of	the	two	methods,	it	will	not	be	saved	in	the	Clipboard.

The	Windows	Clipboard	is	a	part	of	your	computer’s	memory.	All	the	copied	data	is	saved
there	in	a	particular	format.	The	information	saved	in	Windows	Clipboard	can	be	pasted	to
other	Window’s	apps	as	well.

The	Office	Clipboard	is	the	built-in	clipboard	of	Microsoft	Office.	It	is	available	and	can
be	used	in	Office	apps	only.	It	is	one	of	the	ways	to	copy	and	move	cells	in	Excel.			

If	you	want	to	use	the	Clipboard	for	copying	or	moving,	first	you	need	to	open	it	on	your
Excel.	Just	click	the	small	downward	diagonal	arrow	located	at	the	bottom	right	corner	of
the	clipboard	group	in	the	home	tab;	as	shown	in	Figure	12.6.	This	icon	opens	and	closes
the	Office	Clipboard.		

Figure	12.	6	-	Showing	the	Office	Clipboard

	

For	keyboard	users,	press	Ctrl	+	C	twice	to	open	the	Clipboard.	If	this
shortcut	key	 is	not	working,	open	 the	clipboard	by	clicking	 the	small



downward	diagonal	arrow	in	the	clipboard	board	of	the	home	tab,	click
Options	located	at	the	bottom	of	the	Clipboard	and	select	Show	Office
Clipboard	When	Ctrl+C	Pressed	Twice.

Once	your	clipboard	is	open,	select	the	cell(s)	you	want	to	copy	or	move	and	copy	or	cut
using	any	of	the	methods	explained	in	this	book.	The	simplest	one	is	clicking	Ctrl	+	C	to
copy	and	Ctrl	+	X	to	cut.

The	copied	 items	will	 appear	 in	 the	Clipboard.	The	Office	Clipboard	can	hold	up	 to	24
items	at	a	time.	If	you	add	more	items,	it	will	start	deleting	items	from	the	bottom	of	the
clipboard.

Move	the	cell	pointer	to	the	location	where	you	want	to	place	the	copied	cells.

If	you	want	 to	paste	 just	one	 item,	click	 it	 in	 the	clipboard.	 If	you	want	 to	paste	all	 the
items,	click	Paste	All	located	at	the	top	of	the	Clipboard	task	pane.	The	items	are	pasted
from	bottom	up;	that	is	the	bottom	item	in	the	clipboard	will	be	pasted	first	followed	by
the	second	last	item	and	so	on.

The	Paste	All	command	is	very	useful	when	you	need	to	copy	cells	from	multiple	ranges
and	paste	them	on	one	worksheet.	For	example,	if	you	want	to	make	a	list	of	data	entered
in	Cell	A1	in	all	the	worksheets,	select	the	cells	one	by	one,	then	move	to	the	new	location
and	click	Paste	All.

	

The	Paste	All	command	does	not	work	if	any	image	is	copied	in	the
clipboard.

	

To	clear	all	the	items	in	the	Office	Clipboard,	click	the	Clear	All	button	located	just	right
next	to	the	Paste	All	button

Here	are	a	few	more	things	that	you	need	to	know	about	the	mechanism	of	the	Clipboard.

The	 last	 item	 that	 you	 copy	 or	 cut	 to	 the	 Office	 Clipboard	 is	 also	 saved	 in	 the
Windows	Clipboard.

If	you	paste	a	data	 from	 the	Office	Clipboard,	Excel	pastes	 the	 same	data	on	 the
Windows	Clipboard	as	well.

Whatever	 items	you	clear	 from	the	Office	Clipboard,	 the	same	are	 removed	from



the	Windows	Clipboard	as	well.

	

The	 Office	 Clipboard	 of	 Excel	 cannot	 hold	 up	 formulas.	 In	 other
words,	it	cannot	be	used	to	copy	and	move	formulas	in	Excel.	If	you
copy	any	formula	in	the	Office	Clipboard,	it	will	just	copy	the	value
in	the	underlying	cell	and	will	paste	the	same	in	the	new	location.

	

Pasting	Options

You	may	not	always	want	to	copy	everything	of	the	selected	cell.	At	times,	you	may	need
to	copy	the	formula	only,	or	the	formatting	only	or	you	may	want	to	copy	the	results	of	the
formulas	rather	than	the	complete	formula	itself.

Excel	 gives	 you	 several	 options	 to	 paste	 other	 than	 the	 default	 pasting	 option	 that
copies/moves	everything	in	the	selected	cells.	You	can	find	these	options	in	the	Paste	drop
down	list	located	in	the	clipboard	group	of	the	home	tab.

Figure	12.7	-	Additional	Pasting	Options

Paste	(P):	The	first	option	is	the	simple	Paste	option.	It	pastes	the	entire	cell’s	content	and
everything	in	it	including	the	formatting	and	data	validation.

Formulas	(F):	It	pastes	just	the	formula;	no	values	and	no	formatting.

Formulas	&	Number	Formatting	(O):	This	command	pastes	the	formula	as	well	as	the



number	formatting.

Keep	Source	Formatting	(K):	This	command	pastes	the	formula	and	all	formatting.

No	Borders	(B):	This	command	pastes	the	entire	cell’s	content	and	everything	in	it	except
the	borders	in	the	selected	range

Keep	Source	Column	Width	 (W):	 It	 pastes	 the	 formula	 and	 applies	 the	 same	 column
width	to	the	new	location	as	it	was	of	the	selected	cells.

Transpose	(T):	 It	changes	 the	alignment	and	orientation	of	 the	selected	cells.	Rows	are
pasted	as	columns	and	vice	versa.	If	there	are	any	formulas	in	the	selected	range,	they	are
also	adjusted	in	relevance	to	the	corresponding	values	when	transposed.

In	Figure	12.8,	the	values	in	Column	B	are	original	values	and	those	highlighted	in	Row	8
are	the	transposed	values.

Figure	12.8	-	Illustrating	the	Transpose	Pasting	Command

Values	(V):	This	 command	pastes	 the	values	only;	 no	 formatting.	 If	 you	have	 copied	 a
range	of	formulas,	this	option	will	paste	only	the	result	of	formulas.

Values	&	Number	Formatting	(A):	It	pastes	the	values	only	or	the	results	of	the	formula
plus	the	number	formatting.

Values	&	Source	Formatting	(E):	It	pastes	the	values	or	the	results	of	the	formula	plus
the	entire	formatting.

Formatting	(R):	It	only	pastes	the	formatting	of	the	selected	cells.

Paste	Link	(N):	It	paste	the	formulas	contained	in	the	selected	cells.	

Picture	(U):	This	command	pastes	the	selected	range	as	an	image.

Linked	Picture	 (I):	 This	 pasting	 command	 pastes	 the	 copied	 cells	 as	 an	 animated	 live
image	 the	values	 in	which	are	updated	 in	accordance	 to	 the	 source	of	 the	data.	 In	other



words,	if	you	make	any	changes	in	the	copied	cells,	the	same	will	be	updated	in	the	live
image.	

Merge	Conditional	Formatting	(G):	This	icon	appears	in	the	pasting	option	only	when
the	 copied	 cells	 contain	 any	 type	 of	 conditional	 formatting.	 This	 command	merges	 the
conditional	formatting	of	the	selected	cells	to	the	conditional	formatting,	if	any,	in	the	new
location.		

Paste	Special:	This	command	is	located	at	the	bottom	of	the	pasting	options.	It	opens	the
Paste	Special	dialog	box,	which	is	explained	in	the	next	section.

Paste	Special

The	Paste	Special	dialog	box	is	yet	another	way	of	pasting	the	copied	cells.	It	contains	all
the	pasting	options	explained	above	plus	a	few	more.

	

To	open	the	Paste	Special	dialog	box,	you	need	to	copy	the	particular
cells.	This	dialog	box	cannot	be	used	to	move	cells.	In	other	words,
the	Paste	Special	option	won’t	display	if	you	have	cut	cells	

To	open	the	Paste	Special	dialog	box,	copy	the	cell(s)	you	want	to	paste,	then	select	Home
>	Paste	drop	down	list	>	Paste	Special.	Or	you	can	also	right	click	the	copied	cells	and
select	Paste	Special	from	the	shortcut	menu.

Select	the	desired	pasting	option	in	the	Paste	Special	dialog	box	and	click	OK.	

	

For	 keyboard	 users,	 hit	Ctrl	 +	 Alt	 +	 V	 to	 open	 the	 Paste	 Special
Dialog	Box

	

Figure	12.9	shows	a	Paste	Special	Dialog	box.



Figure	12.9	-	The	Paste	Special	Dialog	Box

As	you	can	see	in	the	above	image,	the	Paste	Special	dialog	box	contains	several	pasting
options.	 While	 some	 of	 them	 have	 already	 been	 explained	 in	 the	 previous	 section,
following	is	a	brief	description	of	all	the	Paste	Special	options.	

All:	 This	 command	 pastes	 the	 entire	 cell’s	 content	 and	 everything	 in	 it	 including	 the
formats	and	data	validation.

Formulas:	It	pastes	formula	and	values;	no	formatting

Values:	This	command	pastes	the	values	only;	no	formatting.	If	you	have	copied	a	range
of	formulas,	this	option	will	paste	only	the	result	of	formulas.

Formats:	It	pastes	only	the	formatting	of	the	selected	cells.

Comments:	 It	pastes	 the	comments	attached	 to	 the	copied	cells.	This	option	pastes	only
the	comments;	no	values	and	no	formatting.	

Validation:	It	pastes	the	data	validation	rules	of	the	copied	cells	to	the	target	cells.

All	using	Source	theme:	This	command	pastes	the	entire	cells’	content	and	everything	in
it	 except	 the	 formats.	 It	uses	 the	 same	 formatting	as	 the	document	 theme	of	 the	 source.
This	pasting	 command	 is	useful	when	you	are	 copying	cells	 from	a	different	workbook
that	uses	a	different	document	theme	than	the	current	one.

All	 except	 borders:	 This	 command	 pastes	 the	 entire	 cell’s	 content	 and	 everything	 in	 it
except	the	borders	in	the	selected	range

Column	widths:	It	applies	the	column	width	settings	of	the	copied	cells	to	the	destination
cells.	

Formulas	and	number	formats:	This	command	pastes	the	formula	as	well	as	the	number



formatting.

Values	and	number	formats:	This	command	pastes	the	values	or	results	of	the	formulas
and	the	number	formatting.

All	merging	conditional	formats:	This	pasting	command	is	active	only	when	the	copied
cells	 contain	 any	 type	 of	 conditional	 formatting.	 This	 command	merges	 the	 conditional
formatting	of	the	selected	cells	to	the	conditional	formatting,	if	any,	in	the	new	location.		

Operation:	As	you	can	see	in	Figure	12.9,	the	operation	section	of	the	Paste	Special	dialog
box	contains	5	commands;	namely,	None,	Add,	Subtract,	Multiply	and	Divide.	By	default,
None	 is	 checked.	 The	 other	 commands	 allow	 you	 to	 perform	 simple	 mathematical
operations	in	the	destination	cells.

To	use	the	operation	commands,	copy	cell(s)	and	move	the	cell	pointer	to	the	destination
cell,	then	open	the	Paste	Special	dialog	box	and	select	the	appropriate	operation	command.
Click	OK	once	done.	This	will	 apply	 the	 selected	operation	on	 the	copied	cells	 and	 the
values	contained	in	the	destination	cells.

Suppose	a	cell	 contains	a	numeric	value	of	500.	You	want	 to	add	250	 to	 this	value	and
paste	the	result	in	another	cell.	To	do	so,	copy	the	cell	containing	500,	then	move	the	cell
pointer	to	the	cell	containing	250	and	open	the	Paste	Special	dialog	box.	Select	Add	and
Click	 OK.	 The	 cell	 that	 previously	 contained	 250	 will	 now	 be	 replaced	 with	 750
(500+250).

You	can	also	use	these	commands	to	perform	a	mathematical	operation	on	one	copied	cell
and	paste	 to	a	 range	of	cells.	Suppose	 that	a	 range	of	cells	contains	numeric	values	and
you	want	to	increase	all	these	values	by	10%.	To	do	so,	first	type	110%	in	a	cell	and	copy
this	cell.	Now	select	the	range	that	you	want	to	increase	and	open	the	Paste	Special	dialog
box.	Select	Multiply	and	Click	OK.	Each	value	in	the	selected	range	will	be	multiplied	by
110%.		

	

It	replaces	the	values	in	the	destination	cells	as	well	as	the	formulas,
if	 there	 are	 any.	 Make	 sure	 to	 check	 the	 destination	 range	 before
applying	any	operation	command	as	it	may	modify	the	formula	in	it.

	

Skip	 blanks:	 This	 pasting	 command	 saves	 the	 destination	 cells	 from	 being	 overwritten
with	blank	cells	in	the	copied	range.	In	other	words,	if	your	copied	range	contains	blank



cells,	they	won’t	overwrite	the	values	in	the	destination	cells.	It	skips	the	empty	cells	and
pastes	only	the	filled	ones.

Transpose:	It	changes	the	alignment	and	orientation	of	the	selected	cells.	Rows	are	pasted
as	columns	and	vice	versa.	 If	 there	are	any	formulas	 in	 the	selected	range,	 they	are	also
adjusted	in	relevance	to	the	corresponding	values	when	transposed.

Paste	Link:	This	 option	 creates	 a	 formula	 that	 links	 the	 destination	 range	 to	 the	 source
range.	In	other	words,	if	you	make	any	changes	in	the	underlying	cells,	the	same	will	be
updated	in	the	destination	cells.	

Commenting	to	Document	Your	Work

Adding	comments	is	a	way	to	document	to	your	work.	You	can	attach	comments	to	cells
to	explain	 the	assumptions,	 formulas,	calculations	or	any	other	details.	You	can	also	put
comments	as	reminders	or	alerts	for	errors.

Here	is	how	you	can	attach	comments	to	cells	in	Excel.

1.	 Select	the	cell	that	you	want	to	document

2.	 Select	the	Review	tab	and	click	the	New	Comment	button.

3.	 A	small	comment	box	will	appear	next	to	selected	cell.	Type	your	comment	in	it.

For	keyboard	users,	press	Shift	+	F2	 to	attach	a	comment	box	 to	 the
selected	cell.

Figure	12.10	shows	cells	containing	comments.



Figure	12.10	-	Showing	Comments	in	Excel

The	comment	box	shows	your	name	at	the	top.	To	delete	your	name	from	the	comment,
take	the	cursor	there	and	simply	delete	it	by	hitting	backspace	on	your	keyboard.	You	can
also	enter	any	other	name,	if	you	want.	

If	 you	want	 any	other	 name	 to	 display	 in	 every	 comment	 box,	 select	File	 >	Options	>
General.	There	you	will	find	a	user	name	type	box	containing	your	name	in	it.	Type	the
name	that	you	want	to	appear	in	the	comment	box	and	hit	OK.	From	then	onwards,	any
comment	box	you	add	will	display	the	new	user	name.

Formatting	Comments

Comments	 are	 not	 carved	 on	 stone.	 They	 can	 be	 formatted	 and	 edited.	 You	 can	 even
change	the	shape	of	your	comment	as	well	as	add	a	picture	in	it.

Let’s	start	with	the	basic	formatting	and	then	we	will	move	on	to	some	advanced	comment
formatting	tricks.

To	edit	a	comment,	right	click	the	particular	cell	and	select	Edit	Comment.	This	will	put
the	comment	in	the	edit	mode.	You	can	make	the	changes	in	the	text	of	the	comment.

If	you	want	 to	change	 the	 formatting,	 right	click	a	comment	 in	 its	edit	mode	and	select
Format	Comment.	This	will	open	the	Format	Comment	dialog	box.

You	can	change	the	font	type,	size,	color	and	can	even	add	some	effects	to	the	text.	Click
OK	once	done.



	

Adding	Pictures	in	A	Comment	Box

To	add	any	image	in	a	comment	box,	first	put	 the	comment	 in	 the	edit	mode,	 then	right
click	 the	 comment’s	 border	 and	 select	 Format	 Comment.	 This	 will	 open	 the	 Format
Comment	dialog	box,	as	shown	in	Figure	12.11

Figure	12.11	-	Showing	the	Format	Comment	Dialog	Box

Click	over	the	Colors	and	Lines	tab.	Click	the	Color	drop	down	list	and	select	Fill	Effects.
This	will	open	the	Fill	Effects	dialog	box.	Select	the	Picture	tab	and	click	Select	Picture.

You	will	get	three	options;	you	can	insert	images	from	your	computer	or	from	Office.com
Clip	Art	or	you	can	search	and	get	images	from	the	web.	Click	over	the	appropriate	option
and	select	the	desired	image.

	

If	 you	 are	 unable	 to	 find	 the	Colors	 and	 Lines	 tab	 in	 the	 Format
Comment	dialog	box,	it	means	you	have	not	right	clicked	the	border
of	the	comment.	It	is	very	important	that	you	right	click	the	edge	of
the	comment	to	open	the	complete	Format	Comment	dialog	box.	If
you	will	right	click	anywhere	else	on	the	comment,	it	may	just	open
the	Font	tab	in	the	Format	Comment	dialog	box.

	



Giving	New	Shape	to	the	Comment	Box

Comment	boxes	 are	 rectangular	by	default.	However	you	can	give	 them	any	 shape	you
want.	To	do	so,	 first	you	need	 to	add	 the	Change	Shape	 command	 in	 the	Quick	Access
toolbar.	Here	is	how	you	can	do	that.

1.	 Right	click	the	Quick	Access	toolbar	and	select	Customize	Quick	Access	Toolbar.
This	will	open	the	Quick	Access	toolbar	category	of	Excel	options.

2.	 Select	Drawing	Tools	|	Format	Tab	from	the	Choose	Commands	drop	down	list.

3.	 Select	Change	Shape	in	the	list	underneath	and	click	Add.	Click	OK	to	close	the
dialog	box.

Now	that	you	have	added	the	Change	Shape	command	to	the	Quick	Access	Toolbar,	here
is	how	you	can	use	it	to	the	change	the	shape	of	your	comment	box.

1.	 Make	sure	the	comment	is	in	the	visible	mode.	You	can	do	so	by	right	clicking	the
particular	cell	and	selecting	Show/Hide	Comments

2.	 Now	click	 the	comment’s	border	and	 then	click	 the	Change	Shape	 button	 in	 the
Quick	Access	Toolbar.

3.	 Select	the	desired	shape.

Figure	12.12	shows	a	comment	box	in	an	oval	callout	shape	filled	with	blue	color.

Figure	12.12	-	Changing	the	Shape	of	a	Comment	Box

	

	



Managing	Comments

The	presence	of	 a	 comment	 is	 indicated	by	 a	 small	 red	 triangle	 located	 in	 the	 top	 right
corner	of	the	particular	cell.	To	reveal	a	comment,	move	the	cell	pointer	or	cursor	to	the
particular	cell.

Managing	Individual	Comments

If	you	want	a	comment	to	display	at	all	times,	even	when	a	cell	is	not	selected,	right	click
the	cell	and	select	Show/Hide	Comments.	To	revert	to	normal	settings,	right	click	again
and	select	Hide	comments.

Another	way	 of	 revealing	 a	 comment	 is	 to	 select	Review	 tab	>	Show/Hide	Comment.
Clicking	 it	 again	 will	 hide	 the	 comment.	 This	 process	 is	 for	 individual	 cells.	 In	 other
words,	you	need	to	do	this	with	every	comment	you	want	to	show	or	hide.

Managing	All	Comments

To	apply	the	same	Show/Hide	settings	to	all	the	comment	boxes,	select	File	>	Options	>
Advanced.	 There	 in	 the	 display	 section,	 you	 will	 find	 a	 heading	 “For	 cells	 with
comments,	show:”	This	heading	contains	three	sub-options	as	shown	in	Figure	12.13

Figure	12.13	-	Show/Hide	Settings	for	Comments	in	Excel

							If	you	select	No	comments	or	indicators,	it	will	hide	all	the	comments	as	well
as	the	red	triangle	indicators.

	 	 	 	 	 	 	 If	you	select	Indicators	only	and	comments	on	hover,	 it	will	 show	 the	 red



triangle	indicators	while	the	comments	will	be	displayed	when	the	cursor	is	taken
over	the	particular	cell.

	 	 	 	 	 	 	If	you	select	Comments	and	indicators,	it	will	show	the	indicators	as	well	as
the	comments	regardless	of	where	the	mouse	pointer	is.

Another	way	of	showing	all	the	comments	regardless	of	the	location	of	the	mouse	pointer
is	to	select	Review	tab	>	Show	All	Comments.	Click	it	again	to	hide	all	the	comments.

Here	are	a	few	more	tips	for	managing	comments.

To	expand	the	comment	box,	click	and	drag	it	from	the	edges	to	the	desired	size.

To	select	all	the	cells	containing	comments,	go	to	the	Home	tab.			 	 	 	 	 	 	 	 	 	 	 	 	Click
Find	&	Select	>	Comments.

To	delete	a	comment,	right	click	the	pertinent	cell	and	select	Delete	Comment.	Or
click	Delete	in	the	Review	tab.

To	 read	 all	 the	 comments	 in	 a	 workbook	 without	 having	 to	 click	 on	 each	 cell
individually,	select	 the	Review	 tab	and	click	 the	Next	button	 to	cycle	 through	all
the	comments.	Click	Previous	 to	 read	 all	 the	 comments	 one	 by	 one	 in	 a	 reverse
order.	

Click	the	Show	Ink	button	to	reveal	the	ink	annotations,	if	any.

Printing	Comments

If	you	want,	you	can	print	the	comments	along	with	the	worksheet.	Here	is	how	you	can
do	this.

Select	 the	Page	Layout	 tab	 on	 the	 ribbon.	 Click	 the	 small	 downward	 diagonal	 arrow
located	at	the	bottom	right	corner	of	the	Page	Setup	group.

This	will	open	the	Page	Setup	dialog	box.	Click	the	Sheet	tab	and	expand	the	Comments
drop	down	list.



Figure	12.14	-	Showing	the	Comments	Drop-Down	List	In	the	Page	Setup	Dialog	Box

As	you	can	see	in	Figure	12.14,	there	are	three	options	in	the	Comments	drop-down	list.

							If	you	select	None,	Excel	will	print	none	of	the	comments.

	 	 	 	 	 	 	If	you	select	At	end	of	sheet,	Excel	will	print	all	the	comments	in	simple	text
form	at	the	end	of	the	printed	document.

	 	 	 	 	 	 	 If	you	select	As	displayed	on	sheet,	 it	will	 print	 the	 comments	on	 the	 same
location	as	they	are	on	the	worksheet.

Select	the	desired	option	and	confirm	the	Print	operation.	

If	you	are	selecting	the	As	displayed	on	sheet	option,	keep	in	mind
that	 the	comments	may	obscure	 some	cells	of	 the	worksheet	 in	 the
print	 version.	 Moreover,	 if	 there	 are	 too	 many	 comments	 on	 a
worksheet,	they	may	overlap	in	the	hard	copy.		

	

To	see	how	the	comments	would	appear	in	the	print	form,	check	the	Print	Preview	before
printing.	Refer	to	Chapter	15	for	more	explanation	on	printing	in	Excel.		

Naming	Ranges

When	working	 on	 large	 spreadsheets	 containing	 innumerous	 cells	 and	 formulas,	 typical
cell	 address	 can	make	 the	work	more	 confusing	 and	 complicated.	 You	 cannot	 possibly
memorize	all	the	cell	names.	Even	if	you	do,	moving	back	and	forth	to	refer	a	formula	in



far	end	of	sheet	to	a	cell	in	the	first	row	can	be	quiet	hectic.

Suppose	 you	 need	 to	 enter	 a	 formula	 in	 the	 Cell	 XC104	 and	 the	 formula	 needs	 to	 be
referred	to	the	value	in	Cell	A5.	Now	both	these	cells	are	quite	far	from	each	other	in	the
worksheet.	You	would	either	have	to	memorize	the	cell	name	that	you	need	to	refer	to	or
move	the	active	cell	all	 the	way	to	the	particular	cell.	Don’t	you	think	moving	back	and
forth	between	such	huge	gaps	in	the	worksheet	would	be	very	time	consuming,	especially
if	a	same	value	needs	to	be	used	frequently	throughout	the	worksheet?

How	 about	 renaming	 the	 cell	 so	 that	 you	 can	memorize	 it	 easily	 and	 then	 put	 it	 in	 the
formula	without	 having	 to	move	 all	 the	way	 to	 the	 particular	 cell?	Excel	 allows	you	 to
rename	individual	cells	as	well	as	ranges.	Continuing	the	above	example,	you	can	name
cell	A5	as	Discount_Rate.	Now	 this	 is	very	easy	 to	 remember	and	would	 save	a	 lot	of
your	time.

Moreover,	working	with	names	makes	navigating	worksheet	easier.	You	can	move	to	any
cell	or	range	by	entering	its	name	in	the	Name	box,	located	at	the	left	side	of	the	formula
bar.	The	best	 thing	about	naming	ranges	 is	 that	you	don’t	even	have	 to	memorize	 them.
Just	click	the	drop	down	list	of	the	name	bar	and	it	will	list	down	all	the	defined	names.

Above	all,	naming	ranges	makes	the	formulas	more	readable	and	easier	to	understand.	For
example,	Sales	+	Cost	is	more	understandable	than	C13+C19.

Now	that	you	know	the	advantages	of	naming	cells,	let’s	see	how	you	can	actually	do	that.

Quick	Rules	of	Thumb

There	 are	 several	 ways	 of	 naming	 cells	 and	 ranges	 in	 Excel,	 each	 having	 their	 own
characteristics	 and	 mechanism.	 However	 one	 thing	 is	 common	 among	 all,	 the	 rules.
Regardless	 of	 which	 method	 you	 opt	 for,	 there	 are	 some	 basic	 rules	 that	 you	 need	 to
follow	while	naming	cell(s)	in	Excel.

Excel	 does	 not	 accept	 names	 that	 exceed	 255	 characters.	 So	make
sure	your	name	is	limited	to	it.	Moreover	it	is	highly	recommended
to	 keep	 the	 names	 as	 short	 as	 possible.	 Shorter	 names	 are	 easy	 to
remember	and	take	up	less	time	in	typing.

	

							You	cannot	put	any	spaces	in	names,	Excel	will	not	accept	that.	Instead	of	space,
you	can	use	an	underscore	character	(	_	).



							Names	can’t	contain	any	symbols,	except	for	backslash,	underscore	and	period.

							You	can	make	any	combination	of	letters	and	numerals	but	make	sure	your	name
begins	with	a	 letter,	a	backlash	or	an	underscore.	You	cannot	start	a	name	with	a
number.

	 	 	 	 	 	 	You	cannot	use	 any	other	 cell’s	name.	For	 example,	 you	cannot	name	a	 cell
BZ34.	This	is	already	the	name	of	a	cell,	hence	cannot	be	given	to	any	other	cell.	If
still	 you	 want	 to	 give	 this	 name	 to	 a	 cell,	 precede	 it	 with	 an	 underscore	 or	 a
backslash.

	 	 	 	 	 	 	Avoid	using	 the	following	names:	Print_Area,	Consolidate_Area,	Print_Titles
and	Sheet_Title.	 It	 is	because	Excel	 already	uses	 these	names	 for	 some	 technical
purpose.



How	to	Name	Cells	and	Ranges?

There	are	several	ways	of	naming	cells	and	ranges	in	Excel,	as	explained	below.

Defining	Names	Using	the	Name	Box

The	 easiest	 and	 commonly	 used	ways	 of	 naming	 cells	 in	Excel	 is	 the	Name	Box.	 It	 is
located	on	the	immediate	left	side	of	the	formula	bar.

Follow	the	below	process	to	use	the	Name	Box	in	Excel.	

1.	 Select	the	cell	or	the	range	that	you	want	to	name.

2.	 Go	to	the	Name	Box	and	enter	the	desired	name.

3.	 Hit	Enter	on	your	keyboard	to	confirm	the	name.

	

Pressing	Enter	after	typing	the	name	is	a	very	important	step.	If	you
don’t	hit	Enter	and	click	just	anywhere	else	on	the	worksheet,	Excel
will	not	save	that	name.

	

Keep	in	mind	the	following	while	using	the	Name	Box:

If	 you	 use	 a	 name	 that	 is	 already	 in	 use	 by	 any	 other	 cell	 or	 range,	 Excel	 does
accept	it	neither	it	notifies	you	of	it.	So	make	sure	to	click	the	newly	named	cell	or
range	to	check	if	it	is	actually	named	or	not.

If	you	give	a	name	to	a	range	of	cells,	the	name	will	not	appear	in	the	Name	Box
unless	you	select	the	particular	range.

If	 you	 use	 any	 invalid	 character	 in	 the	 name,	 Excel	 displays	 an	 alert	 window
informing	that	the	reference	name	is	invalid.

To	 select	 a	 named	 cell	 or	 range,	 simply	 click	 the	Name	Box	 drop	 down	 list	 and
click	over	the	particular	name.

Defining	Names	Using	the	New	Name	Dialog	Box

The	New	Name	Dialog	Box	is	another	way	of	naming	cells	and	ranges.	It	is	an	advanced
comprehensive	 naming	 tool	 and	 gives	 you	 more	 control	 over	 the	 naming	 feature.	 For



example,	it	gives	you	the	option	to	apply	the	defined	name	in	the	entire	workbook	or	just
one	worksheet.

Follow	the	below	process	to	use	the	advanced	New	Name	Dialog	Box	in	Excel.	

1.	 Select	the	cell	or	range	that	you	want	to	name.

2.	 Click	over	the	Formula	Tab	>	Define	Name.	This	will	open	the	New	Name	Dialog
Box,	as	shown	in	Figure	12.15	Right	clicking	a	cell	or	range	and	selecting	Define
Name	also	opens	up	the	New	Name	Dialog	Box.

3.	 Type	 the	 desired	 name	 in	 the	 ‘Name’	 type	 text	 box.	You	 can	 also	 use	 the	 name
suggested	by	Excel.

Figure	12.	15	-	The	New	Name	Dialog	Box

4.	 Next,	select	the	‘Scope’	for	the	new	name.	For	example,	if	you	select	Workbook,	it
will	 name	 the	 same	 cell	 or	 range	 in	 all	 the	worksheets	 of	 the	 current	workbook.
Likewise,	you	can	select	 the	worksheet	 in	which	you	want	 to	name	the	particular
cell	or	range.

5.	 If	you	want,	you	can	add	a	comment	in	the	‘Comment’	type	text	box.	For	example,
you	 can	 put	 in	 a	 comment	 to	 explain	 the	 formula	 used	 in	 the	 particular	 cell	 or
range.

6.	 Finally,	 is	 the	 ‘Refers	 to’	 type	 text	 box.	 It	 contains	 the	 cell	 or	 range	 you	 have
selected	for	naming.	If	you	want,	you	can	change	the	selection	here.

7.	 Click	OK	to	confirm	the	name	and	close	the	Dialog	Box.

Keep	in	mind	the	following	while	using	the	New	Name	Dialog	Box:

Once	confirmed,	you	cannot	change	the	scope	of	a	name.



If	a	cell	or	 range	contains	 two	names	one	with	workbook	scope	and	other	with	a
worksheet	scope,	 the	 latter	will	 take	precedence	over	 the	former,	hence	rendering
the	workbook-scope	name	useless.

If	 you	 have	 defined	 a	 name	with	 a	 worksheet	 scope	 but	 need	 to	 use	 it	 in	 other
worksheets	 as	 well,	 you	 can	 do	 so	 by	 typing	 the	 sheet	 name	 followed	 by	 an
exclamation	mark	and	then	the	name	of	the	cell	or	range	you	want	to	refer	to.	For
example,	Sheet5!Name.	You	can	 type	 this	 in	 the	 formula	bar	of	 any	 sheet	 and	 it
will	refer	to	the	Name	cell	or	range	in	Sheet	5.

Defining	Names	From	Selection

The	Create	From	Selection	button	 in	 the	Formula	 tab	of	 the	ribbon	 is	 the	most	 intuitive
and	 accommodating	naming	 tool	 in	 the	Excel.	 It	 enables	 you	 to	 name	 several	 cells	 and
ranges	at	once.

You	can	also	use	the	values	in	one	cell	 to	name	the	corresponding	cells.	For	example,	if
you	want	to	use	the	text	values	in	Row	1	to	give	names	to	the	adjacent	cells	in	Row	2,	you
can	do	so	by	using	the	Create	From	Selection	dialog	box.

Follow	the	below	process	to	define	names	using	the	corresponding	text	values:

Select	the	cells	containing	the	text	values	and	the	cells	that	you	want	to	name.	In	Figure
12.16,	Column	A	contains	the	prospective	name	and	Column	B	contains	the	cells	that	need
to	be	named.	Both	of	them	are	selected.

Select	the	Formulas	Tab.	Click	Create	From	Selection	button.	This	will	open	the	Create
Names	From	Selection	dialog	box,	as	shown	in	Figure	12.16



Figure	12.16	-	The	Create	Names	From	Selection	Dialog	Box

Excel	 suggests	 an	 option	 based	 on	 its	 analysis	 of	 the	 selected	 cells.	 In	 Figure	 12.16,	 it
suggests	Left	column.	It	means	that	Excel	detects	the	prospective	names	to	be	in	the	left
column	of	 the	 selected	 range.	 If	 the	option	 suggested	by	Excel	 is	not	 correct,	 select	 the
desired	option.	If	you	select	Top	row,	Excel	will	define	names	based	on	the	text	values	in
the	top	row.	Likewise	is	for	the	other	options.

Click	OK	to	confirm	and	close	the	dialog	box.

Using	the	data	in	Figure	12.16,	Excel	defined	seven	names:	Rate	for	Cell	B1,	Discount
for	Cell	B2	and	so	on.	

	

Keep	in	mind	the	following	while	using	the	Create	From	Selection	dialog	box:

If	a	prospective	name	is	incorrect	or	contains	any	invalid	characters,	Excel	edits	to
make	 it	valid.	Suppose	 the	 text	value	 is	Discount	Rate.	Now	 this	 is	 invalid	 as	 it
contains	 a	 space	 in	 it.	 Excel	 will	 put	 an	 underscore	 in	 place	 of	 the	 space
(Discount_Rate)	to	make	it	valid.

If	a	row	or	column	that	is	supposedly	containing	text	values	carries	a	numeric	value
as	well,	Excel	simply	ignores	it	and	does	not	create	a	name	for	the	corresponding
cell.	



Befriending	the	Name	Manager

The	Create	From	Selection	is	a	helpful	yet	a	bit	complicated	feature.	You	need	to	practice
it	 a	 couple	of	 times	with	different	 selections	 and	options	 to	understand	 it	 clearly.	Don’t
worry	if	you	mix	up	names	in	 the	selected	cells	or	may	need	to	delete	a	name.	You	can
delete	and	edit	the	names	as	many	times	as	you	want.	The	Name	Manager	of	Excel	helps
you	manage	the	names	of	your	cells	and	ranges.

To	 launch	 the	 Name	Manager,	 select	 the	 Formulas	 Tab	 in	 the	 ribbon.	 Click	 the	Name
Manager	button.

For	keyboard	users,	press	Ctrl	+	F3	to	open	the	Name	Manager

Figure	12.17	-	Showing	the	Name	Manager	and	the	Filter	Options

As	 you	 can	 see	 in	 Figure	 12.17,	 the	Name	Manager	 displays	 information	 about	 every
name	in	every	worksheet	of	the	current	workbook.	It	contains	the	complete	cell	address	of
the	names,	the	values	contained	in	the	respective	cells,	their	scope	and	comment,	if	any.

There	is	a	Filter	button	at	the	top	right	of	the	Name	Manager.	You	can	click	this	to	find
more	 sorting	 options.	 For	 example,	 you	 can	 ask	 the	 Name	Manager	 to	 show	 only	 the
names	with	the	current	worksheet	scope,	or	the	names	with	or	without	errors	and	so	on.

The	Name	Manager	also	contains	a	direct	access	to	the	New	Name	dialog	box.	Click	the
New	Button	to	open	the	New	Name	dialog	box	and	create	more	names.



If	you	want	to	modify	any	name,	Click	Edit.	This	will	open	the	Edit	Name	dialog	box.	It
looks	exactly	the	same	as	the	New	Name	dialog	box.	The	only	difference	is	that	the	Scope
and	Comment	boxes	are	 locked.	 In	other	words,	you	can	edit	 the	name	and	 range	only.
You	cannot	make	any	changes	in	the	scope	or	comments	of	the	selected	name.

To	 delete	 any	 name,	 simply	 select	 the	 name	 in	 the	 Name	Manager	 and	 hit	 the	Delete
button	located	right	next	to	the	Edit	button.	Or	you	can	also	hit	Delete	on	your	keyboard.
In	 either	 case,	 Excel	will	 display	 an	 alert	window	 asking	 you	 to	 confirm	 the	 requested
activity.	If	you	have	hit	Delete	by	mistake,	click	Cancel	or	else	Click	OK	to	confirm	the
deletion.

	

If	you	have	used	a	name	 in	any	formula,	deleting	 that	name	would
render	 the	 respective	 formula	 invalid.	 Excel	 does	 not	 replace	 the
name	with	 the	 original	 address	 of	 the	 cell	 or	 range.	 So	 be	 careful
while	deleting	any	names.	If	you	have	deleted	any	name	accidently,
immediate	 click	 the	Undo	 button	 in	 the	 Quick	 Access	 toolbar	 or
press	Ctrl	+	Z	on	your	keyboard	to	get	back	the	name.

	

Generating	A	List	Of	Names

At	 times	you	may	want	 to	keep	a	 record	of	 all	 the	names	 in	 the	 spreadsheet	or	 to	print
them	in	hard	copy.	In	either	case,	you	need	to	generate	a	list	of	all	the	names	in	Excel	as
you	cannot	print	the	names	directly	from	the	Name	Manager.

	

To	create	a	list	of	the	defined	names	of	cells	and	ranges,

1.	 Select	any	empty	cell	in	a	worksheet.

2.	 Hit	F3	to	open	the	Paste	Name	dialog	box,	as	shown	in	Figure	12.18



Figure	12.18	-	The	Paste	Name	Dialog	Box

3.	 Click	Paste	List.

This	will	create	a	list	of	all	the	names	along	with	their	cell	addresses.

	

Be	careful	while	selecting	 the	cell	 for	creating	 list	of	names.	Excel
pastes	 the	 list	vertically	and	 it	overwrites	any	existing	data	without
informing	or	asking	for	permission.	So	make	sure	 the	cells	beneath
the	 selected	 cell	 and	 adjacent	 to	 them	 are	 either	 blank	 or	 does	 not
contain	any	important	data.

	

	





Chapter	13:	Using	Templates	in	Excel	2013

A	 template	 is	 a	 model	 that	 serves	 as	 a	 basis	 for	 creating	 workbooks	 and	 worksheets.
Templates	can	carry	values	as	well	as	formatting.	They	not	only	save	time	but	help	you	to
maintain	a	 consistent	 theme	and	appearance	of	 spreadsheets	 that	needs	 to	be	created	on
regular	basis.

For	example,	 if	you	make	payroll	sheets	every	month,	you	can	create	a	payroll	 template
and	use	it	to	create	every	month’s	payroll	sheet.	This	will	save	you	from	typing	the	same
headings	 and	 doing	 the	 same	 formatting	 every	 month.	 All	 of	 it	 will	 be	 saved	 in	 your
payroll	template.	You	just	have	to	change	the	values.

If	you	don’t	want	 to	 create	your	own	 template,	you	can	use	 the	ones	provided	 in	Excel
2013	or	you	can	also	get	them	online.	This	chapter	tells	you	all	you	need	to	know	about
templates.	 It	 introduces	 you	 to	Excel’s	 amazing	 templates.	You	will	 also	 learn	 different
ways	of	customizing	and	creating	templates.	

Finding	Your	Required	Template

Templates	were	there	in	the	previous	versions	of	Excel	as	well,	however	this	time	they	are
more	 intuitive	 and	 in	 huge	 variety.	 Excel	 2013	 offers	 numerous	 templates	 including
Online	sales	tracker,	Simple	monthly	budget,	Daily	work	schedules,	Flowcharts,	Wedding
Invite	Tracker	and	so	on.	Whether	you	are	creating	a	spreadsheet	 for	academic	purpose,
office	work	or	personal	use,	you	will	find	a	template	in	Excel	for	all	categories.

There	 are	 templates	 for	 grocery	 list,	 class	 attendance,	 coloring	 book	 and	 much	 more.
Excel’s	list	of	templates	is	ending.	You	just	need	to	find	the	right	one	of	you.	And	this	is
very	simple.

There	are	several	ways	to	find	the	template	you	are	looking	for.

							When	you	open	Excel	2013,	on	the	left	side	are	the	recently	opened	files	and	on
the	right	side	are	the	templates.	Scroll	down	and	look	for	the	desired	file.

							You	can	also	open	the	templates	window	by	clicking	File	>	New.

							If	you	are	unable	to	find	the	template	you	need,	search	for	it	in	the	“Search	for
online	templates”	text	box,	as	shown	in	Figure	13.1



Figure	13.1	-	Searching	For	Templates

	 	 	 	 	 	 	Another	way	of	finding	the	required	template	is	 to	click	any	of	the	suggested
searches.	Doing	so	will	open	the	category	page	of	 templates.	As	shown	in	Figure
13.2,	on	 the	right	side	 is	 the	 list	of	categories.	Click	on	any	category	 to	open	 the
pertinent	templates.

Figure	13.2	-	Categories	of	Available	Templates

How	to	Use	Templates	in	Excel	2013

Now	that	you	know	you	how	to	find	the	required	templates	in	Excel,	let’s	see	how	you	can
create	a	workbook	from	a	template.

1.	 First,	find	the	template	you	are	looking	for.



2.	 Click	 the	 thumbnail	 of	 the	 pertinent	 template.	 This	 will	 open	 a	 small	 window
displaying	description	about	the	template	along	with	its	rating	and	download	size.
Figure	13.3	shows	the	description	window	of	family	budget	template.

Figure	13.3	-	Showing	the	Description	Window	of	a	Template

	

To	 view	 details	 about	 more	 templates	 without	 going	 back	 to	 the
thumbnail	 page,	 click	 the	 arrows	 located	 at	 either	 side	 of	 the
description	window.

	

3.	 If	you	like	the	template,	click	the	Create	button.	Excel	will	download	the	particular
template	and	then	open	a	workbook	based	on	that.

4.	 What	you	do	next	depends	upon	your	needs.	Every	 template	 is	editable.	You	can
change	the	headings,	colors,	values,	formatting	and	whatever	you	want.

	

Figure	13.4	shows	a	workbook	created	from	the	Family	Budget	Template.



Figure	13.4	-	Workbook	Created	From	a	Template

Remember	the	following	things	while	you	work	on	template	based	workbooks.

There	are	not	any	hard	and	fast	 rules	 to	work	on	a	 template	based	workbook.	As
you	can	see	in	Figure	13.4,	the	template	is	nothing	but	a	workbook	already	created
by	Excel.	You	have	to	work	on	it	just	like	you	would	work	on	any	workbook.

Once	you	download	a	template,	it	is	saved	in	your	system.	Whatever	changes	you
make	 in	 it	will	not	affect	 the	original	 template.	 It	will	be	 there	as	 it	 is	when	you
need	it	next	time.

It	is	the	template	that	is	saved	in	your	system	and	not	the	workbook.	So	once	you
open	 a	 template	 based	workbook,	 save	 it	 first	 so	 that	 any	 changes	 you	make	 are
saved	in	it.

Managing	the	Templates

To	find	out	where	the	original	templates	are	saved	after	downloading

1.	 Select	File	>	Options	>	Trust	Center.

2.	 Click	the	Trust	Center	Settings	button.	This	will	open	the	Trust	Center	dialog	box.	

3.	 Now	select	the	Trusted	Locations	tab	on	the	left.	

4.	 There	you	will	find	the	location	of	the	saved	templates.	To	change	the	path	of	the
downloaded	 templates,	 click	 the	Add	 new	 location	 button	 and	 browse	 the	 new
location.



The	commands	to	modify	or	delete	a	template	can	also	be	found	in	this	dialog	box.

Making	Your	Own	Templates

So	 far	 in	 this	 chapter	we	have	 talked	about	using	 the	default	 templates	given	by	Excel.
Though	there	are	numerous	templates	available,	yet	at	times	you	may	not	find	exactly	the
one	you	were	looking	for	or	you	may	not	a	like	a	template.

In	such	cases,	you	can	create	your	own	templates.	Now	there	are	two	ways	to	do	so;	you
can	modify	the	available	template	or	you	can	create	a	totally	new	template.

Customizing	Default	Templates

The	 first	 and	 comparatively	 easier	 way	 of	 creating	 templates	 is	 to	 modify	 the	 existing
ones.

For	 better	 understanding,	 consider	 the	 Family	 Budget	 template	 example	 as	 shown	 in
Figure	13.4

In	this	template,	you	can	change	the	colors,	the	main	heading	and	other	text	values.	Now
you	must	be	 thinking	 that	all	 these	changes	would	 just	affect	 the	workbook	and	not	 the
template,	as	we	said	in	the	previous	section.	Well,	the	keyword	here	is	Save	As.

Select	File	and	click	Save	As	 located	on	the	left	side.	This	will	open	the	Save	As	dialog
box,	as	shown	in	Figure	13.5

Click	the	Save	As	Type	drop	down	list.	Now	as	you	can	see	in	the	Figure	13.5,	there	are
several	formats	for	you	to	save	the	file	in.	If	you	save	the	file	as	Excel	Workbook,	all	the
changes	 that	 you	 made	 will	 be	 saved	 in	 the	 particular	 workbook	 only.	 The	 original
template	will	remain	as	it	is.

To	 save	 the	 changes	 permanently	 in	 the	 template,	 select	Excel	 template	 from	 the	 drop
down	list	and	then	click	Save.	This	will	incorporate	all	the	changes	in	the	template.	If	you
want	to	use	the	particular	template	in	older	versions	of	Excel	as	well,	save	it	as	Excel	97-
2003	Template.



Figure	13.5	-	The	Save	As	Dialog	Box

	

If	you	have	 recorded	any	macros	 in	your	 template,	 save	 the	 file	as
Excel	Macro-Enable	Template.	The	same	goes	for	the	workbook.		

	

Creating	Your	Own	Templates

The	 above	 method	 for	 creating	 customized	 templates	 is	 good	 if	 you	 already	 like	 the
available	template	and	making	a	few	changes	in	it	will	render	it	exactly	the	way	you	need.
However	 at	 times	 the	 available	 template	 may	 be	 totally	 different	 from	 what	 you	 are
looking	 for.	 In	 such	 cases,	modifying	 the	 existing	 template	would	 take	more	 time	 than
creating	one	of	your	own.	Hence	it	is	recommended	that	you	for	the	latter	option	and	make
your	own	template.

Here	is	how	you	can	make	your	own	template,

1.	 Open	a	new	workbook.

2.	 Format	it	as	you	desire,	increase/decrease	the	width	of	columns,	change	the	height
of	columns,	add	or	delete	worksheets	 to	give	 the	workbook	 the	number	of	sheets
you	want,	enter	values,	headings,	 formulas	and	apply	whatever	 settings	and	page
setup	options	you	want.	In	short,	put	all	the	things	in	it	that	you	want	to	see	in	other
workbooks	based	on	this	one.	Just	don’t	put	the	variable	values.



3.	 When	you	have	made	the	workbook	to	your	liking,	select	File	>	Save	As.

4.	 Enter	a	name	for	your	template.

5.	 Select	 Excel	 Template	 (.xltx)	 from	 the	 Save	 As	 Type	 drop	 down	 list.
Alternatively,	 Save	 As	 Excel	 Macro-Enabled	 Template	 (*.xltm)	 if	 your
workbook	contains	macros.

6.	 Close	the	file.

You	can	use	this	template	just	like	you	use	the	available	Excel	templates.

If	you	 select	Save	 rather	 than	Save	As	 in	 the	backstage	 screen,	by
default	it	will	be	saved	as	Excel	Workbook.	To	save	it	as	a	template
or	 if	 it	 contains	macros,	 it	 is	 essential	 that	 you	 click	Save	As	 and
select	the	appropriate	format.





F
Chapter	14:	Formatting	Techniques	

ormatting	may	 be	 not	 necessary	 however	 it	 is	 very	 important	when	 it	 comes	 to
presenting	 the	 spreadsheet.	 Not	 only	 does	 it	 enhance	 the	 appearance	 of	 the
worksheet	but	also	makes	is	easy	to	read	and	understand.

Consider	Figure	14.1	and	14.2	as	an	example.

Figure	14.1	-	Worksheet	without	Formatting	

Figure	14.2	-	Worksheet	with	Formatting	

As	you	 can	 see,	 both	 the	worksheets	 are	 same.	They	 contain	 the	 same	 values,	 text	 and
formulas.	The	 only	 difference	 lies	 in	 the	 formatting.	 It	 is	 the	 formatting	 that	makes	 the
worksheet	in	Figure	14.2	more	visibly	attractive	and	readable	than	the	worksheet	in	Figure
14.1.	

This	 was	 just	 one	 example	 of	 formatting	 in	 Excel.	 Formatting	 is	 a	 vast	 term	 that
encompasses	 many	 features	 of	 Excel.	 Font	 type,	 font	 size,	 borders,	 shading,	 styles,
themes,	 text	alignment,	background	 images	and	so	on;	 it	 all	 falls	under	 formatting.	You
can	highlight	ranges,	merge	cells,	change	the	direction	of	values	and	much	more.	And	then
there	 is	 the	 amazing	Conditional	 formatting	 feature	which	 in	 simple	words	 is	 automatic



formatting.	All	of	this	is	explained	in	detail	in	this	chapter.

Formatting	Basics

Formatting	 is	 a	 quite	 easy	 yet	 a	 very	 exciting	 activity.	You	 can	 format	 individual	 cells,
ranges,	 rows,	 columns	 and	 even	 the	 entire	worksheet.	 Just	 select	 the	 range	you	need	 to
format	and	apply	the	desired	formatting	style.

There	 are	 numerous	 tools	 and	 styles	 of	 formatting,	 explained	 in	 the	upcoming	 sections.
But	before	we	move	on	to	that,	you	need	to	understand	and	remember	the	following	basics
about	formatting	in	Excel.

While	formatting	enhances	the	appearance	of	a	worksheet,	the	main	purpose	of	it	is
to	make	the	data	more	understandable	and	readable.	Keep	this	goal	in	mind	while
formatting.	 Do	 not	 go	 overboard	 with	 colors	 and	 themes	 as	 it	 may	 distract	 the
readers.

When	 you	 format	 a	 cell	 or	 range	 in	 Excel,	 it	 stays	 that	 way	 till	 you	 clear	 the
formatting	or	apply	any	other	formatting	over	it.

Deleting	a	value	does	not	remove	the	formatting	unless	you	delete	the	entire	range
or	clear	the	formatting.

	

To	 remove	 formatting,	 select	 the	 particular	 cell	 or	 range.	 Click	 the
Clear	drop	down	list	represented	by	a	small	pink	eraser	in	the	Editing
group	of	the	Home	tab.	Select	Clear	Formats.

	

If	you	enter	or	edit	a	value	in	a	formatted	cell,	it	won’t	affect	the	formatting	of	the
particular	cell.

If	you	copy	or	move	a	formatted	cell,	the	applied	formatting	style	copies	or	moves
to	the	new	location	unless	you	choose	an	advanced	pasting	option.

How	to	Copy	Formats	In	Excel

Before	we	move	on	the	formatting	tools,	there	is	one	more	thing	you	need	to	and	that	is
the	 trick	 to	copy	 formats	 in	Excel.	At	 times	you	may	need	 to	copy	 the	same	formatting
style	in	different	cells.	Suppose	you	applied	the	percentage	number	font,	bold	text	and	14



font	size	in	a	cell	and	the	same	formats	needs	to	be	applied	in	a	particular	range.

You	can	of	course	apply	the	formats	separately	on	each	cell,	but	that	would	be	very	time
consuming	especially	if	the	particular	range	consists	of	hundreds	of	cells.	So	why	not	copy
the	formatting	style	when	you	have	the	option	to	do	so!

Just	 like	 you	 can	 copy	 and	 paste	 values	 in	 different	 cells,	 you	 can	 do	 the	 same	 with
formatting	as	well.

To	copy	a	formatting	style	from	one	cell	to	another	cell	or	range,

1.	 First	select	the	cell	the	format	of	which	you	want	copy

2.	 Hit	the	Format	Painter	button	located	in	the	bottom	right	of	the	Clipboard	group
in	the	Home	tab.

3.	 Now	select	the	cell	or	range	to	which	you	want	to	apply	the	copied	formats.

Commonly	Used	Formatting	Tools

Excel	 features	 innumerous	 formatting	 tools	 located	 at	 different	 places.	 Font	 type,	 size,
color,	bold,	italic	and	other	font	related	commands	are	the	widely	used	formatting	tools	in
Excel.	They	are	so	commonly	used	that	the	developers	of	Excel	have	placed	them	in	the
first	tab	of	the	Ribbon.

Figure	14.3	-	Showing	the	Commonly	Used	Formatting	Tools	in	the	Home	Tab

You	will	find	all	the	basic	font	formatting	tools	along	with	the	text	alignment	commands
in	 the	 Home	 tab.	 Just	 select	 the	 cell(s)	 you	 want	 to	 format	 and	 hit	 the	 appropriate
formatting	 icon	 in	 the	Home	 tab.	Some	of	 the	commands	also	contain	a	drop	down	 list.
For	example,	 the	font	 type	and	font	size	icons	carry	a	drop	down	list	containing	options
pertinent	to	the	corresponding	command.

Formatting	Via	the	Mini	Toolbar

The	commonly	used	formatting	tools	can	also	be	found	in	the	mini	toolbar.	It	is	the	small
menu	that	appears	when	you	right	click	a	cell	or	range.

Select	 the	 cell(s)	 you	want	 to	 format,	 right	 click	 and	 then	 select	 the	 desired	 formatting
command	in	the	Mini	Toolbar.



Clicking	 anywhere	 on	 the	 mini	 toolbar	 will	 make	 the	 right	 click	 shortcut	 menu	 to
disappear.	However	the	mini	toolbar	would	still	be	there.	So	once	you	are	done	using	the
mini	toolbar,	click	on	any	other	cell	or	hit	Esc	on	your	keyboard	to	hide	it.

Figure	14.4	-	The	Mini	Toolbar

Exploring	the	Format	Cells	Dialog	Box

As	 already	 mentioned,	 the	 Home	 Tab	 and	 the	 Mini	 Toolbar	 contains	 only	 the	 basic
formatting	tools.	Formatting	is	far	more	comprehensive	and	features	numerous	advanced
tools	all	of	which	are	not	available	in	either	of	the	two	places	explained	above.

So	if	you	are	unable	to	find	the	required	formatting	command	in	the	Home	Tab	or	the	Mini
Toolbar,	look	for	it	in	the	Format	Cells	Dialog	Box.	It	allows	you	to	do	much	more	than
the	basic	font	formatting.

There	are	several	ways	to	open	the	Format	Cells	Dialog	Box:

1.	 Select	the	cell(s)	you	want	to	format,	then	right	click	and	select	Format	Cells.

2.	 Press	Ctrl	+	1	on	your	keyboard

3.	 Click	the	small	downward	diagonal	arrow	located	at	the	bottom	right	corner	of	the
Font	group	or	the	Alignment	Group	or	the	Number	group	in	the	Home	tab.

4.	 Select	the	More	Borders	drop	list	in	the	Font	group	of	the	Home	tab	and	click	over
More	Borders

Either	ways,	Excel	will	open	the	Format	Cells	dialog	box,	as	shown	in	Figure	14.5.



Figure	14.5	-	The	Format	Cells	dialog	box

As	you	can	see	in	the	above	image,	the	Format	Cells	dialog	box	contains	six	tabs,	namely;
Number,	Alignment,	Font,	Border,	Fill,	and	Protection.	The	Number	tab	has	already	been
explained	 in	Chapter	8.	The	upcoming	sections	 talks	about	 the	 formatting	commands	 in
the	remaining	tabs	of	the	Format	Cells	dialog	box.

Formatting	Shortcuts	

Formatting	 is	 easier	 and	 far	 more	 fun	 if	 you	 get	 the	 hang	 of	 keyboard	 shortcuts.	 For
example,	Ctrl	+	B	apply	bold	formatting	to	the	font.	Likewise	Ctrl	+	I	make	the	text	italic
and	so	on.

Refer	 to	 Appendix	 “List	 of	 Keyboard	 Shortcuts”	 to	 learn	 the	 keyboard	 shortcuts	 for
Formatting.		

	

Working	with	Different	Fonts

Now	that	you	know	where	to	find	the	different	tools	of	formatting	in	Excel	2013,	let’s	see
how	you	can	actually	use	them.

The	 first	 and	most	basic	 formatting	 tool	 is	Font.	You	can	change	 the	 typeface,	 size	 and
color	of	the	font	of	the	values	in	cells.	The	primary	purpose	of	using	different	fonts	is	to
make	various	values,	such	as	headings	in	the	worksheets,	stand	out.	You	can	also	decrease
the	size	of	the	font	to	make	more	data	fit	in	one	printable	page.

By	default,	Excel	uses	Calibri	font	in	size	11.	You	can	of	course	change	it	to	any	type	and



size.	You	can	find	the	font	formatting	commands	in	the	Mini	Toolbar,	in	the	Home	tab	of
the	ribbon	and	the	Font	tab	of	the	Format	Dialog	box.

Figure	14.6	shows	the	formatting	commands	in	the	Home	tab.

Figure	14.	6	-	Showing	the	Formatting	Commands	in	the	Home	Tab

For	better	understanding,	the	formatting	commands	in	Figure	14.6	are	numbered.	Here	is
their	description.

1	Font	type:	It	is	a	drop	down	list	that	contains	the	types	of	fonts	available	in	Excel	2013.

2	Font	Size:	This	one	is	also	a	drop	down	list.	Click	this	to	select	the	desired	font	size.

3	Bold:	Click	this	to	make	the	values	in	the	selected	cell(s)	Bold.	Alternatively	you	can	hit
Ctrl	+	B	on	your	keyboard.

4	Italic:	Click	this	to	make	the	values	in	the	selected	cell(s)	Italic.	Alternatively	you	can
hit	Ctrl	+	I	on	your	keyboard.

5	Underline:	Click	this	to	Underline	the	values	in	the	selected	cell(s).	Alternatively	you
can	hit	Ctrl	+	U	on	your	keyboard.	This	icon	also	carries	a	drop	down	list	containing	the
options	for	single	underline	and	double	underline.	Apart	 from	these,	 there	are	 two	more
underline	options,	namely,	single	accounting	and	double	accounting.	These	are	available
in	the	Font	tab	of	the	Format	Cells	dialog	box.

6	Bottom	Border:	Clicking	this	icon	will	put	a	bottom	border	in	the	selected	cell(s).	This
command	 also	 carries	 a	 drop	 down	 list	 containing	 several	 other	 border	 options	 such	 as
thick	borders,	colorful	borders	and	so	on.	More	about	using	borders	is	explained	later	on
in	this	chapter.

7	Fill	Color:	As	the	name	suggests,	this	drop	down	list	contains	colors	that	you	can	fill	in
the	selected	cell(s).

8	Font	Color:	Select	 this	command	to	open	the	color	palette	for	fonts.	 If	you	don’t	 like
any	color	in	the	given	palette,	click	More	Colors.



9	Decrease	Font	Size/10	Increase	Font	Size:	If	you	are	not	sure	as	to	which	font	size	you
should	select,	you	can	click	either	of	these	commands	to	decrease	or	increase	the	font	size
one	point	at	a	time.

The	small	downward	diagonal	arrow	located	at	the	bottom	right	corner	opens	the	Font	tab
in	the	Format	Cells	dialog	box.

Apart	 from	 the	 above	 explained	 formatting	 commands,	 you	 can	 also	 strikethrough,
subscript	and	superscript	the	values.	These	formatting	commands	can	be	found	in	the	Font
tab	of	the	Format	Cells	dialog	box.

Formatting	Text	Values	in	Individual	Cells

If	a	cell	contains	a	text	value,	you	can	apply	multiple	formatting	styles	to	it.	This	is	mostly
done	when	a	cell	carries	a	large	text	value	distributed	in	different	lines	or	is	text	wrapped.

To	format	the	text	values	in	individual	cells,	double	click	the	particular	cell	or	hit	F2	to	put
the	cell	in	the	editable	mode.	Now	select	the	characters	that	you	want	to	format	and	apply
the	desired	formatting	style	to	them.		

Figure	14.7	illustrates	an	example	this	formatting	technique.

Figure	14.	7	-	Example	of	Applying	Multiple	Formatting	Styles	in	a	Single	Cell

As	you	can	see	in	Figure	14.7,	Cell	A2	carries	a	large	text	value	which	is	formatted	with
multiple	styles	to	make	it	more	readable.

	

You	 cannot	 apply	multiple	 formatting	 styles	 in	 a	 cell	 if	 it	 contains
numeric	 or	 text	 values.	 This	 technique	 is	 applicable	 to	 text	 values
only.	

	

Aligning	the	Text	

When	you	enter	any	numeric	value	in	a	cell,	by	default	it	is	aligned	to	the	right.	Likewise



in	case	of	a	text	value,	Excel	aligns	it	to	the	left.	However	you	can	change	the	alignment
very	easily.

Excel	allows	you	to	align	the	values	in	a	cell	horizontally	and	vertically.	The	commonly
used	alignment	commands	are	located	in	the	Home	tab	of	the	ribbon.	For	more	alignment
options,	open	the	corresponding	tab	in	the	Format	Cells	dialog	box.

Figure	14.	8	-	The	Alignment	Tab	in	the	Format	Cells	Dialog	Box.

Vertical	Alignment

The	vertical	alignment	options	are	used	to	control	how	the	contents	are	distributed	across
the	height	of	the	cells.

Following	are	the	three	commonly	used	vertical	alignment	options.	These	can	be	found	in
the	Home	Tab	as	well	in	the	Format	Cells	dialog	box.

Top	Align:	It	is	the	first	icon	located	at	the	top	left	corner	of	the	Alignment	group	in	the
Home	tab.	It	arranges	the	cell	contents	at	the	top	of	the	cell.

Middle	Align:	This	command	 is	 located	right	next	 to	 the	Top	Align	 icon.	 In	 the	Format
Cells	dialog	box,	it	is	the	Center	option	in	the	Vertical	drop	down	list.	This	option	aligns
the	values	height	wise	in	the	center	of	the	cell.

Bottom	Align:	 Located	 right	 next	 to	 the	Middle	Align	 command,	 it	 is	 also	 the	 default
vertical	alignment	setting	in	Excel.	It	aligns	the	cell	contents	to	the	bottom	of	the	cell.			



Figure	14.9	-	Showing	Examples	of	the	Three	Commonly	Used	Options	for	Vertical	Alignment

Figure	 14.9	 illustrates	 examples	 of	 the	 three	 basic	 types	 of	 vertical	 alignment.	 Staring
from	the	left,	the	cells	are	aligned	top,	middle	and	bottom	respectively.	

Apart	from	the	above	three	options,	there	are	two	more	that	are	located	in	the	Alignment
tab	of	the	Format	Cells	dialog	box.

Justify:	This	option	justifies	the	contents	vertically.	This	command	is	valid	only	if:

							The	cell	contains	text	values

							The	selected	cell	is	formatted	as	wrapped	text

							The	contents	are	distributed	in	two	or	more	lines

Distributed:	As	 the	 name	 suggest,	 this	 option	 distributes	 the	 text	 vertically	 even	 in	 the
cell.

Horizontal	Alignment

The	 horizontal	 alignment	 commands	 helps	 you	 control	 how	 the	 values	 are	 distributed
across	the	width	of	the	cells.

While	all	 the	options	are	available	 in	 the	Alignment	 tab	of	 the	Format	Cells	dialog	box,
the	first	three	commands	are	commonly	used,	hence	can	be	found	in	the	Home	tab	as	well.

General:	 If	you	select	 this	option,	Excel	will	apply	 the	default	alignment	settings	 to	 the
selected	cell(s).	The	numeric	values	will	be	aligned	to	the	left,	text	to	the	right	and	errors
and	logical	values	in	the	center.			

Left	 (Indent):	This	option	aligns	 the	values	 in	 the	 selected	cell(s)	 to	 the	 left	 side	of	 the
cell(s).	In	the	Home	Tab,	it	is	located	in	the	bottom	left	corner	of	the	Alignment	group.

Center:	It	arranges	the	cell	contents	in	the	center	of	the	cell.	In	the	Home	Tab,	it	is	located
right	next	to	the	Left	Align	icon.

Right	(Indent):	This	option	aligns	the	values	to	the	right	side	of	the	cell(s).	This	command
can	also	be	found	in	the	Home	tab,	right	next	to	Center	Align	icon.

Fill:	This	option	repeats	the	same	value	in	the	same	cell	till	the	cell	is	completely	filled.

Justify:	This	option	aligns	the	text	in	such	a	way	that	the	values	are	spread	equally	to	the
left	and	right	of	the	cell.

Center	Across	Selection:	It	adjusts	the	text	content	in	the	center	of	the	selected	columns.
This	alignment	command	is	mostly	used	to	locate	a	heading	exactly	in	the	center	over	the



corresponding	columns.

Distributed	(Indent):	 This	 option	 justifies	 the	 cell	 content	 horizontally	 even,	 across	 the
selected	columns.

The	 indent	options	 in	 the	Home	 tab	and	 the	Format	cells	dialog	box	can	be	used	 to	put
space(s)	 between	 the	 cell	 border	 and	 the	 content.	 These	 are	mostly	 used	when	 cells	 in
adjacent	rows	contain	headings	and	subheadings.	The	latter	are	indented	to	stand	out	from
the	former.

	

Merging	Cells

Regardless	of	which	alignment	option	you	select,	 if	 the	value	is	 larger	than	the	width	of
the	selected	cell,	 the	content	will	brim	over	to	the	adjacent	cell	on	the	right.	However	if
the	adjacent	cell	is	already	filled,	the	excess	text	will	hide	underneath	it.	

There	 are	 several	ways	 to	 fit	 large	 content	 in	one	 cell.	You	can	 increase	 the	height	 and
width	of	 the	cell	but	 to	do	so	you	would	have	 to	 increase	 the	height/width	of	 the	entire
corresponding	row	or	column.	

Merging	 is	 another	 way	 to	 fit	 large	 values	 in	 one	 cell.	 It	 allows	 you	 to	 expand	 a	 cell
without	 affecting	 its	 corresponding	 row	 and	 column.	 The	 Merge	 feature	 of	 Excel
combines	the	selected	cells	and	merges	them	into	a	single	cell.	This	is	turn	renders	more
space	for	the	content.

To	merge	cells	in	Excel,	select	the	cells	that	you	want	to	merge.

Choose	the	Home	tab.	There	in	the	bottom	right	corner	of	the	Alignment	group,	you	will
find	the	Merge	and	Center	command.	Click	it	to	merge	and	unmerge	the	selected	cells.	By
default,	Excel	aligns	the	cell	contents	in	the	center	of	the	merged	cell.

To	change	the	alignment	of	the	cell	content	and	for	more	merging	options,	click	the	drop
down	arrow	in	the	Merge	and	Center	icon.



Figure	14.10	-	The	Merge	and	Center	Drop	Down	List.

As	shown	in	Figure	14.10,	there	are	four	options	in	the	Merge	and	Center	drop	down	list.

Merge	&	Center:	This	option	merges	the	selected	cell	and	centers	the	cell	content.

Merge	Across:	This	option	is	useful	when	you	need	to	merge	a	range	containing	multiple
rows.	This	feature	creates	multiple	merged	cells,	one	for	each	row	in	the	selection.

Merge	Cells:	This	command	merges	the	selected	cells	without	centering	the	cell’s	content.

Unmerge	Cells:	It	unmerges	the	selected	cells.

	

Make	sure	the	cells	that	you	want	to	merge	are	all	empty	except	for
the	 top	 left	cell	 in	 the	 range.	 If	 the	other	cells	are	not	blank,	Excel
will	 display	a	warning	window	which	 says	 that	Merging	 cells	 only
keeps	the	upper-left	cell	values,	and	discards	the	other	values.

Figure	14.11	-	Warning	Window	for	Merging	Filled	Cells

If	you	click	OK,	Excel	will	delete	the	values	in	all	the	other	cells.	Click	Cancel	to	stop	the
merging	 operation.	 If	 you	 have	merged	 cells	 by	mistake,	 click	 the	Undo	 button	 in	 the
Quick	Access	toolbar	or	press	Ctrl	+	Z	on	your	keyboard.

Using	the	‘Shrink	to	Fit’	Feature

There	are	two	more	ways	to	fit	large	content	in	one	cell;	namely,	Wrap	Text	and	Shrink	to



Fit.

These	options	are	mostly	used	when	the	 text	value	 is	 too	 large	 to	fit	 in	 the	width	of	 the
merged	cell.

The	Wrap	Text	feature	distributes	the	text	in	several	lines	in	the	same	cell.	It	allows	you	to
fit	in	large	text	in	one	cell	without	making	the	columns	too	wide	or	reducing	the	font	size.
You	can	find	the	Wrap	Text	command	in	the	Alignment	tab	of	Format	Cells	dialog	box.	It
is	also	located	in	the	Home	tab	right	over	the	Merge	and	Center	icon.

The	 Shrink	 to	 Fit	 feature	 decreases	 the	 font	 size	 of	 the	 text	 value	 so	 that	 it	 fits	 in	 the
selected	cell.	This	option	can	be	found	in	the	Alignment	tab	of	Format	Cells	dialog	box.

	

You	can	use	only	one	feature	at	a	time,	either	Wrap	Text	or	Shrink	to
Fit.	 If	 a	 cell	 is	 already	 formatted	with	 the	Wrap	 Text	 feature,	 you
won’t	 be	 able	 to	 apply	 the	 Shrink	 to	 Fit	 feature	 over	 it	 and	 vice
versa.

	

Rotating	the	Direction	of	Text

This	is	another	very	interesting	feature	of	Excel.	At	times	you	may	want	to	rotate	the	text
to	make	it	more	visually	attractive	or	readable.	Well,	Excel	allows	you	to	do	that.	You	can
display	the	cell’s	content	vertically,	horizontally	or	at	any	other	angle	between	90	degrees
up	and	90	degrees	down.

You	can	find	the	text	rotation	commands	in	the	Home	tab	and	the	Alignment	tab	of	Format
Cells	dialog	box.

First,	let’s	see	how	you	can	use	the	rotation	commands	in	the	Home	tab.

Select	the	content	you	want	to	rotate.	Then	click	over	the	Home	tab.	There	you	will	find
the	Orientation	drop	down	list	in	the	Alignment	group.



Figure	14.12	-	The	Orientation	Drop	Down	List

As	shown	in	Figure	14.12,	 the	Orientation	drop	down	 list	contains	several	options.	You
can	rotate	the	selected	text	clockwise,	counterclockwise,	vertically	and	so	on.

If	 you	 don’t	 find	 the	 desired	 text	 rotating	 command	 in	 the	Orientation	 drop	 down	 list,
select	Format	Cell	Alignment	to	open	the	Alignment	tab	in	the	Format	Cells	dialog	box.

Figure	14.13	-	Showing	the	Degree	Spinner	in	the	Format	Cells	Dialog	Box

As	shown	in	Figure	14.13,	there	is	a	degree	spinner	in	the	top	right	of	the	Alignment	tab.
Click	 and	move	 the	 hand	 in	 the	 spinner	 to	 the	 desired	 angle,	 or	 you	 can	 also	 type	 the
desired	degrees	in	the	Degrees	type	text	box	located	below	the	spinner.	Click	OK	to	save
the	orientation	and	close	the	dialog	box.

Beautify	your	Worksheet

Excel	 2013	 contains	 many	 colorful	 formatting	 tools	 that	 allow	 you	 to	 make	 your
worksheets	visually	enthralling	and	more	readable.	You	can	change	the	color	of	the	text,
fill	color	in	the	entire	cell(s),	add	borders,	background	images	and	much	more.

The	upcoming	sections	talks	about	all	the	colorful	formatting	tools	of	Excel.

How	to	Add	a	Background	Image

At	times,	you	may	want	to	add	a	background	image	in	the	worksheet.	It	may	be	any	online
image,	 or	 your	 company’s	 logo	 or	 any	 other	 personal	 picture.	 A	 background	 image	 in
Excel	gives	the	same	effect	as	the	wallpaper	on	your	windows	desktop.

To	 add	 a	 background	 image	 in	 Excel,	 select	 the	Page	Layout	 tab.	 Click	Background



located	in	the	Page	Setup	group.	This	will	open	the	Insert	Pictures	dialog	box,	as	shown	in
Figure	14.14

Figure	14.14	-	The	Insert	Pictures	Dialog	Box

As	you	can	see	 in	Figure	14.14,	you	have	got	several	options	 to	choose	 the	background
image	from.	You	can	browse	an	image	file	from	your	computer	or	can	get	a	royalty	free
image	from	Office.com	Clip	Art	or	you	can	also	search	and	browse	a	picture	from	web.
Excel	also	allows	you	to	use	any	picture	from	your	Facebook	or	any	social	media	account.
You	just	have	to	sign	in	with	your	Microsoft	account	to	do	that.

Click	 the	 option	 from	where	 you	want	 to	 export	 the	 image,	 then	 locate	 the	 image	 and
insert	it	in	your	worksheet.

	

Excel	 supports	 all	 the	 common	 graphic	 file	 formats.	 It	 is	 just	 the
animated	GIFs	that	are	displayed	as	still	images.

Once	you	insert	the	image,	Excel	stretches	it	across	the	entire	worksheet.	Depending	upon
the	type	and	size	of	image,	Excel	displays	some	images	as	tiles,	as	shown	in	Figure	14.15



Figure	14.15	-	Showing	a	Worksheet	with	Background	Image	Displayed	As	Tiles

When	you	add	a	background	image	in	Excel,	you	may	perhaps	want	to	hide	the	gridlines
to	get	a	seamless	background.

To	turn	off	the	gridlines,	uncheck	the	View	checkbox	located	under	the	heading	Gridlines
in	the	Page	Layout	tab.

Using	Borders

Borders	are	a	great	way	of	making	the	values	in	adjacent	columns	and	rows	prominent	and
more	readable.	They	are	normally	used	to	separate	a	range	of	cells	or	to	demarcate	rows
and	columns.

	

There	are	several	ways	to	add	borders	in	Excel.

The	simplest	way	of	adding	borders	and	lines	is	the	Border	drop	down	list	 located	in	the
Font	group	of	the	Home	tab.	But	before	you	click	the	Border	drop	down	list,	make	sure	to
select	the	cell(s)	around	or	inside	which	you	want	to	add	borders.



Figure	14.16	-	Showing	the	Preset	Border	Styles	in	the	Home	Tab

As	 shown	 in	 Figure	 14.16,	 there	 are	 13	 preset	 border	 styles	 all	 of	which	 are	 quite	 self
explanatory.	For	example,	if	you	click	All	Borders,	Excel	will	put	a	border	around	each
cell	in	the	selected	range.	Likewise,	you	can	click	Thick	Bottom	Border	to	put	one	thick
border	in	the	bottom	of	the	selected	cells.

If	 you	 don’t	 find	 the	 required	 border	 setting	 in	 the	 13	 given	 preset	 styles,	 click	Draw
Border.	This	will	change	the	mouse	cursor	into	a	small	pencil.	Click	the	pencil	where	you
want	to	add	border.	Or	click	and	drag	the	pencil	to	draw	an	outside	border.	Hit	Esc	once
you	are	done	using	the	border	pencil.	

Below	the	Draw	Border	option,	 there	 is	 the	Draw	Border	Grid	 option.	 It	performs	 the
same	function	as	 the	Draw	Border	 feature.	The	only	difference	 is	 that	 the	Draw	Border
pencil	when	dragged	draws	the	outside	border	only,	whereas	the	Draw	Border	Grid	pencil
when	dragged	draws	all	borders,	inside	and	outside	the	dragged	cells.

If	you	have	made	any	border	by	mistake,	hit	the	Erase	Border	button	and	then	click	over
the	border	that	you	want	to	erase.

	



The	 Erase	 Border	 feature	 is	 very	 useful	 when	 you	 want	 to	 put	 All
Borders	within	 a	 large	 range	 except	 for	 a	 few	 cells.	You	 can	 put	All
Borders	using	the	preset	style	and	then	use	the	Erase	Border	command
to	remove	the	unwanted	ones.		

	

The	Line	Color	command	contains	the	color	palette	for	borders.

The	Line	 Style	 command	 allows	 you	 to	 use	 different	 types	 of	 borders,	 other	 than	 the
simple	single	line	borders,	as	shown	in	Figure	14.16

All	these	border	settings	can	also	be	found	in	the	Border	tab	of	the	Format	Cells	dialog
box.	You	can	open	it	by	clicking	the	More	Borders	command	in	the	Borders	drop	down
list.	 Do	 not	 forget	 to	 select	 the	 cell(s)	 you	 want	 to	 add	 borders	 to	 before	 opening	 the
Format	Cells	dialog	box.

Figure	14.17	-	Showing	the	Border	Tab	of	the	Format	Cells	Dialog	Box

As	you	can	see	in	Figure	14.17,	the	Border	tab	of	the	Format	Cells	dialog	box	contains	all
the	pertinent	options.	You	can	select	 the	style,	color	and	position	of	 the	border.	You	can
also	 select	 any	 of	 the	 three	 preset	 styles	 given	 at	 the	 top	 of	 the	 dialog	 box.	 To	 put	 an
outside	border,	 click	Outline.	To	put	 inside	borders,	 click	 Inside	 and	 to	 remove	 all	 the
borders	from	the	selected	cells,	click	None.

The	Border	 tab	 of	 the	Format	Cells	 dialog	 box	 contains	 all	 the	 commands	 given	 in	 the
Border	 drop	 down	 list	 plus	 one	 more	 advanced	 feature	 and	 that	 is	 the	 option	 to	 put



diagonal	 lines.	 You	 can	 put	 forward	 diagonal	 borders	 or	 backward	 or	 both	 within	 the
selected	range.	The	diagonal	lines	are	normally	used	to	show	crossed	out	cells	or	values.

Figure	14.18	-	Showing	Examples	of	Diagonal	Borders

In	 Figure	 14.18,	 there	 are	 3	 different	 ranges.	 Starting	 from	 the	 left,	 the	 ranges	 contain
forward	diagonal	borders,	backward	diagonal	borders	and	both,	respectively.

Making	Your	Worksheet	Colorful

This	 is	 another	very	 interesting	way	of	 enhancing	 the	 appearance	 and	 readability	of	 the
worksheet.	You	can	change	the	color	of	the	font	as	well	fill	colors	in	the	entire	cell(s).

To	change	the	color	of	the	font,	select	the	cells	the	values	of	which	you	want	to	color,	then
go	to	Home	 tab	and	select	 the	Font	Color	drop	down	list.	Select	 the	desired	color	and
that’s	all	it	is	required	to	make	your	cell	content	colorful.

To	fill	colors	in	cells,	select	the	cells	in	which	you	want	to	fill	colors,	then	go	to	Home	tab
and	select	Fill	Color	drop	down	list.	Select	 the	desired	color	and	Excel	will	put	 that	 in
the	selected	cell(s).

Both	 the	 drop	 down	 lists	 are	 also	 available	 in	 the	Mini	Toolbar	 that	 appears	when	 you
right	click	the	selected	cell(s).

Excel	 2013	 offers	 you	 virtually	 unlimited	 number	 of	 colors.	 So	 if	 you	 don’t	 like	 the
available	colors	in	the	Font	Color	or	Fill	Color	palettes,	click	the	More	Colors	command
located	at	the	bottom	of	both	the	color	palettes.	This	will	open	the	Colors	dialog	box.	You
can	select	any	color	from	the	Standard	tab	or	make	one	of	your	own	in	Custom	tab.	

	

If	you	want	to	hide	the	values	of	a	cell,	make	the	Font	Color	similar	to
the	 Fill	 Color.	 This	 will	 hide	 the	 cell’s	 content;	 however	 it	 will	 still
appear	in	the	Formula	bar	when	you	select	the	corresponding	cell.	

	

Theme	Formatting



If	you	want	to	apply	same	formats	throughout	the	workbook,	theme	formatting	is	a	way	to
do	that.	A	theme	is	a	set	of	formatting	attributes	 including	fonts,	colors	and	effects.	The
best	 thing	 about	 using	 themes	 is	 that	 they	 save	 a	 whole	 lot	 of	 time	 that	 is	 spent	 on
formatting.	Just	one	click	and	your	entire	workbook	will	be	formatted	as	per	the	applied
theme.

A	theme	is	applied	to	the	entire	workbook.	You	cannot	set	different
themes	for	different	worksheets.

	

Excel	2013	contains	a	diverse	variety	of	themes.	The	best	way	to	explore	them	is	to	try	a
few.		

To	apply	a	theme,	select	Page	Layout	>	Themes.	This	will	open	the	Themes	drop	down
menu	containing	the	available	Excel	themes,	as	shown	in	Figure	14.19.

Figure	14.19	-	Showing	the	Themes	Drop	Down	Menu	in	the	Page	Layout	Tab

The	Themes	drop	down	menu	contains	a	 live	preview	of	all	 the	themes.	In	other	words,
you	won’t	have	to	apply	a	theme	to	check	its	attributes.	Just	move	the	mouse	cursor	to	any
theme	and	it	will	be	displayed	in	the	active	sheet.	So	if	you	are	unsure	about	which	theme
to	choose,	cycle	your	mouse	cursor	through	all	the	themes	and	click	the	one	that	you	like.

	

Themes	don’t	affect	the	originally	applied	font	formats.	Suppose	you
entered	 a	 value	 in	 red	 font	 color,	 then	 applied	 a	 theme	 over	 the



workbook.	Now	if	you	reapply	any	other	theme,	it	won’t	change	the
red	font	color.	You	will	have	to	do	it	manually.

	

Figure	14.20	shows	a	workbook	in	default	theme,	without	any	specific	formatting.

Figure	14.20	-	Workbook	in	Default	Theme

Figure	14.21	shows	the	same	workbook	after	applying	the	Savon	Theme.

Figure	14.	21	-	The	Same	Workbook	after	Applying	a	Different	Theme

As	you	can	see	in	both	images,	the	new	theme	changed	the	font	type,	size	and	color	of	the
chart.	The	column	width	and	row	height	are	adjusted	according	to	the	new	formats.		

	

Since	every	theme	features	a	different	font	type	and	size,	applying	a
theme	 may	 affect	 the	 original	 layout	 of	 your	 worksheet.	 For
example,	if	the	theme	you	applied	features	a	larger	font	than	the	one
previously	 applied,	 it	 may	 brim	 over	 the	 values	 contained	 in	 one
printable	 page	 to	 another.	 So	 make	 sure	 to	 check	 the	 layout	 after
applying	a	theme	and	make	changes,	if	required.



	



Creating	Your	Own	Themes

If	you	don’t	like	any	theme	in	the	available	themes,	you	can	create	one	of	your	own.

As	you	can	see	in	Figure	14.19,	the	Themes	group	in	the	Page	Layout	tab	contains	three
more	 commands;	 namely,	 Colors,	 Fonts	 and	 Effects.	 You	 can	 use	 these	 commands	 to
modify	any	or	all	of	the	corresponding	formats.

Suppose	you	 like	 the	color	and	effects	 in	 the	Savon	theme	but	are	not	satisfied	with	 the
choice	 of	 font.	You	 can	 change	 the	 font	 by	 clicking	 the	Font	 command	 in	 the	Themes
group	of	the	Page	Layout	tab.	Select	the	desired	font	and	it	will	be	applied	throughout	the
workbook.

Figure	14.	22	-	The	Font	Command	Drop	Down	List

Every	 theme	 features	 two	 fonts,	one	 for	 the	heading	and	 for	 the	body.	You	can	 select	 a
different	font	for	both.	As	you	can	see	in	Figure	14.22,	the	Font	command	carries	a	drop
down	 list	 containing	 all	 the	 font	 types.	 At	 the	 end	 of	 the	 list	 is	 the	Customize	 Fonts
command.	Click	this	to	open	the	Create	New	Theme	Fonts	dialog	box.	Here	you	will	find
tee	option	to	set	different	fonts	for	the	heading	and	for	the	body.

Just	like	the	Fonts	command,	you	can	change	the	effects	and	color	code	of	a	theme.

Every	 theme	features	a	combination	of	12	colors.	 If	you	do	not	want	 to	apply	 the	same
color	throughout	the	workbook,	click	Customize	Colors	located	at	the	end	of	the	Colors



drop	 down	 list.	 This	will	 open	 the	Create	 New	 Theme	Colors	 dialog	 box,	 as	 shown	 in
Figure	14.23

Figure	14.23	-	The	Create	New	Theme	Colors	Dialog	Box

Select	the	drop	down	list	to	open	the	color	palette	for	the	corresponding	part	of	the	theme.
You	can	also	give	a	personalized	name	to	your	new	color	code.

After	you	customize	a	theme	using	different	fonts,	colors	and	effects,	you	can	save	it	as
well.	Saving	a	theme	will	make	it	available	for	use	not	only	in	other	workbooks	but	also
other	Office	applications	such	as	Word,	PowerPoint	and	so	on.

To	save	your	customized	theme,	select	Page	Layout	>	Themes	>	Save	Current	Theme.
Enter	a	name	for	your	new	theme	and	click	Save.

Style	Formatting

Cell	styles	are	quite	similar	to	themes,	as	both	save	the	users	from	making	multiple	clicks
and	opening	several	dialog	boxes	for	formatting.	As	a	matter	of	fact,	cell	styles	are	even
more	helpful	and	valuable	than	the	themes.	The	latter	is	restricted	to	the	entire	workbook.
You	cannot	apply	different	themes	on	different	workbooks	or	ranges.	On	the	contrary,	cell
styles	can	be	applied	to	any	number	of	cells.	You	can	apply	a	different	style	to	every	cell
and	worksheet.

A	cell	style	is	made	up	of	six	different	formatting	attributes,	namely,	number	format,	font,
text	alignment,	patterns,	borders	and	cell	protection.

	



The	 formatting	 features	 of	 a	 cell	 style	 are	 based	 on	 the	 current
theme.	 If	 you	 change	 the	 theme,	 the	 cell	 style	 will	 update
accordingly.

	

To	apply	a	cell	style,	follow	the	steps	below.

1.	 Select	the	cell(s)	on	which	you	want	to	apply	the	cell	style.	If	you	want	to	apply	the
same	style	on	the	entire	worksheet,	press	Ctrl	+	A.

2.	 Choose	the	Home	Tab.

3.	 Click	Cell	Styles	located	in	the	Styles	group.

4.	 The	Cell	Styles	command	contains	a	drop	down	menu.	Click	the	desired	cell	style
and	Excel	will	apply	it	on	the	selected	cell(s).

Figure	14.24	-	The	Cell	Styles	Drop	Down	Menu



Introducing	the	Cell	Styles

As	you	can	see	 in	Figure	14.24,	Excel	offers	 several	categories	 to	 filter	 the	Cell	Styles.
The	categories	are	explained	as	follows:

Good,	 Bad	 and	 Neutral:	 You	 can	 use	 these	 to	 highlight	 good,	 bad	 and	 general	 news
respectively.	For	example,	 if	you	are	making	an	 income	statement	on	Excel	 and	 the	net
income	is	negative,	you	can	apply	the	Bad	news	style	over	it.	The	first	cell	in	this	category
is	Normal.	 Clicking	 this	 will	 reset	 the	 applied	 styles	 on	 the	 selected	 cell(s)	 to	 default
formatting.

Data	 And	 Model:	 You	 can	 use	 these	 styles	 to	 delineate	 input	 and	 output	 cells.	 This
category	also	contain	styles	 for	 linked	cells,	warnings,	note,	check	cell	and	calculations.
For	 example,	 if	 a	 cell	 contains	 a	 hyperlink,	 you	 can	 format	 it	with	 the	Hyperlink	 style.
Likewise,	 suppose	 a	 range	 contains	 three	 types	 of	 cells,	 one	 that	 accepts	 input	 values,
other	 that	 reveals	 the	 results	 of	 a	 calculation	 and	 the	 third	 one	 contains	 the	 calculation
part.	 You	 can	 format	 these	 cells	 with	 Input,	 Output	 and	 Calculation	 Cell	 Style
respectively.	

Titles	And	Headings:	As	 the	name	 suggests,	 these	 styles	 are	used	 to	delineate	different
levels	of	headings.

Themed	Cell	Styles:	The	styles	in	this	category	offer	four	graduated	percentages	of	each
Accent	color	 for	quartile	comparisons.	Here	you	need	 to	 remember	 that	 these	 styles	are
highly	dependent	upon	the	current	theme.	Changing	the	theme	will	also	disturb	the	colors
in	the	style.

Number	Format:	This	category	includes	the	basic	number	formats	that	are	also	located	in
the	Number	group	of	the	Home	Tab.	However	the	one	in	Cell	Styles	allows	you	to	make
the	 particular	 number	 format	 a	 part	 of	 the	 selected	 style	 in	 conjunction	 with	 other
formatting	attributes.			

Custom:	You	will	 not	 find	 this	 category	 in	 the	Cell	Styles	drop	down	menu	unless	you
create	any	custom	style.	Then	it	appears	at	the	top	of	the	Cell	Styles	gallery.	More	about
Custom	Style	coming	up	in	this	chapter.

Just	like	the	Themes	drop	down	menu,	the	Cell	Styles	menu	also	contains	a	live	preview
of	all	the	styles.	In	other	words,	you	don’t	need	to	apply	a	style	just	to	check	its	attributes.
Just	move	the	mouse	cursor	to	any	style	and	it	will	be	displayed	in	the	selected	cells.	So	if



you	are	unsure	about	which	style	to	choose,	cycle	your	mouse	cursor	through	all	the	styles
and	click	the	one	that	you	like.

Modifying	the	Cell	Styles

If	 you	 like	 a	 style	 partially,	 you	 can	 modify	 it	 to	 make	 it	 exactly	 the	 way	 you	 want.
Suppose	you	like	the	color	and	font	in	the	Linked	Cell	Style	but	are	not	satisfied	with	the
choice	of	the	bottom	border.	You	can	change	the	border	and	any	other	attributes	that	you
want.

Here	is	how	you	can	modify	a	cell	style.

1.	 Select	Home	>	Cell	Styles

2.	 Right	 click	 the	 style	 you	want	 to	 change	 and	 select	Modify.	 This	 will	 open	 the
Style	 dialog	 box	 with	 the	 current	 settings	 for	 the	 underlying	 style,	 as	 shown	 in
Figure	14.25

3.	 Click	the	Format	button	to	open	the	Format	Cells	dialog	box.

4.	 Select	the	relevant	tab	in	the	Format	Cells	dialog	box.	For	example,	if	you	want	to
change	the	borders	in	the	particular	style,	click	the	Border	tab.

5.	 Make	the	required	changes	then	click	OK	to	return	to	the	Style	dialog	box.

6.	 Click	OK	to	close	the	Style	dialog	box.

Figure	14.25	-	The	Style	Dialog	Box

	



If	you	make	changes	in	any	existing	style,	it	will	override	the	original
formatting	attributes.	So	if	you	want	to	modify	a	cell	style,	at	the	same
keep	 the	 original	 one,	 then	 right	 click	 the	 particular	 style	 and	 click
Duplicate	 instead	 of	Modify.	Rest	 of	 the	 procedure	 is	 the	 same.	The
modified	 style	will	 be	 saved	 in	 the	Cell	 Styles	 dialog	 box,	while	 the
original	one	will	also	be	there.

Creating	your	Own	Style

If	you	don’t	 like	any	Cell	Style	 in	 the	 least,	 then	 it	 is	 recommended	 to	create	a	Custom
Style	rather	than	modifying	the	existing	one,	as	the	latter	would	take	far	more	time	than
the	former.

To	create	a	custom	style	in	Excel,

1.	 Select	any	cell	in	a	worksheet	and	apply	the	desired	formats	over	it.	Apply	all	the
formatting	that	you	want	to	include	in	your	custom	style.

2.	 Once	 you	 are	 done	 formatting	 the	 cell,	 select	 Home	 >	 Cell	 Styles	 >	New	 Cell
Style.	This	will	 open	 the	Style	 dialog	box	 containing	your	 applied	 formats	 along
with	a	suggested	name	for	your	new	style.

3.	 If	you	want	 to	change	 the	name,	 type	a	new	one	 in	 the	Style	Name	 text	 box	 and
then	 click	OK.	Your	 custom	 style	will	 now	appear	 in	 the	Cell	Styles	 drop	down
menu.

As	you	can	see	in	Figure	14.25,	there	are	six	check	boxes	in	the	Style	dialog	box,	one	for
each	formatting	attribute.	These	checkboxes	gives	you	an	option	to	include	one	or	more	of
the	formats.	Assume	you	want	to	apply	the	Linked	Cell	 style	but	without	borders.	To	do
so,	 just	 uncheck	 the	Border	 checkbox	 and	 then	 click	OK	 to	 confirm	 to	 close	 the	Style
dialog	box	and	apply	the	particular	style.	

The	 last	 checkbox	 in	 the	 Style	 dialog	 box	 is	Protection.	 You	 can	 use	 this	 to	 allow	 or
restrict	other	users	from	making	changes	in	the	particular	style.	However,	this	command	is
valid	 only	 if	 you	 have	 turned	 on	 the	 Protect	 Sheet	 feature	 in	 the	 Review	 tab.	Refer	 to
chapter	16	to	learn	more	about	protection	options	in	Excel.

Copying	Styles	from	Other	Workbooks

By	 default,	 the	 Custom	 styles	 can	 only	 be	 used	 in	 the	 workbook	 in	 which	 they	 were
created.	However	there	is	a	way	to	copy	them	to	other	workbooks.



Here	is	how	you	can	copy	a	cell	style	one	workbook	to	another.

1.	 First,	open	the	source	workbook,	the	one	in	which	the	particular	custom	style	was
created.

2.	 Now	open	the	destination	workbook,	the	one	in	which	you	want	to	copy	the	custom
style.

3.	 In	 the	destination	workbook,	click	Home	>	Cell	Styles	>	Merge	Styles.	This	will
open	the	Merge	Styles	dialog	box	containing	the	names	of	all	the	open	workbooks.

4.	 Select	the	source	workbook	and	click	OK.	

Deleting	Styles

You	can	only	delete	the	custom	and	duplicate	styles.	Excel	does	not
allow	deleting	its	built-in	cell	styles.

	

To	delete	a	cell	style,	right	click	the	particular	style	and	select	Delete.

	

Deleting	 a	 style	 effect	 the	 formatting	 all	 the	 cells	 to	 which	 the
particular	style	was	applied	to.	All	such	cells	are	reverted	to	normal
cell	style.

	

Conditional	Formatting

Conditional	formatting	is	a	very	infamous	feature	of	Excel.	Though	it	is	a	bit	advanced,	it
is	widely	used	and	applied	in	Excel	based	models.	Conditional	formatting	allows	you	to
format	the	cells	in	such	a	way	that	some	particular	values	are	highlighted	automatically.

For	example,	you	can	apply	conditional	 formatting	 to	command	Excel	 that	 if	 the	values
within	the	selected	range	are	negative,	it	should	fill	the	corresponding	cells	with	red	color.
Then	whenever	you	will	change	a	positive	value	to	negative,	or	 if	 the	resulting	value	of
any	formula	comes	to	be	negative,	the	respective	cell	will	automatically	be	filled	with	red
color.		

The	conditional	formatting	command	can	be	found	in	the	Style	group	on	the	Home	tab.



Figure	14.26	-	Showing	the	Conditional	Formatting	Command	in	the	Home	Tab.

As	shown	in	Figure	14.26,	 the	Conditional	Formatting	button	opens	up	a	drop	down	list
that	carries	the	following	options:

Highlight	Cells	Rules:	This	command	opens	a	continuation	menu	containing	several	other
formatting	rules	that	highlight	values	that	are	greater	than	or	less	than	a	particular	value,
or	that	fall	within	a	specified	range	of	values.

Top/Bottom	Rules:	This	option	also	opens	up	an	extended	menu	containing	rules	such	as
highlight	Top	10	Items,	Bottom	10	Items,	Top	10%	and	so	on.

Data	Bars:	This	command	opens	up	a	palette	containing	Gradient	Fill	and	Solid	Fill	data
bars.	You	 can	use	 these	 to	 indicate	 the	 relative	magnitude	of	 values	within	 the	 selected
range	of	cells.	In	other	words,	the	Data	Bars	can	help	you	highlight	large	and	small	values.
The	larger	the	value,	the	longer	would	be	its	data	bar.

Color	Scales:	This	one	also	opens	up	a	palette	containing	multiple	color	scales.	You	can
use	these	to	highlight	the	relative	magnitude	of	values	within	the	selected	range	of	cells.
For	 example,	 you	 can	 apply	 the	 Color	 Scales	 formatting	 rules	 to	 analyze	 the	 data
distribution	 and	 variation	 across	 large	 data.	 These	 are	 also	 widely	 used	 to	 indicate	 the
investment	 over	 time.	 The	 selected	 cells	 are	 filled	 with	 different	 shades	 of	 one	 or	 two
colors.	The	gradation	in	colors	represents	minimum,	maximum	and	midpoint	values.

Icon	Sets:	The	 Icon	Sets	 command	opens	up	a	window	containing	numerous	 icons	 that
you	can	use	to	represent	different	values	and	ranges.	For	example,	you	can	set	an	icon	for
values	above	55%	and	another	icon	for	those	between	54%	-	60%	and	so	on.



Figure	14.27	-	The	Icon	Sets	in	Excel

New	Rule:	Clicking	this	will	launch	the	New	Formatting	Rule	dialog	box	where	you	can
define	a	customized	conditional	formatting	rule.	

Clear	Rules:	As	the	name	suggests,	this	option	opens	up	a	continuation	menu	containing
options	for	removing	the	applied	conditional	formatting	rules.	You	can	clear	rules	from	the
entire	worksheet,	table,	PivotTable	and	also	from	the	selected	cells.

Manage	 Rules:	 This	 command	 launches	 the	 Conditional	 Formatting	 Rules	 Manager
dialog	box,	where	you	can	modify	the	applied	rules,	delete	them	and	can	also	arrange	their
precedence	by	shifting	them	up	and	down	in	the	dialog	box.

Now	 that	 you	 are	 introduced	 to	 the	Conditional	Formatting	Commands,	 let’s	 learn	 how
you	can	actually	use	these	options.		

Using	Graphical	Markers	for	Conditional	Formatting

The	 easiest	 and	most	 interesting	way	of	 conditional	 formatting	 is	 through	 the	 graphical
markers;	 namely	 Data	 Bars,	 Color	 Scales	 and	 Icon	 Sets.	 These	 are	 the	 middle	 three
options	located	in	the	Conditional	Formatting	drop	down	list	on	the	Home	tab.

The	 previous	 section	 already	 contains	 a	 brief	 description	 about	 the	 three	 graphical
markers.	Let’s	talk	about	their	application	and	mechanism.

Using	Data	Bars

Data	bars	are	used	to	indicate	the	relative	magnitude	of	values	within	the	selected	range	of



cells.	The	larger	the	value,	the	longer	would	be	its	data	bar.

Following	is	an	example	on	how	you	can	use	Data	Bars	in	Excel.

Suppose	you	are	working	on	a	semiannual	sales	report	containing	sales	value	for	the	first	6
months.	You	can	use	Data	Bars	to	indicate	which	month	got	the	highest	sale,	which	had
the	lowest	sale	and	so	on.

To	apply	the	Data	Bars	conditional	formatting,	select	the	cells	you	want	to	format.	Choose
Home	>	Conditional	Formatting	>	Data	Bars.	Then	click	any	of	the	desired	Data	Bars
option.

Figure	14.28	-	Illustrating	Example	of	Data	Bars	in	Excel

Figure	14.28	shows	an	example	of	Data	Bars.

As	you	can	see,	the	data	bars	clearly	signify	which	month	has	the	highest	sales,	which	one
has	the	lowest	and	so	on.	You	can	gather	this	information	even	without	the	exact	numeric
values.

So	 if	 you	want	 to	 hide	 the	 exact	 values	 and	 show	Data	Bars	 only,	 select	 the	 cells	 that
contain	 the	 data	 bars,	 then	 select	Home	 >	Conditional	 Formatting	 >	Manage	 Rules.
This	 will	 open	 the	 Conditional	 Formatting	 Rules	 Manager	 dialog	 box.	 Select	 the
particular	Data	Bars	 in	 the	 list	 of	 rules,	 then	Click	Edit	Rules.	 This	will	 open	 the	Edit
Formatting	Rule	 dialog	 box.	Click	 the	 checkbox	 labeled	Show	Bar	Only,	 as	 shown	 in
Figure	14.29

Click	OK	to	save	the	settings	and	close	the	dialog	box.

	



Figure	14.29	-	Showing	the	Show	Bar	Only	option	in	the	Edit	Formatting	Rule	dialog	box

Using	Color	Scales

Color	 scales	 classify	 the	 values	 using	 color	 gradations.	 This	 feature	 of	 Conditional
Formatting	is	very	helpful	for	understanding	the	distribution	and	variation	of	values	across
a	large	range	of	data.

Continuing	 the	 example	 illustrated	 in	 Figure	 14.28,	 here	 is	 how	 you	 can	 apply	 Color
Scales	conditional	formatting.

1.	 Select	the	cells	you	want	to	format.

2.	 Choose	Home	>	Conditional	Formatting	>	Color	Scales.	Then	click	any	of	 the
desired	Color	Scales	option.

Figure	14.30	-	Illustrating	Example	of	Color	Scales	in	Excel

In	Figure	14.30,	we	have	selected	 the	 last	option	 in	 the	 second	 row	of	 the	Color	Scales
palette.	As	you	can	see	in	the	above	image,	the	highest	value	is	highlighted	with	green	and



the	lowest	value	with	red	color,	and	then	there	are	color	gradations	of	yellow	to	indicate
other	values.

If	 you	 want	 to	 change	 the	 current	 color,	 select	 the	 cells	 that	 contain	 the	 Color	 Scale
formatting,	 then	 select	Home	 >	Conditional	 Formatting	 >	Manage	 Rules.	 This	 will
open	 the	Conditional	Formatting	Rules	Manager	 dialog	 box.	 Select	 the	 particular	Data
Bars	 in	 the	 list	of	 rules,	 then	Click	Edit	Rules	 to	open	 the	Edit	Formatting	Rule	dialog
box.

Figure	14.31	-	Showing	the	Color	Change	Settings	in	the	Edit	Formatting	Rule	Dialog	Box

Click	Color	 to	open	 the	color	palette	 for	 the	Minimum,	Maximum	and	Midpoint	 values.
Excel	will	 automatically	 adjust	 the	gradation	 for	midpoint	value	colors	 and	will	display
the	 complete	 color	 theme	 in	 the	Preview	 pane	 located	 at	 the	 bottom	 of	 the	 dialog	 box.
Once	 you	 are	 satisfied	with	 the	 new	 color	 code,	 click	OK	 to	 confirm	 the	 changes	 and
close	the	dialog	box.	

Using	Icon	Sets

The	third	and	most	interesting	form	of	graphical	markers	is	Icon	Sets.	You	can	apply	this
formatting	to	highlight	different	values	and	ranges.

Continuing	 the	 example	 illustrated	 in	 Figure	 14.28;	 to	 apply	 Icon	 Sets	 conditional
formatting,	 first	 select	 the	 cells	 you	 want	 to	 format.	 Choose	 Home	 >	 Conditional
Formatting	>	Icon	Sets.	Then	click	over	the	desired	set	of	icons.



Figure	14.32	-	Illustrating	Example	of	Icon	Sets	in	Excel

In	 Figure	 14.32,	we	 have	 selected	 the	 first	 set	 of	 icons	 in	 the	Directional	 category.	By
default,	Excel	uses	the	following	formula	to	calculate	the	threshold	values.	

67th	percent	=	min	+	0.67	*	(max-min)	=	2	+	0.67	*	(95-2)	=	64.31.

33th	percent	=	min	+	0.33	*	(max-min)	=	2	+	0.33	*	(95-2)	=	32.69.	

Interrupting	the	above	formula,

	 	 	 	 	 	 	Excel	will	put	a	green	 icon	arrow	for	values	 that	are	equal	 to	or	greater	 than
64.31.

							Likewise,	the	yellow	arrow	is	for	values	that	are	less	than	64.31	and	equal	to	or
greater	than	32.69.

							A	red	arrow	represents	values	that	are	less	than	32.69.

To	 change	 the	 ranges,	 select	 the	 cells	 that	 contain	 the	 Icon	 Sets	 formatting,	 then	 select
Home	 >	 Conditional	 Formatting	 >	Manage	 Rules.	 This	 will	 open	 the	 Conditional
Formatting	Rules	Manager	dialog	box.	Select	the	particular	Icon	Sets	in	the	list	of	rules,
then	Click	Edit	Rules.	This	will	open	the	Edit	Formatting	Rule	dialog	box.



Figure	14.33	-	Showing	the	Icon	Sets	Value	Change	Settings	in	the	Edit	Formatting	Rule	Dialog	Box

Change	the	values,	icons	and	other	settings	by	clicking	the	pertinent	drop	down	lists.	Click
OK	to	confirm	the	changes	and	close	the	Edit	Formatting	Rule	dialog	box.

Revealing	the	Duplicate	Values

At	times	you	may	want	to	identify	duplicate	values	within	a	worksheet	or	a	range	of	cells.
Well,	you	can	do	so	by	applying	the	Conditional	formatting	rules.

Here	is	how	you	can	highlight	the	duplicate	values	within	a	selected	range:

1.	 Select	the	range	of	cells	in	which	you	want	to	highlight	the	repeated	values.

2.	 Select	Home	 >	Conditional	 Formatting	 >	Highlight	 Cell	 Rules	 >	 Duplicate
Values.	This	will	open	the	Duplicate	Values	dialog	box,	as	shown	in	Figure	14.34

3.	 As	you	can	see	in	Figure	14.34,	the	Duplicate	Values	dialog	box	contains	two	drop
down	 lists.	 Click	 the	 first	 one	 to	 select	 whether	 you	 want	 Excel	 to	 highlight
Duplicate	values	or	Unique	values.

4.	 Next,	click	over	the	second	drop	down	list	to	select	the	type	of	formatting	you	want
Excel	to	apply	over	the	identified	(Duplicate	or	Unique)	values.

5.	 Click	OK	to	confirm	the	settings	and	close	the	Duplicate	Values	dialog	box



Figure	14.34	-	The	Duplicate	Values	Dialog	Box

Conditional	Formatting	via	the	Quick	Analysis	Tool

You	 can	 apply	 conditional	 formatting	 via	 the	 Quick	 Analysis	 Tool	 as	 well.	 This	 is
something	that	wasn’t	there	in	the	previous	versions	of	Excel.	The	Quick	Analysis	tool	in
Excel	2013	contains	several	types	of	conditional	formatting	commands.

To	reveal	the	Quick	Analysis	tool,	select	the	range	of	cells	on	which	you	want	to	apply	the
formatting.	 As	 soon	 as	 you	 select	 the	 cells,	 the	 Quick	 Analysis	 button	 appears	 at	 the
bottom	right	of	the	selection.	Click	the	button	to	reveal	the	Quick	Analysis	Tool.

Figure	14.35	-	Showing	the	Conditional	Formatting	Commandsin	the 	Quick	Analysis	Tool

As	shown	in	Figure	14.35,	the	formatting	tab	in	the	Quick	Analysis	tool	contains	several
conditional	 formatting	 commands	 including	 Data	 Bars,	 Color	 Scale,	 Icon	 Set,	 Greater
Than,	Top	10%,	and	Clear	Format.

The	best	 thing	about	 the	Quick	Analysis	 tool	 is	 that	 it	 offers	 a	 live	preview	of	how	 the
selected	 cells	 would	 appear	 in	 different	 conditional	 formats.	 In	 other	 words,	 you	 don’t
need	 to	 apply	 a	 format	 just	 to	 check	 its	 attributes.	 Just	move	 the	mouse	 cursor	 to	 any
conditional	 formatting	command	and	 it	will	be	displayed	 in	 the	selected	cells.	So	 if	you
are	unsure	about	which	formatting	option	to	choose,	cycle	your	mouse	cursor	through	all
the	options	and	click	the	one	that	you	like.

Create	Your	Own	Formulas	for	Conditional	Formatting

Excel	 2013	 contains	 innumerous	 conditional	 formatting	 rules,	 each	of	which	 is	 editable
and	can	be	modified	as	per	the	requirement.	Yet	at	times,	you	may	not	find	exactly	what



you	need.	In	such	cases,	you	can	create	your	own	conditional	formatting	rules.

To	 define	 your	 own	 formatting	 rules,	 select	Home	 >	Conditional	 Formatting	 >	New
Rule.	This	will	open	the	New	Formatting	Rule	dialog	box,	shown	in	Figure	14.36

Figure	14.36	-	The	New	Formatting	Rule	dialog	box

First,	select	the	type	of	rule	you	want	to	create	in	the	‘Select	a	Rule	Type’	list	box.	Then
specify	 the	 corresponding	 settings	 in	 the	 in	 the	 ‘Edit	 the	 Rule	 Description’	 box.
Remember	that	every	rule	has	a	different	set	of	settings.	Once	you	are	done	creating	the
rule,	click	OK	to	confirm	the	settings	and	close	the	dialog	box.

	

	

Following	are	a	few	examples	of	creating	customized	conditional	formatting	rules.

1.	 To	identify	all	the	weekend	dates	in	a	range	of	cells	containing	date	values:

Select	Home	>	Conditional	Formatting	>	New	Rule.	Select	the	last	option	in	the	‘Select
a	Rule	Type	list’	box	(Use	a	Formula	to	determine	which	cells	to	format).	Then	enter	the
following	formula	in	the	‘Format	values	where	this	formula	is	true’	type	text	box:

=OR(WEEKDAY(A1)=7,WEEKDAY(A1)=1)

Select	the	desired	format	by	clicking	the	Format	button.	Click	OK	once	done.



Figure	14.37	-	Defining	Conditional	Formatting	Rule	to	Highlight	the	Weekend	Dates

This	formula	assumes	that	a	range	of	cells	containing	date	values	is
selected	 and	 the	 active	 cell	 is	A1.	Make	 sure	 to	 replace	A1	 in	 this
formula	with	the	address	of	your	active	cell.

2.	 To	highlight	alternate	columns	in	a	particular	range,

Select	 the	 range	 in	 which	 you	 want	 apply	 the	 particular	 conditional	 formatting	 rules.
Select	Home	>	Conditional	Formatting	>	New	Rule.	Select	the	last	option	in	the	‘Select
a	Rule	Type’	list	box	(Use	a	Formula	to	determine	which	cells	to	format).	Then	enter	the
following	formula	in	the	‘Format	values	where	this	formula	is	true’	type	text	box:

=MOD(COLUMN(),2)=0

Select	the	desired	format	by	clicking	the	Format	button.	Click	OK	once	done.

	

This	 procedure	 and	 formula	 can	 also	 be	 used	 to	 highlight	 alternate
rows,	just	replace	the	word	COLUMN	with	ROW	in	the	formula.		

	

3.	 To	highlight	alternative	cells,	like	checkerboard	shading:

Select	 the	 range	 in	 which	 you	 want	 apply	 the	 particular	 conditional	 formatting	 rules.
Select	Home	>	Conditional	Formatting	>	New	Rule.	Select	the	last	option	in	the	‘Select
a	Rule	Type’	list	box	(Use	a	Formula	to	determine	which	cells	to	format).	Then	enter	the
following	formula	in	the	‘Format	values	where	this	formula	is	true’	type	text	box:

=MOD(ROW(),2)=MOD(COLUMN(),2)



Select	the	desired	format	by	clicking	the	Format	button.	Click	OK	once	done.

Figure	14.38	shows	an	example	of	checkerboard	shading	on	a	selected	range	of	cells.

Figure	14.38	-	Showing	an	Example	of	Checkerboard	Shading	in	Excel

Managing	Conditional	Formatting

The	Manage	Rules	command	in	the	Conditional	Formatting	drop	down	list	on	the	Home
tab	opens	the	Conditional	Formatting	Rules	Manager	dialog	box.	It	allows	you	to	do	the
following:

New	Rule:	You	can	define	new	conditional	format	rules	by	clicking	the	New	Rule	button
at	the	top	left	of	the	dialog	box.

Edit	Rule:	You	can	edit	an	existing	rule	by	selecting	the	particular	rule	in	the	Rule	list	box
and	then	clicking	the	Edit	Rule	button.

Delete	Rule:	You	can	delete	the	existing	rules	by	selecting	the	particular	rule	in	the	Rule
list	box	and	then	clicking	the	Delete	Rule	button.

Align	Rules:	If	any	range	of	cells	is	formatted	with	multiple	conditional	formatting	rules,
you	 can	 define	 the	 order	 of	 precedence	 in	 which	 you	 want	 the	 particular	 rules	 to	 be
applied.	To	 do	 so,	 click	 over	 the	 rules,	 one	 at	 a	 time,	 and	move	 them	up	 and	 down	by
clicking	the	arrows	located	to	the	right	of	the	‘Delete	Rule’	button.

When	more	than	one	rule	is	true	and	there	is	not	conflict	among	them,	Excel	applies	both
over	the	selected	range.	In	this	case,	the	precedence	of	rules	in	the	Rule	list	box	does	not
matter.	However	when	more	than	one	rule	is	true	and	a	conflict	exists	among	them,	then
Excel	gives	more	preference	to	the	rule	listed	above.	The	rule	 that	appears	higher	in	the



Rule	list	box	is	applied	first	then	the	one	after	it	and	so	on.

Filter	Display:	By	default,	Excel	displays	all	 the	rules	 in	 the	Rule	 list	box	show.	If	you
want	to	see	and	change	the	alignment	of	a	rule	applied	in	a	particular	sheet,	select	its	name
from	the	“Show	formatting	rules	for”	drop	down	list	located	at	the	top	left	of	the	dialog
box.

Stop	Rule:	By	default,	Excel	applies	the	rules	that	are	true.	If	you	want	to	stop	a	particular
rule	 from	 being	 applied	 even	 when	 it	 is	 true,	 put	 a	 tick	 mark	 in	 the	 ‘Stop	 If	 True’
checkbox	located	in	front	of	every	rule	in	the	Rule	list	box.

	





N
Chapter	15:	Printing	in	Excel	2013

o	 matter	 how	 the	 world	 strives	 to	 create	 a	 paperless	 environment,	 the	 fact
remains	that	a	lot	of	reports	and	data	lists	needs	to	be	printed	in	hard	copy.	You
may	need	to	get	a	hard	copy	of	worksheets	and	tables	that	you	make	on	Excel.

Being	said	that,	it	is	a	common	misconception	that	printing	in	Excel	is	quite	complicated.
After	 going	 through	 this	 chapter,	 you	 will	 be	 freed	 of	 all	 such	 fallacies.	 Printing
worksheets	is	a	matter	of	just	a	few	clicks.	You	can	print	the	entire	worksheets,	or	just	the
active	region	or	even	a	few	selected	cells.	This	chapter	covers	all	the	basic	and	advanced
printing	features	of	Excel	2013.

Basic	Printing	Rules	in	Excel

We	will	 start	 off	 with	 the	 basics	 of	 printing	 in	 Excel	 and	 then	move	 on	 the	 advanced
printing	features.	This	section	is	a	must	for	those	who	are	printing	their	Excel	files	for	the
first	time.

There	are	several	ways	of	printing	a	worksheet,	as	listed	below:

1.	 Select	File	>	Print.	Then	click	the	Print	button

2.	 Press	Ctrl	+	P	on	your	keyboard	then	hit	Enter.	

3.	 Click	the	Quick	Print	icon	in	the	Customize	Quick	Access	Toolbar.	If	it	is	not	there,
click	 the	 downward	 arrow	 located	 on	 the	 right	 of	 the	Quick	Access	 toolbar	 and
select	Quick	Print.

Either	ways,	Excel	uses	the	default	print	settings	unless	you	change	them.

You	should	go	for	the	first	method	of	printing	if	you	want	to	change	the	print	settings.	If
you	don’t	change	it,	Excel	uses	the	following	default	settings	(also	shown	in	Figure	15.1):

							Prints	one	copy	of	the	active	region	in	the	worksheet.	It	does	not	print	the	empty
cells	that	lie	outside	of	the	active	area,	even	if	they	were	filled	before.

							Prints	in	collated	and	portrait	form

	 	 	 	 	 	 	Does	not	print	the	scaled	output.	In	other	words,	the	worksheets	are	printed	at
their	actual	size.

							Does	not	print	any	headers,	footers	or	comments,	if	any.

							Does	not	print	the	gridlines.



	 	 	 	 	 	 	If	the	worksheet	contains	large	amount	of	data,	Excel	splits	the	data	in	pages,
column	wise.	

Previewing	Before	Printing

If	you	are	unsure	about	what	area	Excel	will	consider	as	active	while	printing,	or	if	your
worksheet	contains	large	amount	of	data	and	you	want	to	see	how	it	is	going	to	be	divided
in	the	print	form,	you	can	check	the	Print	Preview	before	actual	printing.

	

There	are	several	ways	of	seeing	the	Print	Preview	of	a	worksheet,	as	listed	below:

1.	 Hit	Ctrl	+	P	or	Ctrl	+	Shift	+	F12	on	your	keyboard.

2.	 Select	File	>	Print.

3.	 Click	the	“Print	Preview	and	Print”	icon	in	the	Customize	Quick	Access	Toolbar.	If
it	is	not	there,	click	the	downward	arrow	located	on	the	right	of	the	Quick	Access
toolbar	and	select	Print	Preview	and	Print.

Either	ways,	you	will	land	on	the	Print	window	in	the	Backstage	view.	As	you	can	see	in
Figure	15.1,	the	left	side	of	the	Print	window	contains	the	print	settings	and	on	the	right
side	 is	 the	 print	 preview.	 If	 your	 active	 worksheet	 consists	 of	 multiple	 pages,	 spin	 the
wheel	on	your	mouse	or	click	the	page	arrows	located	at	the	middle	bottom	of	the	Print
window	to	see	the	print	preview	of	all	the	pages.

Figure	15.1	-	Showing	Print	Settings	and	Print	Preview	in	the	Print	Window	of	the	Backstage	View

Once	you	are	satisfied	with	the	Print	Preview,	click	the	Print	button.	



As	you	can	see	in	Figure	15.1,	there	are	two	tiny	icons	located	in	the	bottom	right	corner
of	the	Print	Window.

Starting	from	the	left,	the	first	button	is	to	zoom	in	and	zoom	out	the	print	preview.	The
second	icon	is	a	toggle	to	display	the	margins	in	print	preview.	You	can	click	and	drag	the
markers	to	increase	or	decrease	any	column’s	width.

	

Whatever	 changes	 you	 make	 in	 the	 column’s	 width	 in	 the	 print
preview	 screen,	 the	 same	 will	 also	 be	 updated	 in	 the	 actual
worksheet.

	

Types	of	Worksheet	Views

You	can	view	a	worksheet	 in	 three	different	modes;	namely,	Normal	view,	Page	Layout
view	 and	 Page	 Break	 Preview.	 By	 default,	 a	 worksheet	 is	 displayed	 in	 Normal	 view.
However	 you	 can	 switch	between	 the	different	 views	by	 clicking	 any	of	 the	 three	page
view	icons	located	at	the	right	side	of	the	status	bar	in	Excel.

The	View	tab	on	the	Ribbon	also	contains	these	commands.	You	will	find	this	in	the	left
side	on	 the	View	tab.	Apart	 from	the	 three	mentioned	commands,	you	can	also	magnify
and	shrink	the	display	using	the	Zoom	slider	and	Zoom	commands	in	the	View	tab.

However	this	chapter	is	not	about	views,	it	is	about	the	role	of	page	views	in	printing.	The
upcoming	sections	explain	how	the	different	page	views	can	help	you	in	printing.

The	Normal	View	Mode

When	 you	 open	 a	worksheet,	 it	 is	 displayed	 in	 the	Normal	mode.	 The	most	 prominent
feature	 about	 Normal	 view	 is	 that	 it	 display	 page	 breaks	 on	 the	 worksheet.	 The	 page
breaks	are	shown	by	dotted	lines.

	

You	 may	 not	 find	 the	 page	 breaks	 the	 first	 time	 you	 open	 a
worksheet.	 To	 see	 the	 dotted	 lines,	 select	 the	 Page	 Layout	 tab	 >
Print	Area	>	Set	Print	Area.

	

It	is	these	page	breaks	that	assist	in	the	printing	process.	Whenever	you	add	any	rows	or



columns,	 or	 increase	 the	 size	 of	 them	 or	 change	 the	 page	 orientation,	 the	 page	 breaks
adjust	automatically.

So	if	you	see	that	the	printed	output	is	moving	to	another	page	just	because	of	one	row	or
column,	 you	 can	 make	 the	 required	 changes	 to	 fit	 the	 data	 within	 one	 page	 break.
Likewise,	 if	 it	 is	 not	 possible	 to	 shrink	 the	 data	 in	 one	 page,	 you	 can	make	 changes	 to
divide	the	printed	output	appropriately	between	two	page	breaks.	Just	keep	an	eye	on	the
page	break	dotted	lines	while	you	make	such	changes.	

Some	people	find	the	dotted	lines	annoying.	So	if	you	want	to	hide	the
page	 break’s	 dotted	 lines,	 select	File	 >	Options	 >	Advanced.	 Scroll
down	 to	 the	Display	 Options	 for	 This	 Worksheet	 section.	 There	 you
will	 find	 the	 Show	 Page	 Breaks	 checkbox.	 Remove	 the	 checkmark
from	it.

	

Working	in	the	Page	Layout	View

The	best	view	for	printing	purpose	is	the	Page	Layout	view.	You	can	consider	this	as	the
editable	version	of	the	print	preview	that	you	see	in	the	Backstage	view.	The	latter	is	the
just	the	view-only	mode	of	the	worksheet.	However	the	Page	Layout	view	allows	you	to
make	changes	in	the	worksheet.	It	shows	the	headers	and	footers	as	well,	if	any.

In	short,	the	Page	Layout	view	gives	you	the	editable	and	precise	preview	of	the	printed
output.

Switching	to	the	Page	Break	Preview

The	third	type	is	the	Page	Break	Preview.	As	the	name	suggests,	this	one	displays	the	page
breaks	in	the	worksheet.	However	unlike	the	normal	mode,	the	page	breaks	shown	in	the
Page	 Break	 Preview	 are	 not	 only	 dotted	 lines.	 They	 are	 indicated	 by	 thick	 and	 dark
colored	dotted	lines.

When	you	will	click	the	Page	Break	Preview	command,	Excel	will	zoom	out	the	display
to	 give	 you	 a	 bird’s-eye	 view	 of	 your	 worksheet.	 	 You	 can	 zoom	 out	 to	 magnify	 the
display.	Figure	15.2	shows	a	worksheet	in	Page	Break	Preview	mode.

Moreover,	 the	Page	 Break	 Preview	 also	 displays	 the	 page	 numbers.	As	 you	 can	 see	 in
Figure	15.2,	the	page	numbers	are	watermarked.	However	they	do	not	appear	in	the	hard
copy.



Figure	15.2	-	Showing	a	Worksheet	in	Page	Break	Preview	Mode

The	most	useful	feature	of	the	Page	Break	Preview	is	that	it	allows	you	to	drag	the	page
breaks.	This	 option	 is	 not	 available	 in	 the	Normal	mode.	When	 you	 click	 and	 drag	 the
page	 breaks,	 Excel	 adjust	 the	 margins	 and	 scaling	 automatically	 so	 that	 it	 can	 fit
information	on	the	pages,	as	per	your	requirements.

Exploring	the	Page	Setup	Settings

The	default	print	settings	works	fine	most	of	the	times.	However,	in	some	cases	you	may
need	 to	 change	 them.	 There	 are	 three	 places	 in	 Excel	 where	 you	 can	modify	 the	 print
settings.

1.	 Select	File	>	Print.	You	will	 find	 the	Print	 settings	on	 the	 right	 side	of	 the	Print
window,	as	shown	in	Figure	15.1

2.	 The	Page	Layout	tab	on	the	ribbon	also	contains	several	print	settings’	commands.

3.	 Click	the	small	downward	diagonal	arrow	located	at	the	bottom	right	corner	of	the
Page	Setup	group	in	the	Page	Layout	tab.	This	will	open	the	Page	Setup	dialog	box
that	contains	the	print	settings.

	

Not	 all	 these	 places	 contain	 all	 the	 print	 settings.	 For	 example,	 the
command	to	specify	where	to	print	cell	comments	is	not	available	in
the	Backstage	view	print	window.	You	will	find	it	 in	 the	Page	Setup
dialog	box.	The	basic	print	settings	are	there	in	almost	all	the	places.
However	if	you	don’t	find	your	required	settings	in	one	place,	try	the
other	two.



	

Following	is	a	brief	description	of	some	important	and	commonly	used	print	settings.

Copies:	By	default,	Excel	prints	only	one	copy	of	 the	printed	output.	To	make	multiple
copies,	use	the	Copies	control	located	at	the	top	of	the	Print	window	in	Backstage	View.
Enter	the	desired	number	of	copies	and	then	hit	Print.

Printer:	To	select	any	other	device	for	printing,	select	File	>	Print.	Click	the	Printer	drop
down	list	and	select	the	printer	you	want	to	use.				

What	To	Print:	The	first	option	under	the	Settings	section	in	the	Backstage’s	Print	window
is	‘what	to	print’.	By	default,	it	is	set	to	Print	Active	Sheets.	Click	the	corresponding	drop
down	list	to	select	any	other	option.

For	example,	you	can	print	the	entire	workbook	or	just	the	current	selection	or	the	selected
table	 and	 so	 on.	This	 command	 is	 also	 available	 in	 the	Page	Layout	 tab	 on	 the	 ribbon.
Select	the	cell(s)	you	want	to	print,	click	Print	Area	>	Set	Print	Area.	Each	range	prints
on	a	separate	page.

	

If	 you	 have	 forgotten	 to	 add	 any	 range	 in	 the	 print	 area,	 select	 the
range,	 then	 choose	 the	Page	Layout	 tab	 on	 the	Ribbon.	 Click	Print
Area	>	Add	to	Print	Area.

	

Collated:	 If	 you	 are	 printing	 more	 than	 one	 copy,	 make	 sure	 the	 Collated	 option	 is
selected	in	 the	corresponding	drop	down	list.	Doing	so	will	command	Excel	 to	print	 the
pages	in	order	for	each	set	of	output.

Page	Orientation:	By	default,	the	page	orientation	is	set	to	Portrait.	You	can	change	it	by
choosing	the	Page	Layout	 tab	on	the	ribbon.	Then	click	the	Orientation	drop	down	list
and	select	the	desired	option.

Page	Size:	To	change	the	page	size,	choose	the	Page	Layout	tab	on	the	ribbon.	Click	Size
and	then	select	the	paper	size	you	are	using.	This	option	is	also	available	in	the	Print	tab
of	the	Backstage	view	as	well	as	in	the	Page	Setup	dialog	box.		

Page	Margins:	Margins	refer	to	the	top	and	bottom	of	the	printed	page	and	the	unprinted
areas	along	the	sides	of	the	worksheet.	You	can	select	the	desired	margins	from	the	quick
margin	settings	or	you	can	also	specify	the	exact	margin	size	you	want.



Whatever	 margin	 size	 you	 specify,	 it	 will	 remain	 same	 for	 all	 the
printed	pages.	You	cannot	set	different	margins	for	different	pages.

	

If	you	want	different	margins	 in	different	pages,	 then	print	each	page
separately,	while	changing	the	page	margin	after	each	print.

	

There	are	several	ways	to	modify	the	page	margins,	as	listed	below.

The	first	way	of	changing	the	page	margins	is	to	view	the	particular	worksheet	in	the	Page
Layout	mode.	There	you	will	see	a	horizontal	ruler	located	above	the	first	column	and	a
vertical	ruler	located	to	the	left	of	the	first	row.	Click	and	drag	the	horizontal	one	to	adjust
the	left	and	right	margins,	and	the	vertical	one	to	set	the	top	and	bottom	margins.

The	Page	Layout	tab	on	the	ribbon	contains	the	quick	margins	option.	Click	the	Margins
drop	 down	 list	 and	 select	 the	 desired	 margin.	 If	 you	 don’t	 find	 the	 desired	 option	 in
available	ones,	click	Custom	Margins	located	at	the	end	of	the	Margins	drop	down	list.
This	will	open	the	Margins	 tab	 in	 the	Page	Setup	dialog	box.	Here	you	can	specify	 the
exact	margins	you	want.

The	quick	margins’	options	along	with	the	Custom	Margin’s	command	are	also	located	in
the	Print	tab	of	the	Backstage	view.

Another	way	to	adjust	the	margins	is	to	open	the	Print	tab	in	the	Backstage	view	and	click
the	Show	Margins	button	located	in	the	bottom	right	corner	of	the	window.	Doing	so	will
reveal	margins	in	the	print	preview.	Drag	the	margins	to	the	desired	size.	

Scale	to	Fit:	Scaling	allows	you	to	control	 the	printed	output	and	fit	 it	 into	 the	required
number	of	pages.	There	are	several	ways	of	scaling	the	worksheets.

Choose	the	Page	Layout	tab.	There	you	will	find	a	Scale	control	command	in	the	Scale	to
Fit	group.	Use	it	to	enter	the	desired	scaling	factor.	By	default,	the	scaling	is	set	to	100%.
The	minimum	that	you	can	scale	down	to	is	10%.	The	maximum	that	you	can	scale	up	to
is	400%.

For	quick	scaling	options,	select	File	>	Print.	Click	 the	No	Scaling	 drop	down	 list	 and
select	the	desired	option.



Figure	15.3	-	The	Scaling	Commands	Available	in	the	Print	Tab	of	the	Backstage	View

Figure	 15.3	 shows	 the	 quick	 scaling	 options	 available	 in	 the	Print	 tab	 of	 the	Backstage
view.	You	can	force	 the	entire	printed	output	 to	 fit	 into	one	page,	or	you	can	shrink	 the
columns	 in	 the	 printed	 output	 so	 that	 they	 all	 fit	 on	 one	 page	 and	 so	 on.	 The	Custom
Scaling	Options	 command	opens	 the	Page	 tab	 in	 the	Page	Setup	 dialog	box.	Here	you
can	specify	the	exact	scaling	factor	you	want.

	

If	 you	 are	 scaling	 the	 printed	 output,	make	 sure	 to	 check	 the	 print
preview	before	printing	 it.	Excel	does	not	 care	how	small	 the	 fonts
have	 become	 due	 to	 scaling.	 It	 will	 oblige	 your	 scaling	 command
even	 if	 it	 means	 making	 the	 font	 so	 small	 that	 that	 they	 are
unreadable.

	

Handling	Page	Breaks

Page	breaks	are	very	 important	when	it	comes	 to	printing	 the	worksheets,	especially	 the
ones	containing	 large	amount	of	data.	You	would	surely	not	want	 to	a	 single	column	 to
print	on	a	separate	page	by	itself	nor	would	you	want	the	printed	output	to	take	up	another
page	just	because	of	one	row	or	column.

The	best	way	to	control	what	prints	where,	 is	by	managing	the	page	breaks.	Excel	2013
gives	you	complete	authority	to	specify	exact	locations	for	entering	page	breaks.

Though	Excel	manages	the	page	breaks	automatically,	you	can	manually	enter	page	breaks
if	the	ones	entered	by	Excel	do	not	seem	appropriate	to	you.	

To	enter	a	horizontal	page	break,	select	the	cell	in	Column	A	from	where	you	want	start



the	new	page.	Then	choose	the	Page	Layout	tab.	Click	Breaks	>	Insert	Page	Break.

	

In	order	to	insert	just	a	horizontal	page	break,	it	is	important	that	you
select	 the	 cell	 in	 Column	A	 or	 else	 Excel	 will	 put	 the	 page	 break
horizontally	as	well	as	vertically.	So	for	example	if	you	want	to	start
a	new	page	from	Row	13,	select	Cell	A13	and	 then	 insert	 the	page
break.

	

To	enter	a	vertical	page	break,	select	the	cell	in	Row	1	from	where	you	want	to	start	the
new	page.	Then	choose	the	Page	Layout	tab.	Click	Breaks	>	Insert	Page	Break.	Make
sure	you	select	a	cell	in	Row	1	in	order	to	insert	just	a	horizontal	page	break.	

If	you	want	to	remove	any	of	the	manually	inserted	horizontal	page	breaks,	select	the	cell
beneath	the	first	row	of	the	particular	page	break.	Then	choose	the	Page	Layout	tab.	Click
Breaks	>	Remove	Page	Break.

Likewise,	 to	 remove	 any	 of	 the	 manually	 inserted	 vertical	 page	 breaks,	 select	 the	 cell
located	 in	 first	 column	 to	 the	 right	 of	 the	 particular	 page	 break.	Then	 choose	 the	Page
Layout	tab.	Click	Breaks	>	Remove	Page	Break.

To	 remove	 all	 the	 manually	 inserted	 page	 breaks,	 choose	 the	 Page	Layout	 tab.	 Click
Breaks	>	Reset	All	Page	Breaks.

Printing	Tips

Following	are	a	few	more	tips	for	advanced	and	selective	printing.	

Printing	Gridlines		

By	default,	Excel	does	not	print	the	gridlines.	However	if	you	want	to	include	the	gridlines
in	the	printed	output,	select	the	Page	Layout	tab.	Put	a	tick	mark	in	the	Print	checkbox
located	under	the	heading	Gridlines.

Printing	Headings		

Just	like	gridlines,	Excel	does	not	print	the	row	and	column	headers	by	default.	However
if	you	want	to	print	the	headers,	select	the	Page	Layout	tab.	Put	a	tick	mark	in	the	Print
checkbox	located	under	the	option	Headings.

Printing	Row	and	Column	Headings			



If	your	worksheet	is	made	in	such	a	way	that	the	first	row	or	first	column	contains	titles	or
any	other	headings	and	the	rest	of	the	cells	contain	data	pertinent	to	those	headings,	it	may
be	difficult	to	read	data	on	pages	that	don’t	have	these	titles.	Excel	offers	a	way	to	resolve
this	issue,	and	that	is	by	printing	the	particular	column	or	row	in	every	page.

It	does	not	necessarily	have	to	be	the	first	row	or	column,	it	could	be	any.	This	is	known	as
selective	printing.	You	can	command	Excel	to	print	a	particular	row	or	column	on	every
page.

To	 print	 selective	 rows	 and	 columns	 on	 each	 page,	 select	Page	Layout	 >	Print	 Titles.
This	will	open	the	Sheet	tab	of	the	Page	Setup	dialog	box,	as	shown	in	Figure	15.4

Figure	15.4	-	Showing	the	Command	to	Print	Selective	Rows	and	Columns	on	Each	Page

Select	the	rows	or	columns	that	you	want	to	appear	in	every	printed	page,	or	you	can	also
type	 in	 the	 references	manually.	For	 example,	 if	you	want	Column	A	and	Column	B	 to
print	on	every	page,	type	A:B	in	the	‘Columns	to	repeat	at	left’	type	text	box.	

	

The	 repeated	 rows	 and	 columns	 will	 only	 appear	 in	 the	 printed
output.	These	will	now	show	in	the	worksheet	unless	you	switch	to
the	 Page	 Layout	 view,	 and	 even	 there	 you	 will	 have	 to	 select	 the
underlying	 cell	 to	 make	 any	 changes	 in	 the	 particular	 row	 or
column’s	content.	
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Chapter	16:	Take	Care	of	Your	Worksheets

hen	 it	 comes	 to	 protection	 and	 security	 of	 data,	 Excel	 2013	 contains	 some
exceptionally	advanced	and	useful	features.	It	allows	you	to	protect	the	entire
worksheets,	as	well	as	 just	a	 few	cells,	or	a	 table,	or	a	graph	and	so	on.	The

security	related	options	featured	by	Excel	are	very	helpful.	You	can	customize	in	any	way
to	get	the	desired	protection.

This	 chapter	 talks	 all	 the	 valuable	 data	 protection	 and	 privacy	 features	 of	 Excel.	 After
going	through	this	chapter,	you	will	be	able	 to	set	passwords	 to	secure	cells,	control	 the
extent	to	which	your	worksheets	can	be	edited,	add	encryption	and	much	more.

Securing	Worksheets

All	the	cells	and	objects	on	a	worksheet	are	locked	and	secured	by	default.	However	you
need	to	activate	the	protection	in	order	to	apply	it.	Select	Review	>	Protect	Sheet.	This
will	open	the	Protect	Sheet	dialog	box,	as	shown	in	Figure	16.1.	The	Format	button	on
the	Home	tab	of	the	ribbon	also	opens	same	dialog	box.

Figure	16.1	-	Protect	Sheet	Dialog	Box

As	you	can	see	 in	Figure	16.1,	all	 the	options	are	quite	self	explanatory.	You	can	select
what	you	want	the	users	of	the	particular	worksheet	to	be	able	to	do.	Once	it	is	done,	the
locked	items	cannot	be	modified.	 In	Figure	16.1,	 the	users	are	 just	allowed	to	select	 the
locked	and	unlocked	cells.	If	anyone	tries	to	perform	any	other	operation	over	the	locked
cell(s),	Excel	displays	an	error	message	as	shown	in	Figure	16.2



Figure	16.2	–	Excel	Displays	an	Error	upon	an	Attempt	to	Edit	a	Protected	Worksheet	

As	 you	 can	 see	 in	 Figure	 16.2,	 the	 error	 window	 also	 gives	 a	 suggestion	 on	 how	 the
protected	cells	can	be	unprotected.	Anyone	can	select	 the	Unprotect	Sheet	command	 in
the	Review	 tab	 and	 then	 make	 the	 necessary	 changes	 in	 the	 locked	 cells.	 In	 order	 to
prevent	 this	 from	 happening,	 set	 a	 password	 in	 the	Protect	 Sheet	 dialog	 box.	 This	will
prevent	other	users	from	making	any	changes	in	the	particular	protection	settings,	except
for	those	who	know	the	password.		

Protecting	Individual	Cells

The	Protect	Sheet	option	in	the	Review	tab	applies	the	particular	settings	on	all	the	cells	in
the	 current	 worksheet.	 However	 at	 times	 you	 may	 not	 want	 to	 lock	 every	 cell.	 For
example,	you	may	want	 to	lock	the	cells	containing	formulas	and	input	values	but	 leave
some	particular	cells	for	comments	and	feedback.

Excel	offers	a	way	to	keep	particular	cells	unlocked	while	protecting	the	entire	sheet.	Here
is	how	can	do	this.

1.	 Before	you	activate	the	Protect	Worksheet	feature,	select	the	cells	that	you	want	to
keep	unlocked.

2.	 Select	Home	 >	Format	 >	Lock	Cell.	 The	Lock	Cell	 command	 is	 activated	 by
default.	Clicking	 it	 deactivates	 it,	 hence	 removes	 the	protection	 settings	 from	 the
selected	cells.

3.	 Now	select	the	Review	tab	and	click	Protect	Sheet.	The	entire	worksheet	will	be
locked	except	for	the	few	selected	cells.

If	you	have	kept	multiple	ranges	unlocked	and	have	gotten	confused	as	to	which	cells	are
unlocked,	just	select	the	cell(s)	you	doubt	is	locked	and	choose	Home	>	Format.	Check
the	Lock	Icon	command.	If	it	seems	like	it	is	already	clicked,	it	means	the	particular	cell	is
locked	and	vice	versa.

You	 can	 also	 fill	 colors	 and	 apply	 borders	 in	 the	 unlocked	 cell(s)	 to
keep	them	distinguished	from	locked	cells.	



Figure	16.3	-	Showing	the	Lock	Icon	Command	in	the	Home	Tab

Securing	the	Entire	Workbook

If	you	want	to	protect	the	entire	workbook’s	structure	from	editing,	select	the	Review	tab
and	 then	 click	 Protect	Workbook.	 This	 will	 open	 the	Protect	 Structure	 and	 Windows
dialog	box,	as	shown	in	Figure	16.4

Figure	16.4	-	The	Protect	Structure	and	Windows	Dialog	Box

Enter	the	password	and	click	OK	to	lock	the	workbook’s	structure.	

Permission	to	Edit

The	protection	features	of	Excel	are	not	just	limited	to	locking	cells	and	worksheets.	There
are	some	advanced	settings	as	well,	the	“Allow	Users	to	Edit	Ranges”	being	one	of	them.

Excel	 allows	you	 to	 set	 password	protection	on	 ranges	 and	 specify	 exactly	which	users
should	be	allowed	to	edit	the	particular	ranges.	To	use	this	feature,	make	sure	the	Protect
Sheet	command	is	deactivated.	Then	select	Review	>	Allow	Users	to	Edit	Ranges.	This
will	open	the	“Allow	Users	to	Edit	Ranges”	dialog	box,	as	shown	in	Figure	16.5



Figure	16.	5	-	Using	the	‘Allow	Users	to	Edit	Ranges’	command	in	Excel

This	is	 the	place	where	you	can	specify	the	editable	ranges	as	well	as	the	users	who	are
permitted	to	make	the	edits.	

Once	the	“Allow	Users	to	Edit	Ranges”	dialog	box	is	opened,	click	New.	This	will	open
another	dialog	box	namely	the	New	Range	dialog	box.

Figure	16.	6	-	Selecting	the	Cell(s)	to	Protect	in	the	New	Range	Dialog	Box

First,	enter	a	title	for	the	range	you	want	to	protect.	Next,	enter	the	range	reference	in	the
‘Refers	To	Cells’	type	text	box;	or	you	can	also	click	the	corresponding	box	and	select	the
range	in	the	worksheet.	Type	a	password	in	the	Range	Password	type	text	box	(optional).
Click	OK	 to	 close	 the	New	Range	 dialog	 box	 and	 return	 to	 the	 “Allow	 Users	 to	 Edit
Ranges”	dialog	box.

To	 edit	 the	 range	 or	 change	 the	 range	 selection	 or	 title,	 click	 the	Modify	button	 in	 the
“Allow	Users	to	Edit	Ranges”	dialog	box.	This	will	reopen	the	Modify	Range	dialog	box
for	the	particular	range.

Now	click	Permissions	to	open	the	‘Permissions	for	Input	Range’	dialog	box,	as	shown	in
Figure	16.7



Figure	16.7	-	The	‘Permissions	for	Input	Range’	Dialog	Box

Click	Add	to	open	the	‘Select	Users	or	Groups’	dialog	box,	as	shown	in	Figure	16.8

Figure	16.8	-	The	‘Select	Users	or	Groups’	Dialog	Box

Now	click	Advanced	to	open	the	extended	version	of	the	Select	Users	or	Groups	dialog
box,	as	shown	in	Figure	16.9



Figure	16.9	-	Adding	Users	in	the	Extended	Version	of	the	‘Select	Users	or	Groups’	Dialog	Box

The	simplest	way	of	adding	users	is	by	clicking	the	Find	Now	button.	It	will	display	the
list	of	all	the	users	and	groups	available	to	your	system.	The	Locations	and	Object	Types
commands	are	for	filtered	search.		

Once	you	specify	the	individuals	whom	you	want	to	allow	editing	of	the	particular	range,
click	OK	to	return	to	the	Permissions	dialog	box.

The	Permissions	 dialog	 box	 lists	 the	 names	 of	 all	 the	 authorized	 users	 along	 with	 the
Allow	 and	Deny	 checkboxes.	 For	 each	 authorized	 users,	 you	 can	 specify	 whether	 they
need	 a	 password	 to	make	 the	 edits	 in	 the	 particular	 edits.	 In	 short,	 this	 feature	 applies
double	protection.	You	don’t	only	specify	 the	authorized	users	but	also	determine	which
users	should	enter	password	to	access	the	editable	form	of	ranges.

Once	 you	 have	 done	 all	 the	 settings	 and	 have	 added	 the	 users,	 the	 last	 step	 in	 the
procedure	is	to	activate	the	Protect	Sheet	command.	You	can	do	so	by	clicking	the	Protect
Sheet	button	 in	 the	“Allow	Users	 to	Edit	Ranges”	dialog	box	or	by	selecting	Review	 >
Protect	Sheet.

	

If	 you	 want	 to	 keep	 track	 of	 who	 you	 have	 authorized	 and	 to	 what
extent,	put	a	tick	mark	in	the	Paste	Permissions	Information	Into	A
New	Workbook	check	box	in	the	‘Allow	Users	To	Edit	Ranges’	dialog



box.

	

	

Hiding/Unhiding	a	Worksheet

As	already	explained	in	Chapter	8,	you	can	hide	the	values	in	a	cell	by	applying	the	Null
format	over	it.	However,	this	will	only	hide	the	values	in	the	cells.	The	entries	will	still	be
visible	in	formula	bar.

To	 hide	 the	 selected	 cell(s),	 hit	Ctrl	+	Shift	+	F	 to	 open	 the	Format	Cells	 dialog	 box.
Select	the	Protection	tab	and	then	click	the	Hidden	checkbox.	This	will	hide	the	formulas
from	view,	though	they	will	still	be	functional.	The	result	of	the	formulas	will	stay	visible
on	the	worksheet.		

Adding	Encryption

Encryption	 is	 another	way	of	 securing	your	workbooks.	 It	 is	 a	 slightly	 complicated	and
advanced	feature	as	it	goes	beyond	the	simple	password	protection.	Encryption,	in	a	way,
obscures	the	data	and	renders	it	unreadable	unless	the	user	knows	the	decode	key.

To	apply	Encryption,	select	File	>	Info	>	Protect	Workbook	>	Encrypt	with	Password,
as	shown	in	Figure	16.9



Figure	16.10	-	Showing	the	Encryption	Command	in	the	Backstage	View

This	opens	the	Encrypt	Document	dialog	box,	as	shown	in	Figure	16.11

Figure	16.	11	-	The	Encrypt	Document	Dialog	Box

Enter	 a	 password,	 click	 OK	 and	 then	 re-enter	 the	 same	 password	 for	 confirmation
purpose.

	

Encrypting	a	workbook	also	activates	the	protection	on	the	workbook
structure.

	

Once	you	apply	 the	Encryption,	you	are	going	to	need	the	same	password	to	reopen	the
workbook.	Moreover,	the	Protect	Structure	and	Windows	dialog	box	(shown	in	16.4)	uses
the	same	password.

Encryption	stays	activated	even	after	you	turn	off	 the	Protect	Workbook	 feature.	To	 turn
off	 the	encryption,	 select	File	>	Info	>	Protect	Workbook	 >	Encrypt	with	Password.
Remove	the	password	from	the	Encrypt	Document	dialog	box	and	click	OK.

Password	Protection	

Whether	you	activate	the	Protect	Sheet	feature,	the	Protect	Workbook	feature	or	any	other
security	tool,	it	is	imperative	that	you	add	a	password	or	else	anyone	can	easily	unprotect
the	worksheets	 and	 turn	 off	 other	 security	 features.	 In	 short,	 the	 protection	 features	 are
useless	unless	secured	by	a	password.	

Password	protection	is	a	serious	activity.	Make	sure	you	don’t	forget
your	 password	 as	 it	 is	 the	 key	 to	 unprotect	 the	 worksheet	 or
workbook.	Also	remember,	passwords	are	case	sensitive.
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BOOK	III:	FORMULAS	AND	FUNCTIONS

ormulas	 and	 functions	 are	 the	 lifeblood	 of	 Excel.	 It	 is	 the	 formulas	 that	 is	 the
identity	of	Excel.	If	there	were	no	formulas	in	Excel,	it	would	have	been	nothing
but	 a	 simple	 word	 processing	 program	 with	 some	 extra	 tabular	 capabilities.	 A

formula	is	a	set	of	codes	and	characters	that	performs	some	type	of	calculation	using	data
from	the	other	cells.	

This	 book	 covers	 extensively	 the	 formulas	 and	 functions	 available	 in	 Excel.	 From	 the
basics	 of	 entering	 formulas,	 to	 simple	 mathematical	 functions	 and	 advanced	 statistical
formulas,	 this	book	covers	 all	 you	need	 to	know	 to	 excel	 at	Excel’s	 formulas.	You	will
also	learn	some	very	useful	financial	and	lookup	formulas.	Moreover,	this	part	also	helps
you	in	making	the	perfect	error	free	worksheet	in	Excel	2013.																		
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							Chapter	23:	Introducing	the	Lookup	Formulas
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							Chapter	25:	Making	an	Error	Free	Worksheet
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Chapter	17:	Learning	the	Basics

xcel	2013	features	innumerable	formulas	and	functions,	but	before	we	introduce
you	to	those,	it	is	important	to	understand	the	mechanism	behind	these	formulas.
This	 chapter	 covers	 all	 such	 basics	 including	 the	 operators	 used	 in	 building

formulas,	 different	 ways	 of	 entering	 and	 modifying	 formulas,	 array	 formulas	 and
numerous	handy	tips	that	will	make	the	usage	of	formulas	easier	and	interesting.						

Know	the	Different	Type	of	Operators

An	operator	 is	 a	 symbol	 that	 determines	 the	 type	 of	 operation	 you	want	 the	 formula	 to
perform.	 In	other	words,	 operators	 specify	 the	 type	of	 computation	 that	 is	 to	 take	place
between	the	cells	and	the	linked	values.	

Most	of	 the	basic	formulas	 in	Excel	require	nothing	but	 the	sole	use	of	operators.	Excel
recognizes	four	types	of	operators;	namely,	Arithmetic,	Reference,	Comparison	and	Single
Text.

Table	17.1	lists	the	operators	along	with	their	function	and	examples.

	



Type Operator Description Function Example

Arithmetic

+ Plus	Sign Adds	the	values =A5+B5+D5

- Minus	Sign Performs	subtraction =A5-B5

/ Forward	Slash Performs	Division =A5/D7

* Asterisk Multiplies	the	values =B5*D8

% Percentage Divides	the	value	by	100 =D9%

^ Exponent	symbol Exponentiation =B5^5

Reference

,	(comma) Union	operator
It	combines	multiple
references	into	one
reference

=SUM(A5,B8:C11,D15)

:	(colon) Range	operator Defines	the	selected	range 	

space Intersection
operator

Evaluates	cells	that	are
common	in	two
references

=SUM(A5:A8	A5:D8)

Comparison

> Greater	than 	 =A5>B5

< Less	than 	 =A5<B6

= Equals	to
Equates	the	values	and
create	links	
between	cells

=A5=B7

>= Greater	than	or
equal	to 	 =A5>=B5

<= Less	than	or	equal
to 	 =A5<=B6

<> Angle	Brackets Not	equal	to =A5<>B7

Single	Text & Ampersand
Connects	different	entries
to	produce	one
continuous	entry

=B4&”	“&C6t

Table	17.	1	-	Excel	Operators	Along	With	Their	Function	and	Examples

Determining	the	Order	of	Operator	Precedence

When	you	create	 formula	using	operators,	 it	 is	 interpreted	 in	a	certain	order	of	operator
precedence	by	Excel.	There	are	certain	rules	 that	Excel	follow	to	determine	 the	order	 in



which	the	different	parts	of	the	formula	are	calculated.

If	a	formula	contains	more	than	one	operator	having	the	same	level	of	precedence,	Excel
follows	the	left-to-right	order	of	precedence	while	performing	the	required	calculation.

Table	17.2	lists	down	the	operators	with	their	level	of	precedence.	

Operator Description Precedence

- Negation 1

% Percentage 2

^ Exponentiation 3

*	and	/ Multiplication	and	Division 4

+	and	- Addition	and	Subtraction 5

& Ampersand/	Concatenation	operator 6

=,	<,	>,	<=,	>=,	<> Comparison	Operators 7

Table	17.2	-	Order	of	Operator	Precedence	in	Excel

Here	 is	 an	 example	 to	make	 you	 understand	 better	 the	 order	 of	 operator	 precedence	 in
Excel.

Suppose	you	entered	the	following	formula	in	a	cell	in	Excel:

=A5+B6*C7

As	 you	 can	 see	 in	 Table	 17.2,	 multiplication	 has	 a	 higher	 precedence	 than	 addition.
Therefore,	while	executing	this	formula,	Excel	will	first	multiply	B6	to	C7,	and	then	the
resulting	 value	 will	 be	 added	 to	 A5.	 Suppose	 A5	 contains	 5,	 B6	 contains	 10	 and	 C7
contains	2.	The	resulting	value	would	be	25	( 5+10*20 ).

If	you	want	Excel	to	perform	the	addition	first,	then	put	it	in	closed	parentheses,	as	shown
below:

=(A5+B6)*C7

If	 you	 enter	 this	 formula,	 Excel	 will	 first	 perform	 the	 calculation	 within	 the	 brackets.
Considering	the	same	values	as	assumed	above,	the	resulting	value	in	this	case	would	be
300	( (5+10)*20 ).



Now	 let’s	 extend	 this	 formula	 for	 further	 understanding.	 Suppose	 you	 entered	 the
following	formula	in	a	cell	in	Excel:

=A5+(B6–C7)/D9

In	this	formula,	Excel	will	first	perform	the	calculation	within	the	parentheses.	After	that,
it	 will	 follow	 the	 standard	 order	 of	 precedence,	 thereby	 performing	 division	 and	 then
addition.	 So	 if	 you	 want	 Excel	 to	 ignore	 the	 order	 of	 precedence	 and	 perform	 the
calculation	 otherwise,	 then	 you	 need	 to	 put	 double	 parentheses.	 Have	 a	 look	 at	 the
following	formula	as	an	example:

		=(A5+(B6–C7))/D9

Here	 we	 have	 entered	 double	 parentheses.	 It	 implies	 that	 Excel	 will	 first	 perform	 the
calculation	in	the	inner	brackets,	then	the	outer	brackets	and	finally	the	division.	

	

Be	very	careful	while	you	use	double	parentheses.	Make	sure	you	put
them	 in	 the	 right	 places	 and	 don’t	 forget	 to	 balance	 the	 pair	 of
brackets	 you	 use.	 There	 must	 be	 right	 parenthesis	 for	 every	 left
parenthesis,	or	else	Excel	will	display	an	Alert	dialog	box,	notifying
an	error	in	the	particular	formula.

	

Ways	of	Entering	Formulas

Now	that	you	know	how	to	use	operators	in	building	formulas,	let’s	see	how	actually	you
can	enter	formulas	in	Excel	2013.	

Type	and	Enter	

The	most	basic	way	of	 entering	 a	 formula	 is	 to	 type	 it	manually	 in	 the	 active	 cell.	 Just
enter	an	equal	sign	(=)	or	a	plus	sign	(+)	followed	by	the	formula.

Point	and	Enter

Though	 you	 can	 manually	 type	 as	 large	 a	 formula	 you	 want,	 this	 method	 of	 entering
formula	 gets	 very	 difficult	 especially	 when	 working	 on	 large	 spreadsheets	 and
uncountable	cells	of	data.

A	 comparatively	 easier	 way	 of	 entering	 formula	 is	 by	 pointing	 to	 the	 cell	 references.



Suppose	you	want	to	enter	the	following	formula	in	a	cell	A9:

=A5+B6*C7

You	can	either	enter	it	manually,	or	use	the	following	method	to	point	and	enter.

1.	 Select	the	cell	A9.

2.	 Type	an	equal	sign	(=)	in	it.

3.	 While	the	equal	sign	(=)	is	still	there,	move	the	cell	pointer	to	Cell	A5.	You	can	use
the	arrow	keys	on	your	keyboard	to	go	to	Cell	A5	or	can	also	directly	click	over	it
using	the	mouse.	Just	move	the	cell	pointer	to	Cell	A5.	Do	not	double	click	it.

4.	 Now	type	a	plus	sign	(+).	Here	you	will	see	that	while	the	cell	pointer	is	at	Cell	A5,
the	plus	sign	will	appear	in	Cell	A9.

5.	 Now	move	the	cell	pointer	to	Cell	B6.

6.	 Type	a	plus	sign	(+),	then	move	the	cell	pointer	to	Cell	B6.

7.	 Type	an	asterisk	(*)	and	then	move	the	cell	pointer	to	Cell	C7.

8.	 Finally,	press	Enter	on	your	keyboard	to	confirm	and	close	the	formula	mode.

	

From	 the	 time	you	put	 an	 equal	 to	 (=)	 sign	 in	 a	 cell	 till	 you	 press
Enter,	 the	 underlying	 cell	 is	 in	 the	 Formula	 Edit	 mode.	 Stay
conscious	 of	 your	 mouse	 clicks.	 Make	 sure	 you	 select	 only	 the
required	cells,	because	any	cells	you	click	will	be	referenced	to	the
underlying	 formula.	 In	 short,	 any	 extra	 clicks	 cell	 while	 the
underlying	 cell	 is	 in	 the	 Formula	 Edit	 mode,	 may	 disturb	 the
corresponding	formula.



How	to	Insert	Functions	into	Formulas

While	operators	can	be	used	 to	build	a	 lot	of	 formulas,	 they	cannot	 replace	 the	need	of
functions.	 It	 is	 the	 functions	 that	help	you	create	 and	manage	complex	calculations	 and
analysis	models	in	Excel.	

There	are	several	ways	of	inserting	functions	in	Excel,	as	explained	below.

		Using	the	Formulas	Tab	on	the	Ribbon

If	you	don’t	remember	or	are	unsure	about	which	function	to	use,	the	best	way	to	find	the
right	 function	 is	 through	 the	 categories	 available	 in	 the	Function	 Library	 group	 in	 the
Formulas	tab	on	the	Ribbon,	as	shown	in	Figure	17.1

Figure	17.1	-	Showing	the	Functions	in	the	Formulas	Tab	on	the	Ribbon

All	you	have	to	do	is	to	select	cell	the	where	you	want	to	enter	the	function,	then	choose
the	Formulas	 tab	and	click	 the	 function	category	 to	open	up	 the	 list	of	 functions	 in	 the
corresponding	category.

As	 you	 see	 in	 Figure	 17.1,	 there	 categories	 for	 financial,	 Logical,	 Text,	 Math	 and
numerous	other	type	of	functions.	Once	the	function’s	list	is	opened,	click	the	one	that	you
intend	to	insert	in	the	active	cell.	Doing	so	will	open	the	Function	Arguments	dialog	box,
as	shown	in	Figure	17.2



Figure	17.2	-	The	Function	Arguments	Dialog	Box

Enter	the	function’s	argument	and	click	OK	to	insert	it	in	the	active	cell.

As	 you	 can	 see	 in	 Figure	 17.2,	 there	 is	 a	 small	 description	written	 about	 the	 particular
function.	If	this	description	is	not	enough	and	you	are	still	unable	to	learn	the	usage	of	the
function,	 click	Help	 on	 this	 function	 link	 located	 at	 the	 bottom	 left	 of	 the	 Function
Arguments	dialog	box.

Using	the	Insert	Function	dialog	box

Another	way	to	 insert	a	function	in	Excel	 is	by	using	the	Insert	Function	dialog	box,	as
shown	in	Figure	17.3

Figure	17.3	-	Inserting	Functions	Using	the	Insert	Function	Dialog	Box

Following	is	the	procedure	on	how	to	use	the	Insert	Function	dialog	box.

Choose	Formulas	tab	and	click	the	Insert	Function	button	on	the	left	of	the	tab.	This	will
open	the	Insert	Function	dialog	box.	It	can	also	be	opened	by	clicking	the	fx	icon	located
on	the	immediate	left	of	the	formula	bar.	

	

For	keyboard	users,	hit	Shift	+	F3	to	open	the	Insert	Function	Dialog
box.

The	 Insert	Function	 dialog	box	contains	 a	drop	down	 list	of	 all	 the	 function	categories.
Just	select	a	category	and	all	the	pertinent	functions	will	be	listed	in	the	list	box.



If	you	are	unable	to	find	the	required	function	this	way,	you	can	also	search	for	it	by	using
the	Search	for	a	Function	type	text	box	located	at	the	top	of	the	dialog	box.

Once	you	find	the	required	function,	click	over	it	to	open	the	Function	Arguments	dialog
box.	Enter	the	argument	and	click	OK.

Using	the	Miraculous	AutoComplete	Formula	Feature	

The	AutoComplete	Formula	 tool	 is	 yet	 another	 advanced	 and	valuable	 feature	 of	Excel
2013.	It	offers	the	easiest	way	of	entering	a	function	in	a	formula.	Here	is	how	you	can	use
it.

1.	 Move	the	cell	pointer	to	the	cell	where	you	want	to	insert	the	function.

2.	 Type	an	equal	sign	(=)	followed	by	the	first	letter	of	the	function	you	want	to	insert.
Suppose	 you	want	 to	 insert	 the	SUMIF	 function.	 To	 do	 that,	 type	S	 and	 all	 the
functions	starting	from	S	will	 appear	below	 the	 selected	cell,	 as	 shown	 in	Figure
17.4

3.	 Using	the	arrow	keys	on	the	keyboard,	move	the	selection	to	the	function	you	want
to	insert.

4.	 Once	the	appropriate	function	is	highlighted,	press	the	Tab	key	on	your	keyboard.

Figure	17.4	-	Entering	the	SUMIF	Function	Using	the	AutoComplete	Formula	Feature	

5.	 The	selected	function	will	appear	in	the	active	cell.	Enter	the	argument	in	the	cell,
use	 commas	 to	 separate	 the	 arguments	 and	 finally,	 don’t	 forget	 to	 close	 the
parentheses,	if	any.

6.	 Hit	Enter	to	complete	the	formula.

How	to	Use	Range	Names	in	Building	Formulas



You	do	not	necessarily	need	to	put	the	cell	address	in	the	formulas.	You	can	put	names	of
the	cells	and	ranges	as	well,	if	there	are	any.

There	are	three	ways	of	using	named	cells	and	ranges	in	a	formula,	as	listed	below:

1.	 Type	 the	 name	 of	 the	 particular	 cell	 or	 range,	where	 you	want	 to	 place	 it	 in	 the
formula.

2.	 Enter	the	first	letter	or	character	of	the	name	and	the	select	it	from	the	Name	drop
down	list.

3.	 Hit	F3	 on	 your	 keyboard.	 This	will	 open	 the	Paste	Name	 dialog	 box.	 Select	 the
appropriate	name	and	click	OK.	The	selected	name	will	appear	in	the	formula.	

Referencing	Cells	in	Formulas

Most	of	the	formulas	that	you	create	in	Excel	contain	references	to	other	cells	and	ranges.
The	references	are	what	make	the	formulas	interactive	and	valuable.	You	just	change	the
value	 in	 the	 referenced	 cell	 and	 all	 the	 referenced	 formulas	 and	 resulting	 values	 are
updated	accordingly.

For	example,	if	you	refer	to	Cell	B7	in	a	formula,	the	moment	you	change	the	value	in	cell
B7,	the	formula’s	result	will	be	updated	accordingly.	On	the	other	hand,	if	you	don’t	refer
the	cell,	you	would	have	to	edit	 the	formula	manually	every	time	you	make	a	change	in
any	input	value.

There	are	three	types	of	references	that	you	can	use	in	Excel.

Using	Relative	References

By	 default,	 Excel	 creates	 relative	 cell	 references	 when	 you	 copy	 and	 drag	 formulas	 to
other	cells.	This	type	of	referencing	applies	to	the	corresponding	rows	and	columns.

The	 relative	 row	 and	 column	 references	 are	 actually	 offsets	 from	 the	 current	 row	 and
column,	hence	they	change	when	you	copy	a	formula	to	other	cells.

	

Using	Absolute	References

The	second	type	of	reference	is	 the	absolute	reference.	In	this	case,	 the	row	and	column
referred	 values	 does	 not	 change	 even	when	 you	 copy	 the	 formula.	 This	 is	 because	 the
reference	is	actually	made	to	one	cell	address	and	that	needs	to	remain	constant	in	all	the
formulas.	An	absolute	reference	contains	two	dollar	signs	($)	in	its	cell	address;	one	sign



is	to	lock	the	column	address	and	other	for	the	row	address.	For	example,	$B$7	represents
an	absolute	reference.	When	entered	in	a	formula,	it	will	remain	same	no	matter	how	far
you	copy	and	drag	 the	 formula.	A	change	 in	cell	B7	will	affect	all	 the	 formula’s	 results
containing	this	absolute	reference.	

Using	Mixed	References

A	mixed	reference	is	a	combination	of	absolute	and	relative	reference.	It	contains	only	one
dollar	sign,	either	with	the	column	address	or	with	the	row	address.	The	one	containing	the
dollar	sign	stays	constant	in	all	 the	copied	formulas,	while	the	other	referred	value	stays
relative.	$B7	and	B$7	are	examples	of	mixed	reference.

Figure	17.5	shows	an	example	of	all	three	types	of	references.

Figure	17.5	-	Example	of	Relative,	Absolute	and	Mixed	Cell	Referencing

The	F4	Trick	for	Referencing	Cells

Here	is	a	handy	exclusive	tip	for	referencing	cells.

							Hit	F4	once	to	change	the	relative	cell	reference	to	absolute	(For	example:	B7	to
$B$7)

							Hit	F4	twice	to	change	the	absolute	cell	reference	to	mixed,	in	which	the	column
reference	 is	 relative	 and	 the	 row	 reference	 is	 absolute	 and	 fixed	 (For	 example:
$B$7	to	B$7)

							Hit	F4	thrice	to	change	the	structure	of	the	mixed	reference.	This	time,		in	which
the	 column	 reference	 is	 absolute	 and	 the	 row	 reference	 is	 relative	 (For	 example:
B$7	to	$B7)

	 	 	 	 	 	 	Hit	F4	four	times	to	change	the	mixed	reference	back	to	the	relative	reference
(For	example,	B$7	to	B7)

How	to	Edit	Formulas

Just	like	you	can	edit	values	in	a	cell,	you	can	edit	the	formulas	as	well.	At	times	you	may



need	 to	 change	 the	 references	 in	 a	 formula	 or	 add	 any	 other	 argument.	Or	 the	 formula
returns	an	error	value	and	you	may	need	to	edit	the	formula	to	make	it	right.

	

To	convert	a	formula	into	text,	simply	remove	the	equal	(=)	sign	from
the	 beginning	 of	 the	 formula.	 To	 reconvert	 the	 text	 into	 formula,
replace	the	equal	sign	(=).	

Editing	formula	is	a	very	common	activity	in	Excel	and	there	are	several	ways	to	perform
it.

Move	 the	 cell	 pointer	 to	 the	 cell	 you	 want	 to	 edit	 and	 then	 change	 the
corresponding	formula	in	the	formula	bar.

Double	click	the	cell	to	put	the	corresponding	formula	in	the	edit	mode.

Hit	F2	on	your	keyboard	to	modify	the	formula	directly	in	the	cell.

If	 you	 have	 entered	 an	 erroneous	 formula	 in	 a	 cell,	 you	 will	 see	 that	 the
corresponding	cell	will	display	small	green	triangle	in	the	upper	left	corner	of	the
cell.	Select	the	cell	and	you	will	see	a	warning	icon	attached	to	the	cell,	as	shown	in
Figure	17.6	Click	the	icon	to	open	the	suggestions	for	correcting	the	formula.

Figure	17.6	-	Showing	the	Warning	Icon	for	Erroneous	Formula		

If	you	find	 the	warning	 icon	annoying	and	wants	 to	 turn	 it	off,	select
File	 >	 Options.	 Find	 and	 unmark	 the	 checkbox	 labeled	 Enable
Background	Error	Checking.		
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Chapter	18:	Working	with	Text	Formulas

xcel	is	definitely	the	best	number	cruncher	software.	However	it	is	pretty	versatile
and	can	perform	numerous	other	functions	as	well,	text	manipulation	being	one	of
them.	 There	 are	 countless	 formulas	 in	 Excel	 that	 allows	 you	 to	 play	 with	 text

values	in	any	way	you	want.

This	chapter	contains	examples	of	some	of	 the	most	useful	and	popular	 text	formulas	 in
Excel.	After	going	through	this	chapter,	you	will	be	able	to	combine	the	text	values	of	two
cells	 into	one	cell,	you	will	 learn	 the	magical	 text	 formula	 to	change	 the	font	case,	 then
there	is	a	function	to	replace	text	in	a	cell	and	so	on.	

Formula	to	Combine	Two	Cells		

Ampersand	is	the	most	commonly	used	operator	when	it	comes	to	creating	text	formulas.
It	 is	widely	used	 to	combine	 the	 first	 and	 last	name	originally	written	 in	different	 cells,
into	one	cell.

Suppose	 cell	A1	 contains	 “United”	 and	 cell	B1	 contains	 “States”.	To	 combine	 both	 the
words	in	Cell	C1,	type	the	following	formula	in	Cell	C1.

=	A1&B1

The	resulting	value	would	be	“UnitedStates”.	To	put	space	between	 the	 two	 text	values,
modify	the	above	formula	in	the	following	way:

=	A1”&”B1

This	will	produce	“United	States”	in	cell	C1.	

The	DOLLAR	Function

If	you	want	 to	 convert	 a	numeric	value	 to	 text	 in	 the	 currency	 format,	 create	 a	 formula
using	the	DOLLAR	function.

The	 DOLLAR	 function	 uses	 two	 arguments;	 the	 first	 one	 is	 the	 number	 you	 want	 to
convert	and	the	second	one	specifies	the	number	of	decimal	places	to	display	in	the	value.

Suppose	 cell	 A1	 contains	 2400.7632	 and	 you	 want	 to	 covert	 this	 into	 “Amount:
$2400.763”

Move	the	cell	pointer	to	the	destination	cell	and	enter	the	following	formula	into	it.

=”Amount:	“&DOLLAR(2400.7632,	2)



The	 “2”	written	 at	 the	 end	 of	 the	 formula	 signifies	 that	 you	want	 to	 display	 2	 decimal
places	in	the	resultant	value.	

Formula	to	Remove	Extra	Spaces	

Many	 times	 you	may	 need	 to	 import	 data	 into	 Excel	 from	 other	 sources,	 such	 as	 web
pages.	The	imported	data	may	contain	several	extra	spaces	and	unprintable	characters.

There	are	two	functions	that	can	help	you	in	this	regard.

1.	 The	CLEAN	function	deletes	all	the	unprintable	characters	from	the	text	value.

2.	 The	TRIM	function	deletes	all	the	spaces	and	puts	a	single	space	in	the	appropriate
places.	

Suppose	cell	A1	contains	a	value	“Sales			Revenue	for			Third					Quarter”.	The	quoted	text
is	copied	from	a	web	version	of	a	company’s	sales	report,	hence	contains	many	spaces.

To	save	yourself	from	manually	removing	the	extra	spaces,	enter	the	following	formula	in
any	other	cell.

=TRIM(A1)

Or	if	you	want	to	rectify	the	value	in	the	same	cell,	hit	F2	to	put	the	cell	in	edit	mode	and
then	type	the	following	before	the	value:

=TRIM(“

Close	the	quotation	and	parentheses	when	the	value	ends.

So	the	complete	formula	will	be	like:

=TRIM(“Sales	Revenue	for			Third				Quarter”)

Formula	to	Repeat	Characters

If	you	want	to	repeat	a	text	value	or	any	characters	in	it,	you	can	apply	the	REPT	function
to	do	that.	It	repeats	the	values	as	many	times	as	specified	in	the	formula.



Suppose	you	want	to	fill	a	cell	with	hyphens	(-).	To	do	so,	enter	the	following	formula	in
the	destination	cell.

=REPT(“-“,30)

The	character	 inside	 the	quotations	can	also	be	replaced	with	a	cell	address.	However	 if
you	are	referencing	a	cell	address,	remove	the	quotation	marks	as	well.	‘30’	represent	the
number	of	times	you	want	the	character	to	be	repeated.

Using	REPT	to	Create	Histogram

A	 very	 interesting	 application	 of	 the	 REPT	 function	 is	 that	 it	 can	 be	 used	 to	 create	 a
histogram.	Following	is	an	example	of	how	you	can	do	this.

Figure	18.1	-	Creating	Histogram	Using	the	REPT	Function

As	you	can	see	in	Figure	18.1,	column	B	contains	the	units	produced	in	the	corresponding
month.	The	following	formula	is	entered	in	Cell	C3:

=REPT(CHAR(162),B3/100)

The	 formula	 is	 then	 dragged	 down	 to	 the	 cover	 the	 entire	 range.	 “162”	 represents	 the
character	that	made	up	the	histogram.	It	is	the	162	character	in	the	Wingdings	2	font.

Formula	to	Change	Case

Excel	features	three	functions	that	allow	you	to	change	the	case	of	text	without	having	to
do	it	manually.	



UPPER

The	UPPER	function	converts	 the	text	 to	ALL	UPPERCASE.	Suppose	Cell	B2	contains
“united	 states”.	 Entering	 the	 following	 formula	 in	 the	 destination	 cell	 would	 result	 in
UNITED	STATES.

=UPPER(B2)

LOWER

The	LOWER	function	converts	the	text	to	all	lowercase.

Continuing	 the	 same	 example,	 the	 following	 formula	would	 result	 in	 united	 states”,	 as
shown	in	Figure	18.2

		=LOWER(C4)

PROPER

The	PROPER	function	converts	the	text	to	Proper	Case,	in	which	the	first	letter	of	every
word	is	capitalized.

Continuing	the	same	example,	 the	following	formula	would	result	 in	“United	States”,	as
shown	in	Figure	18.2

		=PROPER(C5)

Figure	18.2	-	Illustrating	the	Use	of	Different	Functions	to	Change	Case

Substituting	Text

At	 times,	 you	 may	 need	 to	 replace	 a	 part	 of	 the	 text	 value	 or	 a	 few	 characters	 in	 it.
Suppose	you	 copied	data	 from	some	external	 source	 and	 after	 pasting	 it	 into	Excel,	 the
data	shows	hyphens.	You	want	to	replace	the	hyphens	with	space.	There	are	two	ways	to
do	that:

1.	 Select	Home	 >	Find	&	Select	 >	Replace.	 This	will	 open	 the	Find	 and	 Replace



dialog	box.	Enter	the	new	and	old	values	to	make	the	replacement.

2.	 You	 can	 also	 replace	 text	 and	 characters	 by	 using	 functions.	 Excel	 provides	 two
functions	to	substitute	values	in	cells;	namely	SUBSTITUTE	and	REPLACE.

SUBSTITUTE

The	SUBSTITUTE	functions	can	be	used	to	replace	a	specific	part	of	text.	This	function
comes	 in	 handy	when	 you	 know	which	 characters	 needs	 to	 be	 replaced	 but	 are	 unsure
about	their	position.

Suppose	a	cell	contains	January	2013	and	you	want	to	replace	2013	with	2014.	Entering
the	following	formula	in	the	destination	cell	will	cause	the	resulting	value	to	be	January
2014.

=SUBSTITUTE(“January	2013”,”2013”,”2014”)

As	you	can	see	in	the	above	formula,	the	first	argument	contains	the	underlying	text,	the
second	 argument	 contains	 the	 value	 that	 needs	 to	 be	 changed	 and	 the	 third	 argument
contains	the	new	value.

REPLACE

The	 REPLACE	 function	 can	 be	 used	 to	 replace	 text	 that	 occurs	 in	 a	 specific	 location
within	 the	 entire	 underlying	 value.	 This	 function	 comes	 in	 handy	 when	 you	 know	 the
position	of	the	text	or	characters	that	needs	to	be	replaced	but	are	unsure	about	what	the
actual	values	are.		

Suppose	a	cell	contains	January	2014	and	you	want	 to	replace	 the	space	with	a	hyphen.
Entering	the	following	formula	in	the	destination	cell	will	cause	the	resulting	value	to	be
January-2014.

=REPLACE(“January	2014”,8,1,”-”)

As	you	can	see	in	the	above	formula,	the	first	argument	contains	the	underlying	text,	the
second	argument	contains	the	position	of	the	character	that	needs	to	be	replaced,	the	third
argument	contains	 the	number	of	characters	 that	needs	 to	be	changed	after	 the	specified
position	and	finally	the	fourth	argument	is	the	new	character	enclosed	in	quotation	marks.

Formula	to	Separate	First,	Middle	And	Last	Name

One	of	the	most	popular	and	common	applications	of	Excel	is	that	it	is	used	to	maintain
list	of	names.	If	the	names	are	imported	from	any	other	source,	most	of	the	times	the	full



names	are	pasted	in	one	single	row.

Excel	provides	a	way	to	divide	the	first,	middle	and	last	name	into	three	different	columns
respectively.

Suppose	 the	names	are	 listed	 in	Column	A,	with	 the	first	name	in	Cell	A2,	as	shown	in
Figure	18.3

Figure	18.3	-	Separating	the	First,	Middle	and	Last	Name	in	Excel

Enter	the	following	formula	in	Cell	B2	to	return	the	first	name.

=LEFT(A2,FIND(”	“,A2)-1)

Enter	the	following	formula	in	Cell	C2	to	return	the	middle	name.

=IF(ISERR(FIND(”	“,A2,1+FIND(”	“,A2))),””,MID(A2,FIND(”	“,A2)+1,FIND(”
“,A2,1+FIND(”	“,A2))-FIND(”	“,A2)-1))

Enter	the	following	formula	in	Cell	D2	to	return	the	first	name.

=IF(ISERR(FIND(”	“,A2,1+FIND(”	“,A2))),MID(A2,FIND(”
“,A2)+1,LEN(A2)),MID(A2,1+FIND(”	“,A2,1+FIND(”	“,A2)),LEN(A2)))

All	 the	above	 formulas	assume	 that	 the	 first	name	 is	 in	Cell	A2.	 If
you	have	 used	 any	other	 row	 and	 column,	 then	 just	 copy	 the	 same
formula	but	change	the	reference	cell.	Since	the	reference	is	relative,
dragging	 it	 down	 will	 apply	 the	 same	 formula	 to	 all	 the	 other
corresponding	rows	and	columns.

	



Formula	to	Remove	Titles	from	Names

Suppose	cell	A2	contains	Mr.	Paul	Emmanuel.	You	want	to	remove	Mr.	and	just	put	Paul
Emmanuel	in	a	cell.	Enter	the	following	formula	in	the	destination	cell	to	return	the	name
without	the	title.	

First	enter	the	following	formula	in	Cell	B2.	This	would	return	the	title	only.

=IF(ISERROR(FIND(“Mr.”,A2))=FALSE,“Mr.”,IF(ISERROR(FIND(“Mrs.”,A2))=FALSE,“Mrs.”,IF(ISERROR(FIND(“Dr.”,
A2))=FALSE,“Dr.”,””)))

Now	enter	the	following	formula	in	Cell	C2.	This	would	return	the	name	only.

=IF(B2=””,A2,MID(A2,FIND(“.”,B2)+2,LEN(A2)-FIND(“.”,B2)))

You	 can	drag	 this	 formula	 down	 the	 column	 to	 remove	 titles	 from	all	 the	 names	 in	 the
corresponding	column	and	row.	If	you	don’t	want	to	see	the	title	and	just	the	name,	hide
the	row	containing	titles.



The	LEN	Function

You	can	use	the	LEN	function	to	count	the	number	of	words	in	a	text	value.	However,	the
LEN	function	alone	is	not	capable	of	counting	the	accurate	number.	You	need	to	combine
it	with	a	few	more	functions.

Suppose	Cell	A1	contains	 “United	States	of	America”.	 In	order	 to	 count	 the	number	of
words	in	this	value,	enter	the	following	formula	in	any	other	cell.

=IF(LEN(TRIM(A1))=0,0,LEN(TRIM(A1))-LEN(SUBSTITUTE(A1,”	“,””))+1)

In	 the	 above	 formula,	 first	 the	 TRIM	 function	 removes	 the	 extra	 spaces.	 The
SUBSTITUTE	function	then	creates	a	new	value	with	all	the	spaces	removed.	Finally	the
LEN	 function	 subtracts	 the	 substituted	 value	 from	 the	 trimmed	 value	 to	 calculate	 the
number	of	spaces.	This	value	is	then	incremented	by	1	to	count	the	total	number	of	words.

Figure	18.4	-	Counting	the	Number	of	Words	in	a	Cell



As	you	can	see	in	Figure	18.4,	entering	a	formula	in	Cell	A2	results	in	4.	It	implies	that
the	value	in	Cell	A1	contains	4	words.	The	Formula	bar	shows	the	formula	entered	in	cell
B2.	

This	was	just	an	example.	One	does	not	count	the	number	of	words	in	such	a	small	value.
This	formula	is	normally	used	to	count	the	words	in	range	of	cells.	To	do	so,	just	replace
the	cell	reference	with	the	range	address.
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Chapter	19:	Understanding	the	Date	and	Time	Formulas

orking	with	Date	and	Time	formulas	in	Excel	can	be	a	bit	confusing,	especially
for	beginners.	In	order	to	use	the	date	and	time	formulas	correctly,	it	is	highly
essential	 that	you	first	understand	how	Excel	 interprets	Date	and	Time.	Once

you	will	understand	 the	mechanism,	 it	will	be	easy	for	you	 to	make	effectual	use	of	 the
valuable	date	and	time	functions.

This	chapter	gives	you	all	 the	 information	you	need	to	know	in	order	 to	create	date	and
time	formulas	in	Excel.	The	chapter	starts	with	how	Excel	treats	such	formulas	and	then
goes	on	to	different	examples	and	applications	of	how	you	can	create	formulas	in	Excel	to
manipulate	date	and	time.				

How	Does	Excel	Read	Date	and	Time

Excel	does	not	 treat	dates	and	 times	as	 simple	numeric	or	 text	values.	For	Excel,	 every
date	and	time	is	a	serial	number.	Any	value,	the	format	of	which	slightly	resembles	a	date
or	time	format,	is	automatically	read	as	a	serial	number	by	Excel.

The	first	date	that	Excel	recognizes	is	January	1,	1900.

In	case	of	a	date,	a	serial	number	signifies	the	number	of	days	that	passed	since	January	1,
1900.	 This	 date	 carries	 a	 serial	 number	 1.	 Likewise,	 January	 2,	 1900	 carries	 a	 serial
number	2,	and	so	on.	The	 last	date	 in	Excel’s	date	system	is	December	31,	9999	(serial
number:	2,958,465).

	

The	time	cycle	of	Excel	starts	with	midnight	(serial	number	=	0.00000000).

In	the	case	of	 times,	 the	serial	numbers	are	extended	to	include	decimals.	The	fractional
value	 represents	 the	 number	 of	 hours,	 minutes	 and	 seconds	 that	 have	 passed	 since
midnight.	12:00:00	AM	(midnight)	carries	a	serial	number	0.00000000	and	12:00:00	PM
(noon)	carries	a	serial	number	0.50000000.

The	 serial	 number	 equivalent	 of	 one	 minute	 is	 approximately	 0.00069444.	 Hence,	 the
serial	number	for	1:30:00	PM	is	0.56250000	and	for	4:30:00	PM	is	0.68750000.

	

Don’t	worry!	You	don’t	need	to	learn	all	these	serial	numbers.	This	is
just	to	give	you	an	idea	about	how	helps	Excel	interpret	date	and	time



in	formulas	and	calculate	the	elapsed	time	accordingly.

	

Creating	Formulas	to	Calculate	the	Elapsed	Date

One	of	the	most	common	applications	of	Date	formulas	is	that	they	are	used	to	calculate
the	 number	 of	 days	 passed	 between	 two	 dates.	 The	 best	 part	 is	 that	 this	 is	 the	 easiest
formula	to	create	when	it	comes	to	manipulating	date	and	time.	You	just	need	to	enter	a
subtraction	operator	and	that	is	all	it	is	required	to	calculate	the	elapsed	dates.

Suppose	cell	A1	contains	1/1/2013	and	cell	B1	contains	1/2/2012.	To	calculate	the	number
of	days	between	the	elapsed	dates,	enter	the	following	formula	in	the	destination	cell.

=A1-B1

	

Make	sure	the	cells	that	you	refer	in	the	formula	are	all	formatted	with
the	 Date	 format,	 or	 else	 they	 will	 be	 considered	 as	 simple	 numeric
values	by	Excel.	

	

To	find	the	number	of	years	passed	between	two	dates,	apply	the	same
formula	and	then	divide	the	resulting	value	by	365.			

	

Creating	Formulas	to	Calculate	the	Elapsed	Time

Most	 of	 the	 time	 formulas	 are	 created	 to	 calculate	 the	 time	 elapsed	 between	 two	 time
periods.	Suppose	you	maintain	a	worksheet	for	recording	the	entry	and	exit	times	of	your
employees.	Now	you	want	to	include	in	the	worksheet	the	time	each	employee	spends	in
the	office.	You	can	do	so	by	calculate	the	time	difference	between	the	entry	and	exit	time.

For	example,	if	cell	A1	contains	9:15	AM	and	cell	B1	contains	4:30	PM.	To	calculate	the
number	of	hours	and	minutes	between	the	 two	times,	enter	 the	following	formula	 in	 the
destination	cell.

=B1-A1

This	 will	 yield	 7:15	 AM	 in	 the	 destination	 cell.	 To	 convert	 this	 value	 into	 number	 of



hours,	format	the	destination	cell	with	General	format	and	then	multiply	it	by	24.

The	final	answer	will	be	7.25.	It	 implies	that	 the	particular	worker	spent	7	hours	and	25
minutes	in	the	office.			

Exploring	Common	Time	Functions

First	let’s	talk	about	the	valuable	and	commonly	used	Time	functions	in	Excel	2013	and
then	we	will	move	on	to	the	Date	functions.		

HOUR,	MINUTE,	and	SECOND

The	HOUR,	MINUTE,	and	SECOND	functions	allow	you	 to	 separate	a	 time	value	 into
hours,	minutes	and	seconds	respectively.	Suppose	cell	A1	contains	2:45:30	PM.

Entering	the	following	formula	in	the	destination	cell	(B2	in	this	example)	would	result	in
14.

=HOUR(A1)

	

The	HOUR	function	follows	the	24-hour	time	period	and	calculate	the
number	in	hours	accordingly.	

Continuing	the	same	example,	 to	extract	 the	number	of	minutes	from	the	original	value,
enter	the	following	formula	in	the	destination	cell	(B3	in	this	example).	It	would	return	the
value	45	in	B3.

=MINUTE(A1)

Continuing	the	same	example,	 to	extract	 the	number	of	seconds	from	the	original	value,
enter	the	following	formula	in	the	destination	cell	(B4	in	this	example).	It	would	return	the
value	30	in	B4.

=SECOND(A1)

Figure	19.1	illustrates	the	example	explained	above.	



Figure	19.1	-	Illustrating	the	use	of	HOUR,	MINUTE,	and	SECOND	Functions

NOW

The	NOW	function	is	used	to	put	the	current	date	and	time	in	a	cell.	This	function	is	very
useful	when	you	 are	 recording	 any	observation	or	 results	 of	 an	 experiment	 and	need	 to
record	the	exact	time	anything	happens.					

The	date	and	time	are	based	on	the	computer’s	internal	clock.	This	function	is	the	easiest
to	use.	All	you	have	to	do	is	enter	the	following	formula	in	the	destination	cell	and	Excel
will	put	the	current	date	and	time	in	it.

=NOW()

	

By	default,	the	NOW	function	uses	the	“d/mm/yyyy	hh:mm”	format,
that	is	it	puts	the	date	before	the	time.	You	can	change	this	format	by
creating	 a	 desired	 custom	 format	 and	 then	 applying	 it	 over	 the	 cell
containing	the	NOW	function.

	

TIME	and	TIMEVALUE

The	TIME	function	in	Excel	yields	a	decimal	number	that	represents	the	serial	number	of
the	underlying	 time	value.	The	serial	number	 ranges	 from	0	 (zero)	which	 represents	 the
time	0:00:00	and	goes	up	to	0.99999999	representing	time	23:59:59.

The	TIME	function	is	used	to	combine	the	hour,	minutes	and	seconds	into	one	value.	You
can	say	this	as	the	opposite	of	HOUR,	MINUTE,	and	SECOND	functions	that	separate	a
time	value	into	the	corresponding	component.

To	use	the	TIME	function,	enter	the	following	argument	in	the	destination	cell:

=TIME(hour,minute,second)



Remember	the	following	while	using	the	TIME	function.

	 	 	 	 	 	 	When	entering	the	hour	value,	use	a	number	between	0	and	23.	If	you	type	a
number	greater	than	23,	Excel	divides	it	by	24	and	then	puts	the	resulting	value	in
the	‘hour’	part	of	the	TIME	formula.

	 	 	 	 	 	 	Likewise	when	entering	the	minute	value,	type	a	number	between	0	and	59.	If
you	enter	a	number	greater	than	59,	Excel	will	convert	into	hours	and	minutes.	The
hour	value	will	be	added	to	the	hour	part	of	the	TIME	formula.

							The	above	rule	applies	to	seconds	also.	That	is	when	you	enter	the	minute	value,
type	a	number	between	0	and	59.	If	you	enter	a	number	greater	than	59,	Excel	will
convert	 into	minutes	 and	 seconds.	The	minute	value	will	 be	 added	 to	 the	minute
part	of	the	TIME	formula.

Have	a	look	at	figure	19.2,	as	an	example.

Figure	19.2-	Example	of	the	TIME	Function

In	 this	example,	 it	 is	assumed	 that	cell	B1	contains	15,	cell	B2	contains	45	and	cell	B3
contains	30.	The	following	formula	is	entered	in	cell	B4.

=TIME(B1,B2,B3)	

The	 resulting	value	combined	all	 the	 three	 input	values	and	 returned	one	 time	value.	 In
cell	B5,	we	have	applied	general	number	format	to	the	resulting	value.	This	is	 the	serial
number	for	3:45	PM.	In	cell	B6,	we	have	changed	the	formatting	of	the	resulting	value	to
include	the	seconds	as	well.	

Exploring	Common	Date	Functions

The	following	section	explains	the	important	and	useful	Date	functions	in	Excel.	You	can
insert	 these	functions	manually	as	well	as	from	the	Date	and	Time	drop	down	list	 in	 the
Formulas	tab	on	the	Ribbon.

DATE	and	DATEVALUE



Just	like	the	TIME	function,	the	DATE	function	combines	different	values	into	one	date.
To	use	the	DATE	function,	enter	the	following	argument	in	the	destination	cell:

=DATE(year,month,day)

Example

=DATE(2009,10,6)

Entering	the	above	formula	would	return	the	following	value:	6-10-2009

This	 function	 comes	 in	 handy	 when	 you	 are	 working	 on	 large	 set	 of	 data	 containing
different	parts	of	the	date	in	different	cells.	You	can	combine	these	cells	to	get	the	full	date
at	one	place.			

	

TODAY

This	function	is	just	like	the	NOW	function.	You	can	use	it	to	put	the	current	date	in	a	cell.
It	 is	 also	 very	 easy	 to	 use.	 All	 you	 have	 to	 do	 is	 enter	 the	 following	 formula	 in	 the
destination	cell	and	Excel	will	put	the	current	it.

=TODAY()

The	TODAY	function	uses	the	“d/mm/yyyy”	format.	However,	you	can	change	this	format
by	 creating	 a	 desired	 custom	 format	 and	 then	 applying	 it	 over	 the	 cell	 containing	 the
TODAY	function.

	

Do	 not	 use	 the	TODAY	 function	 to	 record	 historical	 data.	 The	 date
returned	 from	 the	 TODAY	 function	 is	 not	 fixed.	 In	 other	 words,	 it
changes	whenever	you	open	the	worksheet	containing	it.	For	example,
if	you	use	this	function	today,	the	resulting	value	will	display	today’s
date.	When	you	will	open	the	same	worksheet	tomorrow,	the	resulting
value	will	then	display	tomorrow’s	value	and	so	on.

	

WEEKNUM

You	can	use	the	WEEKNUM	function	to	find	out	where	the	week	in	a	particular	date	falls
within	the	year.



To	use	the	WEEKNUM	function,	enter	the	following	argument	in	the	destination	cell:

=WEEKNUM(serial_number,[return_type])

In	this	function,	the	first	argument	implies	the	serial	number	of	the	date	whose	week	you
want	 to	 find	out.	The	 second	 argument	 (return_type)	 is	 an	optional	 argument.	 It	 can	be
either	1	or	2.	If	you	enter	1,	it	means	that	you	want	Excel	to	consider	Sunday	as	the	first
day	of	the	week.	If	you	enter	2,	it	means	that	Excel	should	count	Monday	as	the	first	day
of	the	week	and	then	perform	the	calculation	accordingly.

	

If	you	don’t	enter	either	1	or	2,	it	is	considered	as	1	by	Excel.

	

	

For	example,	entering	the	following	formula	in	a	cell	would	return	the	value	26.

=WEEKNUM(DATE(2013,6,25))

In	the	above	formula,	the	serial	number	argument	was	replaced	with	the	DATE	function.

The	 resulting	value	 is	26,	 it	means	 that	 this	particular	date	 lies	 in	 the	26th	week	of	year
2013.

NETWORKDAYS

The	 NETWORKDAYS	 is	 used	 to	 calculate	 the	 number	 of	 working	 days	 between	 two
dates.	

To	 use	 the	NETWORKDAYS	 function,	 enter	 the	 following	 argument	 in	 the	 destination
cell:

=	NETWORKDAYS(start_date,end_date,[holidays])

The	third	argument	(holidays)	is	optional.	You	can	put	the	number	of	holidays	observed	by
your	 company.	 Doing	 so	 will	 command	 Excel	 to	 subtract	 the	 holidays	 from	 the	 total
number	of	working	days.

Figure	19.3	shows	an	example	of	this	function.



Figure	19.3	-	Using	the	NETWORKDAYS	Function	to	Calculate	the	Number	of	Working	Days	in	2013

As	you	see	in	Figure	19.3,	column	B	(range	B5:B19)	contains	the	dates	of	all	the	public
holidays	in	2013.

The	 following	 formula	 is	entered	 in	cell	E5	 to	calculate	 the	working	days	 including	 the
mentioned	holidays:

=NETWORKDAYS(DATE(2012,12,31),DATE(2013,12,31))

The	 following	 formula	 is	 entered	 in	 cell	 E6	 to	 calculate	 the	 working	 days	 less	 the
mentioned	holidays:

=NETWORKDAYS(DATE(2012,12,31),DATE(2013,12,31),B5:B19)

DAYS360

The	DAYS360	function	can	be	used	to	calculate	the	number	of	days	passed	between	two
dates.

	

The	 DAYS360	 function	 is	 based	 on	 a	 360-day	 year.	 It	 assumes	 12
equal	months	of	30	days	each	in	a	year.

	

To	use	the	DAYS360	function,	enter	the	following	argument	in	the	destination	cell:

=	DAYS360(start_date,end_date,[method])

The	first	two	arguments	are	the	serial	numbers	representing	the	particular	dates.

	



To	 convert	 a	 date	 into	 serial	 number,	 format	 the	 particular	 cell	 with
General	Number	format.		

	

The	 third	 argument	 (method)	 in	 the	 DAYS360	 function	 is	 optional.	 It	 could	 be	 either
TRUE	or	FALSE.

If	you	enter	TRUE,	Excel	will	use	the	U.S.	calculation	method.	In	this	method,	the	starting

date	is	same	as	the	31st	of	the	month,	it	is	considered	as	equivalent	to	the	30th	of	the	same

month.	Likewise,	if	the	ending	date	is	equal	to	the	31st	of	a	month	and	the	starting	date	is

before	than	the	30th	of	the	month,	then	the	ending	becomes	the	first	day	of	the	next	month.

If	you	enter	FALSE	in	the	method	argument,	Excel	uses	the	European	calculation	method.

According	to	this	method,	the	starting	and	ending	dates	that	lies	on	the	31st	of	a	month	are

equal	to	the	30th	of	the	same	month.

Example

Suppose	Cell	A1	contains	Start	Date	(5-15-2006)	and	Cell	A2	contains	End	Date	(5-15-
2006)

=DAYS360(A1,A2,1)

Entering	 the	above	formula	 in	a	blank	cell	will	 return	1221;	 that	 is,	 the	number	of	days
passed	between	the	two	mentioned	dates.	



	





W
Chapter	20:	Some	Commonly	Used	Formulas

hile	Excel	 contains	 a	 function	 for	 almost	 every	 type	of	 formula	 you	want	 to
create,	the	summing	and	counting	functions	are	the	ones	highly	used.	Most	of
the	operations	and	activities	done	in	Excel	involves	SUM	or	COUNT	function

or	a	subset	of	either.					

This	 chapter	 explains	 some	 of	 the	most	 commonly	 used	 functions	 of	 Excel.	 The	 basic
SUM	and	COUNT	 functions	 are	 quite	 easy	 to	 used,	 however	 this	 is	 not	what	 the	 basic
mathematical	functions	are	all	about.	There	are	several	advanced	summing	and	counting
functions	 that	are	not	easy	 to	perform	 initially	but	once	you	get	proficient	 in	 these,	you
will	find	them	very	useful	and	valuable.

Coming	forward,	this	chapter	presents	description	and	examples	of	the	valuable	and	most
handy	summing	and	counting	functions.							

The	Simple	SUM	Formula

The	first	and	most	basic	mathematical	function	in	Excel	is	SUM.	As	the	name	suggests,	it
totals	the	values	or	references	specified	in	the	formula.	

To	use	the	SUM	function,	enter	the	following	argument	in	the	destination	cell:

=SUM(number1,	number2,	…)

The	number	arguments	can	either	be	simple	numeric	values	or	cell	references	or	you	can
also	select	a	range.

The	 SUM	 function	 only	 considers	 numeric	 values	 and	 cells	 that
contain	 these.	 It	 ignores	 the	 text	 and	 logical	 values,	 as	well	 as	 the
blank	cells.	

	

SUM	is	such	a	popular	and	highly	used	function	that	Microsoft	has	placed	it	several	places
in	Excel.	Apart	from	being	present	in	the	Formula	tab	and	Insert	Function	dialog	box,	you
will	find	it	in	the	Editing	group	on	the	Home	tab,	as	shown	in	Figure	20.1.



Figure	20.1	-	Showing	the	SUM	Function	on	the	Home	Tab

Just	select	the	cells/values	that	you	want	to	sum,	then	click	then	click	the	SUM	icon	on	the
Home	tab.

For	Keyboard	users,	press	Alt	+	=	to	enter	the	SUM	function.				



Formula	to	Count	the	Blank

Excel	provides	a	way	to	count	the	number	of	blank	cells	in	a	range.	It	can	be	done	via	the
COUNTBLANK	function.

To	use	the	COUNTBLANK	function,	enter	the	following	argument	in	the	destination	cell:

=	COUNTBLANK(range)

	

The	COUNTBLANK	function	works	only	with	an	adjacent	 range	of
cells.	 If	 you	 select	 a	 noncontiguous	 range	 in	 the	 range	 argument,	 it
shows	a	#VALUE!	error.	

	

This	 function	 comes	 in	 handy	when	you	need	 to	 find	 the	 number	 of	 empty	 cells	 in	 the
entire	worksheet.	Suppose	you	want	to	find	the	number	of	blank	cells	in	Sheet4.	To	do	so,
enter	the	following	formula	in	a	cell	in	any	sheet	other	then	Sheet	4.

=COUNTBLANK(Sheet4!1:1048576)

The	1:1048576	selects	the	entire	sheet.	This	value	will	remain	the	same	as	every	sheet	has
the	name	number	of	total	cells.

Make	sure	the	destination	cell	lies	in	any	other	worksheet	then	the	one
entered	in	the	formula,	or	else	Excel	will	display	a	circular	reference
error.

	

Formula	to	Count	Filled	Cells

Just	like	Excel	provides	a	way	to	count	blank	cells,	there	is	a	function	to	count	the	filled
cells.	The	COUNTA	function	returns	the	number	of	filled	cells	in	the	specified	range.

To	use	the	COUNTA	function,	enter	the	following	argument	in	the	destination	cell:

=COUNTA(value1,[value2],…)

You	don’t	 have	 to	 enter	 the	 cell	 references.	 Just	 enter	 the	 function,	 select	 the	particular
range,	close	the	parentheses	and	hit	Enter.	



=COUNTA(A1:B5)

For	 example,	 entering	 the	 above	 formula	 will	 return	 the	 number	 of	 filled	 cells	 in	 the
specified	range	(A1:B5).			

Value	Based	Counting	Formulas

The	COUNTA	function	counts	cells	that	contain	any	types	of	values.	It	could	be	numeric,
text,	or	 logical	values.	Moreover,	 if	a	cell	contains	a	 formula	whose	 resulting	value	 is	a
blank	cell	or	zero,	it	is	also	counted	by	COUNTA.

But	what	if	you	need	to	count	the	cells	containing	numeric	values	only?	Or	just	 the	text
values?	Well,	Excel	also	provides	a	way	to	count	a	specific	type	of	value.

How	to	Count	Cells	Containing	Numeric	Value

Enter	 the	 following	 argument	 in	 the	 destination	 cell	 to	 count	 the	 numeric	 cells	 in	 a
particular	range.

=COUNT(value1,[value2],…)

You	don’t	have	to	enter	each	value.	Just	enter	the	function,	select	 the	particular	range	in
which	 you	 want	 to	 count	 the	 number	 of	 numeric	 values,	 close	 the	 parentheses	 and	 hit
Enter.	

Example

=COUNTA(A1:B5)

Entering	 the	 above	 formula	 will	 return	 the	 number	 of	 filled	 cells	 containing	 numeric
values	in	the	specified	range	(A1:B5).			

	

Date	and	Time	values	are	also	considered	as	numeric	values	by	the
COUNT	 function.	 Hence	 if	 your	 selected	 range	 contains	 any	 of
these,	 the	 number	 of	 Date	 and	 Time	 cells	 will	 be	 counted	 and
returned	to	the	destination	cell.		

	

	

	

How	to	Count	Cells	Containing	Text	Value



If	you	want	to	count	the	number	of	cells	containing	text	values,	enter	the	following	array
argument	in	the	destination	cell:

=SUM(IF(ISTEXT(range),1))

While	entering	 the	above	formula,	select	 the	particular	range	 in	 the	range	argument	and
the	rest	of	the	formula	remains	the	same.

Example

=SUM(IF(ISTEXT(A1:B6),1))

Entering	the	above	formula	and	then	pressing press	Ctrl	+	Shift	+	Enter	will	 return	 the
number	of	filled	cells	containing	text	values	in	the	specified	range	(A1:B6).			

The	 above	 formula	 must	 be	 entered	 as	 an	 array	 formula,	 or	 else	 it
won’t	work	correctly.	To	do	so,	press	Ctrl	+	Shift	+	Enter	instead	of
Enter	after	you	close	the	last	parentheses	in	the	formula.		

	

Refer	to	Chapter	24	to	learn	more	about	Array	formulas.		



How	to	Count	Cells	Containing	Non-Text	Values

If	you	want	 to	count	 the	number	of	cells	containing	non-text	values,	enter	 the	following
array	argument	in	the	destination	cell:

=SUM(IF(ISNONTEXT(range),1))

While	entering	 the	above	formula,	select	 the	particular	range	 in	 the	range	argument	and
the	rest	of	the	formula	remains	the	same.

This	 formula	also	needs	 to	be	entered	as	 an	array	 formula.	You	need	 to	press	 	 	 	Ctrl	+
Shift	+	Enter	instead	of	Enter	after	putting	up	the	complete	formula.		

Example

=SUM(IF(ISNONTEXT(A1:B6),1))

Entering	the	above	formula	and	then	pressing press	Ctrl	+	Shift	+	Enter	will	 return	 the
number	of	filled	cells	containing	non-text	values	in	the	specified	range	(A1:B6).			

	

In	Excel,	the	array	formulas	are	represented	by	curly	parentheses	{}.
For	 example,	 the	 above	 array	 formula	 when	 entered	 in	 Excel	 will
display	as	following	in	the	formula	bar.

{=SUM(IF(ISNONTEXT(range),1))}.		

	

How	to	Count	Cells	Containing	Logical	Values

To	count	the	number	of	cells	containing	logical	values,	enter	the	following	array	argument
in	the	destination	cell:

=SUM(IF(ISLOGICAL(range),1))

This	one	is	also	an	array	formula,	hence	needs	to	be	entered	accordingly.

Example

=SUM(IF(ISLOGICAL(A1:B6),1))

Entering	the	above	formula	and	then	pressing press	Ctrl	+	Shift	+	Enter	will	 return	 the
number	 of	 filled	 cells	 containing	 logical	 values	 (True/False)	 in	 the	 specified	 range



(A1:B6).			

The	COUNTIF	Function

The	COUNTIF	function	is	 the	conditional	counting	function.	It	counts	the	cells	within	a
range	that	meets	a	certain	specified	criteria.

To	use	the	COUNTIF	function,	enter	the	following	argument	in	the	destination	cell:

=COUNTIF(range,criteria)

As	you	can	see	in	the	above	formula,	there	are	two	arguments	in	the	COUNTIF	function.
The	range	argument	refers	to	the	range	of	cells	in	which	you	want	to	count	the	particular
values.

The	criteria	argument	 includes	 the	criteria	for	 the	 inclusion	of	 the	cells	 in	counting.	For
example,	 the	 criteria	 could	 be	 entered	 as	 “25,	 “<45”,	 “pass”	 and	 so	 on.	 Suppose	 the
criteria	 is	 “<45”.	 Following	 this	 argument,	 Excel	 will	 count	 cells	 that	 contain	 numeric
value	 less	 than	 45.	Likewise,	 if	 the	 criterion	 is	 “pass”,	Excel	will	 return	 the	 number	 of
cells	containing	the	text	value	“pass”.	

The	COUNTIF	function	works	only	with	an	adjacent	range	of	cells.	If
you	 select	 a	 noncontiguous	 range	 in	 the	 range	 argument,	 it	 shows	 a
#VALUE!	error.	

	

AND	and	OR

At	times	you	may	want	to	enter	two	or	more	criteria	in	the	COUNTIF	formula.	The	AND
and	OR	arguments	allow	you	to	do	that.	

Applying	the	AND	Principle

If	you	use	an	AND	condition	in	a	COUNTIF	formula,	Excel	will	count	the	cells	if	all	the
specified	criteria	are	met.

To	use	the	AND	condition,	enter	the	following	argument	in	the	destination	cell:

=COUNTIFS(criteria_range1,criteria1,	criteria_range1,criteria1”)

The	first	argument	 requires	you	 to	enter	or	select	 the	 range	 in	which	you	want	Excel	 to
count	the	cells.	The	second	argument	is	the	criterion	for	the	corresponding	range.	You	can
enter	 as	many	 ranges	 and	 criteria	 you	want.	Once	 the	 formula	 is	 complete	 and	 you	 hit



Enter,	Excel	returns	the	number	of	cells	containing	values	that	fit	into	all	the	criteria.

Following	is	an	example	formula	using	the	AND	condition.		

=COUNTIFS(B4:G15,”>20000”,B4:G15,”<40000”)

The	above	formula	commands	Excel	to	count	the	number	of	cells	containing	value	above
20,000	and	below	40,000,	within	the	specified	range.	

The	 following	 formula	 is	 the	 alternative	 for	 the	 above	 formula.	 Both	 return	 the	 same
answer.	You	can	use	whichever	you	feel	is	easier.

=SUM((B4:G15>20000)*(B4:G15<40000))

The	SUM	formula	is	an	array	formula.	So	make	sure	to	press	Ctrl	+	Shift	+	Enter	instead
of	Enter	after	putting	up	the	complete	formula.		

Applying	the	OR	Principle

If	you	use	an	OR	condition	in	a	COUNTIF	formula,	Excel	will	count	the	cells	if	any	of	the
mentioned	criteria	is	met.

Following	is	an	example	of	the	OR	condition.

=COUNTIF(B4:G15,”>20000”)+COUNTIF(B4:G15,”<20000”)

Following	 this	 argument,	 Excel	 counts	 the	 cells	 that	 fall	 in	 either	 of	 the	 two	 specified
criteria.

	

Formula	to	Count	the	Number	of	Unique	Values	

Following	is	an	example	of	a	formula	that	would	calculate	the	number	of	unique	values	in
the	specified	range.

=SUM(1/COUNTIF(A1:G15,B4:G15))

Remember	it	is	an	array	formula,	hence	need	to	be	treated	as	one.

There	is	one	limitation	in	the	above	formula.	That	is,	if	the	specified	range	consists	of	any
blank	cells,	it	returns	an	error.

Following	is	the	alternative	to	the	above	formula.	You	can	use	it	when	the	range	includes
blank	cells	as	well.

=SUM(IF(COUNTIF(A1:G15,B4:G15)=0,””,1/COUNTIF(A1:G15,B4:G15)))



This	one	is	also	an	array	formula.

Applications	of	the	SUMIF	Function

Just	like	the	COUNTIF	is	the	conditional	counting	function,	the	SUMIF	is	the	conditional
summing	 function.	 This	 function	 commands	 Excel	 to	 total	 the	 values	 that	 fit	 in	 the
mentioned	criteria.

To	use	the	SUMIF	function,	enter	the	following	argument	in	the	destination	cell:

=SUMIF(range,criteria,[sum_range])

As	you	can	see	 in	 the	above	formula,	 there	are	 three	arguments	 in	 the	SUMIF	function.
The	 range	 argument	 contains	 values	 that	 indicate	whether	 to	 include	 a	 particular	 cell’s
value	in	the	sum.

The	 criteria	 argument	 includes	 the	 criteria	 for	 the	 inclusion	 of	 the	 cells	 in	 the	 totaled
value.	For	example,	the	criteria	could	be	entered	as	“<200,	“<850”	and	so	on.	Suppose	the
criteria	 is	 “<200”.	 Following	 this	 argument,	 Excel	 will	 total	 cells	 that	 contain	 numeric
value	less	than	200.

The	third	argument	(sum_range)	is	an	optional	argument.	It	refers	to	the	range	of	cells	that
you	want	 to	 sum.	 If	 you	don’t	 enter	 this	 argument,	 then	 by	 default	Excel	 considers	 the
range	selected	in	the	first	argument.	In	other	words,	you	need	to	enter	the	third	argument
only	if	the	range	and	sum_range	are	different.

Suppose	you	want	to	total	all	the	negative	values	in	a	range	named	“integers”.	To	do	so,
enter	the	following	formula	in	the	destination	cell.	

=SUMIF(integers,”<0”)

The	SUMIF	also	comes	in	handy	when	you	need	to	sum	the	total	value	that	lies	before	or
after	a	particular	date.	For	example,	the	following	formula	would	return	the	sum	of	values,
the	corresponding	due	date	of	which	is	after	February	1,	2012:	

=SUMIF(B4:G15,”>=”&DATE(2012,2,1))	





E
Chapter	21:	Creating	Formulas	for	Financial	Analysis

xcel	provides	the	most	diverse	and	widest	range	of	financial	functions	that	helps
you	 make	 almost	 any	 kind	 of	 money-related	 decision.	 Whether	 it	 is	 a	 simple
assessment	of	whether	you	should	buy	a	new	cell	phone	or	a	decision	as	large	as

starting	up	your	own	business,	you	will	find	a	function	and	formula	for	it	in	Excel.

The	list	of	financial	functions	provided	by	Excel	is	endless.	While	they	are	all	briefed	in
the	 appendix	 section	 of	 this	 book,	 this	 chapter	 discusses	 some	 of	 the	 most	 handy	 and
commonly	used	financial	functions.								

Formulas	to	Calculate	Depreciation

Depreciation	 refers	 to	 the	 value	 of	 an	 asset	 at	 a	 certain	 point	 of	 time.	 The	 value	 is
estimated	on	the	basis	of	the	original	value	of	the	asset	and	its	lifetime.

Excel	provides	five	functions	to	calculate	the	depreciation	of	an	asset	over	time;	namely,
SLN,	VBD,	DDB,	DB	and	SYD.		Each	function	represents	a	different	type	of	depreciation
method.

While	 there	 is	 a	 different	 formula	 for	 every	 depreciation	 function,	 following	 are	 the
common	arguments	used	in	almost	every	function.

Cost:	Underlying	cost	of	the	asset.

Start_Period:	Starting	period	for	the	calculation.

End_Period:	Ending	period	for	the	calculation.

Salvage:	The	cost	of	the	asset	after	it	has	been	completely	depreciated.

Life:	Time	period	over	which	the	asset	will	depreciate.

Period:	 Time	 period	 in	 the	 life	 of	 the	 asset	 for	 which	 the	 depreciation	 value	 is	 to	 be
calculated.

No_switch:	 It	could	be	either	1	 (TRUE)	or	0	 (FALSE).	 It	 indicates	whether	 to	 toggle	 to
straight	line	depreciation	method	in	case	the	SL	depreciation	is	greater	than	the	declining
balance	depreciation	value.

Factor:	Rate	at	which	value	of	the	asset	declines.

SLN

The	SLN	function	uses	the	straight	line	depreciation	method	for	calculating	the	value	of



an	asset	over	a	single	period.	This	method	assumes	that	the	asset	depreciates	by	an	equal
amount	every	period	till	it	is	fully	depreciated.

To	use	the	SLN	function,	enter	the	following	argument	in	the	destination	cell:

=SLN(cost,salvage,life)

Figure	21.1	shows	an	example	of	using	the	SLN	function.

Figure	21.1	-	Example	of	Calculating	the	Straight	Line	Depreciation	Value	in	Excel

In	 this	 example,	 the	asset	 is	 a	heavy	duty	printing	machine	 that	 is	originally	bought	 for
$15,000.	It	has	a	life	of	8	years	and	a	salvage	value	of	$1,200.	The	following	formula	is
applied	in	the	destination	cell	(Cell	B5):

=SLN(B1,B3,B2)

The	resulting	value	implies	that	the	asset	is	depreciated	each	year	by	$1,725	

VDB

The	VDB	function	uses	the	Variable	Declining	Balance	depreciation	method.	It	calculates
the	depreciation	value	of	an	asset	for	a	specific	period	of	 time	(it	could	be	the	complete
life	of	the	asset	or	a	partial	period).	The	VDB	method	uses	the	double	declining	balance	or
another	accelerated	depreciation	method	that	you	specify.				

To	use	the	VDB	function,	enter	the	following	argument	in	the	destination	cell:

=VDB(cost,salvage,life,start_period,end_period,[factor],[no_switch)

The	 start_period	 and	 end_period	 argument	 specifies	 the	 time	 period	 for	 which	 the
depreciation	is	to	be	calculated.	It	could	be	any	length	of	time	during	the	life	of	the	asset.

While	all	the	arguments	are	necessary,	the	factor	and	no_switch	arguments	are	optional.	If
you	 don’t	 enter	 the	 factor,	 it	 is	 assumed	 as	 2	 by	 Excel	 which	 represents	 the	 double
declining	balance	method.	In	other	words,	skipping	the	factor	argument	implies	that	you



want	Excel	to	use	double	declining	balance	method	to	calculate	depreciation.

Likewise,	 the	 no_switch	 argument	 is	 optional.	 If	 you	 skip	 this	 one,	 by	 default	 Excel
assumes	it	as	FALSE,	hence	toggles	to	the	straight	line	depreciation	method.	

DDB

The	DDB	function	uses	the	Double	Declining	Balance	depreciation	method.	It	calculates
the	 depreciation	 value	 of	 an	 asset	 at	 an	 accelerated	 rate.	 As	 per	 the	 DDB	method,	 the
depreciation	 value	 of	 an	 asset	 is	 at	 its	 peak	 in	 the	 first	 period	 of	 its	 life,	 then	 declines
gradually	in	the	subsequent	periods.

To	use	the	DDB	function,	enter	the	following	argument	in	the	destination	cell:

=DDB(cost,salvage,life,period,[factor])

	

Make	sure	you	use	the	same	units	for	life	and	period.	For	example,	if
the	 life	 of	 the	 asset	 is	 expressed	 in	 years,	 period	 must	 also	 be	 in
years.	

The	factor	argument	is	optional.	If	omitted,	it	is	assumed	as	2	by	Excel,	hence	the	double
declining	balance	method	is	used.	If	you	enter	3	in	the	factor	argument,	Excel	applies	the
triple	declining	balance	method	to	calculate	the	depreciation.

Continuing	 the	 same	example	 as	discussed	 in	 the	 straight	 line	depreciation,	Figure	21.2
shows	the	DDB	depreciation	of	the	printing	machine.

Figure	21.2	-	Example	of	Using	the	DDB	Function	in	Excel

The	following	formula	is	entered	in	cell	B6	to	find	the	DDB	depreciation	value.

=DDB(B1,B3,B2,2)



The	‘2’	in	the	above	formula	represents	the	period.	It	means	that	double	declining	balance
depreciation	for	the	second	year	is	$2,813.

As	you	see	in	Figure	21.2,	the	DDB	value	for	third	year	is	less	than	the	second	year.	This
is	because	in	DDB	method,	the	depreciation	value	declines	as	time	passes.

	

DB

The	DB	function	uses	the	Declining	Balance	depreciation	method.	It	works	the	same	way
as	the	DDB	method	except	for	one	difference;	and	that	is,	the	DB	method	uses	the	fixed
declining	 balance	 method	 to	 compute	 the	 depreciation	 value.	 In	 other	 words,	 the	 DB
method	calculates	the	depreciation	at	a	fixed	rate.

To	use	the	DB	function,	enter	the	following	argument	in	the	destination	cell:

=DB(cost,salvage,life,period,[month])

While	 all	 the	 other	 arguments	 in	 the	 DB	 function	 are	 same,	 except	 for	 the	 month
argument.	It	is	an	optional	one	that	specifies	the	number	of	months	depreciated	in	the	first
year.	It	omitted,	Excel	assumes	it	as	12	months.

Figure	 21.3	 extends	 the	 same	 printing	 machinery	 example	 to	 include	 the	 DB	 value	 of
depreciation.			

Figure	21.3	-	Extending	the	Printing	Machinery	Example	to	Calculate	the	DB	Value	of	Depreciation.			

	

SYD	

The	SYD	function	uses	“Sum	of	the	Years’	Digits”	depreciation	method	which	distributes
a	large	percentage	of	the	depreciation	value	in	the	initial	years	of	the	asset’s	life.

To	use	the	SYD	function,	enter	the	following	argument	in	the	destination	cell:



=SYD(cost,salvage,life,period)

Make	sure	you	use	the	same	units	for	life	and	period.

Formulas	to	Analyze	Investment

This	section	discusses	the	functions	that	help	you	analyze	cash	flows	and	investments.		

Following	are	the	common	arguments	used	in	the	investment	related	financial	functions.

Rate:	Interest	rate	per	period.

Future	value	(fv):	Value	of	an	investment	at	the	end	of	the	period.

Reinvestment	rate:	The	rate	at	which	the	underlying	investment	money	is	reinvested.

value1,	value2,…:	Cash	inflows	and	periodic	payments.

Type:	 Period	 when	 the	 payment	 is	 to	 be	 made.	 This	 argument	 can	 either	 be	 0	 (end	 of
period)	or	1	(beginning	of	period).

Present	value	(pv):	Value	of	the	asset/investment	today.

Guess:	Initial	discount	rate	for	iterative	calculations.

Period:	Number	of	periodic	payments.

Finance	rate:	The	rate	at	which	the	investment	amount	is	borrowed.

PV

PV	is	the	function	used	to	calculate	the	present	value	of	an	investment.	It	is	also	used	as	an
argument	in	some	other	financial	functions.

Present	Value	is	the	one	of	the	most	widely	used	methods	to	evaluate	the	feasibility	of	a
business	venture.	Simply	put,	PV	is	the	underlying	principal	value	of	the	investment.	It	is
calculated	 by	 discounting	 the	 cash	 inflows,	 that	 is	 the	 payments	 received	 from	 the
investment,	 back	 to	 the	 present	 time.	 If	 the	 PV	value	 is	 above	 the	 initial	 investment,	 it
means	the	underlying	investment	is	profitable.	

In	Excel,	you	need	to	enter	the	following	argument	to	calculate	PV:

=	PV(rate,nper,pmt,[fv],[type])

nper:	Number	of	payment	periods	for	a	loan.

pmt:	Payment	amount	per	period.

fv:	It	is	optional	argument.	If	omitted,	Excel	assumes	it	to	be	0	(zero).



type:	This	one	is	also	an	optional	argument.	If	omitted,	Excel	considers	it	as	zero	(that	is,
the	end	of	the	period).

Figure	21.4	shows	an	example	of	the	PV	function.

Figure	21.4	-	Example	of	Using	the	PV	Function	in	Excel.

In	 this	example,	 the	 investment	amount	 is	borrowed	for	a	36-month	period	at	an	annual
interest	rate	of	8%.	The	expected	monthly	payment	on	this	amount	is	$121.8.

The	following	formula	is	entered	in	the	destination	cell	(B5)	to	calculate	the	PV.

=PV(B1/12,B2,-B3)

NPV

The	NPV	function	is	used	to	calculate	the	Net	Present	Value	of	an	investment.	If	the	NPV
is	greater	than	zero,	it	means	the	investment	is	profitable.

To	calculate	NPV	of	an	investment	in	Excel,	enter	the	following	argument:

=NPV(rate,value1,[value2],…)

	

FV

The	 FV	 investment	 evaluation	 method	 is	 the	 exact	 opposite	 of	 the	 PV	 method.	 It
calculates	the	future	value	of	an	investment	at	some	future	period	in	time.

To	calculate	FV	of	an	investment	in	Excel,	enter	the	following	argument:

=FV(rate,nper,pmt,[pv],[type])

IRR

The	IRR	function	is	used	to	calculate	the	internal	rate	of	return	of	an	investment.	IRR	is
the	 discount	 rate	 at	 which	 the	NPV	 is	 equal	 to	 zero.	 In	 other	words,	 it	 is	 the	 rate	 that
equates	the	PV	of	the	inflows	to	the	initial	cost	of	the	investment.



If	 the	 IRR	 is	 greater	 than	 the	underlying	 rate,	 it	means	 the	 investment	 is	 profitable	 and
vice	versa.

To	calculate	IRR	of	an	investment	in	Excel,	enter	the	following	argument:

=IRR(values,[guess])

The	IRR	method	assumes	that	the	payments	are	made	at	the	end	of	a	period.	Guess	is	an
optional	argument.	If	you	don’t	enter	it,	Excel	assumes	it	to	be	10%.	

Figure	21.5	illustrates	an	example	of	calculating	IRR	in	Excel.

Figure	21.5	-	Illustrating	an	Example	of	Calculating	IRR	in	Excel

In	this	example,	it	is	assumed	that	a	person	wants	to	buy	a	townhouse	worth	$300,000.	He
then	plans	to	rent	the	townhouse	for	the	next	10	years.	The	first	year’s	rent	is	expected	to
be	$42,000,	 increasing	by	$900	every	year	over	 the	 remaining	9	years.	To	calculate	 the
IRR	of	this	investment,	the	following	formula	is	entered	in	the	destination	cell	(B13):

=IRR(B1:B11)

	

The	 first	 value	 in	 the	 selected	 range	 is	 the	 initial	 investment	 and	 it
must	be	entered	as	a	negative	value,	or	else	Excel	 returns	a	#NUM!
error.

As	you	can	see	in	Figure	21.5,	the	IRR	of	the	particular	investment	is	calculated	to	be	8%.
If	 the	 cost	 of	 investment	 (hurdle	 rate)	 is	 less	 than	 8%,	 it	 means	 that	 it’s	 a	 profitable
investment.



MIRR

The	MIRR	function	computes	the	Modified	Internal	Rate	of	Return	of	an	investment.

The	MIRR	method	comes	in	handy	when	you	intend	to	reinvest	the	profit	generated	from
the	underlying	investment.

To	calculate	MIRR	of	an	investment	in	Excel,	enter	the	following	argument:

=MIRR(values,finance_rate,reinvest_rate)

This	formula	assumes	that	all	the	transactions	take	place	at	the	end	of	a	period.

The	first	value	 in	 the	selected	range	is	 the	 initial	 investment	and	it	must	be	entered	as	a
negative	value,	or	else	Excel	returns	a	#NUM!	error.

Formulas	to	Valuate	Stocks	and	Securities

Stocks	 and	 securities	 are	 also	 a	kind	of	 investment.	While	 there	 are	numerous	 financial
functions	that	you	can	use	to	valuate	equity	and	stock,	the	ones	discussed	in	this	section
are	 meant	 specifically	 for	 analyzing	 different	 types	 of	 securities.	 Following	 are	 the
common	arguments	used	in	such	functions.

Investment:	Investment	amount.

Coupon:	Annual	coupon	rate	of	the	security

Basis:	Specifies	 the	 type	of	day	count	basis	of	 the	security.	By	default	or	 if	not	entered,
Excel	assumes	it	to	be	0	(zero).	It	means	a	US	(NASD)	30/360	day	count	basis.	The	basis
values	could	also	be	1	=	day	count	basis	is	actual/actual;	2	=	actual/360;	3	=	actual/365;	4
=	European	30/360.

Redemption:	The	value	of	security	at	the	time	of	redemption.

Frequency:	 Number	 of	 coupon	 payments	 per	 year.	 	 If	 frequency	 is	 1,	 it	 means	 annual
payments	(one	payment	made	per	year).	Likewise,	2	specify	semiannual	payments	and	4
means	quarterly	payments.

Par:	Par	value	(face	value)	of	the	security.	By	default	or	if	omitted,	Excel	assumes	it	to	be
$1,000.

Price/Pr:	Current	price	of	the	security

Issue:	Specifies	the	issue	date	of	the	security	(the	date	the	security	is	issued)

Settlement:	 Specifies	 the	 settlement	 date	 of	 the	 security	 (the	 date	 on	 which	 you	 are



supposed	to	pay	for	it.	This	date	must	be	higher	than	the	issue	date.

Maturity:	 Specifies	 the	 maturity	 date	 of	 the	 security	 (the	 date	 on	 which	 the	 security
matures).	This	date	must	be	ahead	than	the	settlement	date.

Rate:	The	interest	rate	of	the	security	at	the	issue	date.	This	rate	must	be	equal	to	or	higher
than	zero.

First_interest:	The	first	interest	date	of	the	security.

Yield:	Specifies	the	annual	yield	of	the	security.	This	rate	must	be	equal	to	or	higher	than
zero.

DOLLARDE	and	DOLLARFR

The	DOLLARDE	function	converts	the	fractional	price	of	a	currency	and	security	into	a
decimal	value.	

To	use	the	DOLLARDE	function	in	Excel,	enter	the	following	argument:

=DOLLARDE(fractional_dollar,	fraction)

=DOLLARDE(1.5,8)

In	 the	above	example,	Excel	will	convert	1.5	 to	a	decimal	number	(answer:	1.625).	The
fraction	value	is	10	signifies	that	the	resulting	price	value	has	a	precision	of	1/8	of	a	dollar.

The	 DOLLARFR	 performs	 the	 opposite	 of	 the	 DOLLARDE	 function.	 It	 converts	 the
value	of	a	security	initially	expressed	in	decimals	into	a	fractional	value.	

To	use	the	DOLLARFR	function	in	Excel,	enter	the	following	argument:

=DOLLARDE(decimal_dollar,	fraction)

=DOLLARFR(1.625,8)

Entering	the	above	formula	in	Excel	will	return	the	dollar	in	fractional	value	(answer:	1.5).

	

The	 arguments	 used	 in	 the	 DOLLARDE	 and	 DOLLARFR	 functions	 are	 briefed	 as
follows:

Fractional	dollar:	The	fractional	value	separated	by	a	decimal	symbol.

Fraction:	Specifies	the	value	that	is	to	be	used	in	the	denominator	of	the	fraction.	

Decimal_dollar:	The	underlying	value	of	the	security	expressed	in	decimal	number.	



ACCRINT	and	ACCRINTM

The	ACCRINT	 function	 in	Excel	 calculates	 the	 interest	 accrued	by	 a	 security	 that	 pays
periodic	interest.

To	use	the	ACCRINT	function	in	Excel,	enter	the	following	argument:

=	ACCRINT(issue,first_interest,settlement,rate,par,	frequency,[basis],[calc_method])

All	 the	 arguments	 are	 explained	 in	 the	 beginning	 of	 this	 section,	 except	 for	 the
calc_method	one.

The	calc_method	argument	contains	a	 logical	value	 that	 indicates	 the	way	of	calculating
the	total	accrued	interest.	This	argument	is	required	when	the	settlement	date	is	later	than
the	first_interest	date.

The	calc_method	argument	 could	 either	 be	 1	 (TRUE)	 or	 0	 (FALSE).	 The	 former	 value
calculates	the	total	accrued	interest	from	the	issue	date	to	the	settlement	date,	whereas	the
latter	calculates	the	total	accrued	interest	from	the	first_interest	date	to	the	settlement	date.

Bu	default	or	if	omitted,	it	is	assumed	as	TRUE	by	excel.

Example

=ACCRINT(A1,A2,A3,A4,A5,A6)

Assuming,

A1	=	29500	(serial	number	of	issue	date)

A2	=	29656	(serial	number	of	the	first	interest	date)

A3	=	29568	(serial	number	of	the	settlement	date)

A4	=	10%	(Coupon	rate)

A5	=	1000	(par	value)

A6	=	4	(frequency	-	quarterly)

The	 resulting	 answer;	 that	 is	 18.6,	 shows	 the	 accrued	 interest	 of	 a	 security	 with	 the
specified	conditions.

DISC

The	DISC	function	computes	the	discount	rate	for	a	security.

To	use	the	DISC	function	in	Excel,	enter	the	following	argument:



=DISC(settlement,	maturity,	pr,	redemption,	[basis])

All	the	arguments	are	explained	in	the	beginning	of	this	section.

Figure	21.6	illustrates	an	example	of	using	the	DISC	function	in	Excel.

Figure	21.6	-	Calculating	Discount	Rate	Using	the	DISC	Function	in	Excel

As	 shown	 in	 the	 formula	 bar	 in	 Figure	 21.6,	 the	 following	 formula	 is	 entered	 in	 the
destination	cell	(B7)	to	calculate	the	discount	rate:

=DISC(B2,B3,B4,B5,0)

The	discount	rate	is	0.1674	or	16.74%.

INTRATE

The	INTRATE	function	in	Excel	computes	the	interest	rate	for	a	fully	invested	security.

To	use	the	INTRATE	function	in	Excel,	enter	the	following	argument:

=INTRATE(settlement,	maturity,	investment,	redemption,	[basis])

RECEIVED

The	RECEIVED	function	computes	 the	amount	received	at	maturity	for	a	fully	 invested
security.

To	use	the	RECEIVED	function	in	Excel,	enter	the	following	argument:

=INTRATE(settlement,	maturity,	investment,	discount,	[basis])

Figure	21.7	shows	the	example	of	INTRATE	and	RECEIVED	functions.



Figure	21.7	-	Example	of	Using	the	INTRATE	and	RECEIVED	Functions	in	Excel

The	 following	 formulas	were	entered	 to	 calculate	 the	 interest	 rate	 and	 received	amount,
respectively.	

=INTRATE(B2,B3,B4,B5,0)

=RECEIVED(B2,B3,B4,B6,0)

	

Formulas	to	Analyze	Loans

This	 section	 explains	 the	 functions	 that	 can	help	you	 analyze	 and	 evaluate	 the	different
components	of	a	loan.	Most	of	these	functions	also	serve	as	arguments	in	the	investment
related	functions.	

RATE

The	RATE	 function	 computes	 the	 periodic	 interest	 rate	 of	 a	 loan.	 It	 uses	 the	 following
argument:

=RATE(nper,pmt,pv,[fv],[type],[guess])

All	the	arguments	are	explained	in	the	“Formulas	to	Analyze	Investment”	section	of	 this
chapter.	The	first	 three	arguments	are	mandatory	while	 the	 last	 three	are	optional.	 If	not
entered,	Excel	assumes	the	default	values	for	the	optional	arguments.	

Figure	21.8	shows	an	example	of	how	you	can	use	the	RATE	function	in	Excel.



Figure	21.8	-	Using	the	RATE	Function	in	Excel

The	following	formula	is	entered	in	the	destination	cell	(B6)	to	calculate	the	interest	rate
per	period:

=RATE(B2,B3,B4)

The	resulting	value	is	then	multiplied	by	12	to	calculate	the	annual	interest	rate.	

In	the	above	example,	PV	is	a	negative	value	hence	represents	the	money	owed.

NPER

The	NPER	function	calculates	the	number	of	payment	periods	for	a	loan.

To	use	the	NPER	function	in	Excel,	enter	the	following	argument:

=NPER(rate,pmt,pv,[fv],[type])

Other	then	fv	and	type,	all	the	other	arguments	are	necessary.

Continuing	the	same	example	as	illustrated	in	Figure	21.8,	the	following	formula	needs	to
be	entered	in	a	new	destination	cell	in	order	to	calculate	the	number	of	payment	periods.

=NPER(B6,B3,B4)

This	formula	returns	36	(means	36	months).	

	

The	rate	argument	in	the	NPER	function	uses	the	rate	per	period.	If
you	enter	annual	interest	rate,	Excel	may	return	a	#NUM!	error.	So
make	sure	you	enter	the	periodic	interest	rate.

PMT

The	 PMT	 function	 in	 Excel	 is	 used	 to	 calculate	 the	 loan	 payment	 per	 period.	 Loan
payment	includes	the	principal	plus	the	interest	amount.



To	use	the	PMT	function	in	Excel,	enter	the	following	argument:

=PMT(rate,nper,pv,[fv],[type])

The	last	two	arguments	(fv	and	type)	are	optional.

Example

=PMT(A1,A2,A3)

Assuming	the	following	values:

A1	=	10%	(rate)

A2	=	36	(nper)

A3	=	-	100,000	(pv)		

The	resulting	answer;	that	is	$10,334,	shows	the	loan	payment	per	period.

IPMT

As	 explained	 in	 the	 previous	 heading,	 the	 PMT	 function	 calculates	 the	 principal	 plus
interest	payment	per	period.	If	you	want	to	calculate	only	the	interest	payment,	you	can	do
so	by	using	the	IPMT	function.

The	 IPMT	 function	 assumes	 fixed	 payment	 amounts	 and	 a	 constant
interest	rate.

	

To	use	the	IPMT	function	in	Excel,	enter	the	following	argument:

=IPMT(rate,per,nper,pv,[fv],[type])

The	 last	 two	 arguments,	 fv	 and	 type	 are	 optional.	 If	 omitted,	 Excel	 assumes	 the	 default
values.

Figure	21.9	illustrates	an	example	of	using	the	IPMT	function	in	Excel.



Figure	21.9	-	Example	of	Using	the	IPMT	Function	in	Excel

The	 following	 formula	 is	 entered	 in	 the	 destination	 cell	 (B7)	 to	 calculate	 the	 interest
payment	per	period:

=IPMT(B2,B3,B4,B5)

The	formula	returns	an	interest	amount	of	$23.68.

The	 amount	 calculated	 through	 the	 IPMT	 function	 pertains	 to	 a	 single	 period	 only.
However,	 there	 is	 a	way	 to	 compute	 the	 cumulative	 interest	 paid	between	 two	payment
periods	as	well.	You	can	so	by	using	the	CUMIPMT	function.

The	CUMIPMT	function	uses	the	following	argument:

=	CUMIPMT	(rate,nper,pv,start_period,end_period,type)

There	 are	 a	 few	 major	 differences	 when	 it	 comes	 to	 the	 arguments	 in	 the	 IPMT	 and
CUMIPMT	 function.	 Firstly,	 the	 per	 argument	 is	 replaced	 by	 the	 start_period	 and
end_period	 argument.	This	 specifies	 the	 time	period	of	which	you	want	 to	calculate	 the
cumulative	interest.

Secondly,	 unlike	 the	 IMPT	 function,	 all	 the	 arguments	 in	 the	 CUMIPMT	 function	 are
mandatory.	 None	 is	 optional.	 You	 need	 to	 enter	 the	 timing	 of	 the	 payment	 in	 the	 type
argument.

Type	0	=	payment	at	the	end	of	the	period

Type	1	=	payment	at	the	beginning	of	the	period

	

While	 using	 the	 CUMIPMT	 function,	 make	 sure	 you	 use	 the	 same
units	for	nper,	start	period	and	end	period.	For	example,	if	the	nper	is
expressed	 in	 months,	 then	 the	 other	 two	 arguments	 must	 also	 be



entered	as	months.		

	

PPMT

Just	like	the	IMPT	function	calculates	the	interest	part	of	the	total	periodic	loan	payment,
the	PPMT	function	computes	the	principal	payment	part.

	

The	PPMT	function	assumes	 fixed	payment	 amounts	 and	a	 constant
interest	rate.

	

To	use	the	PPMT	function	in	Excel,	enter	the	following	argument:

=PPMT(rate,per,nper,pv,[fv],[type])

The	 last	 two	 arguments,	 fv	 and	 type	 are	 optional.	 If	 omitted,	 Excel	 assumes	 the	 default
values.

Just	like	the	IPMT	function,	the	principal	payment	amount	calculated	through	the	PPMT
function	 pertains	 to	 a	 single	 period	 only.	To	 compute	 the	 cumulative	 principal	 payment
paid	between	two	payment	periods,	you	need	to	use	the	CUMPRINC	function.

The	CUMPRINC	function	uses	the	following	argument:

=	CUMPRINC	(rate,nper,pv,start_period,end_period,type)

While	using	the	CUMPRINC	function,	make	sure	you	use	the	same	units	for	nper,	start
period	and	end	period.	For	example,	if	the	nper	is	expressed	in	quarterly	periods,	then	the
other	two	arguments	must	also	be	entered	as	quarters.		





E
Chapter	22:	Working	with	Statistical	Formulas

xcel	provides	innumerous	functions	that	can	help	you	do	the	statistical	analysis	of
your	 data.	 From	 the	 basic	 statistical	 functions	 such	 as	 AVERAGE,	 MEDIAN,
MODE	 to	 advanced	 functions	 like	 PERCENTILE,	 VAR	 and	 so	 on,	 the	 list	 of

statistical	functions	built	in	Excel	2013	is	endless.

While	 all	 the	 statistical	 functions	 are	 briefed	 in	 the	 appendix	 section	 of	 this	 book,	 this
chapter	discusses	the	most	popular	and	valuable	ones.				

	

To	insert	statistical	function	from	the	Formula	tab	on	the	Ribbon,	click
the	More	Functions	drop	down	menu	and	then	select	Statistical.	This
will	open	the	Statistical	category	of	the	Excel	functions.	For	keyboard
users:	hit	Alt	+	MQS.		

	

The	Basic	Average	Functions

The	most	 basic	 and	 commonly	 used	 statistical	 operation	 is	 average	 and	Excel	 provides
four	functions	to	perform	this	operation.	There	are	four	ways	to	calculate	the	average	of
the	 values	 in	 a	 range	 of	 cells;	 namely,	 	 AVERAGE,	 AVERAGEA,	 AVERAGEIF	 and
AVERAGEIFS.

The	first	and	most	basic	function	is	AVERAGE.	It	calculates	 the	arithmetic	mean	of	 the
numeric	values	in	the	selected	range	of	cells.



This	function	uses	the	following	argument:

=AVERAGE(number1,	[number2],…)

Now	you	don’t	have	to	refer	each	cell	separately.	Just	enter	the	function,	select	the	range
containing	the	values	you	want	to	find	the	average	of,	close	the	parentheses	and	hit	Enter.
You	can	enter	up	to	255	number	arguments	at	a	time	in	the	AVERAGE	function.	

AVERAGEA	is	another	handy	statistical	function	in	Excel.	It	uses	the	following	argument:

=AVERAGE(value1,	[value2],…)

As	you	must	have	noticed,	the	arguments	for	AVERAGE	and	AVERAGEA	are	exactly	the
same.

Well,	the	arguments	are	definitely	the	same,	difference	lies	in	the	mechanism	of	both	the
functions.	The	AVERAGE	function	calculates	the	arithmetic	mean	of	numeric	values	only.
It	ignores	the	blank	cells,	text	and	logical	values,	if	there	are	any	in	the	selected	range.	On
the	other	hand,	the	AVERAGEA	uses	all	types	of	values	in	the	calculation.

The	Conditional	Average	Function

This	 section	 discusses	 the	 remaining	 two	 average	 functions	 of	 Excel,	 namely
AVERAGEIF	and	AVERAGEIFS.	These	 are	 the	 conditional	 average	 functions.	 In	other
words,	 they	 allow	 you	 to	 specify	 criteria	 for	 the	 inclusion	 of	 cells	 in	 the	 average
calculation.	

To	use	the	AVERAGEIF	function,	enter	the	following	argument	in	the	destination	cell:

=AVERAGEIF(range,criteria,[average_range])

Here	is	the	brief	description	of	the	arguments	used	in	the	AVERAGEIF	function:

range:	Cell(s)	and	value(s)	to	average.

criteria:	 The	 criteria	 for	 the	 inclusion	 of	 cells	 in	 the	 average	 computation.	 The	 criteria
could	be	a	numeral,	 a	 text	or	 logical	value	or	any	cell	 reference.	Suppose	 the	criteria	 is
“>25”.	It	means	that	Excel	computes	the	average	of	values	that	are	greater	than	25	in	the
selected	range.	

average_range:	 It	 is	an	optional	argument.	 It	 refers	 to	 the	actual	 range	of	cells	 that	you
want	 to	compute	 the	average	of.	 If	you	don’t	enter	 this	argument,	 then	by	default	Excel
considers	 the	 range	selected	 in	 the	 first	argument.	 In	other	words,	you	need	 to	enter	 the



third	argument	only	if	the	range	and	average_range	are	different.

The	average_range	criterion	comes	in	handy	when	you	want	to	select	cell(s)	on	the	basis
of	the	content	in	the	row(s)	and	column(s)	but	the	actual	calculation	is	to	be	performed	in
the	values	carried	by	the	adjacent	row(s)	and	column(s),	respectively.

The	AVERAGEIFS	function	is	almost	the	same	as	the	AVERAGEIF	function,	except	for
one	difference;	and	that	is	the	allowance	to	add	more	than	one	criterion.

To	use	the	AVERAGEIFS	function,	enter	the	following	argument	in	the	destination	cell:

=AVERAGEIF(average_range,criteria_range1,criteria1,	[criteria_range2,criteria2],…)

You	 can	 select	 multiple	 ranges	 and	 specify	 a	 different	 criterion	 for	 each	 range.	 The
average_range	 argument	 refers	 to	 range	 of	 cells	 that	 contain	 the	 values	 you	 want	 to
average.	The	criteria_range	argument	specifies	 the	values	you	want	 to	compare	and	 the
criteria	argument	contains	the	criterion	for	the	corresponding	range.					

You	 can	 enter	 up	 to	 127	 criteria	 ranges	 and	 criteria	 arguments	 at	 a	 time	 in	 the
AVERAGEIFS	function.	

MIN	and	MAX

The	MIN	and	MAX	functions	 returns	 the	 largest	 and	 smallest	value,	 respectively	 in	 the
selected	range.

To	find	the	highest	value	in	a	range	of	cells,	enter	the	following	argument.

=MAX(number1,[number2],…)

To	find	the	lowest	value	in	a	range	of	cells,	enter	the	following	argument.

=MIN(number1,[number2],…)

=MIN(B3:C10)

Entering	the	above	formula	will	return	the	lowest	value	in	the	cell	range	B3:C10

MEDIAN

The	MEDIAN	 function,	 as	 the	 name	 suggests,	 computes	 the	median	 of	 the	 values	 in	 a
range	of	cells.	In	other	words,	it	returns	the	middle	number	in	the	selected	values;	that	is,	a
number	that	lies	exactly	in	the	center	of	the	equal	number	of	high	and	low	values.

If	 the	selected	range	includes	even	number	of	cells,	 the	median	would	be	the	average	of
two	values	that	lies	in	the	middle	of	data	set.



The	MEDIAN	function	uses	the	following	syntax:

=MEDIAN(number1,[number2],…)

You	don’t	have	 to	enter	 the	values	 individually	 in	 the	number	arguments.	Just	select	 the
particular	range	and	hit	Enter.				

Example

=MEDIAN(B3:C10)

The	above	formula	will	return	the	middle	number	in	the	cell	range	B3:C10

MODE.MULT

The	MODE.MULT	function	yields	a	vertical	array	of	the	repetitive	and	most	recurrently
occurring	values	in	the	selected	range	of	cells.						

	

The	 MODE.MULT	 function	 only	 considers	 numerical	 values.	 Text
and	 logical	 values,	 if	 any	 are	 ignored.	 Moreover,	 if	 there	 are	 not
repetitive	values	in	the	selected	range,	Excel	returns	#N/A	error	value.

	

To	use	the	MODE.MULT	function,	enter	the	following	argument	in	Excel:

=	MODE.MULT(number1,[number2],…)

	

To	return	the	repetitive	values	in	a	horizontal	array,	use	the	following
argument:

=TRANSPOSE(MODE.MULT(number1,number2,…)).

	

MODE.SNGL

The	MODE.SNGL	identifies	and	returns	the	most	repetitive	value	in	the	selected	range	of
cells.	If	there	are	no	duplicate	values,	it	displays	a	#N/A	error.

The	MODE.SNGL	function	uses	the	following	syntax:

=	MODE.SNGL(number1,[number2],…)



=MODE.SNGL(B3:E14)

Entering	 the	 above	 formula	 in	 Excel	 returns	 the	most	 repetitive	 value	 in	 the	 cell	 range
B3:E14.

PERCENTRANK

The	PERCENTANK	functions	determine	the	ranking	of	the	values	in	the	selected	range.
The	ranking	is	returned	in	terms	of	percentage	of	the	selected	values.

There	 are	 two	 types	 of	 PERCENTANK	 functions;	 namely,	 PERCENTRANK.INC	 and
PERCENTRANK.EXC.

Following	 is	 the	 brief	 description	 on	 the	 arguments	 used	 in	 the	 PERCENTRANK
functions.

array:	The	range	of	cells	containing	data	to	be	ranked.

X:	Specifies	the	value	whose	rank	you	want	to	determine

significance:		Specifies	the	level	of	precision	in	the	rank;	that	is,	how	many	decimal	digits
you	want	in	the	percentage.	This	argument	is	optional	and	if	omitted,	Excel	assumes	three
decimal	digits.

The	PERCENTRANK.INC	uses	the	following	syntax:

=	PERCENTRANK.INC(array,x,[significance])

You	can	use	this	function	to	analyze	the	relative	standing	of	a	value	in	a	set	of	data.	This
function	includes	all	 the	values	in	the	selected	range,	unlike	the	PERCENTRANK.EXC,
explained	as	follows.

The	PERCENTRANK.EXC	uses	the	following	syntax:

=	PERCENTRANK.EXC(array,x,[significance])

As	 you	 can	 see,	 both	 the	 functions	 hold	 the	 same	 syntax	 and	 arguments.	 The	 only
difference	 between	 them	 is	 that	 in	 the	 PERCENTRANK.INC	 function	 includes	 all	 the
values	in	the	selected	range,	whereas	the	PERCENTRANK.EXC	excludes	the	rankings	of
0%	and	100%	(0..1,)	from	the	data	set.

Figure	22.1	shows	an	example	where	the	PERCENTRANK	functions	are	used	to	evaluate
the	relative	performance	of	employees.	



Figure	22.1	-	Using	the	PERCENTRANK	Functions	in	Excel	to	Analyze	the	Comparative	Performance	of	Employees

In	 the	example	shown	in	Figure	22.1,	 the	following	formulas	are	entered	 in	cell	D3	and
D4	respectively.

=PERCENTRANK.INC($B$3:$B$13,B3)

=PERCENTRANK.EXC($B$3:$B$13,B3)

The	same	formula	is	dragged	down	to	cover	the	entire	range.	The	array	argument	contains
an	absolute	reference;	therefore	it	did	not	change	upon	dragging.

Using	the	PERCENTILE	Functions

The	PERCENTILE	function	works	the	other	way	round	the	PERCENTRANK	functions.
They	determine	the	value	in	the	selected	data	that	stands	at	a	specified	rank.

Just	 like	 the	 PERCENTANK	 function,	 the	 PERCENTILE	 function	 is	 of	 two	 types;
namely,	 PERCENTILE.INC	 and	 PERCENTILE.EXC.	 The	 former	 type	 includes	 all	 the
values	 in	 the	 selected	 range	whereas	 the	 latter	eliminates	 the	 rankings	of	0%	and	100%
(0..1,)	from	the	data	set.

Following	are	syntax	of	the	PERCENTILE	functions:

=PERCENTILE.INC(array,k)

=PERCENTILE.EXC(array,k)

array:	The	range	of	cells	containing	the	relative	data

K:	 it	 is	 the	 percentile	 value	 whose	 corresponding	 value	 you	 want	 to	 determine.	 This
argument	needs	to	be	entered	in	the	decimal	form.	For	example,	to	determine	which	value

represents	the	52nd	percentile	in	the	example	shown	in	Figure	22.1,	you	need	to	enter	the
following	formula	in	the	destination	cell.



=PERCENTILE.INC($B$3:$B$13,0.52)

Functions	to	Calculate	Population	Statistics

Variance	and	standard	deviation	are	 the	most	common	and	preferred	ways	of	measuring
dispersion	in	population	or	any	other	set	of	data.	

The	VAR	and	STDEV	functions	in	Excel	return	the	variance	and	standard	deviation	of	the
selected	data	set,	respectively.

There	are	different	forms	of	 the	VAR	and	STDEV	functions.	However	before	you	apply
any	 of	 them,	 you	 need	 to	 specify	 whether	 the	 underlying	 values	 represent	 the	 total
population	or	just	a	sample	of	it.	This	would	determine	the	form	of	function	you	are	going
to	use.

If	 you	use	 the	VAR.S	and	STDEV.S	 functions,	Excel	 assumes	 that	 the	 selected	data	 set
represent	the	sample	of	the	total	population.	On	the	other	hand,	the	VAR.P	and	STDEV.P
functions	assume	that	the	values	represent	the	total	population.

To	use	 the	VAR	and	STDEV	functions,	 enter	 the	appropriate	 following	argument	 in	 the
destination	cell.

=	VAR.S(number1,[number]2,…)

=	VAR.P(number1,[number]2,…)

=STDEV.S(number1,[number]2,…)

=	STDEV.P(number1,[number]2,…)

As	 you	 can	 see,	 all	 functions	 use	 the	 same	 arguments.	 The	 difference	 lies	 in	 the
assumptions	and	mechanism	of	the	function.

	

The	 VAR.S,	 VAR.P,	 STDEV.S	 and	 STDEV.P	 consider	 numerical
values	 only.	 If	 the	 selected	 range	 contains	 any	 text	 or	 logical	 value,
these	are	ignored	by	the	four	abovementioned	functions.

	

If	you	want	 to	 include	 the	 text	and	logical	values	 in	 the	variance	and	standard	deviation
calculation,	you	need	to	use	STDEVA	and	VARA	OR	STDEVPA	and	VARPA	functions.

Following	is	a	brief	explanation	of	these	functions.	The	arguments	and	way	of	using	these



is	the	same	as	in	case	of	the	non-text	forms	of	VAR	and	STDEV	functions.	

	

In	all	 the	below	explained	functions,	Text	values	and	FALSE	logical
values	are	evaluated	as	0	(zero).	A	TRUE	Logical	value	is	evaluated
as	1.

	

STDEVA:	Calculates	the	standard	deviation	of	the	entire	data,	including	text	and	logical
values.	This	function	assumes	that	the	data	set	represents	sample	population.						

VARA:	Computes	 the	variance	of	 the	selected	data,	 including	 text	and	 logical	values.	 It
assumes	that	the	data	set	represents	sample	population.								

STDEVPA:	Calculates	the	standard	deviation	of	the	entire	data,	including	text	and	logical
values.	This	function	assumes	that	the	data	set	represents	the	entire	population.								

VARPA:	It	is	similar	to	the	VARA	function,	except	that	it	assumes	that	the	selected	data
set	represents	the	entire	population.					

	



	





Chapter	23:	Introducing	the	Lookup	Formulas

Excel	provides	several	handy	and	amazing	lookup	functions	that	can	help	you	find	a	value
in	 Excel	 without	 having	 to	 skim	 through	 all	 the	 cells.	 The	 best	 example	 of	 a	 lookup
function	is	a	telephone	directory	maintained	in	Excel.	You	can	create	a	lookup	formula	to
locate	a	particular	name	and	contact	number	in	the	blink	of	an	eye.

This	 chapter	 explains	 in	 detail	 the	 different	 lookup	 functions	 and	 their	 application	 in
Excel.	You	will	learn	to	use	the	three	most	popular	and	handy	lookup	functions	along	with
several	other	formulas	to	lookup	an	exact	value	in	Excel	and	the	technique	to	work	with
the	MATCH	and	INDEX	functions	and	so	on.		

Get	To	Know	the	Lookup	Functions

The	 three	 basic	 lookup	 functions	 in	 Excel	 2013	 include	 LOOKUP,	 VLOOKUP	 and
HLOOKUP.	These	 are	 normally	 used	 to	 search	 a	 row	 or	 column	 for	 a	 lookup	 value	 in
order	to	find	the	related	value.	

LOOKUP

The	 LOOKUP	 function	 in	 Excel	 searches	 the	 lookup	 value	 in	 a	 range	 consisting	 of	 a
single	row	or	column	(lookup	vector),	and	then	returns	the	value	from	the	same	position	in
the	other	single	row	or	column	(result	vector).

To	use	the	LOOKUP	function	in	Excel,	enter	the	following	argument:

=LOOKUP(lookup_value,lookup_vector,[result_vector])

Here	is	a	brief	description	of	the	arguments	used	in	the	LOOKUP	function.

lookup_value:	It	is	the	value	that	you	want	to	lookup	in	the	first	selected	range;	that	is	the
lookup	vector.	The	lookup_value	can	be	a	numeric,	text	or	logical	value.	It	can	also	be	a
name	or	cell	reference.	

lookup_vector:	It	is	the	row	or	column	containing	the	lookup	value.

result_vector:	This	argument	 is	optional.	It	specifies	 the	other	row	or	column	containing
the	value	to	be	returned.	Make	sure	the	result_vector	contains	the	same	number	of	cells	as
the	lookup_vector.

	

Make	 sure	 the	 values	 in	 the	 lookup-vector	 range	 are	 placed	 in



ascending	order	or	else	Excel	may	return	an	incorrect	value.

	

If	 the	 lookup	 value	 is	 lower	 than	 the	 lowest	 value	 in	 the	 lookup-
vector,	Excel	returns	#N/A	error.

	



Figure	23.1	shows	an	example	of	a	LOOKUP	function	in	Excel	2013.

Figure	23.1	-	Example	of	Using	the	LOOKUP	Function	in	Excel

The	 example	 illustrated	 in	 Figure	 23.1	 shows	 a	 performance	 score	 sheet	 of	 employees.
The	standard	score	of	performance	is	150.	To	find	out	which	employee	has	achieved	the
exact	 or	 closest	 standard	 score,	 the	 following	 formula	 is	 entered	 in	 the	 destination	 cell
(D3):

=LOOKUP(D2,B3:B14,A3:A14)

The	 first	 argument	 in	 the	 above	 formula	 refers	 to	 the	 cell	 containing	 the	 lookup	 value,
which	 is	 the	standard	score	of	performance.	The	second	argument	specifies	 the	 range	 in
which	all	the	scores	are	located.	The	third	argument	contains	the	resulting	values.	As	you
can	see	in	Figure	23.1,	Excel	returns	“Marcus	Welby”	in	the	destination	cell.	It	implies	the
Marcus	Welby	has	secured	the	standard	score	among	all	the	mentioned	employees.



VLOOKUP

The	VLOOKUP	function	searches	the	lookup	value	in	the	left	most	column	of	the	selected
table	and	returns	the	corresponding	value	from	the	specified	column.

The	VLOOKUP	table	uses	the	following	syntax:

=VLOOKUP(lookup_value,table_array,col_index_num,	[range_lookup])

Here	is	a	brief	description	of	the	arguments	used	in	the	VLOOKUP	function.

lookup_value:	 It	 is	 the	 value	 that	 you	 want	 to	 lookup	 in	 the	 left	 most	 column	 of	 the
selected	table.	The	lookup_value	can	be	a	numeric,	text	or	logical	value.	It	can	also	be	a
name	or	cell	reference.	

table_array:	It	is	the	range	that	contains	the	lookup	data.

col_index_num:	It	specifies	the	column	number	in	the	table_array	range	from	which	the
relative	 value	 is	 to	 be	 returned.	For	 example,	 a	col_index_num	argument	 of	1	 returns	 a
value	from	the	first	column	of	selected	table	range;	a	col_index_num	argument	of	2	returns
a	value	from	the	second	column	of	selected	table	range	and	so	on.

	

If	 the	 col_index_num	 argument	 is	 less	 than	 1,	 Excel	 returns	 a
#VALUE!	error.

If	the	col_index_num	argument	is	greater	than	the	number	of	columns
in	the	selected	table	range,	Excel	returns	a	#REF!	error..

range_lookup:	 It	 contains	 a	 logical	 argument	 that	 specifies	 whether	 the	 VLOOKUP
function	should	find	an	exact	match	of	the	lookup	value	or	just	an	approximate	match.	If
the	range_lookup	argument	is	TRUE,	Excel	returns	an	exact	or	an	approximate	match.	It
first	 looks	 for	an	exact	match,	 if	not	 found,	 it	 then	 returns	an	approximate	match	of	 the
lookup	value.

If	the	range_lookup	argument	 is	FALSE,	 it	 returns	an	exact	match.	 If	Excel	 is	unable	 to
find	the	precise	match,	it	returns	#N/A	error.

	

range_lookup	is	an	optional	argument.	If	not	entered,	Excel	assumes	it



to	be	TRUE,	hence	returns	an	exact	or	approximate	match.

	

If	the	range_lookup	argument	is	TRUE	or	omitted,	it	is	imperative	that	the	first	column	of
the	lookup	table	is	aligned	in	ascending	order	(alphabetical	order	in	case	of	text	values)	or
else	Excel	may	return	an	incorrect	value.

	

If	 the	 lookup	 value	 is	 lower	 than	 the	 lowest	 value	 in	 the	 left	 most
column	of	the	lookup-table,	Excel	returns	#N/A	error.

	

Figure	23.2	continues	the	same	example	(shown	in	Figure	23.1)	to	include	the	VLOOKUP
value.	

Figure	23.2	-	Example	of	Using	the	VLOOKUP	Function	in	Excel

In	 this	example,	 firstly	 the	values	 in	 the	first	column	are	sorted	alphabetically.	Then	 the
following	formula	is	entered	in	the	destination	cell	(D3)

=VLOOKUP(D2,A3:B14,2)		

Interpreting	the	above	formula,	it	searches	the	value	in	cell	D2	(that	is,	James	van	Eaton)
in	the	first	column	of	the	table_array	(A3:B14)	and	returns	the	corresponding	value	from
the	second	column	in	the	table_array.



HLOOKUP

The	HLOOKUP	is	similar	 to	 the	VLOOKUP	function,	with	only	one	difference;	 that	 is,
the	 lookup	 table	 in	 case	of	HLOOKUP	 is	 arranged	horizontally	 instead	of	 vertically.	 In
other	 words,	 the	 HLOOKUP	 function	 searches	 the	 lookup	 value	 in	 the	 top	 row	 of	 the
selected	table	and	returns	the	corresponding	value	from	the	specified	row	in	the	table.

The	HLOOKUP	table	uses	the	following	syntax:

=HLOOKUP(lookup_value,table_array,row_index_num,	[range_lookup])

Here	is	a	brief	description	of	the	arguments	used	in	the	HLOOKUP	function.

lookup_value:	It	is	the	value	that	you	want	to	lookup	in	the	top	most	row	of	the	selected
table.	The	lookup_value	can	be	a	numeric,	text	or	logical	value.	It	can	also	be	a	name	or
cell	reference.	

table_array:	It	specifies	the	range	that	contains	the	lookup	data.

row_index_num:	 It	 specifies	 the	 row	 number	 in	 the	 table_array	 range	 from	which	 the
relative	value	 is	 to	be	 returned.	For	example,	a	row_index_num	argument	of	1	 returns	 a
value	 from	 the	 first	 row	 in	 the	 selected	 table	 range;	 a	 row_index_num	 argument	 of	 2
returns	a	value	from	the	second	row	in	the	selected	table	range	and	so	on.

range_lookup:	 It	 contains	 a	 logical	 argument	 that	 specifies	 whether	 the	 HLOOKUP
function	should	find	an	exact	match	of	the	lookup	value	or	just	an	approximate	match.	If
the	range_lookup	argument	is	TRUE,	Excel	returns	an	exact	or	an	approximate	match.	It
first	 looks	 for	an	exact	match,	 if	not	 found,	 it	 then	 returns	an	approximate	match	of	 the
lookup	value.

If	the	range_lookup	argument	 is	FALSE,	 it	 returns	an	exact	match.	 If	Excel	 is	unable	 to
find	the	exact	match,	it	returns	#N/A	error.

range_lookup	is	an	optional	argument.	If	not	entered,	Excel	assumes	it
to	be	TRUE,	hence	returns	an	exact	or	approximate	match.

	

In	 short,	 the	HLOOKUP	works	 exactly	 the	 same	 as	 the	VLOOKUP	 function.	The	 only
difference	is	that	the	column	part	in	the	latter	is	replaced	by	row	in	the	former.		

Tip	To	Replace	the	#N/A	Error	

As	 already	 explained	 in	 the	 above	 section,	 VLOOKUP	 and	 HLOOKUP	 functions,	 by



default	 returns	 the	exact	or	approximate	value.	 In	other	words,	 if	 the	exact	match	of	 the
lookup	value	is	not	found	in	the	specified	range,	it	returns	the	next	closest	value.

If	 you	 want	 to	 find	 the	 exact	 match,	 enter	 FALSE	 in	 the	 range_lookup	 argument.	 But
remember	that	if	Excel	is	unable	to	find	the	exact	match,	it	returns	a	#N/A	error.

At	times,	you	may	want	to	use	another	word	or	phrase	for	the	#N/A	error.	Suppose	you	are
maintaining	 an	 inventory	 worksheet	 in	 which	 you	 want	 to	 enter	 a	 lookup	 formula	 to
determine	 if	 a	 particular	 item	 is	 listed	 in	 the	 column	 containing	 names	 of	 available
inventory.	Needless	 to	 say	 that	 you	would	have	 to	 enter	 the	VLOOKUP	or	HLOOKUP
formula	with	a	false	argument,	so	as	to	find	the	availability	of	the	particular	item	(which	is
going	to	be	your	lookup	value).		

If	the	specified	item	is	not	found	in	the	selected	range,	Excel	returns	the	#N/A	error.	You
may	want	to	replace	the	#N/A	error	with	the	term	“Not	Available”.

Suppose	the	underlying	VLOOKUP	formula	is:

=VLOOKUP(D2,A3:B14,2,FALSE)

To	replace	the	#N/A	error	value	with	any	other	term,	replace	the	above	formula	with	the
following	one:

=IFERROR(VLOOKUP(D2,	A3:B14,2,FALSE),”Not	Available”)

Lookup	with	Match	and	INDEX	Functions

The	 MATCH	 and	 INDEX	 functions	 in	 Excel	 are	 often	 used	 together	 in	 the	 lookup
formulas.

First,	let’s	talk	about	the	MATCH	function.	It	finds	the	relative	position	of	a	cell	in	a	range
or	array	that	matches	the	specified	lookup	value	in	a	specified	order.

The	MATCH	function	has	the	following	syntax:

=MATCH(lookup_value,lookup_array,[match_type])

Following	is	a	brief	description	of	the	arguments	used	in	the	MATCH	function.

lookup_value:	 It	 is	 the	 value	 that	 you	 want	 to	 lookup	 in	 the	 lookup_array	 (second
argument	 in	 the	MATCH	 function).	The	 lookup_value	 can	be	 a	numeral,	 text	 or	 logical
value.	It	can	also	be	a	name	or	cell	reference.	

lookup_array:	It	specifies	the	range	of	cells	that	contains	the	lookup	data.

match_type:	This	argument	specifies	how	Excel	matches	the	lookup	value	in	the	selected



range.	It	can	be	0,	1	or	-1.

If	 match_type	 is	 1,	 Excel	 returns	 the	 largest	 value	 that	 is	 less	 than	 or	 equal	 to	 the
lookup_value.	 In	 this	 case,	 it	 is	 essential	 that	 the	 lookup_array	 is	 aligned	 in	 ascending
order	 (alphabetical	order	 i.e.	A	–	Z,	 in	 case	of	 text	values)	or	 else	Excel	may	 return	 an
incorrect	value.

If	match_type	is	0,	Excel	returns	the	value	that	is	exactly	equal	to	the	lookup_value.

If	match_type	 is	 -1,	Excel	 returns	 the	 smallest	 value	 that	 is	 greater	 than	or	 equal	 to	 the
lookup_value.	 In	 this	case,	 it	 is	 essential	 that	 the	 lookup_array	 is	 aligned	 in	 descending
order	(inverse	alphabetical	order	i.e.	Z	–	A,	in	case	of	text	values)	or	else	Excel	may	return
an	incorrect	value.

	

match_type	is	an	optional	argument.	 If	not	entered,	Excel	assumes	 it
to	be	1,	hence	returns	the	largest	value	that	is	less	than	or	equal	to	the
lookup_value.

	

Now	 let’s	 discuss	 the	 INDEX	 function.	 It	 returns	 a	 value	 or	 cell	 reference	 at	 the
intersection	point	of	a	particular	column	and	row,	in	the	specified	range.

The	INDEX	function	has	the	following	syntax:

=INDEX(array,row_num,[column_num])

Here	is	a	brief	description	of	the	arguments	used	in	the	INDEX	function.

array:	The	range	of	cells

row_num:	Specifies	 the	row	number	in	the	array	from	which	the	resulting	value	is	 to	be
returned.	

col_num:	Specifies	the	column	number	in	the	array	from	which	the	resulting	value	is	to	be
returned.	

Keep	in	mind	the	following	while	you	work	with	the	INDEX	function.

If	the	selected	array	contains	only	one	row	or	column,	the	corresponding	row_num
or	column_num	argument	is	optional.

If	the	selected	array	contains	more	than	one	row	and	column,	and	you	have	entered



either	row_num	or	column_num	argument,	then	Excel	returns	an	array	of	the	entire
row	or	column,	respectively.	

If	both	the	row_num	and	column_num	arguments	are	used,	Excel	returns	the	value
in	the	cell	at	the	intersection	point	of	the	specified	row	and	column	number.

Figure	23.3	illustrates	an	example	of	INDEX	function.

Figure	23.3	-	Illustrating	the	Use	of	INDEX	Function	in	Excel	2013

In	 the	 above	 example,	 three	 different	 INDEX	 formulas	 are	 applied.	 All	 the	 formulas
contain	the	array	argument,	the	row_num	and	column_num	arguments	are	different.

For	example,	in	the	first	formula,	the	row_num	argument	is	2	and	column_num	argument
is	1.	Hence	Excel	 returned	 the	value	 located	 in	 intersecting	cell	 at	 second	 row	and	 first
column	in	the	selected	array.	As	you	can	see	in	Figure	23.3,	Literature	 lies	in	specified
position.

Now	that	you	know	the	individual	usage	of	the	MATCH	and	INDEX	functions,	following
are	 a	 few	 applications	 of	 how	 you	 can	 use	 these	 two	 functions	 together	 in	 the	 lookup
formulas.

Formula	to	Lookup	A	Case	Sensitive	Value

Suppose	 your	 lookup	 value	 is	 PAUL.	 Whether	 you	 use	 LOOKUP,	 VLOOKUP	 or
HLOOKUP	 function,	 Excel	 returns	 Paul,	 paul,	 PAUL	 and	 all	 the	 same	 values.	 In	 other
words,	the	lookup	formulas	are	not	case	sensitive.	At	times	you	may	want	to	lookup	the
exact	(case	sensitive)	text	value.		

Suppose	the	underlying	LOOKUP	formula	is:

=LOOKUP(D2,B3:B14,A3:A14)

In	 the	 above	 formula,	 D2	 is	 the	 cell	 containing	 the	 lookup	 value,	 B3:B14	 is	 the	 range
containing	the	lookup	data	and	A3:A14	is	the	range	containing	the	corresponding	resulting
values.



If	you	want	 the	above	lookup	formula	 to	be	case	sensitive,	replace	it	with	 the	following
array	formula:

=INDEX(A3:A14,MATCH(TRUE,EXACT(B4,B3:B14),0))

	

The	 above	 formula	 must	 be	 entered	 as	 an	 array	 formula,	 or	 else	 it
won’t	work	correctly.	To	do	so,	press	Ctrl	+	Shift	+	Enter	instead	of
Enter	after	you	close	the	last	parentheses	in	the	formula.		

	

Refer	to	Chapter	24	to	learn	more	about	Array	formulas.		

Learning	the	Two-Column	Lookup

At	times	you	may	need	to	search	a	value	based	on	values	in	two	columns.

Figure	23.4	illustrates	one	such	example.

Figure	23.4	-	Determining	a	Value	Based	On	Two	Lookup	Values

The	 above	 image	of	worksheet	 contains	 a	 lookup	 table	made	up	 of	 three	 columns.	The
first	 one	 carries	 the	 name	 of	 the	 course,	 second	 contains	 the	 exam	 score	 and	 the	 third
carries	the	name	of	the	students.

For	the	sake	of	understanding,	we	have	named	the	ranges	as	follows:

A2:A13	=	course	(This	range	contains	the	lookup	data	of	one	lookup	value)	

B2:B13	=	score	(This	range	contains	the	lookup	data	of	the	other	lookup	value)	

C2:C13	=	student	(This	range	contains	the	resulting	values)	

Suppose	 you	 want	 find	 the	 name	 of	 the	 student	 who	 scored	 87	 in	 mathematics.	 This



implies	two	lookup	values	(87	and	mathematics).

As	you	can	see	in	Figure	23.4,	the	lookup	values	are	entered	in	cell	F4	and	F5.	Entering
the	following	array	formula	in	the	destination	returns	the	required	answer:

=INDEX(student,MATCH(F4&F5,score&course,0))

The	 above	 formula	 returns	 the	 value	 “Mary	 Jean	 Post”.	 Interpreting	 this	 answer,	Mary
Jean	Post	is	the	student	who	scored	87	in	mathematics.

This	formula	must	be	entered	as	an	array	formula,	or	else	it	won’t	work	correctly.	To	do
so,	press	Ctrl	+	Shift	+	Enter	instead	of	Enter	after	you	close	the	last	parentheses	in	the
formula.		

	





A
Chapter	24:	Learn	to	Work	with	Array	Formulas

rray	formulas	are	mentioned	a	many	times	in	this	book.	A	couple	of	times	in	the
previous	 chapters,	 the	 shortcut	 key	 for	 entering	 array	 formulas	 has	 also	 been
stated.	But	array	formulas	are	a	lot	more	than	what’s	explained	so	far.

Well,	 this	 chapter	 talks	 in	 detail	 about	 the	 valuable	 array	 formulas	 and	 their	 handy
features.	 Starting	 with	 the	 basic	 concept	 to	 the	 types	 of	 array	 formulas	 and	 different
dimensions,	this	chapter	tells	you	all	you	need	to	know	about	using	the	array	formulas	in
Excel.			

Defining	Array	Formulas

Simply	 put,	 array	 is	 an	 assortment	 of	 items	 operated	 on	 individually	 or	 collectively.	 In
Excel,	an	array	formula	is	a	special	kind	of	formula	that	works	on	a	range	of	values.	If	the
array	 formula	 is	dependent	on	a	 range	of	cells,	 the	corresponding	 range	 is	known	as	an
array	range.	On	the	other	hand,	if	the	formula	contains	to	a	list	of	values,	they	are	called
array	constant.

	

It	 is	 not	 necessary	 to	 store	 the	 arrays	 in	 cells.	 You	 can	work	with
arrays	that	are	stored	in	Excel’s	memory	only.		

	

There	are	two	types	of	array	formulas;	namely,	Single	cell	array	formulas	and	Multi	array
cell	 formulas.	 The	 former	 operates	 on	 arrays	 that	 display	 the	 results	 in	 a	 single	 cell,
whereas	 the	 latter	 displays	 the	 result	 in	 a	 range	 of	 cells.	 Moreover,	 a	Multi	 array	 cell
formula	 is	 also	 entered	 into	 an	 array,	 as	 against	 the	 Single	 cell	 array	 formula	which	 is
entered	into	a	single	cell.

Apart	from	the	types,	arrays	are	also	categorized	in	terms	of	dimensions.	An	array	can	be
one-dimensional	or	two-dimensional.	The	array	dimensions	pertain	to	the	number	of	rows
and	columns.	A	one	dimensional	array	is	the	one	that	can	be	stored	in	a	range	consisting	of
a	single	row	or	column,	whereas	a	two	dimensional	array	can	be	stored	in	a	range	of	cells
consisting	multiple	rows	and	columns.		

The	 types	 and	 dimensions	 are	 explained	 in	 detail	 with	 examples	 in	 the	 upcoming
chapters.			



Applying	the	Multi-Cell	Array	Formula

First,	let’s	talk	about	the	multi	cell	array	formula.	Have	a	look	at	Figure	24.1.

Figure	24.1	-	Creating	One	Multi-Cell	Array	Formula	to	Calculate	Sales	for	Different	Products

The	worksheet	shown	in	Figure	24.1	contains	a	worksheet	holding	sales	data	for	different
products.

The	following	formula	is	entered	in	Cell	D2	to	calculate	the	total	sales	for	Product	A.

=B2*C2

Normally,	you’d	drag	this	formula	down	to	calculate	the	sales	of	other	products	as	well.
Upon	dragging	down,	column	D	contains	seven	formulas,	one	for	each	product.

An	 alternative	 way	 of	 performing	 this	 calculation	 is	 by	 creating	 one	 multi-cell	 array
formula.	The	one	multi-cell	array	formula	will	dwell	 in	all	 the	seven	cells	and	return	an
array	of	seven	resulting	values.

Here	is	how	you	can	create	a	multi	cell	formula:

Select	the	range	of	cells	that	is	to	hold	the	resulting	values.	In	Figure	24.1,	it	is	E2:E8

Enter	the	following	formula

=B2:B8*C2:C8

Press	Ctrl	+	Shift	+	Enter	on	your	keyboard	to	enter	the	formula.	Normally,	we	hit	Enter
to	enter	a	formal,	but	when	entering	an	array	formula,	you	need	 to	press	Ctrl	+	Shift	+
Enter.

As	you	can	see	in	Figure	24.1,	the	entire	range	in	Column	E	consists	of	a	single	formula.
Since	the	result	is	displayed	in	a	range	of	cells,	it	is	known	as	a	multi	cell	array	formula.	

The	 curly	 brackets	 shown	 in	 the	 formula	 bar	 are	 a	 symbol	 of	 array



formulas.	 It	 signifies	 that	 the	 corresponding	 cells	 contain	 an	 array
formula.	However	you	don’t	have	to	enter	these	brackets,	neither	will
they	 show	 when	 the	 cell	 is	 in	 the	 edit	 mode.	 These	 are	 just	 an
indication	 or	 you	 can	 say	 a	 reminder	 of	 the	 presence	 of	 an	 array
formula	in	the	pertaining	cells.		

	

Excel	 does	not	 allow	multi	 cell	 array	 formulas	 in	 range	of	 cells	 that	 are	 formatted	 as	 a
table.	 Likewise,	 if	 a	 range	 already	 contains	 a	 multi	 cell	 array	 formula,	 it	 cannot	 be
converted	into	a	table.

As	you	can	see	 in	Figure	24.1,	 the	resulting	values	 in	Column	D	and	Column	E	are	 the
same.	In	Column	D,	we	have	entered	a	single	formula	and	then	dragged	it	down	the	range.
In	Column	E,	we	have	selected	the	entire	range	and	entered	one	multi-cell	array	formula.	

Entering	a	multi	cell	array	formula	produces	the	same	answers	as	individual	formulas.	As
a	matter	of	fact,	the	former	provides	the	following	advantages	against	the	latter:

	 	 	 	 	 	 	A	 multi	 cell	 formula	 eliminates	 the	 probability	 of	 over	 writing	 a	 formula
mistakenly,	as	you	can’t	modify	or	delete	just	one	cell	in	the	array	formula.	If	you
do	so,	Excel	displays	an	error	message.

	 	 	 	 	 	 	The	error	message,	as	explained	in	the	previous	point,	prevents	the	novice	and
unauthorized	users	to	tamper	with	your	formulas.

							When	working	on	a	large	range	of	cells,	a	multi	cell	formula	ensures	that	all	the
formulas	are	identical	hence	produce	the	correct	results.		

Though	a	multi	cell	array	formula	has	several	pros,	it	has	some	cons	as	well.

û	 	 	 	 	 	You	cannot	insert	a	new	row	into	the	array	range.	This	drawback	serves	as	an
advantage	 when	 you	 don’t	 want	 other	 users	 to	 modify	 your	 worksheet	 or	 array
formula.			

û	 	 	 	 	 	If	you	add	any	new	data	or	row	to	the	bottom	of	the	range,	you	need	to	select
the	entire	range	and	modify	the	formula	accordingly.	You	cannot	just	copy	or	drag
the	formula	down.

Applying	the	Single-Cell	Array	Formula

Figure	 24.2	 continues	 the	 same	 sales	 report	 example	 (shown	 in	 Figure	 24.1)	 to	 explain
single	cell	array	formulas.



Figure	24.2	-	Creating	a	Single-Cell	Array	Formula	to	Calculate	the	Cumulative	Sales	of	All	Products

In	 the	above	Figure,	 the	user	wants	 to	calculate	 the	cumulative	sales	of	all	 the	products.
One	way	is	to	sum	the	values	in	Column	D	or	Column	E.	However,	this	would	take	up	a
lot	of	time	if	you	don’t	need	to	calculate	the	individual	sales	of	each	product	and	directly
compute	the	total	sales	of	all	the	products.		

To	 enter	 a	 single	 cell	 array	 formula,	 enter	 the	 following	 formula	 in	 the	 destination	 cell
(C10):

=SUM(B2:B8*C2:C8)

This	 formula	must	be	entered	as	an	array	formula;	hence	you	need	 to	press	 	 	 	 	 	 	Ctrl	+
Shift	+	Enter	instead	of	Enter	after	completing	the	formula.

As	 you	 can	 see	 in	 Figure	 24.2,	Cell	C10,	D10	 and	E10	 all	 contains	 the	 same	 resulting
value.	The	difference	 is	 in	 the	 calculation	procedure	 and	mechanism.	The	value	 in	Cell
C10	 is	 calculated	 directly,	 without	 any	 intermediate	 computations.	 This	 method	 is
therefore	preferable	and	 time	saving	 if	you	don’t	need	 the	 individual	product-wise	sales
values.					

	

An	alternate	way	of	calculating	total	sales	in	the	above	example	is	by
entering	the	following	formula	in	the	destination	cell:

=SUMPRODUCT(B2:B8,C2:C8)

This	will	yield	the	same	answer	as	the	single	cell	array	formula.		



How	to	Create	an	Array	Constant

As	already	mentioned,	an	array	does	not	need	to	be	stored	in	worksheet	ranges.	You	can
work	with	arrays	saved	in	Excel’s	memory	also.	These	are	known	as	array	constant.

The	examples	in	the	previous	sections	used	arrays	stored	in	a	range	of	cells.	This	one	talks
about	the	ones	stored	in	Excel’s	memory.

Following	is	an	example	of	a	formula	containing	an	array	constant:

=SUM({2,5,2,7,9})

The	above	formula	uses	an	array	however	it	is	not	an	array	formula	itself.	Therefore	you
do	not	need	to	press	Ctrl	+	Shift	+	Enter	to	enter	the	formula.

This	 is	 just	 an	 example	 of	 a	 simple	 array	 constant.	The	 formula	will	 produce	 the	 same
result,	even	if	you’d	have	entered	the	simple	SUM	formula.

The	array	constant’s	formula	comes	in	handy	when	you	need	to	use	two	array	constants	at
a	time.

For	example,	the	following	formula	contains	two	array	constants:

=SUM({2,5,2,9}*{3,5,9,4})

	

While	entering	an	array	formula,	you	need	to	press																									
Ctrl	+	Shift	+	Enter	to	enter	the	formula.	However	if	you	are	using
array	 constants,	 then	 you	 need	 to	 type	 in	 the	 curly	 brackets	 at	 the
appropriate	positions	in	the	formula.		

Following	is	the	array-less	alternative	to	the	above	formula.

=SUM(2*3,5*5,2*9,9*4)

The	following	formula	is	a	combination	of	array	constants	and	array	stored	in	range:

=SUM((A7:D7*{2,4,6,8}))

In	 short,	 ‘arrays	 stored	 in	 ranges’	means	 ‘cell	 references’	 and	 ‘array	 constants’	means
‘values’.

If	 your	 formula	use	 arrays	 stored	 in	 cells	 (that	 is	 cell	 references),	 it	must	 be	 entered	 as



array	formulas	(by	pressing	by	Ctrl	+	Shift	+	Enter).	On	the	other	hand,	if	your	formula
contains	direct	values	 (that	 is	 array	constants),	you	must	manually	put	curly	brackets	 in
appropriate	places.

You	need	to	remember	the	following	while	working	with	array	constants:

An	 array	 constant	 can	 contain	 numerals,	 text	 and	 logical	 values,	 and	 even	 error
values.

The	text	values	must	be	enclosed	in	double	quotation	marks.

The	numeral	can	be	an	integer,	a	decimal	value	or	a	scientific	notation.

Array	constant	does	not	 recognize,	hence	cannot	contain	dollar	 sign,	parentheses,
commas	and	percentage	signs.					

An	array	constant	cannot	contain	functions	and	functions,	and	links	to	other	arrays.

Exploring	the	Dimensions	of	an	Array

As	 mentioned	 before,	 an	 array	 can	 be	 one	 dimensional	 or	 two	 dimensional.	 The
understanding	of	dimensions	is	as	important	as	the	study	of	the	types	and	array	constants.
This	section	explains	the	different	orientations	of	an	array	along	with	relevant	examples.			

First,	let’s	talk	about	one	dimension	arrays.		A	one	dimensional	array	is	the	one	that	can	be
stored	 in	a	 range	consisting	of	 a	 single	 row	or	column.	This	dimension	 further	 contains
two	orientations;	vertical	and	horizontal.	

One	Dimensional	Vertical	Arrays

One	Dimensional	Vertical	Array	corresponds	to	a	single	row.	The	array	is	displayed	in	a
column	of	cells	and	the	items	in	it	are	separated	by	semicolons.

Following	is	an	example	of	a	five-element	vertical	array	constant:

{2;4;6;8;10}

To	display	the	above	array	constant	in	a	column,	first	select	a	range	consisting	of	5	cells	in
one	column.	Then	enter	the	following	formula:

={2;4;6;8;10}

Press	Ctrl	+	Shift	+	Enter.	All	the	numeric	values	will	be	displayed	in	a	contiguous	range
in	a	single	column.

The	above	explained	process	of	creating	one	dimensional	vertical	array	comes	 in	handy



when	the	array	constant	contains	text	values.	Consider	the	following	six-element	vertical
array	constant,	as	an	example:

{“Paul”;”Mary”;”Wilson”;”David”;”Cole”;”Lisa”}

To	 display	 these	 names	 in	 a	 vertical	 array,	 select	 a	 range	 consisting	 of	 6	 cells	 in	 one
column.	Then	enter	the	following	formula:

={“Paul”;”Mary”;”Wilson”;”David”;”Cole”;”Lisa”}

Press	Ctrl	+	Shift	+	Enter.	All	the	name	values	will	be	displayed	in	the	selected	cells,	as
shown	in	Figure	24.3

Figure	24.3	-	Displaying	Text	Values	in	a	Vertical	Array

One	Dimensional	Horizontal	Arrays

The	one	dimensional	horizontal	array	is	different	from	the	one	dimensional	vertical	array
in	two	aspects,	as	listed	below:

1.	 The	array	is	displayed	in	a	row	of	cells

2.	 The	items	in	a	one	dimensional	horizontal	array	are	separated	by	commas.

Following	is	an	example	of	a	five-item	horizontal	array	constant:

{2,4,6,8,10}

To	 display	 the	 above	 array	 constant	 in	 a	 row,	 first	 select	 a	 range	 consisting	 of	 5
consecutive	cells	in	a	row.	Then	enter	the	following	formula:

={2,4,6,8,10}

Press	Ctrl	+	Shift	+	Enter.	All	the	numeric	values	will	be	displayed	in	a	contiguous	range
in	a	single	row.

	

If	 the	 selected	 range	 contains	 more	 cells	 than	 the	 number	 of	 array



items,	the	extra	cells	display	#N/A	error	value.	If	you	select	a	vertical
range	of	cells	and	enter	a	horizontal	array	constant	 formula	 in	 it,	all
the	selected	cells	will	display	the	first	item.			

	

Two	Dimensional	Arrays

A	 two	 dimensional	 array	 allows	 you	 to	 combine	 the	 vertical	 and	 horizontal	 array
constants.	 The	 rules	 remain	 the	 same;	 that	 is,	 you	 need	 to	 put	 commas	 to	 separate	 the
horizontal	elements	and	semicolons	to	separate	the	vertical	elements	in	a	two	dimensional
array	formula.

Following	is	an	example	of	a	3	x	4	two-dimensional	array	constant:

{2,2,4,4;6,6,8,8;10,10,12,12}

In	the	above	array	constant,	there	are	four	items	for	the	first	row,	then	a	semicolon	which
implies	the	starting	of	the	next	row,	again	there	are	four	items	in	the	second	row	and	then
the	third	row.

To	display	this	in	an	array	of	12	cells,	first	select	a	range	of	empty	cells	that	contains	four
columns	and	three	rows.	Then	type	the	following	formula:

={2,2,4,4;6,6,8,8;10,10,12,12}

Press	Ctrl	+	Shift	+	Enter.

Figure	24.4	illustrates	how	the	array	constant	will	be	displayed	in	the	selected	cells.

Figure	24.4	-	Illustrating	a	Two	Dimensional	Array

It	 is	 essential	 that	 each	 row	 in	 a	 two	 dimensional	 array	 constant
contains	the	same	number	of	items	or	values.	For	example,	the	below
array	 is	 invalid	 as	 there	 are	 only	 three	 items	 in	 the	 second	 row,
whereas	the	other	two	have	four	items	each.

{2,2,4,4;6,8,8;10,10,12,12}



Excel	does	not	support	nor	even	allow	a	formula	with	an	invalid	array.





B
Chapter	25:	Making	an	Error	Free	Worksheet

y	 now	 you	 must	 have	 gotten	 a	 fair	 idea	 on	 how	 formulas	 are	 created	 and
references	are	 linked.	While	working	with	 these,	you	need	 to	be	careful	as	one
error	or	misplacement	of	an	argument	can	produce	errors	in	the	entire	worksheet.

Surely	you	would	not	want	to	make	the	entire	worksheet	again	just	because	of	one	wrong
entry	or	any	other	mistaken	clicks.

This	chapter	tells	you	how	you	can	locate	the	source	of	error	and	rectify	it,	in	order	to	save
your	efforts	 from	going	down	 the	drain.	 Just	 like	one	 incorrect	entry	or	 referencing	can
affect	all	the	resulting	cells,	the	reversal	of	the	misdoing	can	rectify	all	of	it	at	once.	

Starting	from	the	types	of	formula	errors,	auditing	tools	and	error	trapping	techniques,	this
chapter	helps	you	make	a	perfect	and	completely	error	free	worksheet.

Fixing	the	Formula	Errors

While	working	on	spreadsheets	containing	complex	and	interlinked	formulas,	one	minor
change	may	produce	a	massive	ripple	effect	and	produce	errors	in	all	the	referenced	cells
and	 other	 linked	 formulas.	 And	 this	 is	 not	 something	 that	 you	 can	 prevent	 from
happening!	Formula	errors	are	very	common	in	Excel	and	you	are	bound	to	encounter	one
while	working	on	interrelated	and	lengthy	formulas.

	

	

Types	of	Formula	Errors

The	 trickiest	 thing	when	 it	 comes	 to	 formula	 errors	 is	 that	 if	 the	 underlying	 formula	 is
interlinked	 to	 other	 formulas	 in	 the	workbook,	 then	 you	 need	 to	 identify	 the	 source	 of
error	and	then	deal	accordingly.	Changing	the	resulting	value	manually	won’t	be	enough;
on	the	contrary	it	may	complicate	the	error	in	other	referenced	formulas.	

Being	 said	 that,	 the	 rectification	process	 depends	 upon	 the	 type	of	 error	 you	 encounter.
Following	 is	 a	 brief	 description	 about	 the	 general	 categories	 of	 formula	 errors	 that	 you
may	encounter	while	working	in	Excel.	

Syntax	Errors:	As	 the	name	suggest,	 syntax	error	occurs	when	 there	 is	a	problem	in	 the
syntax	of	the	underlying	formula.	In	other	words,	you	may	encounter	this	error	when	you
fail	to	follow	the	syntax	and	argument	structure	of	a	function.



The	most	 common	 type	 of	 syntax	 error	 is	mismatched	 parentheses.	 It	 occurs	when	 the
number	of	right	parentheses	is	not	equal	to	the	number	of	left	parentheses	in	the	formula.
The	next	common	syntax	error	occurs	when	you	enter	incorrect	or	incomplete	arguments.

Syntax	errors	are	the	easiest	to	identify.	In	case	of	mismatched	parentheses,	Excel	does	not
let	you	enter	a	formula.

Incomplete	 Calculation	 Errors:	 This	 error	 occurs	when	 the	 formulas	 are	 not	 calculated
completely.

To	 make	 sure	 that	 your	 formulas	 are	 completely	 calculated,
press																								Ctrl	+	Alt	+	Shift	+	F9	on	your	keyboard.		

	

Semantic	Errors:	This	error	normally	occurs	when	you	spell	a	function	incorrectly.	Excel
attempts	to	interpret	it	as	a	name	and	displays	the	#NAME?	error.

Logical	Errors:	Logical	 errors	 are	difficult	 to	 identify	 as	 they	 are	not	 displayed	overtly.
They	 occur	when	 a	 formula	 contains	 a	 logical	 error	which	 in	 turn	 causes	 it	 to	 produce
incorrect	or	imprecise	result.

Array	Formula	Entry	Errors:	This	error	occurs	when	you	press	Enter	instead	of			Ctrl	+
Shift	+	Enter	while	entering	an	array	formula.	Depending	upon	the	function	and	structure
of	formula,	Excel	may	display	an	error	alert	or	it	may	produce	incorrect	result.

Incorrect	Reference	Errors:	This	error	occurs	when	you	enter	incorrect	cell	reference	in	a
formula.

Circular	References:	A	circular	reference	occurs	when	a	formula	refers	to	its	own	value,	or
when	a	cell	reference(s)	is	dependent	upon	the	underlying	formula’s	resulting	value.



Get	To	Know	the	Common	Error	Values

Error	values	mostly	occur	when	you	enter	any	invalid	or	incorrect	formula	thus	rendering
Excel	unable	to	perform	the	specified	calculation.

Error	 values	 are	 of	 many	 types,	 each	 corresponding	 to	 a	 different	 source	 of	 error.
Following	 is	 a	 brief	 description	 of	 all	 the	 error	 values	 including	 their	 meaning	 and
possible	causes.

	

Every	 error	 value	 spurs	 from	 a	 different	 cause	 and	 the	 only	way	 to
rectify	the	error	is	to	identify	the	source	of	it	and	then	edit	the	formula
accordingly	to	make	it	right.			

	

#DIV/0!

Mathematically,	you	cannot	divide	any	number	with	zero.	It	is	an	invalid	operation.	When
you	try	to	perform	this	in	Excel,	it	displays	the	#DIV/0!	error.		This	error	occurs	when	you
perform	a	division	operation	containing	0	(zero)	or	a	blank	cell	reference.

#N/A

This	 error	 occurs	when	 a	 lookup	 formula	 is	 unable	 to	 return	 the	 required	 value.	Many
users	type	this	error	value	manually	in	a	cell	to	indicate	unavailable	data.

#NULL!

As	explained	previously	 in	 this	 book,	 the	 intersection	operator	 in	Excel	 is	 a	 space.	The
#NULL!	 error	 occurs	 when	 you	 put	 an	 intersection	 operator	 in	 a	 formula	 where	 it	 is
actually	not	available	in	the	worksheet.	In	other	words,	when	you	refer	an	intersection	of
two	cell	ranges	in	a	formula	that	actually	don’t	intersect,	Excel	displays	a	#NULL!	error.

This	error	also	occurs	when	you	mistakenly	enter	a	space	instead	of	a	comma	in	a	formula,
as	 latter	 is	 the	 argument	 separator.	 So	 when	 you	 put	 a	 union	 separator	 instead	 of	 an
argument	separator,	Excel	displays	the	#NULL!	error.

#NAME?

The	#NAME?	error	occurs	when	Excel	is	unable	to	recognize	a	cell	or	range	name.	This
could	be	due	to	any	of	the	following	reasons:



û	 	 	 	 	 	The	 formula	 contains	 a	 text	 value	 that	 is	 not	 enclosed	 in	 double	 quotation
marks.

û	 	 	 	 	 	The	 formula	 contains	 a	misspelled	 function	 name.	This	 also	 falls	 under	 the
category	of	semantic	errors.

û	 	 	 	 	 	The	formula	refers	 to	range	of	cells	but	 the	range	address	does	not	contain	a
colon	between	the	cell	addresses.

û						The	formula	contains	a	deleted	name	range.

û						The	formula	contains	an	advanced	or	add-in	function	that	is	not	installed	in	the
current	version	of	Excel.

Excel	 is	 comparatively	 less	 advanced	 and	 smart	 when	 it	 comes	 to
using	name	ranges	 in	formulas.	If	you	use	a	name	range	or	a	named
cell	 reference	 in	 a	 formula	 and	 then	delete	 the	name	 later	on,	Excel
displays	the	#NAME?	error.	It	does	not	automatically	replace	the	cell
address	with	the	corresponding	range	or	cell.	

	

#REF!

The	#REF!	error	occurs	when	a	formula	contains	an	invalid	cell	reference.	This	could	be
due	to	any	of	the	following	reasons:

û	 	 	 	 	 	When	 the	 row,	 column	 or	 the	 cell	 containing	 the	 cell	 reference	 is	 deleted.
Suppose	you	entered	the	following	formula	in	a	cell:

=SUM(C5,D4,B1)

Now	if	you	delete	Column	C,	D	or	B	or	any	of	the	rows	containing	the	mentioned
cell	references,	Excel	will	display	the	#REF!	error.

û						When	worksheet	containing	the	cell	reference	is	deleted.

û						When	copying	a	formula	to	any	other	location	invalidates	the	cell	references	in
it.

û						When	you	cut	and	paste	a	cell	to	a	cell	already	containing	a	cell	reference.



#VALUE!

This	 error	 occurs	 when	 a	 function	 contains	 a	 wrong	 or	 invalid	 argument,	 or	 a	 wrong
operator	is	used	in	it.	This	could	be	due	to	any	of	the	following	reasons:

û						When	an	argument	in	a	formula	contains	invalid	or	incorrect	data	type.

û	 	 	 	 	 	When	the	argument	refers	 to	a	cell	 range,	whereas	 it	should	refer	 to	a	single
value	or	cell	only.

û						When	you	press	Enter	instead	of	Ctrl	+	Shift	+	Enter	while	entering	an	array
formula.	This	is	also	known	as	Array	Formula	Entry	Error.

û						When	a	customized	function	does	not	perform	the	calculation.	You	can	hit	Ctrl
+	Alt	+	F9	to	force	a	recalculation.

#NUM!

The	#NUM!	error	occurs	when	 there	 is	 some	 issue	with	 the	numerical	value	or	number
format	in	the	formula.	For	example,	this	error	occurs	when	an	argument	contains	a	text	or
logical	value	whereas	 it	 is	 supposed	 to	be	a	numeral,	or	when	 the	 resulting	value	 is	 too
large	or	too	small	to	fit	in	the	corresponding	cell.

	

When	a	referenced	cell	in	a	formula	returns	an	error	value	or	when	a
cell	 containing	 error	 value	 is	 referred	 in	 a	 formula,	 the	 formula
returns	 the	 particular	 error	 value	 as	 well.	 When	 this	 happens,	 the
error	value	spreads	like	wildfire	throughout	the	workbook	and	all	the
cells	 that	 are	 in	 anyway	 linked	 to	 the	 underlying	 formula.	 In	 such
cases,	 it	 becomes	 very	 difficult	 to	 identify	 the	 cell	 from	where	 the
error	value	originated	so	as	you	can	rectify	it.	

The	Phantom	Link	Error

The	Phantom	link	error	occurs	when	the	links	contained	in	a	workbook	are	outdated.

Figure	25.1	shows	the	Excel	phantom	error	alert	window.



Figure	25.1	-	Phantom	Error	Notification	Giving	You	the	Option	to	Update	the	Links

The	phantom	 links	 are	mostly	 created	when	 a	worksheet	 containing	names	 is	 copied	 to
any	other	workbook.

If	you	want,	you	can	update	the	links	however	there	are	two	other	methods	that	you	can
try	to	resolve	this	issue.

First,	select	File	>	Info	>	Edit	Links	to	Files	to	display	the	Edit	Links	dialog	box.	Now
one	by	one	select	each	link	and	click	Break	Link.	If	the	phantom	links	issue	still	persists,
try	the	second	method,	explained	as	follows.	

Select	Formulas	 tab	 >	Defined	 Names	 >	Name	Manager.	 This	 will	 open	 the	Name
Manager	 dialog	 box.	 Scroll	 through	 all	 the	 names	 and	 if	 you	 see	 any	 name	 that	 says
#REF!,	delete	it.

If	your	Name	Manager	dialog	box	contains	numerous	names	and	scrolling	through	all	of
them	would	 take	 up	 a	 lot	 of	 time,	 you	 can	 use	 the	 filter	 option	 located	 at	 the	 top	 right
corner	of	the	dialog	box.	To	do	so,	Click	Filter	and	then	select	Click	Names	with	Errors.

Using	Conditional	Formatting	to	Hide	Errors

At	 times	 the	error	values	won’t	be	much	of	a	concern	 to	you	and	you	may	 just	want	 to
hide	 them,	 you	 can	 do	 so	 using	 Conditional	 Formatting.	 You	 can	 set	 a	 conditional
formatting	rule	that	can	render	all	the	error	values	invisible.

Following	is	the	step	by	step	process	on	how	you	can	do	that:

1.	 Select	the	cell(s)	containing	error	values	that	you	want	to	hide.

2.	 Select	Home	tab	>	Conditional	Formatting	>	New	Rule.	This	will	open	the	New
Formatting	Rule	dialog	box.

3.	 In	the	Select	a	Rule	Type	box,	click	Select	the	Format	Only	Cells	That	Contain

4.	 Click	the	Cell	Value	drop	down	list	and	select	Errors.

5.	 Click	the	Format	button	to	open	the	Format	Cells	dialog	box.

6.	 Click	the	Color	drop	down	menu	to	open	the	color	palette.	Select	White	color	and
click	OK.	If	the	selected	cells	are	shaded,	then	choose	the	same	color	in	the	color
palette.

7.	 Click	OK	to	close	the	New	Formatting	Rule	dialog	box	and	return	to	the	worksheet.
All	 the	 error	 values	 in	 the	 selected	 cells	 would	 have	 disappeared	 from	 the



worksheet.

Formula	Auditing	Tools

If	 you	 are	unable	 to	 trap	 the	 contagious	 errors	 that	 seem	 to	have	 spread	 throughout	 the
worksheet,	you	may	have	to	check	all	the	linked	cells	to	find	the	source	of	error.	At	times
the	errors	become	so	viral	that	you	may	have	to	recreate	the	entire	worksheet;	even	in	this
case	there	is	no	such	guarantee	that	the	previous	errors	won’t	occur	again.

So	the	best	solution	out	of	it	 is	 to	find	the	origin	of	error	and	rectify	it	once	and	for	all.
Fortunately,	Excel	 2013	 contains	 some	very	 advanced	 and	 smart	 formula	 auditing	 tools
that	can	help	you	track	down	the	cause	of	error.

The	Formula	Auditing	tools	are	 located	in	 the	Formula	Auditing	group	on	 the	Formulas
tab	of	the	Ribbon,	as	shown	in	Figure	25.2.

Figure	25.2	-	The	Formula	Auditing	Tools	in	Excel	2013

Before	we	explain	the	applications	of	the	formula	auditing	tools,	you	need	to	understand
two	terms	pertaining	to	them.	First	is	Direct	Precedents,	which	refer	to	cells	that	directly
feed	the	formulas.	The	second	term	is	Dependents	which	implies	the	cells	that	depend	on
the	results	of	the	formulas.

Following	is	a	brief	description	about	the	formula	auditing	tools	available	in	Excel.

	

Trace	Precedents

When	 you	 click	 the	 Trace	 Precedents	 command	 once,	 Excel	 puts	 arrows	 to	 the	 direct
precedents;	 that	 is,	 the	 cells	 that	 are	 referred	 to	 in	 the	 formula	 in	 the	 cell.	Clicking	 the
Trace	Precedents	command	again	cause	Excel	to	add	a	tracer	to	the	arrows	that	identifies
the	cells	that	are	referred	to	in	the	formulas	in	the	direct	precedents.

Choosing	the	Error	Checking	Option

The	Error	Checking	tool	performs	a	complete	error-check	and	tells	you	the	nature	of	the
error	in	the	selected	cell.	It	also	offers	help	on	the	particular	error	and	allows	you	to	trace
its	precedents.



When	you	will	click	the	Error	Checking	drop	down	list,	you	will	see	that	there	is	another
option	by	the	name	of	Trace	Error.	Clicking	it	will	cause	Excel	to	find	the	cell	that	holds
the	underlying	formula	containing	the	error.

The	third	option	in	the	Error	Checking	drop	down	list	is	Circular	References.	It	carries	a
continuation	 menu	 that	 tells	 you	 the	 cells	 addresses	 of	 all	 the	 cells	 having	 circular
references	in	the	current	worksheet.

Trace	Dependents

The	Trace	Dependents	tool	 traces	all	 the	cells	 that	currently	are	or	have	been	directly	or
indirectly	 linked	 to	 the	 underlying	 formula.	 When	 you	 click	 the	 Trace	 Dependents
command	once,	Excel	puts	arrows	from	the	selected	cell	to	the	direct	precedents;	that	is,
the	 cells	 that	 are	 referred	 to	 in	 the	 formula	 in	 the	 cell.	 Clicking	 this	 Trace	Dependents
command	again	will	cause	Excel	to	add	a	tracer	to	the	arrows	that	identifies	the	cells	that
are	referred	to	in	the	formulas	in	the	direct	precedents.

Evaluating	the	Formula	

The	Evaluate	Formula	tool	evaluates	each	part	and	item	of	the	selected	cell.	Select	the	cell
that	you	want	to	analyze	and	click	the	Evaluate	Formula	command	in	the	Formulas	tab.
This	 will	 open	 the	 Evaluate	 Formula	 dialog	 box.	 Here	 you	 will	 see	 the	 complete
evaluation	of	the	selected	cell.

Removing	Arrows

If	you	don’t	have	time	or	want	to	rectify	the	errors	and	just	want	to	remove	the	errors	from
the	view,	you	can	do	so	by	clicking	the	Remove	Arrows	button	in	the	Formulas	tab.

Figure	25.3	-	The	Remove	Arrows	Commands	in	Excel

As	you	can	see	 in	Figure	25.3,	 the	Remove	Arrows	command	contains	 a	drop	down	 list
with	three	options,	briefed	as	follows:

1.	 The	Remove	Arrows	command	removes	all	the	arrows	on	the	current	worksheet



2.	 The	Remove	Precedent	Arrows	command	removes	all	arrows	that	were	put	up	after
you	clicked	the	Trace	Precedents	button

3.	 The	Remove	Dependent	Arrows	command	removes	all	the	arrows	that	were	put	up
when	you	clicked	the	Trace	Dependents	button.

Window	Watching	Tool

The	Watch	 Window	 command	 opens	 the	Watch	 Window	 dialog	 box,	 which	 shows	 the
current	workbook,	worksheet,	cell	address,	 range	name,	value	 in	 the	underlying	cell	and
formula	in	the	cells	that	are	added	in	the	watch	list.

If	you	want	to	add	a	cell	to	the	watch	list,	select	the	particular	cell	in	the	worksheet,	click
Watch	Window	to	open	the	Watch	Window	dialog	box	and	then	click	Add	Watch	in	it.		
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BOOK	IV:	CHART	AND	GRAPHICS

umbers,	 formulas,	 calculations	 and	 so	 on…these	 are	 normally	 the	 words	 that
comes	into	our	mind	when	we	think	of	“Excel”.	Excel	has	a	general	impression
of	being	a	number	cruncher	but	this	is	not	what	it	is	all	about.	If	you	think	of	it

this	way,	then	you	are	not	aware	of	the	most	colorful	and	exciting	feature	of	Excel;	that	is,
the	charts	and	graphics.

Excel	 has	 the	 ability	 to	 create	 some	 advanced	 graphical	 and	 enthralling	 pictorial
representations	 of	 the	 data.	 The	 best	 part	 is	 that	 these	 charts	 are	 linked	 to	 the
corresponding	cells.	In	other	words,	the	pictorial	representations	in	Excel	are	live,	hence
are	updated	as	soon	as	the	input	data	is	changed.		

The	four	chapters	in	this	book	talks	about	the	colorful	charting	and	other	pictorial	features
of	 Excel.	 You	will	 learn	 some	 unique	 tricks	 to	 use	 Excel’s	 graphical	 abilities,	 drawing
tools	and	Sparkline	graphics.

AT	A	GLANCE

Chapter	26:	Creating	Charts

Chapter	27:	Advanced	Charting	Techniques

Chapter	28:	Working	With	Sparkline	Graphics

Chapter	29:	Beautifying	Your	Work	with	Pictures	and	Graphics				
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Chapter	26:	Creating	Charts

his	chapter	discusses	the	basics	of	the	charting	capabilities	of	Excel.	It	introduces
you	 to	 the	different	 chart	 types	 and	 their	 applications.	Moreover,	you	will	 learn
how	 to	 create	 a	 chart	 in	 Excel,	 how	 to	 resize	 it	 and	 several	 other	 chart

management	techniques.	

Understanding	the	Basics	

Starting	from	the	basic	definition,	a	chart	is	a	pictorial	representation	of	numeric	values.
Also	 known	 as	 graphs,	 charts	 have	 been	 an	 integral	 part	 of	 Excel	 since	 its	 early	 days;
needless	to	say	that	they	have	improved	and	advanced	over	time.

Excel	2013	offers	some	of	the	most	advanced	and	high	tech	charting	capabilities.	You	can
create	 chart	 from	 numeric	 values	within	 the	 same	worksheet	 as	well	 as	with	 data	 from
other	 worksheets.	 Then	 you	 can	 also	 change	 the	 chart	 type,	 size,	 input	 values	 and
formatting	as	many	times	as	you	want	even	after	creating	a	chart.				

A	chart	in	Excel	can	either	be	embedded	in	a	worksheet	or	can	be	displayed	in	a	separate
chart	sheet.	An	embedded	chart	is	the	one	that	floats	on	top;	that	is,	on	the	drawing	layer
of	the	worksheet.

By	default,	every	chart	is	created	as	an	embedded	chart.	You	can	then	later	on	move	it	to
the	chart	sheet.

To	create	a	chart	directly	on	a	separate	chart	sheet,	select	the	data	and
hit	F11.		

	

An	embedded	chart	can	easily	be	moved	to	a	chart	sheet	and	vice	versa.	To	do	so,	select
the	 chart,	 click	Chart	Tools	 >	Design	 >	Location	 >	Move	Chart.	 This	 will	 open	 the
Move	Chart	dialog	box.	Click	the	New	Sheet	check	circle	and	enter	a	name	for	the	chart
sheet.	If	you	don’t	want	to	give	any	particular	name	to	the	chart	sheet,	you	can	use	the	one
proposed	by	Excel	in	New	Sheet	type	text	box.



Figure	26.1	-	Moving	an	Embedded	Chart	to	a	Chart	Sheet

In	Figure	26.1,	the	proposed	name	is	Chart.

Now	that	you	know	the	basic	features	of	a	chart,	 let’s	see	how	you	can	actually	create	a
chart	in	Excel.	

	

	

Selection	of	Data

The	first	step	in	creating	a	chart	is	 to	select	the	data	for	the	chart.	Your	selection	should
contain	rows	and	column	headings	to	serve	as	labels	and	series	indicators	in	the	chart.	You
can	select	a	contiguous	range	or	separate	rows	and	columns.

	

The	 data	 range	 for	 the	 chart	 does	 not	 need	 to	 be	 contiguous.	 If	 you
want	to	create	a	chart	of	data	lying	in	different	and	nonadjacent	rows
and	columns,	press	and	hold	Ctrl	while	you	select	all	the	data.			

	

You	don’t	have	 to	select	 the	entire	data	 in	every	case.	 If	you	want	 to
create	a	chart	of	all	data	in	a	table	or	a	range	of	cells	that	is	separated
from	other	filled	cells,	just	select	any	one	cell	in	the	table	or	range	and
create	 the	 chart.	Excel	 2013	 is	 quite	 smart	 and	will	 almost	 guess	 the
data	 range	 for	 chart	 accurately.	This	 technique	 comes	 in	handy	when
the	data	for	chart	is	a	contiguous	range.		

	

While	Excel	allows	you	 to	create	a	chart	using	data	 located	 in	different	worksheets,	 the



initial	data	must	be	from	the	same	worksheet.	You	can	then	later	on	add	more	data	from
different	worksheets	to	the	already	created	chart.

Pick	a	Chart	Type

Once	you	are	done	selecting	 the	data,	 the	next	step	 is	 to	select	 the	chart	 type.	To	do	so,
choose	the	Insert	tab.	There	in	the	Charts	group,	you	will	 the	different	chart	categories.
Each	category	command	is	a	drop	down	list	containing	the	types	of	charts	available	in	the
particular	category.	Select	the	chart	type	you	want	to	create	and	it	will	be	displayed	on	the
active	worksheet.

If	you	are	unable	to	choose	a	chart	type,	you	can	let	Excel	do	that	for	you.	In	the	Charts
group	on	the	Insert	tab,	you	will	find	the	Recommenced	Charts	button.			Select	the	data
you	want	 to	 create	 the	 chart	 of	 then	 click	 the	Recommenced	Charts	 button.	 This	will
open	the	Insert	Chart	dialog	box,	as	shown	in	Figure	26.2

Figure	26.2	-	Creating	a	Chart	by	Using	the	Recommended	Chart	Feature	in	Excel

The	chart	at	the	top	is	the	one	highly	recommended	by	Excel.	You	can	also	scroll	down	for
other	recommendations.	If	you	like	any	of	the	recommended	charts,	select	it	and	then	click
OK.	

Play	With	Different	Styles	and	Layouts

After	creating	a	chart,	you	may	want	to	try	different	colors	and	layouts	with	the	same	data
to	check	which	graph	gives	the	best	and	intended	pictorial	representation.	

Well,	you	don’t	have	to	recreate	or	modify	a	chart	to	check	different	styles.	Just	select	the



chart,	then	click	Design	tab	in	the	Chart	Tools	contextual	tabs.	There	in	the	Chart	Styles
group,	you	will	see	the	same	chart	type	in	different	colors.	Just	hover	your	mouse	cursor
over	to	any	of	the	style	and	check	its	preview	in	your	chart	on	the	worksheet.	Don’t	worry
the	changes	will	not	be	applied	just	by	hovering	over	the	style.	If	you	like	any	chart	style,
click	it	to	apply.	

Just	 like	 styles	 and	 colors,	 you	 can	 experiment	with	 different	 layouts	 as	well.	A	 layout
contains	 supplementary	chart	 elements,	 such	as	 a	 title,	 axes,	data	 labels,	 and	more.	You
can	 add	 or	 delete	 the	 individual	 elements	manually	 as	well,	 but	 using	 a	 built-in	 layout
saves	a	lot	of	time.	Even	if	you	don’t	find	the	exact	layout	you	want,	you	can	select	a	one
that	is	closely	similar	to	what	you	want	and	then	make	a	few	adjustments	in	it.

To	check	how	a	predefined	layout	would	look,	select	the	chart,	then	click	Design	tab	in	the
Chart	Tools	contextual	 tabs.	There	 in	 the	Chart	Layouts	group,	 click	 the	Quick	Layout
button	 drop	 down	 list	 to	 explore	 the	 different	 layouts	 available.	 Just	 hover	 your	mouse
cursor	over	to	any	of	the	layout	and	check	its	preview	in	your	chart	on	the	worksheet.

If	you	want	to	manually	add	or	remove	any	chart	elements,	click	the	Chart	Elements	icon
represented	by	a	plus	sign	at	the	top	right	of	the	chart.	

Figure	26.3	-	Adding	Chart	Elements

As	 shown	 in	Figure	26.3,	 the	Chart	Elements	 option	 contains	 a	 checkbox	 list	 of	 all	 the
elements.	Moreover,	each	item	contains	a	continuation	menu	containing	more	options	for
the	particular	option.	Put	a	 tick	mark	next	 to	 the	elements	 that	you	want	 to	add	 to	your
graph.	Uncheck	ones	that	you	want	to	remove.	

Exploring	the	Different	Chart	Types	in	Excel

If	you	don’t	like	any	of	the	charts	recommended	by	Excel,	you	can	select	from	the	ones



located	 in	 the	Charts	 group	on	 the	 Insert	 tab.	Following	 is	a	brief	description	of	 the	all
charts	categories	in	Excel.

	

Each	category	contains	several	types	of	charts.	While	this	section	talks
about	 the	 general	 category	 only,	 you	 can	 experiment	 any	 chart	 by
hovering	 your	 mouse	 cursor	 over	 it.	 Doing	 so	 will	 also	 reveal	 a
ScreenTip	for	the	particular	chart.		

Column	Charts

The	most	commonly	used	chart	type	is	the	column	chart.	It	portrays	each	data	point	in	the
form	of	a	vertical	column.	The	height	of	the	column	corresponds	to	and	signifies	the	size
of	the	value.

In	column	charts,	the	value	scale	is	plotted	on	the	vertical	axis.	You	can	entail	any	large	or
small	data	series.	The	corresponding	values	 from	each	series	are	stacked	on	 top	of	each
other.	Normally,	each	column	and	data	series	is	shown	in	a	different	color,	which	you	can
change	in	the	Chart	Styles	group	in	the	Design	tab.	

Column	charts	are	of	many	types.	It	could	be	2-D,	3-D,	cone,	cylindrical	and	much	more.
Click	 the	Column	 command	 in	 the	 Insert	 tab	 on	 the	 Ribbon	 to	 explore	 the	 different
column	charts.

Bar	Chart

A	 bar	 chart	 is	 nothing	 but	 a	 90-degrees	 clockwise	 rotated	 version	 of	 a	 column	 chart.
However,	 it	 holds	 one	 distinct	 advantage	 over	 a	 column	 chart.	 A	 bar	 chart	 can
accommodate	lengthier	category	labels,	hence	make	them	more	readable.

If	your	data	range	consists	of	lengthy	labels	and	headings,	then	it	 is	recommended	to	go
for	bar	chart	as	it	would	be	difficult	to	adjust	the	labels	in	the	column	chart.			

Figure	26.4	shows	different	 type	of	column	and	bar	charts	plotted	using	 the	same	set	of
data.



Figure	26.4	-	Showing	Two	Different	Types	of	Column	and	Bar	Chart

Line	Charts

Line	Charts	are	normally	used	to	plot	continuous	data	and	to	identify	trends.	The	category
axis	in	a	line	chart	normally	displays	equal	intervals.		

Figure	26.5	shows	an	example	of	line	chart.

In	the	example	shown	in	Figure	26.5,	the	annual	sales	data	of	two	products	is	plotted	on	a
line	chart.	From	the	shape	of	the	line,	the	sales	trend,	fluctuations,	peak	and	lowest	points
on	sales	can	easily	be	identified.	

	

Figure	26.5	-	Creating	Line	Chart	to	Analyze	the	Sales	Trend	over	the	Year			

You	can	add	any	number	of	data	series	in	a	line	chart	and	the	lines	can	be	distinguished	by
using	 different	 colors.	 For	 example,	 you	 can	 plot	 the	 annual	 sales	 trend	 of	 different



products	 on	 the	 same	 line	 graph,	 and	 then	 use	 different	 colors	 to	 differentiate	 the	 sales
trend	of	each	product,	just	like	it	is	shown	in	Figure	26.5.

You	 can	 also	 add	 squares,	 triangles	 or	 any	 other	markers	 to	 differentiate	 the	 lines	 from
each	other.	The	markers	come	in	very	handy	when	you	need	to	print	a	non-color	version	of
the	chart.	In	such	cases,	since	that	chart	is	printed	in	grayscale,	markers	are	the	only	way
to	distinguish	between	different	lines.			

Area	Charts

Area	charts	are	quite	similar	to	line	charts	but	with	one	major	difference;	that	is,	the	area
below	the	line	is	filled.	The	colorful	area	makes	it	easier	to	evaluate	the	size	of	values.	The
data	series	with	smaller	values	are	plotted	in	the	back	of	the	chart.

Figure	26.6	shows	an	example	of	an	area	chart.

Figure	26.6	-	Creating	an	Area	Chart	to	Analyze	the	Sales	Trend	over	the	Year			

Surface	Charts

Surface	charts	are	used	to	display	multiple	data	series	on	a	surface.

	

You	cannot	create	a	surface	chart	with	one	data	series.	It	must	contain
at	least	two	data	series,	or	else	Excel	displays	an	error.			

	

Following	are	a	few	distinct	features	of	surface	charts:

Unlike	 line	 chart	 that	 uses	 colors	 to	 distinguish	 data	 series,	 a	 surface	 chart	 uses
colors	to	differentiate	values	and	not	series.



The	number	of	colors	used	depends	upon	the	major	unit	scale	setting	for	the	value
axis.

Each	color	pertains	to	one	major	unit.

You	cannot	plot	3-D	data	points	on	 a	 surface	 chart.	The	 series	 axis	 for	 a	 surface
chart	is	not	a	value	axis,	it	is	a	category	axis.	In	other	words,	if	your	data	contains
three	 coordinates	 (x,	 y	 and	 z),	 you	 cannot	 plot	 it	 accurately	 unless	 the	 first	 two
coordinates	are	equally	spaced.

Radar	Charts

A	 radar	 chart	 is	 a	 special	 type	 of	 chart	 that	 has	 a	 separate	 axis	 for	 each	 category.	One
another	very	distinct	feature	that	makes	the	Radar	charts	stand	apart	from	other	charts	in
Excel	is	that	the	axes	in	it	stretches	outward	from	the	middle	of	the	chart	with	each	data
point	plotted	on	the	corresponding	axis.

Figure	26.7	illustrates	an	example	of	a	radar	chart.

Figure	26.7	-	Example	of	a	Radar	Chart



Pie	Charts

Pie	charts	are	normally	used	 to	 show	relative	proportions	 to	a	whole.	For	example,	you
can	create	a	pie	chart	to	show	the	contribution	of	each	product	in	the	total	revenue,	or	the
proportion	of	each	course	in	the	total	credit	hours	for	the	academic	degree	and	so	on.

Pie	charts	are	useful	when	created	with	a	small	number	of	data	points,	preferably	five	to
six	points.	A	pie	chart	with	too	many	data	points	and	values	becomes	very	cramped	and
difficult	to	read.		

	

Use	 pie	 charts	 only	 when	 the	 values	 in	 your	 data	 are	 all	 positive
integers.	Pie	charts	do	not	recognize	negative	values,	and	if	you	add
one,	it	will	be	automatically	converted	to	a	positive	value.			

	

The	 most	 distinct	 and	 popular	 feature	 of	 a	 pie	 chart	 is	 its	 ability	 to	 explode.	 You	 can
separate	one	or	more	slices	of	a	pie	chart	to	emphasize	the	particular	data	series.	And	it	is
very	simple!	All	you	have	to	do	it	select	 the	chart,	click	over	any	pie	slice	 to	active	 the
entire	pie,	 the	click	 the	 slice	 that	you	want	 to	emphasize	and	drag	 it	outwards	 from	 the
center.

Figure	26.8	shows	an	example	of	such	a	pie	chart.

Figure	26.8	-	Pie	Chart	with	an	Exploded	Slice	to	Emphasize	the	Sales	of	Product	B	

Scatter	Charts

Scatter	charts	(also	known	as	XY	chart,	scattergrams	and	scatter	plots)	have	no	category



axis.	They	are	normally	used	to	display	relationship	between	two	variables.	

Figure	26.9	shows	an	example	of	a	scatter	chart.

Figure	26.9	-	Showing	the	Relationship	between	Two	Elements	Using	a	Scatter	Chart															

In	the	example	illustrated	in	Figure	26.9,	the	scatter	chart	shows	the	relationship	between
free	 trials	of	 a	product	and	 sales.	 It	 indicates	 the	effect	of	giving	 free	giveaways	on	 the
sales	of	the	particular	over	the	year.		

Bubbles	Charts

A	bubble	chart	is	quite	similar	to	a	scatter	chart	but	with	one	major	difference;	that	is,	a
bubble	chart	allows	you	to	add	an	additional	data	series	 that	 is	shown	by	the	size	of	 the
bubbles.

Figure	26.10	shows	an	example	of	a	bubble	chart.	The	same	set	of	data	that	was	used	to
create	a	scatter	chart	is	taken	in	the	below	image	to	create	a	bubble	chart.

Figure	26.10	-	Example	of	a	Bubble	Chart	in	Excel	2013

	

Stock	Charts



Stock	charts,	as	the	name	suggests,	are	mostly	used	to	display	data	related	to	stock	market.
For	 example,	 market	 index,	 NASDAQ	 performance,	 technical	 analysis	 of	 a	 company’s
stock	price	and	so	on.	

There	are	several	subtypes	of	stock	charts.	Depending	upon	the	subtype,	a	stock	chart	can
contain	three	to	five	data	series.	

Figure	26.11	shows	an	example	of	a	stock	chart.

Figure	26.11	-	Example	OF	A	Stock	Chart



Adjusting	the	Chart	Size

	

By	default,	every	chart	in	Excel	is	an	embedded	chart	unless	created
on	or	moved	to	a	chart	sheet.	So	every	time	the	term	chart	in	used	in
this	book,	it	refers	to	an	embedded	chart.

	

To	 resize	 a	 chart,	 click	 the	 outer	 edge	 or	 corner	 of	 the	 chart.	 You	will	 see	 that	 square
handles	appears	on	the	corners	of	 the	chart	and	then	within	a	second,	 the	mouse	pointer
will	turn	into	a	double	arrow.	Click	the	double	arrow	and	drag	it	inwards	or	outwards	to
achieve	the	desired	size.

You	can	also	resize	a	chart	by	selecting	Format	in	the	Chart	Tools	contextual	tabs.	There
in	the	Size	group	you	will	find	two	controls;	one	to	adjust	the	height	and	other	to	adjust	the
width	of	the	selected	chart.	

Moving	a	Chart

To	move	a	chart	from	one	place	to	another	on	a	worksheet,	simply	click	the	chart,	place
the	cursor	on	any	of	the	chart’s	border	and	then	drag	it	to	the	desired	location.

You	can	also	use	the	traditional	cut	and	paste	technique	to	move	a	chart.	Select	the	chart
you	want	to	move,	right	click	and	select	Cut	(or	hit	Ctrl	+	X).	Then	select	 the	cell	near
the	new	desired	location,	right	click	and	select	Paste	(or	hit	Ctrl	+	V).

You	can	a	move	a	chart	to	a	different	location	in	the	same	worksheet
or	 to	 a	 new	 worksheet.	 In	 case	 of	 the	 latter,	 the	 chart	 will	 still	 be
linked	to	the	original	values.

	

Removing	a	Chart

To	 get	 rid	 of	 an	 embedded	 chart,	 click	 the	 particular	 chart	 and	 hit	 Delete	 on	 your
keyboard.	 To	 delete	 multiple	 charts	 at	 the	 same	 time,	 press	 and	 hold	 Ctrl	 on	 your
keyboard	 and	 then	 click	 all	 the	 charts	 that	 you	want	 to	 get	 rid	 of.	 Hit	Delete	 on	 your
keyboard



To	delete	a	chart	sheet,	right	click	the	corresponding	sheet	tab	and	select	Delete.	To	delete
multiple	chart	sheets	at	 the	same	time,	press	and	hold	Ctrl	on	your	keyboard	while	you
click	all	the	chart	sheets	that	you	want	to	get	rid	of.	Then	right	click	and	select	Delete.
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Chapter	27:	Advanced	Charting	Techniques

elect	your	data,	choose	a	chart	type	and	that’s	all	it	is	required	to	create	a	graph	in
Excel.	However,	 at	 times	 a	 simple	default	 chart	won’t	 be	 just	 enough.	You	may
need	to	customize	a	chart	to	make	it	more	effective.

Customizing	 a	 chart	 in	 Excel	 includes	 changing	 the	 colors,	 appearance,	 background,
legends,	titles	and	much	more.	You	may	not	get	your	desired	layout	and	chart	style	built	in
Excel	every	time.	You	may	have	to	modify,	add	and	remove	some	chart	elements	to	make
your	chart	perfect.	

This	 previous	 chapter	 talked	 about	 basic	 charting	 techniques	 in	 Excel.	 This	 chapter
extends	charting	 to	 a	more	advanced	 level.	Here	you	will	 discover	how	 to	modify	your
chart	to	make	it	look	exactly	the	way	you	want.	You	will	also	learn	some	handy	tricks	on
adding	titles	and	legends,	working	with	data	series,	charting	elements	and	much	more.				

Choosing	the	Chart	Elements	

Just	like	every	operation	you	do	in	Excel,	the	first	step	in	modifying	a	chart	is	to	select	the
chart	element	that	you	want	to	modify	and	then	apply	the	required	command.

	

You	can	modify	as	many	elements	as	you	want	but	one	at	a	time.	You
cannot	 customize	 multiple	 elements	 at	 a	 time.	 For	 example,	 if	 you
want	to	change	the	font	of	two	legends	or	axes	titles,	you	must	select
and	modify	one	title	at	a	time.

There	 are	 three	ways	 of	 selecting	 a	 chart	 element;	mouse,	 keyboard	 and	 chart	 element
controls.	Let’s	discuss	each	one	by	one.

The	simplest	way	to	select	a	chart	element	is	by	clicking	it	using	your	mouse.	The	selected
chart	element	displays	small	circles	at	the	corners.

At	times	you	may	get	confused	as	to	whether	you	selected	the	right	element.	This	mostly
happens	when	the	chart	is	cramped	with	lots	of	elements	in	it.

To	check	 it	you	made	 right	 selection,	 select	Format	 in	 the	Chart	Tools	 contextual	 tabs.
There	 in	 the	Current	Selection	group	you	will	 find	 the	name	of	 the	selected	element,	as
shown	in	Figure	27.1



Figure	27.1	-	Showing	the	Name	of	the	Selected	Element	in	the	Format	Tab

In	 Figure	 27.1,	 the	 numerical	 values	 located	 on	 the	 vertical	 axis	 are	 selected.	 In	 the
Current	Selection	group,	it	says	“Vertical	(Value)	Axis”.

Some	chart	elements	are	too	minute	or	tricky	to	be	selected	with	a	mouse.	Don’t	worry!
There	are	other	ways	of	selection	too.

If	you	are	unable	to	select	the	required	element	with	a	mouse,	try	it	with	a	keyboard.	Just
select	 the	 chart	 to	 make	 it	 active	 then	 use	 the	 arrow	 keys	 to	 cycle	 through	 the	 chart
elements.

Remember	the	following	points	while	selecting	chart	elements	with	a	keyboard:

To	select	individual	items	within	a	chart	series,	first	select	the	entire	series	and	then
use	left	and	right	arrows	on	the	keyboard.

To	select	specific	elements	within	a	 legend,	 first	select	 the	entire	 legend	and	 then
cycle	through	the	elements	using	the	left	and	right	arrow	keys.

To	select	a	particular	data	label,	first	select	the	entire	set	of	data	labels	and	then	use
left	and	right	arrows	on	the	keyboard	to	move	to	the	appropriate	data	label.

If	 you	 are	 unable	 to	 select	 the	 right	 element	 with	 a	 mouse	 or	 keyboard,	 then	 select	 it
manually	 in	 the	 Chart	 Selection	 group.	 To	 do	 so,	 select	 Format	 in	 the	 Chart	 Tools
contextual	 tabs.	 There	 in	 the	 Current	 Selection	 group	 you	 will	 find	 a	 drop	 down	 list
containing	names	of	the	elements	in	the	selected	chart.

	

If	you	need	to	do	a	lot	of	work	with	charts,	it	is	recommended	to	add



the	Chart	Elements	 drop	 down	 list	 to	 the	Quick	Access	 toolbar.	 Just
right	 click	 the	 mentioned	 drop	 down	 list	 and	 click	 Add	 to	 Quick
Access	Toolbar.		

Working	with	Chart	Element

Now	 that	 you	 know	how	 to	 select	 the	 required	 element,	 let’s	 see	 how	you	 can	 actually
modify	it.	There	are	several	ways	of	customizing	the	selected	chart	element,	explained	as
follows.		

Ribbon	Commands

The	Ribbon	contains	some	commonly	used	chart	formatting	commands.	For	example,	 to
change	the	color	of	the	chart	(bars,	lines,	pie	slices	and	so	on),	select	the	chart	then	select
Chart	Tools	>	Format	>	Shape	Styles	group.

Not	all	 the	chart	 formatting	commands	can	be	found	 in	 the	Chart	Tools	contextual	 tabs.
For	example,	to	change	the	font	of	the	title	or	legend,	select	the	text	then	change	the	font
through	the	Font	type	and	size	commands	in	the	Home	tab	on	the	Ribbon.

Format	Task	Pane

If	 you	 are	 unable	 to	 find	 the	 required	 formatting	 option	 in	 the	 Ribbon,	 look	 for	 it	 the
Format	task	pane.	It	contains	a	lot	of	other	chart	customization	tools.

You	can	access	the	Format	task	pane	by	using	any	of	the	following	methods:

1.	 Right	click	the	chart	element	that	you	want	to	modify,	then	select	Format	nnn	(nnn
is	the	name	of	the	selection).	

2.	 Double	click	the	chart	element.

3.	 Select	 the	 chart	 element	 that	 you	 want	 to	 modify,	 then	 select	 Chart	 Tools	 >
Format.	There	in	the	Current	Selection	group,	click	Format	Selection.

	

For	keyboard	users,	select	the	chart	element	and	press	Ctrl	+	1	on	your
keyboard.

	

Using	Mini	Toolbar	to	Modify	the	Chart	Elements



The	Mini	Toolbar	 also	 contains	 a	 few	chart	 formatting	 tools.	 It	 appears	when	you	 right
click	an	element	in	a	chart,	as	shown	in	Figure	27.2

Figure	27.2	-	Showing	the	Chart	Element	Mini	Toolbar

	

Formatting	the	Plot	Area

At	times,	you	may	want	to	format	or	beautify	the	plot	area	as	well.	The	Plot	Area	 is	 the
area	that	actually	contains	the	chart	and	the	chart	series.

Following	are	a	few	tips	to	format	the	plot	area,

To	move	 the	 Plot	Area,	 select	 the	 border	 of	 the	 chart	 and	 drag	 it	 to	 the	 desired
location.

To	 resize	 the	 Plot	 Area,	 click	 any	 of	 the	 corner	 handles	 and	 drag	 it	 inwards	 or
outwards	to	the	desired	size.

To	make	the	Plot	Area	transparent,	set	the	Shape	Fill	property	to	No	Fill.	This	will
then	make	the	color	in	the	chart	area	show	through.

In	 some	 cases,	 the	 size	 of	 the	 plot	 area	 adjusts	 automatically	 in	 response	 to	 the	 other
changes.	 For	 example,	 adding	 a	 legend	 or	 an	 additional	 title	 to	 a	 chart	 automatically
increases	the	plot	area.		

Naming	Charts

A	chart	is	incomplete	without	titles.	It	is	very	difficult	to	read	and	analyze	a	chart	unless



you	know	which	axis	represents	what.	This	section	talks	about	different	types	of	titles	that
you	can	add	to	your	chart.	

Inserting	a	Chart	Title

A	 chart	 can	 have	 several	 titles,	 such	 as	 the	 Chart	 title,	 Category	 axis	 title,	 Secondary
category	axis	title,	Value	axis	title	and	Depth	axis	title.

How	many	 and	 which	 titles	 you	 should	 use	 depends	 upon	 the	 type	 of	 your	 chart.	 For
example,	a	pie	chart	can	only	contain	a	chart	title.	You	cannot	add	any	axis	titles	as	the	pie
chart	itself	does	not	have	any	axes.	Likewise,	the	Depth	axis	title	is	only	compatible	with
3-D	charts.

To	 add	 a	 chart	 title,	 first	 select	 the	 chart,	 click	 the	Chart	 Elements	 button	 (a	 plus	 sign
located	to	the	right	of	the	chart)	and	then	put	a	tick	mark	next	to	Chart	Title.

If	 you	want	 to	 change	 the	 location	 of	 the	Chart	 title	 in	 the	 plot	 area,	 simply	move	 the
mouse	cursor	over	 to	 the	Chart	Title	 item	and	select	 the	arrow,	 then	specify	 the	desired
location.	For	advanced	settings	related	to	Chart	titles,	click	More	Options.	This	will	open
the	Format	Chart	Title	task	pane

The	 same	 procedure	 applies	 to	 all	 other	 types	 of	 titles.	 Just	 remember	 one	 thing:	 You
cannot	resize	the	box	containing	the	title.	The	only	way	to	increase	or	decrease	the	size	of
a	title	is	by	changing	its	font	size.		

You	can	link	the	chart	title	or	axis	title	to	a	cell.	Suppose,	cell	A1	contains	the	text	value
“January”.	 If	 you	 link	 the	 axis	 title	or	 chart	 title	 to	 cell	A1,	 the	 corresponding	 text	will
appear	in	the	title’s	location	in	the	Plot	Area.	Every	time	you	change	the	text	value	in	cell
A1,	the	same	will	be	updated	in	the	linked	title.

To	link	a	title	to	a	cell,	select	the	title,	type	an	equal	sign	(=),	then	select	the	cell	reference
and	hit	Enter.



Adding	Legends

A	Legend	contains	text	and	some	other	keys	that	indicate	the	data	series	in	a	chart.	A	Key
refers	to	a	small	graphical	object	that	pertains	to	chart’s	series,	one	key	for	each	series.

Adding	a	legend	to	a	chart	is	quite	simple.	First,	select	the	chart	to	activate	it,	then	click
the	Chart	Elements	 button	 (a	 plus	 sign	 located	 to	 the	 right	 of	 the	 chart)	 and	 enable	 the
Legend	item.

If	you	want	to	specify	a	position	for	the	legend,	click	the	small	arrow	located	right	next	to
the	Legend	 item	 then	 select	 the	desired	 location.	You	can	also	move	a	 legend	manually
within	the	Plot	area.	To	do	so,	simply	click	and	drag	it	to	wherever	you	like.		

To	get	rid	of	a	legend,	just	click	it	and	hit	Delete	on	your	keyboard.

Just	 like	 you	 can	 customize	 the	 chart	 elements,	 you	 can	modify	 the	 legend	 elements	 as
well.	For	example,	you	can	bold	or	underline	the	text	in	a	legend	to	emphasize	a	particular
data	series.

If	 you	 did	 not	 add	 legends	 at	 the	 time	 of	 creating	 the	 chart,	 by	 default	 Excel	 displays
Series	 1,	 Series	 2,	 and	 so	 on	 as	 legends.	 To	 rename	 the	 default	 series	 name,	 select	 the
Design	 tab	in	the	Chart	Tools	Contextual	 tabs.	There	 in	 the	Data	group,	you	will	 find	a
command	named	Select	Data.	Click	this	command	to	open	the	Select	Data	Source	dialog
box,	as	shown	in	Figure

Select	 the	 series	you	want	 to	 rename	and	click	 the	Edit	button.	This	will	open	 the	Edit
Series	dialog	box.	Enter	the	desired	name	and	click	OK.	Repeat	the	same	to	rename	other
series.	

Working	with	Axes

The	number	of	axes	depends	upon	the	type	of	chart	you	use.	For	example,	pie	charts	have
no	 axes.	 All	 other	 2-D	 charts	 have	 two	 axes	 but	 you	 can	 add	 one	 more,	 that	 is	 the
secondary	value	axis.	Likewise,	all	3-D	charts	have	three	axes.

You	can	manage	the	axes	in	your	charts	through	the	Format	Axis	Task	pane.

To	modify	 the	value	axis,	 right	click	 the	axis	and	select	Format	Axis	 from	 the	 shortcut
menu.	This	will	open	the	Format	Axis	task	pane,	as	shown	in	Figure	27.3



Figure	27.3	-	Showing	the	Format	Axis	Task	Pane

The	 Bounds	 section	 located	 at	 the	 top	 of	 the	 task	 pane	 indicates	 the	 minimum	 and
maximum	values	 for	 the	axis.	Based	on	 the	 lowest	 and	highest	numerical	value	 in	your
data,	 Excel	 determines	 the	minimum	 and	maximum	 value	 automatically.	However,	 you
can	 also	 specify	 any	 other	 values.	Likewise,	 the	Major	 and	Minor	 units	 are	 also	 set	 by
default	but	you	can	of	course	change	them.

Once	you	change	any	of	the	default	values,	the	Auto	icon	located	right	next	to	the	value
changes	 to	 “Reset”.	 Clicking	 it	 resets	 the	 default	 Excel	 settings	 pertaining	 to	 the
corresponding	command.

Another	very	 interesting	option	 in	 the	Format	Axis	Task	pane	 is	 the	 “Values	 in	Reverse
Order”.	 It	 reverses	 the	 scale’s	 direction.	 For	 example,	 if	 it	 is	 a	 column	 chart,	 then
activating	the	“Values	in	Reverse	Order”	option	would	put	the	columns	upside	down.

If	you	are	creating	several	charts	using	the	same	nature	of	data,	it	is	highly	recommended
to	keep	the	Minimum	and	Maximum	Bounds	values	same	for	the	all	charts.	Suppose	you
have	created	five	column	charts	to	evaluate	the	monthly	sales	of	five	products;	one	chart
for	 one	 product.	 Keeping	 the	 Bounds	 values	 same	 would	 help	 you	 make	 effective
comparison	among	the	products.	

Understanding	the	Data	Series

Every	chart	is	made	up	of	one	or	more	data	series.	It	is	the	data	series	that	translates	itself
in	the	form	a	chart’s	bar,	column,	pie,	bubbles	and	so	on.



Suppose	 you	 are	 working	 on	 a	 column	 chart	 that	 displays	 the	 sales	 revenue	 generated
every	month.	Now	rather	than	creating	a	new	chart	every	month,	don’t	you	think	it	would
be	better	and	more	effective	if	you	just	add	the	monthly	data	to	the	already	created	column
chart.	This	will	also	make	the	monthly	comparison	easier.

This	section	talks	about	all	such	operations.	You	will	learn	to	add,	modify,	delete	and	do
much	more	to	your	data	series.

Managing	the	Data	Series

Following	are	a	few	techniques	for	managing	your	data	series.

To	delete	any	data	series	and	its	corresponding	representation	in	the	chart,	simply
select	the	referenced	data	and	hit	Delete	on	your	keyboard.

To	modify	the	values	in	a	data	series,	first	select	the	chart	element	representing	it.
This	will	automatically	select	the	corresponding	data	on	the	worksheet.	Now	drag
the	range	to	include	more	data	points.			

Another	way	to	edit	data	series	is	via	the	Edit	Series	dialog	box.	Here	is	what	you
need	to	do.	First,	right	click	the	data	series	in	the	chart	and	then	click	Select	Data
from	 the	 shortcut	 menu.	 This	 will	 open	 the	 Select	 Source	 Data	 dialog	 box,	 as
shown	in	Figure	27.4.	Select	the	series	that	you	want	to	modify	and	then	click	the
Edit	button	located	over	the	Series	section.	This	will	then	open	Edit	Series	dialog
box.	Select	the	new	series	and	click	OK.

Figure	27.4	-	Editing	the	Data	Series	via	the	Select	Source	Data	Dialog	Box

Adding	New	Series

At	 times	 you	 may	 want	 to	 add	 an	 entire	 new	 data	 series	 to	 a	 chart	 rather	 than	 just
modifying	 the	 existing	 one.	 One	 way	 is	 to	 recreate	 the	 chart	 with	 new	 data	 series.



However	 this	 approach	may	 take	 up	 a	 lot	 of	 time	 if	 the	 chart	 is	 perfectly	 created	 and
formatted	and	you	just	need	to	add	one	or	more	series.

In	such	cases,	it	is	highly	recommended	that	you	follow	any	of	the	following	methods	to
add	the	new	data	series	to	the	already	created	and	formatted	chart.

If	the	new	data	series	is	attached	to	the	one	already	used	in	the	chart,	you	can	drag
it	 to	 include	 the	 new	 data	 points	 in	 it.	 This	 method	 works	 for	 embedded	 charts
only.		

To	add	a	non-contiguous	data	series,	select	 the	chart	 to	activate	 it,	 then	select	 the
Design	 tab	 in	 the	Chart	Tools	contextual	 tabs.	There	 in	 the	Data	group,	click	 the
Select	Data	command.	This	will	open	the	Select	Source	Data	dialog	box.	Click	the
Add	button	located	over	the	Series	section.	This	will	then	open	Edit	Series	dialog
box.	Specify	the	new	series	and	click	OK.

You	can	add	new	data	series	by	the	typical	Copy	and	Paste	method.	Select	the	data
that	you	want	to	add,	hit	Ctrl	+	C	on	your	keyboard	to	copy,	then	click	the	chart	to
activate	it	and	hit	Ctrl	+	V	to	paste	the	data	into	the	chart.

	

If	a	chart	is	initially	created	from	a	table,	any	data	you	add	in	the	table
is	 automatically	 added	 to	 the	 corresponding	 chart.	 Therefore,	 it	 is
recommended	to	format	the	particular	range	of	cells	as	table	and	then
create	a	chart	from	it.		

	

How	to	Insert	Trendline

A	trendline	highlights	the	general	trends	in	the	data.	It	is	mostly	needed	in	case	time	based
charts.	Trendline	is	also	often	used	to	forecast	the	future	of	any	data.

Here	is	how	you	can	display	a	trendline	in	your	chart:

1.	 Select	the	data	series.

2.	 Click	 the	Chart	Elements	 icon	 represented	 by	 a	 plus	 sign	 at	 the	 top	 right	 of	 the
chart.

3.	 Put	a	tick	mark	next	to	Trendline.



There	are	 several	 types	of	 trendlines	 that	you	can	enter.	To	 specify	your	preferred	 type,
click	 the	arrow	 to	 the	 right	of	 the	Trendline	 item.	This	will	open	 the	continuation	menu
containing	the	types	of	trendlines	provided	by	Excel.	Select	the	one	you	want	to	add	to	the
chart.

Figure	27.5	-	Showing	a	Trendline	in	a	Column	Chart

Figure	27.5	shows	a	 trendline	 in	a	column	chart.	For	more	formatting	and	other	options
regarding	 trendlines,	 open	 the	Format	 Trendline	 task	 pane.	You	 can	 access	 the	Format
Trendline	 task	 pane	 by	 double	 clicking	 the	 trendline	 or	 by	 right	 clicking	 and	 selecting
Format	Trendline.

How	to	Insert	Error	Bars

When	you	are	plotting	a	data	that	contains	negative	and	positive	values,	you	may	want	to
add	Error	Bars	to	indicate	the	nature	of	the	data	points.	Error	bars	are	not	compatible	with
all	chart	types.	These	can	be	used	in	area,	column,	bar,	line	and	scatter	charts	only.

Error	bars	display	the	positive	and	negative	nature	of	the	values	which	in	turn	indicates	the
uncertainty	in	data.

Here	is	how	you	can	display	Error	Bars	in	your	chart:

1.	 Select	the	data	series.

2.	 Click	 the	Chart	Elements	 icon	 represented	 by	 a	 plus	 sign	 at	 the	 top	 right	 of	 the
chart.

3.	 Put	a	tick	mark	next	to	Error	Bars.

There	 are	 several	 types	 of	 error	 bars	 that	 you	 can	 put	 in	 your	 chart.	 To	 specify	 your
preferred	 type,	 click	 the	 arrow	 to	 the	 right	 of	 the	Error	 Bars	 item.	 This	 will	 open	 the
continuation	menu	 containing	 the	 types	 of	 error	 bars	 provided	 by	Excel.	 Select	 the	 one
you	want	to	add	to	your	chart.



Following	is	a	brief	explanation	of	the	types	of	error	bars:

Standard	Error:	 This	 type	 of	 error	 bars	 represents	 one	 standard	 error	 unit,	 where	 the
standard	error	of	the	data	series	is	automatically	calculated	by	Excel.

Percentage:	These	errors	represent	the	percent	value	of	each	data	point.

Standard	 Deviation:	 This	 type	 of	 error	 bars	 represents	 the	 standard	 deviation	 of	 the
specified	units.

Custom:	As	the	name	suggests,	this	option	allows	you	to	specify	units	for	the	upper	and
lower	error	bars.	You	can	enter	the	value	manually	or	specify	the	range	of	cells	containing
the	error	values.

For	more	formatting	and	other	options	regarding	Error	Bars,	open	the	Format	Error	Bars
task	pane.	You	can	access	the	Format	Error	Bars	 task	pane	by	double	clicking	the	error
bars	in	the	chart	or	by	right	clicking	and	selecting	Format	Error	Bars.





S
Chapter	28:	Working	With	Sparkline	Graphics	

parkline	 is	 yet	 another	very	 exciting	 and	highly	popular	 feature	of	Excel.	 It	 is	 a
miniature	 chart	 contained	within	 a	 single	 cell.	A	 single	 sparkline	 represents	 one
series	of	data	only.

Sparkline	allow	quick	analysis	of	time-based	and	fluctuating	data.	These	miniature	charts
are	ideal	when	you	have	less	space	on	the	worksheet	and	need	to	display	individual	data
series.

This	chapter	 talks	 in	detail	about	 the	Sparklines	features	 in	Excel.	You	will	discover	 the
different	types	of	Sparklines,	how	to	create	one	and	most	interestingly,	how	to	customize
your	Sparklines.		

Exploring	the	Types	of	Sparklines

There	are	 three	 types	of	Sparklines	 that	you	can	create	 in	Excel;	namely,	Line,	Column
and	Win/Loss.	Following	is	a	brief	explanation	of	each.

Line	Sparklines:	As	the	name	suggests,	a	line	sparkline	is	quite	similar	to	a	line	chart.	It
represents	 a	 single	 data	 series	with	 a	marker	 for	 each	 data	 point.	 The	 provision	 to	 add
markers	is	optional.

Column	Sparklines:	A	column	sparkline	 is	 similar	 to	a	column	chart,	 except	 that	 it	 can
display	a	single	series	of	data	only.	

Win/Loss	Sparklines:	A	Win/Loss	sparkline	represents	the	negative	and	positive	values	in
the	data.	It	contains	blocks	of	two	colors,	one	representing	negative	numbers	and	the	other
showing	positive	values.	The	Win/Loss	sparklines	ignore	zero	values.	

Figure	28.1	shows	a	worksheet	containing	all	three	types	of	sparklines.	



Figure	28.	1	-	Showing	the	Three	Types	of	Sparklines

As	you	can	 see	 in	 the	 above	 image,	 the	 line	 and	column	 sparklines	 represents	 the	 sales
trend	of	the	three	products	over	the	period	of	6	months.	One	can	easily	identify	from	the
sparklines	that	Product	A	has	a	consistent	sales	growth	rate,	Product	B	is	comparatively	a
riskier	 product	 and	 has	 fluctuating	 sales	 trend.	 Likewise,	 Product	 C	 secured	 the	 lowest
sales	in	March.	

In	the	Win/Loss	sparklines,	there	are	red	and	blue	blocks.	The	red	blocks	signify	that	the
current	month’s	 sale	 is	 lower	 than	 the	 base	month	 (which	 is	 January	 in	 this	 example).
Likewise,	the	blue	block	in	the	sparkline	indicates	a	positive	growth	in	current	month.

How	to	Create	Sparklines

Now	that	you	have	an	understanding	of	the	different	types	of	sparklines,	here	is	how	you
can	create	sparklines	in	Excel.

1.	 Select	the	cell	in	which	you	want	to	create	a	sparkline

2.	 Choose	the	Insert	tab

3.	 There	in	the	Sparklines	group,	you	will	find	three	commands,	one	for	each	type	of
sparkline.	Click	 the	one	you	want	 to	create.	 In	either	case,	 the	Create	Sparklines
dialog	box	will	open	up,	as	shown	in	Figure	28.2



Figure	28.2	-	The	Create	Sparklines	Dialog	Box

4.	 In	the	Data	Range	field,	enter	the	range	address	of	the	data	series	or	select	it	on	the
worksheet.	 The	 Location	 Range	 field	 contains	 the	 address	 of	 the	 cell	 that	 you
selected	in	the	first	step.	If	you	want	to	specify	any	other	location	for	the	sparkline,
type	or	point	it	in	the	Location	Range	field.

	

How	to	Create	Customized	Sparklines

Just	 like	 charts,	 you	 can	 tailor	 sparklines	 to	 make	 them	 exactly	 the	 way	 you	 want.
Customizing	sparklines	include	changing	colors,	formatting,	managing	markers	and	much
more.

When	you	 select	 cell(s)	 containing	 sparkline(s),	 a	 new	 tab	 is	 added	 to	 the	Ribbon.	The
new	tab,	namely	Design,	contains	all	the	sparkline	related	options.

Making	the	Sparklines	Colorful

To	 change	 the	 color	 of	 your	 sparklines,	 select	 the	 cells	 containing	 it	 and	 then	 click	 the
Design	tab.	There	in	the	Style	group,	you	will	find	several	color	options.			If	you	don’t	like
any	 style	 from	 the	 ones	 already	 provided	 by	Excel,	 click	Sparkline	Color	 to	 open	 the
color	palette	and	select	your	own	color	for	the	selected	sparkline.	

The	Sparkline	Color	palette	also	contains	the	Weight	option,	which	allows	you	to	increase
or	decrease	the	thickness	of	your	sparkline.	

Figure	28.3	shows	the	commands	in	the	Design	tab.

Figure	28.3	-	The	Design	Tab	Containing	Sparkline	Customization	Options	

As	 you	 can	 see	 in	 the	 above	 image,	 the	Style	 group	 contains	 another	 command	 by	 the



name	of	Marker	Color.	It	allows	you	to	specify	a	different	color	for	each	marker	in	your
sparklines.	 For	 example,	 you	 can	 specify	 a	 different	 color	 for	 markers	 representing
negative	values,	then	a	different	one	for	those	indicating	high	data	points	and	so	on.	

Highlighting	Data	Points

The	Show	group	in	the	Design	tab	contains	checkboxes	for	data	points.	You	can	toggle	the
markers	 and	 other	 given	 options.	 For	 example,	 putting	 a	 tick	 mark	 in	 the	 Low	 Point
checkbox	will	place	a	market	at	the	lowest	data	point	in	the	selected	sparkline.

By	 default,	 the	 Line	 sparklines	 do	 now	 show	 negative	 data	 points.	 However,	 if	 you
activate	the	Negative	Points	checkbox	in	the	Show	group,	Excel	will	put	a	marker	in	the
line	sparkline	to	indicate	the	negative	values.	You	can	change	the	color	of	this	marker	by
selecting	the	Negative	Points	command	in	the	Marker	Color	drop	down	list	in	the	Style
group.

Displaying	Axes

By	default,	 the	sparklines	does	not	display	any	axes.	However	if	you	want,	you	can	add
horizontal	axis.

To	 display	 a	 horizontal	 axis	 in	 your	 sparklines,	 select	 the	 cell	 containing	 the	 particular
sparklines,	then	select	Design	tab	>	Group	group	>	Axis	>	Show	Axis.		



Deleting	Sparkline

Sparklines	cannot	be	 removed	via	normal	deleting	procedures.	 It	won’t	go	away	 just	by
hitting	 Delete	 or	 Backspace	 on	 your	 keyboard.	 To	 delete	 a	 sparkline,	 select	 the	 cell(s)
containing	sparkline(s),	then	select	Design	tab	>	Group	group	>	Clear,	as	shown	in	Figure
28.4

Figure	28.4	-	Deleting	a	Sparkline

	





W

Chapter	29:	Beautifying	Your	Work	with	Pictures	and
Graphics				

hen	talking	about	graphics	and	pictorial	representation,	Excel	offers	a	lot	more
than	just	charts	and	sparklines.	There	is	a	wide	and	diverse	variety	of	graphical
objects	that	you	can	insert	on	your	worksheets.

This	chapter	talks	about	all	such	colorful	tools.	It	introduces	you	to	the	non-chart	artistic
side	of	Excel.	Here	you	will	learn	to	use	the	wide	variety	of	shapes,	interactive	SmartArt,
picturesque	WordArt	 and	much	more.	 This	 chapter	 also	 contains	 a	 high	 tech	 exclusive
trick	on	saving	your	graphical	items.		

Working	with	Shapes

Shapes	constitute	a	very	integral	part	of	Microsoft	Office	apps.	Whether	it	is	Word,	Excel
or	any	other	software	of	MS	Office	any,	shapes	are	one	of	the	most	commonly	used	tools.

Excel	contains	a	variety	of	shapes	 including	several	kinds	of	circles,	 rectangles,	arrows,
flowchart	 shapes	 and	 much	 more.	 This	 section	 discloses	 some	 handy	 tricks	 on	 using
shapes	in	Excel.	

	

Shapes	are	 inserted	for	many	purposes,	 the	most	common	one	being
to	draw	attention	to	certain	cells.	If	you	are	using	them	for	the	same
intent,	make	sure	not	to	overcrowd	your	worksheet	with	shapes	or	else
they	may	lose	their	impact.

Adding	Shapes

To	insert	a	shape	on	your	worksheet,	select	Insert	tab	>	Illustrations	group>	Shapes.



Figure	29.1	-	Shapes	Gallery	in	Excel

As	you	can	see	in	Figure	29.1,	the	Shapes	command	in	the	Insert	tab	is	a	large	drop	down
menu	 containing	 the	 innumerous	 types	 of	 shapes	 sorted	 into	 categories.	 Look	 for	 the
desired	shape	and	then	follow	any	of	the	below	stated	methods	to	add	it	to	the	worksheet.

							Click	the	desired	shape	in	the	Shapes	drop	down	menu	and	then	click	anywhere
on	the	worksheet.	The	selected	shape	in	its	default	size	will	be	added.

							Click	the	desired	shape	in	the	Shapes	drop	down	menu	and	then	drag	the	mouse
pointer	on	the	worksheet	to	draw	the	shape	in	the	required	size.	

Either	ways,	once	the	shape	is	inserted,	you	can	resize	it,	drag	it	to	any	location,	fill	colors
in	it,	put	borders	around	it,	add	text	in	it	and	much	more.	All	the	shape	related	formatting
options	can	be	found	in	Format	tab	that	appears	in	the	Ribbon	after	you	select	a	shape.

Following	are	a	few	more	tips	with	regards	to	shape	formatting:

To	move	a	shape	to	any	other	location	in	the	worksheet,	simply	click,	hold	and	drag
it	to	the	desired	place.

To	 resize	 a	 shape,	 activate	 it	 first	 by	 selecting	 it.	 Then	 either	 use	 the	 height	 and
width	controls	 in	 the	Size	 group	on	 the	Format	 tab,	 or	 click	 and	drag	 any	of	 the
square	handles	that	appears	on	the	borders	of	the	particular	shape.		

To	rotate	a	shape,	activate	it	first	by	selecting	it.	Then	either	use	the	Rotate	Objects
command	in	the	Size	group	on	the	Format	tab,	or	click	and	spin	the	small	circular
arrow	that	appears	on	top	of	the	selected	shape.



To	 insert	 a	 shape	 into	 a	 chart,	 first	 select	 a	 chart	 and	 then	 select	 a	 shape	 in	 the
Shapes	drop	down	menu.	Rest	of	the	procedure	remains	the	same.

When	you	 insert	 a	 shape	 into	 a	 chart,	 it	 is
embedded	 into	 it	 and	 therefore	 moves
along.	 In	 other	 words,	 moving	 a	 chart
would	move	the	shape	in	it	too.	Likewise,	if
you	change	the	size	of	the	chart,	the	size	of
the	 embedded	 shape	 also	 adjusts
accordingly.			

If	you	want	 to	keep	 the	aspect	 ratio	 same	while	 resizing	a	 shape,	press	and
hold	the	Ctrl	key	while	you	drag	the	shape’s	square	handles.		

Arranging	Shapes	in	Stacks

All	the	graphical	objects	that	reside	on	the	drawing	layer	on	the	worksheet,	which	includes
shapes	too,	are	arranged	in	a	stack.	The	lastly	added	shape	is	placed	on	top	of	the	stack,
which	is	then	overtopped	by	another	shape	and	so	on.

A	 larger	 shape	when	 inserted	on	 top	of	 a	 smaller	 shape	can	put	 the	 smaller	ones	out	of
view.	However,	you	can	rearrange	the	stack	as	per	your	requirement.

To	do	so,	select	the	shape	to	make	it	active.	Then	click	the	Selection	Pane	button	located
in	 the	Arrange	 group	 on	 the	Format	 tab	 that	 appears	 in	 the	 Ribbon	 after	 you	 select	 a
shape.	This	will	open	the	Selection	pane	which	contains	the	list	of	all	the	graphical	objects
on	 the	 drawing	 layer	 of	 the	 current	 worksheet.	 The	 items	 are	 listed	 in	 order	 of	 their
appearance;	that	is,	the	top	object	on	the	stack	is	listed	first	and	so	on.	

The	 easiest	 way	 to	 rearrange	 the	 position	 of	 objects	 in	 a	 stack	 is	 by	 moving	 the
corresponding	item	up	and	down	in	the	Selection	pane	list.

To	 change	 the	 position	 of	 a	 single	 shape	 in	 the	 stack,	 right	 click	 and	 select	 any	 of	 the
following	commands:

Bring	to	Front	>	Bring	to	Front.	This	command	puts	 the	 selected	 shape	on	 top	of	 the
stack.

Bring	 to	Front	 >	Bring	 Forward:	 This	 command	moves	 the	 selected	 shape	 one	 level
higher	from	its	current	position	in	the	stack.



Send	to	Back	>	Send	to	Back:	This	command	puts	the	selected	shape	at	the	bottom	of	the
stack.

Send	 to	Back	 >	Send	Backward:	 This	 command	 moves	 the	 selected	 shape	 one	 level
down	from	its	current	position	in	the	stack.

All	the	above	mentioned	commands	can	also	be	found	in	the	Arrange	group	on	the	Format
tab.

Reshaping	Shapes

Another	advanced	and	exciting	quality	of	Excel	is	that	it	allows	you	to	create	customized
shapes.	So	if	you	don’t	find	the	required	shape	in	the	ones	provided	by	Excel,	create	one
of	your	own.

Following	are	a	few	handy	tricks	on	customizing	shapes:	

To	rotate	a	shape,	click	and	turn	the	circular	arrow	that	appears	on	top	of	the	shape.

Combine	 two	 or	 more	 shapes	 to	 make	 a	 new	 one.	 Refer	 to	 the	 next	 heading
“Grouping	Shapes”	to	learn	more	about	the	combining	technique.

You	 can	 create	 an	 entirely	 new	 shape	 by	 using	 the	 freeform	 shapes	 in	 the	 Lines
category	in	the	Shapes	gallery.	

You	can	customize	a	 shape	by	editing	 its	points.	To	do	 so,	 select	 the	 shape,	 then
choose	the	Format	tab.	There	in	the	Insert	Shapes	group,	click	the	Edit	Shape	icon
>	Edit	 Points.	 This	 will	 put	 some	 new	 square	 handles	 in	 the	 selected	 shape’s
border.	Click	and	drag	these	handles	to	reconfigure	the	new	shape.		

Some	 shapes	 contain	 one	 or	 more	 small	 yellow	 square	 handles.	 Click	 and	 drag
these	handles	to	increase	or	decrease	the	size	of	the	shape’s	outline.	Yellow	handles
can	 change	 the	 entire	 look	of	 the	 shape.	 It	 can	 transform	a	 triangle	 into	 a	 line,	 a
square	into	a	plus	sign	and	much	more.	

Grouping	Shapes

You	can	merge	two	or	more	shapes	to	create	a	single	graphical	object.	This	technique	is
known	as	Grouping.

The	process	to	group	shapes	is	very	simple.

1.	 Make	 sure	 all	 the	 needed	 shapes	 are	 on	 the	 same	 worksheet.	 Add,	 if	 any	 is
missing.	



2.	 Keep	 the	Ctrl	 key	pressed	down	and	 then	 select	 all	 the	 images	 that	 you	want	 to
combine.

3.	 Right	click	any	of	the	selected	image,	then	choose	Group	>	Group.

All	the	shapes	that	are	grouped	moves	together.	Whatever	formatting	you	apply	is	applied
to	the	entire	group	and	all	the	objects	in	it.

Excel	allows	you	to	combine	a	chart	with	a	shape.	The	process	is	the
same.	Just	make	sure	the	graphical	objects	that	are	to	be	grouped	are
on	the	same	worksheet.		

	

To	 break	 the	 group	 back	 into	 its	 original	 components,	 right	 click	 then	 select	Group	 >
Ungroup.	

Using	WordArt

Figure	29.2	shows	a	worksheet	containing	different	examples	of	WordArt.			

Figure	29.2	-	Showing	Different	Examples	of	WordArt

In	Figure	29.2,	different	 forms	of	WordArt	are	applied	on	 the	 same	phrase.	As	you	can
see,	WordArt	is	nothing	but	a	colorful	way	to	put	some	beautiful	graphical	effects	in	your
text.	

To	use	WordArt,	select	Insert	tab	>	Text	>	WordArt.



Figure	29.3	-	WordArt	Styles	Provided	by	Excel

As	shown	 in	Figure	29.3,	 the	WordArt	command	on	 the	 Insert	 tab	contains	a	gallery	of
WordArt	 styles.	 Click	 the	 one	 you	want	 to	 use.	 This	 will	 put	 an	 object	 on	 the	 current
worksheet	 with	 the	 placeholder	 text	 “Your	 Text	 Here”.	 Type	 your	 text	 in	 place	 of	 this
placeholder,	then	resize,	change	the	color	and	format	it	as	you	like.

Just	like	all	other	graphical	objects,	selecting	a	WordArt	object	adds	a	contextual	tab	in	the
Ribbon.	 The	 contextual	 tab,	 namely	 Format,	 contains	 all	 the	 WordArt	 formatting
commands.	Or	you	can	also	the	formatting	commands	in	 the	 task	pane	by	right	clicking
the	WordArt	and	selecting	Format	Shape	or	Format	Text	Effects.

Learning	SmartArt		

If	Excel’s	Shapes	are	amazing,	its	SmartArt	feature	is	absolutely	incredible.	SmartArt	are
editable	 images	 that	 are	made	 up	 of	 a	 variety	 of	 shapes.	Using	 these,	 you	 can	 create	 a
variety	of	diagrams,	graphs,	flowcharts	and	much	more.

	

How	to	Insert	SmartArt

To	insert	a	SmartArt	into	a	worksheet,	select	Insert	>	Illustrations	>	SmartArt.	This	will
open	the	Choose	a	SmartArt	Graphic	dialog	box,	as	shown	in	Figure	29.4



Figure	29.4	-	Exploring	the	Choose	a	SmartArt	Graphic	Dialog	Box

On	 the	 left	 side	 of	 the	 dialog	 box	 are	 the	 categories	 of	 SmartArt	 in	 Excel.	 Select	 any
category	to	see	its	subtypes	in	the	middle	section	of	the	dialog	box.	The	right	side	displays
the	 default	 sample	 of	 the	 selected	 SmartArt	 followed	 by	 a	 brief	 description	 about	 its
applications.

Select	the	one	you	want	to	insert	and	click	OK.

Don’t	worry	if	you	cannot	find	the	perfect	SmartArt.	Select	the	one	that	is	closest	to	your
requirements	and	then	customize	it	as	desired.	The	following	section	entails	some	tips	and
tricks	for	customizing	SmartArt.	

	

How	to	Customize	SmartArt

Customizing	SmartArt	 includes	changing	 layouts	and	styles,	 filling	colors	 in	SmartArt’s
components,	converting	into	shapes,	adding	more	shapes	and	much	more.	Here	are	a	few
valuable	tips	in	this	regard.

Inserting	Additional	Elements:	Suppose	you	 inserted	 the	Vertical	Box	List	SmartArt	 that
contains	three	rectangles	by	default.	To	add	another	rectangle,	select	any	one	rectangle	in
the	SmartArt,	then	choose	the	Design	tab	>	Create	Graphic	group	>	Add	Shape.	

Basic	Formatting:	The	process	to	move	and	resize	any	elements	in	the	SmartArt,	and	all
the	other	basic	formatting	 techniques	are	same	as	 in	case	of	other	graphical	objects.	For
example,	drag	the	square	handles	 to	resize,	drag	the	edges	to	relocate,	select	an	element
and	hit	Enter	to	put	the	selected	item	in	the	editable	mode	and	so	on.

Changing	the	Style	and	Layout:	You	can	change	the	layout	of	your	SmartArt	by	selecting
Design	tab	>	Layouts.



If	you	are	unsure	about	which	layout	would	look	best,	experiment	a	few	before	finalizing
any	one.	To	 check	how	a	predefined	 layout	would	 look,	 select	 the	SmartArt,	 then	 click
Design	tab.	There	in	the	Layouts	group,	just	hover	your	mouse	cursor	over	to	any	of	the
layout	and	check	its	preview	in	your	SmartArt	on	the	worksheet.

Just	like	layout,	you	can	check	the	preview	of	different	styles.	The	Styles	gallery	is	located
right	next	to	the	Layouts	group	in	the	Design	tab.

Changing	 the	 theme	 of	 the	 workbook	 also	 changes	 the	 layout	 and
style	 of	 SmartArt.	 As	 a	 matter	 of	 fact,	 some	 themes	 give	 an
incredibly	 dramatic	 and	 attractive	 appearance	 to	 the	 SmartArt.	 To
explore	different	themes,	select	Page	Layout	>	Themes.		

	

Capturing	Screenshots

Another	very	high	tech	and	popular	feature	of	Excel	is	its	ability	to	insert	screenshots	of
any	other	windows	currently	running	on	your	computer.	It	saves	the	hassles	of	taking	the
Print	Screen,	saving	it	and	then	inserting	it	as	image	file	in	Excel.	You	can	directly	insert	a
screenshot	to	your	worksheet	without	even	having	to	hit	the	Print	Screen	button	on	your
keyboard.

To	 use	 Excel’s	 screenshot	 feature,	 make	 sure	 the	 Window	 you	 want	 to	 insert	 the
screenshot	of	is	opened	but	minimized	on	your	system.	Select	Insert	 tab	>	Illustrations
group	>	Screenshot.	 The	 Screenshot	 command	 drops	 down	 to	 display	 all	 the	windows
that	 are	 currently	 open	 on	 your	 computer.	 Select	 the	 window	 and	 Excel	 will	 insert	 its
screenshot	on	the	current	worksheet.	

Saving	Graphics	Separately

At	times,	you	may	want	to	save	the	charts	and	shapes	as	a	separate	file	other	than	the	one
in	Excel.	Well,	there	is	not	any	direct	way,	let	alone	a	shortcut	key	to	save	the	graphical
objects	as	a	separate	image	file.	However,	there	is	a	secret	recipe	for	this	too.	But	first	you
need	to	add	some	tools	to	your	Quick	Access	Toolbar,	explained	as	follows.

1.	 Right	 click	 the	Quick	 Access	 toolbar	 and	 select	 Customize	 the	 Quick	 Access
Toolbar.	This	will	open	the	Excel	Options	dialog	box.

2.	 Select	Commands	Not	in	the	Ribbon	in	the	top	left	drop	down	list.



3.	 Scroll	down	the	list	on	the	left	and	select	Web	Options.	Click	Add.

4.	 Next,	select	Web	Page	Preview	in	the	same	list.	Click	Add.

5.	 Click	OK	to	close	the	Excel	Options	dialog	box	and	return	to	the	worksheet.	There
will	be	two	new	buttons	in	your	Quick	Access	toolbar.

You	 have	 to	 perform	 the	 above	 steps	 just	 once.	 Once	 the	Web	Options	 and	 Web	 Page
Preview	buttons	are	added	to	your	Quick	Access	toolbar,	follow	the	process	listed	below
save	the	Excel’s	graphical	objects	as	separate	files	on	your	computer.

1.	 Open	the	workbook	that	contains	the	image	you	want	to	save.

2.	 Click	 the	Web	Options	 button	 in	 your	Quick	Access	 toolbar.	This	will	 open	 the
Web	Options	dialog	box.

3.	 In	 the	Browsers	 tab,	put	 a	 tick	mark	 in	 the	“Allow	PNG	as	a	Graphics	Format”
checkbox,	 if	 it	 is	 not	 already	 marked.	 Next,	 make	 sure	 the	 “Rely	 on	 VML	 for
displaying	graphics	in	browser”	is	unchecked.

4.	 Now	select	the	Pictures	 tab.	 In	 the	“Pixels	Per	Inch”	drop	down	list,	 select	120.
Click	OK	to	save	the	settings	and	close	the	Web	Options	dialog	box.

5.	 Click	the	Web	Page	Preview	button	in	the	Quick	Access	toolbar.	This	will	convert
a	 copy	 of	 the	workbook	 into	HTML	 and	will	 display	 it	 in	 your	 default	 browser.
															

6.	 In	the	browser,	right	click	the	graphical	object	and	select	Save	Image	As.

7.	 This	will	open	the	typical	Save	As	dialog	box.	Select	a	location	and	file	type	for	the
image,	enter	a	name	for	your	image	if	you	want	to	and	then	click	Save.





BOOK	V:	DATA	MANAGEMENT	AND

ANALYSIS

Crunching	 numbers,	 performing	 calculations,	 complex	 formulas,	 colorful	 graphs	 and
interactive	 charts…and	 there	 is	 still	 more	 to	 Excel!	 This	 book	 introduces	 you	 to	 yet
another	exciting	and	handy	capability	of	Excel;	that	is	Data	Analysis.

Excel	 is	 a	 surprisingly	 amazing	 and	 high	 tech	 data	 analysis	 tool.	 Apart	 from	 its
considerable	 data	 analysis	 competencies,	 Excel	 is	 also	 pretty	 good	 at	 managing	 vast
database	tables	and	unending	data	lists.	The	What-If	Analysis	feature	of	Excel	allows	you
to	 do	much	more	 than	 simple	 data	 analysis.	And	 then	 there	 are	 the	 highly	 popular	 and
useful	Pivot	Tables	that	gives	a	completely	new	definition	to	data	management.

All	these	things	are	covered	in	this	part	of	the	book.	As	you	will	discover	in	the	upcoming
sections,	 the	data	management	and	analysis	capabilities	of	Excel	are	not	only	 incredibly
powerful	but	also	quite	easy	to	use.

AT	A	GLANCE

Chapter	30:	Managing	and	Sorting	Data	Lists

Chapter	31:	Working	With	Pivot	Tables

Chapter	32:	Performing	What-if	Analysis

	





Chapter	30:	Managing	and	Sorting	Data	Lists

This	chapter	talks	all	about	data	lists.	You	will	learn	the	basic	procedure	of	creating	data
lists	 along	 with	 some	 handy	 tricks	 on	maintaining,	 filtering	 and	 sorting	 data	 lists.	 The
chapter	 concludes	 with	 a	 very	 important	 and	 useful	 topic	 that	 explains	 the	 process	 of
retrieving	external	data	into	Excel.

Defining	Data	Lists	

A	data	list,	also	known	as	a	database	is	nothing	but	a	table	in	Excel	that	follows	a	special
structure.	Data	lists	in	some	aspects,	differs	from	the	other	kind	of	tables	in	Excel.

Some	main	features	of	Data	Lists	are	listed	as	follows:

Data	lists	contain	column	headings	only.	Known	as	field	names	in	technical	terms,
the	column	headings	represent	items	contained	in	the	corresponding	columns.

Each	 row	 in	 the	 data	 list	 contains	 complete	 information	 about	 each	 entity
(technically	known	as	record)	that	you	track	in	the	data	list.

Each	column	in	the	data	list	holds	information	about	each	item	in	the	database.	The
item	in	columns	is	technically	known	as	field	of	the	data	list.

Creating	a	Basic	Data	List

Follow	the	steps	briefed	below	to	create	a	new	data	list	in	a	worksheet:

1.	 Select	an	empty	cell	from	where	you	want	to	start	the	new	data	list.

2.	 Start	putting	field	names	(column	headings)	that	represent	items	you	want	to	add	in
the	particular	data	list.	Once	you	are	done	adding	the	field	names,	you	are	now	all
set	to	enter	the	first	row	of	data.

3.	 Start	making	entries	in	the	corresponding	columns	of	the	row,	directly	beneath	the
one	containing	the	field	names.	

4.	 Now	 select	 the	Home	 tab	 on	 the	 ribbon.	 There	 in	 the	 Styles	 group,	 click	 the
Format	 as	 Table	 command.	 This	 will	 open	 the	 continuation	 menu,	 as	 show	 in
Figure	30.1

5.	 Select	 the	 desired	 style,	 then	 click	OK	 in	 the	Format	 As	 Table	 dialog	 box	 that
appears	after	you	click	over	any	style	in	the	Format	as	Table	drop	down	gallery.



Figure	30.1	-	Table	Formatting	Styles	in	Excel

Adding	a	Data	Form

Data	Form	is	another	way	of	managing	lengthy	lists	and	ranges	in	Excel.	You	can	add	a
Data	Form	to	a	normal	range	of	cells,	as	well	as	to	one	that	has	been	formatted	as	a	table.

To	work	with	a	data	form,	first	you	need	to	add	its	command	to	your	Quick	Access	toolbar
or	to	the	Ribbon.

Here	is	how	you	can	add	the	data	form	command	to	your	Quick	Access	toolbar:

1.	 Right	 click	 the	Quick	 Access	 toolbar	 and	 select	 Customize	 the	 Quick	 Access
Toolbar.	This	will	open	the	Excel	Options	dialog	box.

2.	 Select	Commands	Not	in	the	Ribbon	in	the	top	left	drop	down	list.

3.	 Scroll	down	the	list	on	the	left	and	select	Form.	Click	Add.

4.	 Click	OK	to	close	the	Excel	Options	dialog	box	and	return	to	the	worksheet.	There
will	be	a	new	button	in	your	Quick	Access	toolbar.

You	have	to	perform	the	above	steps	just	once.	Once	the	Form	command	is	added	to	your
Quick	Access	toolbar,	follow	the	process	listed	below	to	add	a	Data	Entry	Form:

1.	 Arrange	your	data	 in	such	a	way	so	that	Excel	may	recognize	it	as	a	 table.	Make
sure	there	are	column	headings	in	the	first	row	of	the	particular	data	range.

2.	 Now	select	any	cell	 in	 the	 table	and	hit	 the	Form	command	in	the	Quick	Access



toolbar.	This	will	open	up	a	Dialog	box,	customized	as	per	your	data.	Each	heading
in	the	dialog	box	represents	a	field	name	in	your	data	range	or	table,	as	shown	in
Figure	30.2

Figure	30.2	-	Creating	a	Data	Entry	Form	in	Excel

3.	 Fill	in	the	information	in	the	dialog	box.

4.	 When	you	are	done	entering	data,	click	New.	Excel	will	add	this	data	into	a	row	in
the	worksheet	and	will	clear	up	the	dialog	box	for	the	next	row	of	data.	Enter	the
data	 for	 the	 next	 row	 and	 click	New.	 Likewise,	 perform	 the	 same	 step	 for	 other
rows.

	

If	a	cell	in	a	particular	table	or	range	contains	a	formula,	the	result	of
the	formula	appears	as	uneditable.	In	other	words,	you	cannot	edit	a
formula	while	creating	a	data	form.			

	

To	modify	the	data	entered	in	any	of	the	previous	rows,	scroll	up	in
the	dialog	box	till	you	find	the	row	you	want	to	edit.		

	

Sorting	Data	Lists

The	Sort	&	Filter	Data	command	on	the	Ribbon’s	Home	tab	allows	you	to	sort	the	data	in
your	data	 list.	You	can	sort	 the	values	 from	 the	 largest	 to	smallest	and	vice	versa.	Then
you	can	also	sort	the	fields	by	sorting	the	corresponding	columns.	Likewise,	you	can	sort
the	records	by	sorting	the	appropriate	rows.

	



While	 the	 Sort	 &	 Filter	 command	 is	 mostly	 used	 to	 arrange	 and
maintain	data	 lists,	 you	 can	 sort	 the	 data	 in	 normal	 ranges	 and	other
data	that	has	not	been	arranged	or	formatted	as	a	table.			

	

How	to	Sort	Data	on	One	Field

To	sort	the	data	in	one	field	(or	column),	select	any	cell	in	the	corresponding	column	then
click	the	appropriate	command	from	the	Sort	&	Filter	drop	down	list:

							Sort	A	to	Z	or	Sort	Z	to	A	to	sort	text	values.

							Sort	Oldest	to	Newest	or	Sort	Newest	to	Oldest	to	sort	Date	values.

							Sort	Smallest	to	Largest	or	Sort	Largest	to	Smallest	to	sort	numeric	values.

When	 you	 select	 a	 cell,	 Excel	 recognizes	 the	 type	 of	 value	 in	 it	 and	 put	 the	 sorting
commands	accordingly	in	the	Sort	&	Filter	drop	down	list.

Figure	30.3	shows	the	Sort	&	Filter	commands	for	Text	fields.

Figure	30.3	-	Showing	the	Sort	&	Filter	Commands	for	Text	fields

How	to	Sort	Data	on	Multiple	Fields

To	sort	the	data	in	more	than	one	column,	follow	the	steps	listed	below:

1.	 Select	any	cell	in	the	data	list	table.

2.	 Select	Data	tab	>	Sort	&	Filter	group	>	Sort.	This	will	open	the	Sort	dialog	box,	as
shown	in	Figure	30.4.	You	can	also	open	the	Sort	dialog	box	by	selecting	Home	>
Sort	&	Filter	>	Custom	Sort.



Figure	30.4	-	Showing	the	Sort	Dialog	Box

3.	 The	Sort	By	drop	down	 list	contains	all	 the	 field	names	 in	 the	particular	data	 list
table.	 Select	 the	 name	of	 the	 field	 you	want	 to	 sort	 first.	Then	 select	 the	 sorting
option	in	the	Order	drop	down	list.

4.	 Repeat	the	same	process	for	all	the	fields,	by	selecting	them	one	by	one	in	the	Sort
By	drop	down	list.

5.	 Once	you	are	done,	click	OK	to	close	the	Sort	dialog	box.

6.	 (Optional)	The	Sort	dialog	box	also	contains	an	Options	button.	Click	this	to	open
the	Sort	Options	dialog	box	that	allows	you	to	change	the	orientation	of	the	sorting
operation	from	top-to-bottom	(default	settings)	to	left-to-right.

	

If	a	selected	field	contains	any	duplicate	values,	click	the	Add	Level
button	 to	 insert	 another	 sort	 level	 in	 the	Sort	 dialog	 box.	 This	will
allow	you	to	specify	how	the	records	in	the	particular	field	should	be
sorted.	You	can	add	as	many	sort	levels	as	you	want.		

How	to	Sort	the	Columns

Excel	 provides	 you	 a	 way	 to	 change	 the	 placement	 of	 the	 fields	 in	 a	 data	 list	 without
having	to	cut	and	paste	the	individual	columns.

	

When	you	sort	the	fields	in	a	data	list,	Excel	adds	a	row	at	the	top	of
the	 list.	 This	 row	 is	 the	 primary	 sorting	 level.	 It	 contains	 numbers,
starting	 from	 1	 to	 the	 number	 of	 the	 last	 field	 in	 your	 data	 list.	 The
numbers	represent	the	new	order	of	the	fields	(columns).			

	



Following	is	how	you	can	change	the	orientation	of	the	fields	in	a	data	list	table:

1.	 Select	any	cell	in	the	data	list	table.

2.	 Select	the	Design	 tab	in	the	Table	Tools	contextual	 tab.	There	 in	 the	Tools	group,
click	the	Covert	to	Range	button.

3.	 Excel	 will	 ask	 you	 to	 confirm	 the	 conversion.	 Click	Yes	 in	 the	 dialog	 box	 that
appears	after	you	click	the	Covert	to	Range	button.

4.	 Select	 all	 the	 records	 in	 the	 data	 list	 table	 including	 the	 top	 row	 containing	 the
numbers	on	which	the	fields	are	to	be	sorted.

5.	 Select	Data	tab	>	Sort	&	Filter	group	>	Sort	button.	This	will	open	the	Sort	dialog
box,	 as	 already	 shown	 in	Figure	30.4.	You	can	 also	open	 the	Sort	 dialog	box	by
selecting	Home	>	Sort	&	Filter	>	Custom	Sort.

6.	 Hit	 the	Options	 button	 in	 the	 Sort	 dialog	 box.	 This	 will	 open	 the	 Sort	 Options
dialog	box.

7.	 Select	the	Sort	Left	to	Right	check-circle.	Click	OK.

7.	 The	 Sort	 By	 drop	 down	 list	 contains	 the	 Row	 numbers.	 Select	Row	 1	 and	 then
select	the	sorting	option	in	the	Order	drop	down	list.	Make	sure	the	Sort	On	drop
down	 list	box	 read	Values.	Click	OK.	Excel	will	 sort	 the	 fields	 according	 to	 the
order	of	the	entries	in	the	top	row.

8.	 (Optional)	If	you	want	to	remove	the	top	row	from	a	particular	range,	select	the	top
row	and	hit	Delete	in	the	Home	tab.

9.	 To	 reconvert	 the	 range	 to	 table	 format,	 hit	 the	 Format	 as	 Table	 button	 on	 the
Home	 tab.	This	will	open	 the	Format	as	Table	dialog	box.	Click	OK,	but	before
that	make	sure	the	My	Table	Has	Headers	checkbox	is	checked.

	

While	you	sort	the	columns	in	a	data	list,	make	sure	the	Sort	Left	to
Right	option	 in	 the	Sort	Options	dialog	box	 is	 checked.	 If	 it	 is	not,
Excel	sorts	records	instead	of	fields,	and	in	doing	so,	it	sorts	the	row
of	the	field	names	with	the	other 	data	records	in	the	data	list.

	



Filtering	Data	Lists

Filtering	in	Excel	is	the	process	to	pick	out	the	relevant	and	useful	data	in	the	data	list.	It
allows	 you	 to	 leave	 behind	 only	 the	 required	 information	 in	 the	 data	 list,	 while	 hiding
from	display	the	unnecessary	data.

This	section	introduces	you	to	the	Excel’s	very	popular	AutoFilter	tool	that	allows	you	to
filter	your	data	lists	as	per	your	current	needs.

														Meet	the	Excel’s	AutoFilter

AutoFilter	 is	 another	 way	 to	 manage	 your	 data	 lists.	 It	 enables	 you	 to	 filter	 out	 the
unwanted	data	out	of	the	data	list.	The	AutoFilter	button	is	attached	to	each	cell	containing
the	 field	 name.	All	 you	have	 to	 do	 is	 to	 click	 the	AutoFilter	 button	 and	 then	 select	 the
desired	filtering	criteria	from	the	drop	down	menu.		

If	you	don’t	find	the	AutoFilter	buttons	attached	to	the	field	names	in	your	data	list	table,
select	any	cell	in	the	particular	table,	then	click	the	Filter	button	on	the	Data	tab.	Or	you
can	also	select	Home	tab	>	Sort	&	Filter	>	Filter.

	

For	keyboard	users,	press 	Ctrl	+	Shift	+	L	or	Alt	+	AT	to	reveal	the
AutoFilter	buttons.

	

When	 you	 click	 the	 AutoFilter	 button,	 Excel	 recognizes	 the	 type	 of	 value	 in	 the
corresponding	 column	 and	 put	 the	 filter	 commands	 accordingly	 in	 the	 AutoFilter	 drop
down	menu.	If	the	column	contains	numeric	values	only,	the	AutoFilter	drop	down	menu
displays	 Number	 Filter	 options.	 Likewise	 if	 a	 column	 contains	 text	 values	 or	 a
combination	 of	 text,	 number	 and	 dates,	 the	 AutoFilter	 drop	 down	 menu	 contains	 Text
Filter	options.

Figure	30.5	shows	the	AutoFilter	commands	for	a	column	containing	text	fields.



Figure	30.5	-	Showing	the	AutoFilter	Commands	for	a	Column	Containing	Text	Values

Date	Filtering	

Table	30.1	contains	brief	description	about	the	filter	options	in	the	AutoFilter	drop	down
menu,	in	case	the	corresponding	column	contains	date	values.

Filter	Option Description

Equals Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Equals	selected	in	the
first	criteria.

Before Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Is	Before	selected	in	the
first	criteria.

After Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Is	After	selected	in	the
first	criteria.

Between
Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Is	After	or	Equal	To
selected	in	the	first	criteria	and	the	Is	Before	or	Equal	To	options	selected	in	the
second	AND	criteria.

Tomorrow Filters	out	all	the	records	leaving	behind	the	ones	with	tomorrow’s	date	only.

Today Filters	out	all	the	records	leaving	behind	the	ones	with	current	date	only.

Yesterday Filters	out	all	the	records	leaving	behind	the	ones	with	yesterday’s	date	only.

Next	Week Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	week
ahead.

This	Week Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	current
week.

Last	Week Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	previous
week.



Next	Month Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	month
ahead.

This	Month Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	current
month.

Last	Month Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	previous
month.

Next	Quarter Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	3-month
quarterly	period	ahead.

This	Quarter Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	current	3-
month	quarterly	period.

Last	Quarter Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	previous	3-
month	quarterly	period.

Next	Year Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	calendar
year	ahead.

This	Year Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	current
calendar	year.

Last	Year Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	previous
calendar	year.

Year	to	Date Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	current
year	up	to	the	current	date	in	this	field.

All	Dates	in	the
Period

Filters	out	all	the	records	leaving	behind	the	ones	with	date	entries	in	the	quarter
(Quarter	1	through	Quarter	4)	or	month	(January	through	December)	that	you	select
from	its	submenu.

Custom	Filter Launches	the	Custom	AutoFilter	dialog	box	where	you	can	specify	your	own	criteria
for	more	AND	or	OR	conditions.

Table	30.1	-	Date	Filter	Options	in	the	AutoFilter	Drop	Down	Menu

	

	

Text	Filtering

Table	30.2	contains	brief	description	about	the	filter	options	in	the	AutoFilter	drop	down
menu,	in	case	the	corresponding	column	contains	text	values.

Filter	Option Description

Equals Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Equals	selected	in	the
first	criteria.

Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Does	Not	Equal



Does	Not	Equal selected	in	the	first	criteria.

Begins	With Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Begins	With	selected
in	the	first	criteria.

Ends	With Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Ends	With	selected	in
the	first	criteria.

Contains Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Contains	selected	in
the	first	criteria

Does	Not	Contain Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Does	Not	Contain
selected	in	the	first	criteria.

Custom	Filter Launches	the	Custom	AutoFilter	dialog	box	where	you	can	specify	your	own
criteria	for	more	AND	or	OR	conditions.

Table	30.2	-	Text	Filter	Options	in	the	AutoFilter	Drop	Down	Menu



Number	Filtering

Table	30.3	contains	brief	description	about	the	filter	options	in	the	AutoFilter	drop	down
menu,	in	case	the	corresponding	column	contains	numeric	values.

Filter	Option Description

Equals Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Equals	selected	in	the
first	criteria.

Does	Not	Equal Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Does	Not	Equal
selected	in	the	first	criteria.

Greater	Than Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Greater	Than
selected	in	the	first	criteria.

Greater	Than	or
Equal	To

Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Greater	Than	or
Equal	To	selected	in	the	first	criteria.

Less	Than Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Less	Than	selected	in
the	first	criteria.

Less	Than	or	Equal
To

Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Less	Than	or	Equal
To	selected	in	the	first	criteria.

Between
Launches	the	Custom	AutoFilter	dialog	box	with	the	option	Is	Greater	Than	or
Equal	To	selected	in	the	first	criteria	and	the	Is	Less	Than	or	Equal	To	options
selected	in	the	second	AND	criteria.

Top	10 Launches	the	Top	10	AutoFilter	dialog	box	where	you	can	specify	the	top	10
fields	and	filter	out	all	leaving	behind	just	the	specified	top	10	fields.

Above	Average Filters	out	all	the	records	leaving	behind	the	ones	where	the	values	in	the	selected
field	are	greater	than	the	average	of	the	values	in	the	same	field.

Below	Average Filters	out	all	the	records	leaving	behind	the	ones	where	the	values	in	the	selected
field	are	less	than	the	average	of	the	values	in	the	same	field

Custom	Filter Launches	the	Custom	AutoFilter	dialog	box	where	you	can	specify	your	own
criteria	for	more	AND	or	OR	conditions.

Table	30.3	-	Numeric	Filter	Options	in	the	AutoFilter	Drop	Down	Menu

	

	

Extracting	External	Data



Many	a	times	you	may	need	to	copy	data	from	external	databases	to	Excel.	Well,	you	can
simply	type	it	in	Excel,	however,	this	is	not	such	a	good	idea	if	the	data	you	want	is	huge.

Excel	 offers	 you	 several	 ways	 to	 acquire	 data	 from	 a	 number	 of	 external	 sources,
including	 web	 pages,	 text	 documents,	 files	 on	Microsoft	 Access,	 SQL	 server,	 Analysis
Services,	 Microsoft	 Azure	 Marketplace	 and	 so	 on.	 All	 the	 external	 sources	 and	 their
respective	data	importing	wizards	can	be	found	in	the	Get	External	Data	drop	down	list
located	in	the	Data	tab	on	the	Ribbon.	This	section	explains	the	process	of	extracting	data
from	some	common	external	sources.

How	to	Retrieve	Data	from	the	Web

To	 extract	 data	 from	Web,	 first	 the	 select	Data	 tab.	Click	Get	External	Data	 >	From
Web.	This	will	open	the	New	Web	Query	dialog	box,	as	shown	in	Figure	30.6

Figure	30.6	-	Using	the	New	Web	Query	Dialog	Box	to	Import	Data	from	the	Web

As	you	can	see	 in	Figure	30.6,	 there	 is	an	address	bar	at	 the	 top	of	 the	New	Web	Query
dialog	box.	In	the	address	bar,	enter	the	URL	address	of	web	page	from	where	you	want	to
extract	the	data	and	hit	the	Go	button.	If	you	have	visited	the	web	page	recently,	you	can
find	its	address	by	clicking	the	drop	down	button	attached	to	the	address	bar.	Once	you	do
that,	Excel	will	display	 the	user	 interface	of	 the	particular	web	page	 in	 the	center	of	 the
New	Web	Query	dialog	box.

You	can	also	explore	the	website	further	in	the	New	Web	Query	dialog	box.	For	example,
suppose	you	want	to	extract	data	from	the	Sports	page	of	Yahoo.	You	can	either	directly
enter	 the	 URL	 address	 of	 the	 sports	 page	 or	 you	 can	 click	 the	 Sports	 tab	 on	 the	main
Yahoo	page	in	the	New	Web	Query	dialog	box.		

Once	 you	 are	 on	 the	 right	 page,	 look	 for	 the	 small	 right-side	 pointing	 arrows.	 These



arrows	 indicate	 the	possibility	of	 importing	 the	particular	 table	on	Excel.	To	 import	any
table	from	the	webpage,	click	the	arrow	accompanying	it.	You	can	select	multiple	arrows
at	a	time.

Once	you	are	done	checking	the	arrows,	click	the	Import	button.	Doing	so	will	close	the
New	Web	Query	dialog	box	and	open	the	Import	Data	dialog	box,	as	shown	in	Figure	30.7

Figure	30.7	-	The	Import	Data	Dialog	Box

In	 the	 Import	Data	 dialog	 box,	 specify	 the	 cell	where	 you	want	 the	 selected	 data	 to	 be
imported.	You	can	also	indicate	your	preference	of	whether	you	want	to	add	the	data	in	the
current	worksheet	or	a	new	worksheet.	Click	OK	once	done.

How	to	Retrieve	Data	from	Text	Files													

The	typical	Copy	and	Paste	method	is	not	the	only	way	to	extract	data	from	text	files	into
Excel.	Though	you	can	do	it	this	way,	a	far	easier	way	is	to	extract	it	directly	via	the	Text
Import	Wizard.	Here	is	how	you	can	do	this:

1.	 Select	Data	tab	>	Get	External	Data	>	From	Text.	This	will	open	the	Import	Text
File	dialog	box.

2.	 Click	 the	Open	 button	 and	 specify	 the	 folder	 where	 the	 particular	 text	 file	 is
located.

3.	 Select	the	file	and	click	Import.	Doing	so	will	open	the	Text	Import	Wizard.

4.	 The	Text	 Import	Wizard	 displays	 all	 the	 default	 settings.	Make	 any	 changes	 you
want.	 If	 you	 are	 importing	 a	CSV	 file,	make	 sure	 the	Delimited	 option	 is	 check
marked.			

5.	 Click	the	Finish	button.	The	Import	Data	dialog	box	will	appear.

6.	 Hit	 the	 Properties	 button.	 This	 will	 open	 the	 External	 Data	 Range	 Properties
dialog	box

7.	 Remove	 the	 checkmark	 from	 the	Save	Query	Definition	 check	 box.	 Then	 click



OK	to	close	this	dialog	box	and	return	to	the	Import	Data	dialog	box.

8.	 In	the	Import	Data	dialog	box,	specify	the	cell	where	you	want	the	data	from	the
selected	text	file	to	be	imported.	You	can	also	indicate	your	preference	of	whether
you	want	to	add	the	data	in	the	current	worksheet	or	a	new	worksheet.	Click	OK
once	done.	

Using	Microsoft	Query	to	Retrieve	Data

The	Microsoft	Query	Wizard	in	Excel	allows	you	to	import	data	from	unlisted	databases.

To	extract	data	using	Microsoft	Query,	follow	these	steps:

1.	 Select	Data	tab	>	Get	External	Data	>	From	Other	Sources	>	From	Microsoft
Query.	This	will	open	the	Choose	Data	Source	dialog	box,	as	shown	in	Figure	30.8

Figure	30.8	-	Showing	the	Choose	Data	Source	Dialog	Box

2.	 As	you	can	see	in	Figure	30.8,	by	default,	the	<New	Data	Source>	item	is	listed	at
the	top	in	the	Database	tab.	Let	the	settings	stay	this	way	and	click	OK.

3.	 The	Create	New	Data	Source	dialog	box	appears,	where	you	are	required	to	specify
the	name	for	your	new	database	query	as	well	as	the	driver	to	be	used	in	accessing
the	external	database.	Naming	the	database	allows	you	to	reuse	the	same	database
without	having	to	define	it	every	time	you	need	to	access	it.		

4.	 Once	you	are	done	entering	the	name	and	specifying	the	driver,	click	the	Connect
button.	 Doing	 so	 opens	 up	 a	 dialog	 box	 in	 accordance	 to	 your	 selected	 driver.
Suppose	 you	 selected	Driver	 do	Microsoft	Access	 (*.mdb)	 as	 the	 driver	 in	 the
Create	New	Data	Source	dialog	box,	Excel	opens	up	an	ODBC	Access	Setup	dialog
box.

5.	 Hit	the	Select	button.	This	action	opens	the	Select	Database	dialog	box.

6.	 Locate	the	folder	that	contains	the	file	you	want	to	import.	Click	OK.	



7.	 Click	OK	 in	 the	Setup	dialog	box.	This	action	 takes	you	back	to	 the	Create	New
Data	Source	dialog	box.	It	now	contains	the	name	of	database	that	you	specified	in
the	previous	steps.

8.	 (Optional)	 Select	 a	 default	 table	 to	 use	 in	 your	 database	 and	 specify	 a	 name	 for
your	table.

9.	 Click	OK	to	save	the	settings	and	return	to	the	Choose	Data	Source	dialog	box.

10.		 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	The	Choose	Data	Source	dialog	box	now	contains	the	name	of	your
newly	created	database.	Select	your	database	and	then	specify	your	database	query
to	complete	the	data	extraction	procedure.	





A
Chapter	31:	Working	With	Pivot	Tables	

Pivot	Table	is	a	special	type	of	table	that	allows	you	to	summarize	your	data	lists
for	effective	analysis.	It	makes	it	easy	for	you	to	identify	the	correlation	between
elements	in	a	data	list.

Some	of	the	most	handy	and	interesting	features	of	Pivot	Table	are	as	follows:

Pivot	Table	allows	you	to	summarize	large	values	in	a	data	list.

Not	only	is	the	Pivot	Table	capable	of	summarizing	the	data	but	it	does	so	by	using
a	variety	of	summary	functions.

Pivot	Table	 is	very	 interactive.	You	can	 rearrange	 the	data	 in	any	way	you	want,
even	after	creating	it.

The	data	used	in	a	Pivot	table	is	linked	to	its	original	source.	However	unlike	other
cell	references,	Pivot	table	does	not	update	automatically	when	you	change	values
in	 the	 source	data.	You	will	 have	 to	 click	 the	Refresh	button	 to	update	 the	Pivot
Table	every	time	you	make	changes	in	the	referenced	data.

Now	 that	 you	 have	 an	 idea	 about	what	 Pivot	 table	 is,	 let’s	 explore	 its	 applications	 and
functionality.	This	chapter	talks	about	all	the	basic	mechanism	of	creating,	managing	and
formatting	Pivot	 tables.	You	will	 also	 learn	 about	Pivot	Charts	 and	 the	powerful	 add-in
Power	Pivots.

	

Different	Ways	of	Creating	Pivot	Tables

You	can	create	a	Pivot	Table	automatically	as	well	as	manually.	While	the	former	way	is
easier,	the	latter	is	more	popular	and	lets	you	generate	a	customized	Pivot	Table.

We	will	start	off	with	the	easier	method;	that	is,	the	automatic	way	of	generating	a	Pivot
Table	and	then	move	on	to	the	manual	procedure.

Generating	Pivot	Table	Automatically

Introduced	 in	 Excel	 2013,	 the	 Recommended	 Pivot	 Tables	 tool	 was	 not	 there	 in	 the
previous	versions	of	Excel.	It	is	one	of	the	most	handy	and	popular	feature	in	Excel	2013.

The	Recommended	Pivot	Tables	feature	provides	the	easiest	way	to	generate	Pivot	Tables.
All	you	have	to	do	is	to	select	any	cell	in	the	data	range,	click	Insert	tab	>	Recommended



PivotTables.	This	action	will	open	the	Recommended	PivotTables	dialog	box,	as	shown	in
Figure	31.1

The	Recommended	PivotTables	dialog	box	contains	thumbnails	pertaining	to	the	selected
data.	 Select	 any	 thumbnail	 and	 click	OK	 to	 generate	 its	 corresponding	 Pivot	 table.	 By
default,	Excel	inserts	a	Pivot	Table	on	a	new	worksheet.

Clicking	any	cell	in	a	Pivot	Table	opens	the	PivotTable	Fields	task	pane.	You	can	use	this
task	pane	to	rearrange,	format,	filter	and	do	much	more	to	your	Pivot	Table.

Figure	31.1	-	Creating	a	Pivot	Table	Using	the	Recommended	PivotTables	dialog	box

Generating	Pivot	Table	from	External	Data	Sources

The	procedure	explained	 in	 the	previous	 section	can	be	used	 to	create	Pivot	Table	 from
data	 lists	 in	Excel.	However,	 if	you	want	 to	use	 the	data	from	External	databases,	Excel
provides	you	a	way	to	do	that	as	well.

Here	is	how	you	can	generate	Pivot	Tables	by	directly	using	the	data	from	external	data
sources	without	having	to	import	it	first.

1.	 Select	any	blank	cell	in	a	worksheet.

2.	 Click	Insert	tab	>	Recommended	PivotTables.	This	action	will	open	the	Choose
Data	Source	dialog	box,	as	shown	in	Figure	31.2

3.	 Hit	 the	Choose	Connection	 button	 to	 specify	 the	 external	 data	 source.	This	will
open	the	Existing	Connections	dialog	box,	containing	the	list	of	the	recommended
pivot	tables

4.	 Click	the	one	you	want	to	insert.	



Figure	31.2	-	Creating	Pivot	Table	from	External	Data	Sources

If	you	do	not	like	any	of	the	Recommended	PivotTables,	hit	the	Blank	PivotTable	button
located	at	 the	bottom	left	of	 the	Recommended	PivotTables	dialog	box	(shown	in	Figure
31.1),	then	create	a	Pivot	Table	manually.

Generating	Pivot	Table	Manually

Following	is	the	basic	process	of	creating	a	Pivot	Table	manually.	First	you	need	to	create
a	basic	version,	 then	you	can	experiment	with	different	 layouts	and	 formats	 till	you	are
satisfied	with	the	final	results.

The	first	step	in	creating	a	Pivot	Table	manually	is	to	specify	the	data	of	which	the	table	is
to	be	created.	 If	your	data	 is	 in	a	worksheet,	 select	 any	cell	 in	 that	data	 range	and	 then
click	Insert	>	PivotTable.	Doing	so	will	open	the	Create	PivotTable	dialog	box,	as	shown
in	Figure	31.3

In	 the	 Create	 PivotTable	 dialog	 box,	 Excel	 attempts	 to	 guess	 the	 data	 range	 in	 the
Table/Range	 type	 text	 bar.	 If	 the	 estimate	 is	 not	 correct,	 select	 the	 data	 range	 in	 your
worksheet.

	

Figure	31.3	-	Showing	the	Create	PivotTable	Dialog	Box

By	default,	the	“Select	a	table	or	range”	option	is	check-marked	in	the	Create	PivotTable



dialog	 box.	 If	 you	 want	 to	 use	 data	 from	 any	 external	 source,	 click	 the	 Choose
Connection	button	and	specify	the	data	source.

Next	in	the	Create	PivotTable	dialog	box	is	 the	“Choose	where	you	want	 the	PivotTable
report	to	be	placed”	option.	By	default,	this	option	is	set	to	New	Worksheet.	However,	 if
you	want	to	create	a	Pivot	Table	on	the	current	worksheet,	click	the	Existing	Worksheet
option	and	then	select	the	location	of	the	Pivot	table	in	the	current	worksheet.		Click	OK
once	done.

Excel	generates	an	empty	Pivot	Table,	as	shown	in	Figure	31.4

The	PivotTable	Fields	task	pane	is	docked	on	the	right	side	of	the	worksheet.	The	column
heads	 in	 the	 selected	 data	 range	 are	 listed	 as	 fields	 in	 the	 PivotTable	 Fields	 task	 pane.
Click	the	checkboxes	of	the	fields	that	you	want	to	add	to	your	Pivot	table.

Figure	31.4	-	Creating	a	Pivot	Table	Manually

You	can	also	add	fields	to	the	Pivot	table	by	dragging	them	from	the	top	of	the	task	pane
to	the	four	areas	located	at	the	bottom	of	the	PivotTable	Fields	task	pane;	or	you	can	right
click	a	field	a	select	the	appropriate	option	from	the	shortcut	menu.		

Keep	 playing	 with	 the	 fields	 by	 moving	 them	 between	 the	 four	 boxes	 or
checking/unchecking	the	checkboxes	till	you	reach	the	desired	result.

How	to	Format	a	Pivot	Table

By	 default,	 the	 data	 in	 a	 Pivot	 table	 uses	 General	 number	 formatting.	 To	 change	 the
number	format,	right	click	any	value	in	the	Pivot	table	and	select	Number	Format	from	the
shortcut	 menu.	 This	 will	 open	 the	 Format	 Cells	 dialog	 box	 where	 you	 can	 apply	 the
desired	number	format	on	the	selected	value(s).

	



	

Changing	the	Style	of	a	Pivot	Table

When	 it	 comes	 to	 formatting	 the	Pivot	Table,	 you	 can	 change	 the	 style	of	 the	 table.	To
check	how	a	built-in	style	would	look,	select	any	cell	in	the	Pivot	table,	then	click	Design
tab.	There	in	the	PivotTable	Styles	group,	click	the	downward	pointing	arrow	to	open	the
Styles	gallery.	 Just	 hover	your	mouse	 cursor	over	 to	 any	 style	 and	check	 its	 preview	 in
your	Pivot	Table	on	the	worksheet.	Click	the	one	that	you	want	to	apply.

Even	if	you	don’t	find	the	exact	style	you	want,	you	can	select	a	one	that	is	closely	similar
to	what	you	want	and	 then	make	a	 few	adjustments	 in	 it.	You	can	also	create	your	own
style	by	clicking	the	New	PivotTable	Style	command	located	in	the	bottom	of	the	Styles
gallery.

Changing	the	Layout	of	a	Pivot	Table

Layout	 is	 another	 aspect	 of	 Pivot	 Table	 formatting.	 The	 Layout	 group	 in	 the	 Design
contextual	tab	contains	various	formatting	commands,	explained	as	follows:

Subtotals:	The	Subtotals	drop	down	 list	 contains	commands	 to	control	 the	placement	of
subtotals	in	the	Pivot	Table.	You	can	also	hide	the	subtotals	by	selecting	the	Do	Not	Show
Subtotals	command	in	the	Subtotals	drop	down	list.

Grand	Totals:	The	Grand	Totals	drop	down	list	allows	you	to	select	the	types,	if	any,	you
want	to	display.	

Report	 Layout:	 The	Report	 Layout	 command	 gives	 you	 three	 layouts	 to	 choose	 from;
namely,	compact,	outline	and	tabular.	You	can	also	specify	if	you	want	to	display	or	hide
the	repeating	items.	

Blank	Row:	The	Blank	Row	command	gives	you	options	to	insert	or	remove	blank	lines
after	each	item	in	the	Pivot	Table.

Advanced	Formatting	Options

When	 you	 click	 any	 cell	 in	 a	 Pivot	 Table,	 two	 contextual	 tabs	 appears	 in	 the	 ribbon;
namely	 Analyze	 and	 Design.	 The	 Design	 tab	 contains	 the	 style	 and	 layout	 pertaining
formatting	commands.	These	are	already	discussed	in	the	previous	sections.

The	 Analyze	 tab	 contains	 some	 advanced	 formatting	 options	 that	 can	 affect	 the	 entire
appearance	 of	 your	 Pivot	 Table.	 For	 example,	 the	 Show	 command	 in	 the	 Analyze	 tab
contains	three	buttons	that	allows	you	to	toggle	the	display	of	Field	List,	+/-	Buttons	and



Field	Headers.

For	more	formatting	options	regarding	the	layout,	filters,	display	and	so	on,	select	any	cell
in	 the	Pivot	 table.	Then	choose	Analyze	 tab	>	Pivot	Table	 >	Options	 >	Options.	This
will	open	the	PivotTable	Options	dialog	box,	as	shown	in	Figure	31.5

You	can	also	open	the	PivotTable	Options	dialog	box	by	right	clicking	any	cell	in	the	Pivot
table	and	selecting	PivotTable	Options	from	the	shortcut	menu.

There	are	not	any	hard	and	fast	rules	as	to	what	type	of	formatting	should	you	apply.	The
best	way	to	get	familiar	with	the	formatting	elements	is	to	try	them	all	at	 least	once	and
then	settle	on	the	one	that	seems	most	appropriate	to	you.	

Figure	31.5	-	Showing	the	Layout	and	Formatting	Commands	in	the	PivotTable	Options	Dialog	Box

Generating	Pivot	Charts

A	Pivot	Chart	 is	a	more	attractive	and	 interactive	 form	a	Pivot	 table.	Simply	put,	 it	 is	a
data	analysis	tool	that	can	help	you	interpret	the	data	in	the	Pivot	table.

Creating	a	pivot	chart	is	very	easy.	Here	is	how	you	can	do	that:

1.	 A	pivot	chart	is	always	created	from	a	Pivot	table.	So	the	first	step	is	to	generate	a
Pivot	table.

2.	 Select	any	cell	in	the	Pivot	table,	then	choose	Analyze	tab	>	PivotChart.	This	will
open	the	Insert	Chart	dialog	box,	as	shown	in	Figure	31.6.	The	Insert	Chart	dialog
box	displays	a	thumbnail	of	all	the	chart	types	that	you	can	create	from	the	selected
Pivot	table.



3.	 Select	the	thumbnail	of	the	chart	that	you	want	to	create	and	then	click	OK.

Figure	31.6	-	Creating	a	Pivot	Chart	Using	the	Insert	Chart	Dialog	Box

Once	you	click	OK,	Excel	inserts	an	embedded	pivot	chart	on	the	same	worksheet	as	the
Pivot	table.

Just	 like	 normal	 chart	 formatting,	 you	 can	 format	 a	 Pivot	 chart	 as	 well.	 You	 can
experiment	with	different	styles,	layouts,	chart	titles,	legends	and	so	on.	When	you	click	a
Pivot	 chart,	 three	 tools	 (Analyze,	 Design	 and	 Format)	 are	 added	 to	 the	 Ribbon.	While
these	tabs	contain	all	the	Pivot	chart	formatting	commands,	the	style	and	color	options	can
also	be	accessed	by	clicking	the	small	paint	brush	icon	located	at	the	top	right	of	the	Pivot
chart.

Above	the	paint	brush	icon	is	a	plus	sign	that	contains	the	buttons	to	toggle	the	display	of
different	chart	elements.

Moving	a	Pivot	Chart

By	default,	a	Pivot	Chart	is	inserted	into	the	same	worksheet	that	contains	the	underlying
pivot	table.	Follow	these	steps	to	move	a	Pivot	Chart	to	a	new	worksheet:

1.	 Select	the	Pivot	Chart	that	you	want	to	move.

2.	 Choose	Analyze	tab	>	Move	Chart.	This	will	open	the	Move	Chart	dialog	box,	as
shown	in	Figure	31.7



Figure	31.7	-	Moving	a	Pivot	Chart	to	a	New	Worksheet

3.	 Excel	suggests	a	generic	name	for	the	selected	chart.	If	you	want	to	rename	it,	click
the	New	sheet	 check	 circle	 and	 then	 enter	 your	 chart	 name	 in	 the	 corresponding
text	type	bar.	

4.	 Select	the	Object	in	drop	down	list	and	click	the	name	of	the	sheet	to	which	you
want	to	the	particular	chart.	

5.	 Click	OK	once	done.

Activating	PowerPivot

PowerPivot	 is	a	high	tech	add-in	 that	was	introduced	in	Excel	2010.	This	advanced	tool
that	 is	 capable	 of	 summarizing	 infinitely	 large	 databases,	 containing	 thousands	 and
millions	of	records,	was	made	even	more	powerful	and	integral	in	Excel	2013.

The	PowerPivot	has	been	made	a	part	of	Excel	2013	in	the	form	of	its	Data	Model	feature.
This	implies	that	you	don’t	need	to	install	the	PowerPivot	add-in.	It	is	already	integrated	in
Excel	2013;	you	need	to	activate	it	though.

Follow	these	steps	to	start	using	PowerPivot	in	Excel:

1.	 Select	File	 >	Options	 >	Add-Ins.	 This	 will	 open	 the	 Add-Ins	 tab	 in	 the	 Excel
Options	dialog	box.

2.	 At	 the	 bottom	 left	 in	 the	Add-Ins	 tab,	 you	will	 find	 the	Manage	 drop	 down	 list.
Click	it	and	then	select	COM	Add-Ins	from	the	drop	down	list.

3.	 Hit	the	Go	button.	This	will	open	the	COM	Add-Ins	dialog	box,	as	shown	in	Figure
31.8

4.	 Click	the	checkbox	labeled	Microsoft	Office	PowerPivot	for	Excel	2013.

5.	 Click	OK	to	close	the	COM	Add-Ins	dialog	box	and	return	to	Excel.



Figure	31.8	-	The	COM	Add-Ins	Dialog	Box

You	will	see	that	a	new	tab	by	the	name	of	PowerPivot	is	added	to	the	Ribbon.	This	new
tab	 contains	 all	 the	 commands	 pertaining	 to	 the	 application	 and	 management	 of
PowerPivot.

	

The	 Excel	 PowerPivot	 add-in	 is	 compatible	 with	 Office	 2013
Professional	 Plus	 edition	 as	well	 as	 all	 the	 versions	 of	Office	 365,
except	for	one;	that	is,	Small	Business.	Moreover,	it	is	not	available
in	 Excel	 2013	 that	 is	 installed	 on	 the	 RT	 edition	 of	 the	Microsoft
Surface	tablet.	If	you	are	using	Excel	on	a	Microsoft	Surface	tablet,
it	has	 to	have	Windows	8	Pro	or	 else	 the	Excel	2013	 in	 it	will	not
support	the	PowerPivot	add-in.			

	





Chapter	32:	Performing	What-if	Analysis	

What	if	the	cost	of	production	increases	by	10%?	What	if	we	increase	the	per	unit	retail
price	 by	 $0.5?	These	 are	 few	 examples	 of	 the	What-If	 situations.	 Excel	 is	 pretty	much
capable	of	answering	such	questions	without	even	the	need	to	remake	the	entire	model.

It	is	Excel’s	one	of	the	most	advanced	and	appealing	feature	that	it	can	create	and	manage
interactively	 dynamic	models;	models	 that	 instantly	 updates	 as	 soon	 as	 you	 change	 the
input	values.	The	What-If	capability	of	Excel	allows	you	to	check	the	effect	of	different
assumptions	on	the	final	result	by	just	changing	a	few	variables.

Excel	provides	several	useful	 tools	 that	can	help	you	analyze	a	 situation	under	different
scenarios.	This	chapter	talks	about	the	three	most	commonly	used	What-If	tools	in	Excel;
namely	Scenario	Manager,	Goal	Seeker	and	Data	Tables.

At	the	end	of	this	chapter,	we	introduce	to	the	Excel’s	very	popular	and	valuable	add-in,
Solver.	 It	 is	powerful	utility	add-in	 that	can	help	you	manage	data	models	and	complex
problems	having	multiple	variables.

Analyzing	Different	Scenarios

The	Scenario	Manager	 enables	you	 to	 create	different	 scenarios	 and	 set	different	values
for	 each	 scenario.	 For	 example,	 you	 can	 create	 a	 worst-case	 scenario	 in	 which	 your
company	 made	 no	 profit	 in	 the	 current	 month,	 then	 you	 make	 a	 best-case	 scenario	 in
which	the	profits	rose	by	30%	and	so	on.	Likewise,	you	can	create	several	cases	and	sets
of	input	values	to	analyze	the	effect	of	changing	variables	on	the	final	result.

After	 saving	 different	 scenarios,	 you	 can	 also	 generate	 a	 summary	 report	 showing	 the
result	of	the	three	scenarios.	But	first,	let’s	see	how	you	can	create	scenarios	in	Excel.

Follow	these	steps	to	create	new	scenarios	in	Excel:

1.	 The	first	step	is	to	indicate	the	changing	cells.	Changing	cells	are	cells	containing
input	values	that	changes	in	each	scenario.

To	make	it	easier	to	identify	the	changing	cells	in	your	data	range,	it
is	highly	recommended	that	you	give	names	to	the	changing	cells.	It
will	make	it	easier	for	you	to	keep	track	of	the	input	values.			

	



The	Changing	Cells	must	contain	constant	values	and	not	formulas.
If	 there	 are	 any	 formulas	 in	 the	 Changing	 Cells,	 they	 will	 be
replaced	by	constant	values	(that	will	be	the	result	of	the	formulas)
when	you	show	the	Scenario.

	

2.	 Select	 the	 changing	 cells	 in	 the	 worksheet.	 If	 the	 changing	 cells	 are	 not	 in	 a
contiguous	range,	press	and	hold	Ctrl	while	you	select	all	the	cells.

3.	 Select	Data	 tab	 >	Data	 Tools	 group	 >	What-If	Analysis	 >	Scenario	Manager.
This	will	open	the	Scenario	Manager	dialog	box,	as	shown	in	Figure	32.1

Figure	32.1	-	Showing	the	Scenario	Manager	Dialog	Box

4.	 Hit	 the	Add	button	 in	 the	Scenario	Manager	 dialog	 box.	This	will	 open	 the	Add
Scenario	dialog	box,	as	shown	in	Figure	32.2

Figure	32.2	-	Adding	Scenarios	Using	the	Add	Scenario	Dialog	Box



	

5.	 In	 the	Scenario	Name	 text	 box,	 enter	 a	 name	 for	 your	 scenario.	 It	 could	 be	 any
name	 pertaining	 to	 the	 particular	 scenario.	 The	most	 commonly	 used	 names	 are
generic	names	such	best	case,	worst	case,	most	likely,	least	likely	and	so	on.

6.	 After	 the	Scenario	Name	 text	box	 is	 the	Changing	Cells	 text	box	which	contains
the	address	range	of	the	cells	that	you	selected	in	the	second	step.	If	you	missed	the
second	step	or	want	to	change	the	changing	cells,	you	can	do	so	in	this	text	box.

7.	 Next	 is	 the	 Comment	 box	 that	 displays	 your	 name	 and	 the	 time	 the	 particular
scenario	is	created.	You	can	add	other	comment	or	note,	if	you	want.

8.	 After	 the	 Comment	 box,	 there	 are	 two	 checkboxes,	 Prevent	 changes	 and	Hide.
Keep	the	Prevent	changes	option	checked	if	you	want	to	prevent	other	users	from
making	 changes	 in	 the	 particular	 scenario.	Keep	 the	Hide	 option	 checked	 if	 you
want	to	hide	the	particular	scenario	when	the	worksheet	is	protected.

9.	 Click	OK	once	done.	This	will	close	 the	Add	Scenario	dialog	box	and	opens	 the
Scenario	Values	dialog	box,	as	shown	in	Figure	32.3.

10.																			The	Scenario	Values	dialog	box	displays	the	address	range	or	name	of
the	selected	cells	along	with	their	respective	values.	Change	the	values,	if	you	want
any,	 then	hit	 the	Add	button.	This	will	 close	 the	Scenario	Values	 dialog	box	and
returns	you	to	the	Add	Scenario	dialog	box.

11.																			Repeat	steps	5	-	10	to	create	as	any	scenarios	as	you	want.

Figure	32.3	-	Entering	Input	Values	in	the	Scenario	Values	Dialog	Box

Once	 you	 are	 done	 creating	 scenarios,	 all	 these	 will	 appear	 in	 the	 Scenario	 Manager
dialog	box.

To	show	a	particular	set	of	values	in	the	worksheet,	simply	double	click	the	corresponding



scenario	 in	 the	Scenario	Manager	 dialog	box	or	 select	 the	 scenario	 and	 click	 the	Show
button.	

Managing	Scenarios

If	 after	 creating	 a	 scenario,	 you	want	 to	 delete	 it,	 click	 the	Delete	 button	 in	 the
Scenario	Manager	dialog	box.

If	after	creating	a	scenario,	you	want	make	some	changes	in	it,	click	the	Edit	button
in	 the	 Scenario	Manager	 dialog	 box.	 You	 can	 modify	 the	 changing	 cells	 range
address,	and	change	the	input	values,	and	change	the	name	of	the	scenario	and	you
can	also	make	changes	in	the	Protection	settings.	

	

Merging	Scenarios

Just	below	the	Edit	button	is	the	Merge	button,	which	allows	you	to	merge	scenarios	from
other	worksheets	as	well	from	other	workbooks.	To	do	so,	first	hit	the	Merge	button.	This
will	open	the	Merge	Scenarios	dialog	box.

First,	select	 the	workbook	that	contains	the	scenarios	you	want	to	merge,	next	select	 the
worksheet	containing	the	prospective	scenarios.	Click	OK	once	done.

Once	 you	 click	 OK,	 Excel	 copies	 the	 scenarios	 from	 the	 specified	 worksheet	 and	 the
merges	them	with	the	one	already	created	on	the	current	worksheet.

	

If	you	want	to	merge	scenarios	from	any	other	workbook,	make	sure
it	is	opened	on	your	system	or	else	Excel	will	not	display	its	name	in
the	Merge	Scenarios	dialog	box.

	

Generating	a	Summary	Report

Double	clicking	a	scenario	in	the	Scenario	Manager	dialog	box	shows	it	on	the	worksheet.
This	implies	that	at	a	time	you	can	view	only	one	scenario,	unless	you	enter	each	scenario
separately	on	a	worksheet.	However,	Excel	provides	a	way	to	view	all	the	three	scenarios
at	the	same	time	on	the	same	worksheet	without	any	extra	efforts.

A	Scenario	Summary	 report	shows	the	changing	values	 in	all	 the	scenarios.	Moreover,	 it
gives	you	an	option	to	display	the	resulting	values	as	well.



Generating	a	 summary	 report	 in	Excel	 is	pretty	 easy.	All	you	have	 to	do	 is	 to	 click	 the
Summary	 button	 in	 the	 Scenario	 Manager	 dialog	 box.	 This	 will	 open	 the	 Scenario
Summary	dialog	box.

Figure	32.4	-	The	Scenario	Summary	Dialog	Box

First,	 specify	 if	 you	want	 to	 generate	 a	 simple	 Scenario	 summary	 report	 or	 a	 Scenario
PivotTable	report.	Next,	specify	the	address	of	cells	containing	the	results	that	you	want	to
show	in	your	summary	report.	Click	OK	once	done.

If	 you	 have	 named	 your	 changing	 and	 result	 cells,	 the	 summary
report	shows	the	cell	names	instead	of	their	address.	This	is	why	we
previously	 recommended	 you	 to	 give	 names	 to	 the	 changing	 and
result	cells.	This	makes	the	report	more	readable.

	

To	save	your	scenario	summary	report,	hit	Ctrl	+	S	or	you	can	also
click	the	Save	command	on	the	Quick	Access	toolbar.	To	print	your
scenario	 summary	 report,	 hit	 Ctrl	 +	 P	 or	 you	 can	 also	 click	 the
Quick	Print	command	button	on	the	Quick	Access	toolbar.			

Using	the	Goal	Seek	Feature

How	much	markup	should	you	charge	to	make	a	$10	million	profit	this	year?

How	many	sales	calls	you	need	to	make	to	achieve	your	$50,000	monthly	target?

The	 Goal	 Seek	 tool	 in	 Excel	 answers	 all	 such	 questions.	 It	 helps	 you	 determine	 a
particular	value	that	you	need	in	order	 to	reach	your	objective.	You	can	access	 the	Goal
Seek	tool	by	clicking	the	Goal	Seek	command	in	the	What-If	Analysis	drop	down	list	on
the	Data	tab.

Let’s	 take	a	simple	example	 to	 learn	 the	application	of	Goal	Seek.	Suppose	you	want	 to



find	 out	 the	maximum	20-year	mortgage	 value	 if	 the	 interest	 rate	 is	 4.5%	 and	 you	 pay
fixed	monthly	payments	of	$1,500.

One	way	to	find	the	required	value	is	the	‘trial	and	error’	method.	You	keep	experimenting
with	different	 trial	values	 till	you	achieve	the	correct	answer.	 	 	 	However,	doing	so	may
take	 up	 a	 whole	 lot	 of	 your	 time,	 needless	 to	 say	 that	 it	 would	 change	 the	 underlying
values	as	well.	By	using	Goal	Seek,	you	can	find	out	the	required	value	and	it	won’t	in	the
least	effect	the	original	values.

You	can	use	the	Goal	Seek	tool	to	solve	this	problem,	however	for	that,	first	you	need	to
determine	a	trial	value.	Let’s	assume	a	trial	mortgage	amount	of	$350,000.	



Here	is	how	you	can	use	Goal	Seek	in	this	particular	example.	The	same	example	and	goal
seek	process	is	illustrated	in	Figure	32.5.

Figure	32.5	-	Solving	the	Mortgage	Problem	Using	the	Goal	Seek	Dialog	Box

1.	 Select	the	cell	containing	the	formula	that	returns	the	resulting	value.	In	this	case,	it
is	Cell	B4,	as	shown	in	Figure	32.5

2.	 On	 the	Data	 tab,	 click	What-If	Analysis	 >	Goal	Seek.	 This	will	 open	 the	Goal
Seek	dialog	box,	shown	in	Figure	32.5

3.	 The	Set	cell	text	box	contains	the	cell	address	that	you	selected	in	step	1.	Make	sure
it	is	the	cell	that	contains	the	formula.

4.	 In	the	To	value	text	box,	type	the	value	you	want	as	the	result	of	the	formula.	In	this
example,	it	is	-1500.	Since	it	is	going	to	be	a	cash	outflow,	therefore	we	have	put	a
minus	sign	with	it.

5.	 In	the	By	changing	cell	 text	box,	specify	the	cell	address	containing	the	unknown
value;	that	is	the	trial	value.	In	this	case,	it	is	Cell	B1.	If	you	have	named	any	cell,
you	can	enter	the	name	instead	of	the	cell	address.

6.	 Recheck	all	the	entries	and	click	OK.

Once	 you	 hit	OK,	 the	Goal	 Seek	 dialog	 box	will	 be	 replaced	 by	 the	Goal	 Seek	 Status
dialog	box	stating	the	target	value	as	well	as	the	current	value.	The	value	that	you	want	to
find	out	is	stated	in	the	corresponding	cell	(Cell	B1	in	this	case),	as	shown	in	Figure	32.6.
If	you	want	to	save	the	new	values	in	the	worksheet,	hit	the	OK	button	in	the	Goal	Seek
Status	dialog	box.	To	restore	the	original	values,	click	Cancel.



Figure	32.6	-	The	Goal	Seek	Tool	Providing	Solution	of	the	Mortgage	Problem

	

The	mortgage	problem	as	illustrated	above	is	a	very	simple	example	of	using	Goal	Seek.
While	using	 the	Goal	Seek	 tool	on	complex	problems,	Excel	may	 take	a	 little	 longer	 in
performing	the	goal	seeking	calculations.	In	such	cases,	you	can	click	the	Pause	button	in
the	Goal	Seek	Status	dialog	box	to	hold	the	calculation,	and	then	hit	the	Step	button	to	the
see	the	result	at	each	iteration.

To	move	back	and	forth	between	the	original	and	goal	seek	values
even	after	closing	the	Goal	Seek	Status	dialog	box,	use	the	typical
Undo	 and	 Redo	 commands	 on	 the	 Quick	 access	 toolbar.	 Press
Ctrl+Z	to	display	the	original	values,	provided	you	clicked	OK	in
the	Goal	Seek	Status	dialog	box.	Press	Ctrl+Y	to	display	the	values
applied	after	performing	the	goal	seek	operation.			

	

A	Handy	Tip	to	Increase	Precision

By	default,	Excel	stops	the	Goal	Seek	operation	after	it	performs	100	iterations	or	after	it
finds	an	answer	that	is	at	least	0.001	precise	of	your	specified	target	value.	If	you	want	a
greater	precision	 than	0.001,	select	File	>	Options	>	Formulas.	 	Put	a	 tick	mark	 in	 the
Enable	 iterative	 calculation	 checkbox,	 then	 increase	 the	 value	 in	 the	 Maximum
Iterations	text	box	or	decrease	the	value	in	the	Maximum	Change	text	box,	or	both.



Figure	32.7	-	Changing	the	Settings	to	Increase	the	Precision	in	Goal	Seek	Results	

How	to	Use	Data	Tables

What	will	be	the	effect	on	the	net	profit	if	the	capital	gain	tax	increases	by	2%?	This	is	just
one	example	of	what	type	of	problems	can	be	solved	with	the	use	of	Data	Tables.

A	Data	Table	allows	you	to	analyze	the	effect	of	one	or	 two	variable	on	the	final	result.
For	example,	you	may	want	to	see	how	changing	the	tax	rate	affects	the	net	income,	or	the
effect	of	increased	discount	rate	on	the	total	operating	expenses	and	so	on.

	

A	data	table	is	useful	only	when	you	need	to	see	the	effect	of	one	or
two	variables	on	the	bottom	line.	In	other	words,	a	data	table	can	work
with	maximum	two	input	values	at	a	time.

	

There	two	types	of	data	tables	that	you	can	create	in	Excel,	one-variable	and	two-variable.
Let’s	talk	about	each	in	detail.	

Generating	a	One-Variable	Data	Table

As	the	name	suggests,	a	one-variable	data	table	can	deal	with	a	single	input	cell	only.	You
can	change	the	input	value	but	the	input	cell	remains	the	same.	In	other	words,	you	can	see
the	effect	of	only	one	variable	on	the	bottom	line.

Creating	 a	one-variable	data	 table	 in	Excel	 is	 not	 a	 one-click	 automatic	procedure.	You
need	 to	 set	 up	 the	 table	 manually.	 You	 can	 place	 the	 table	 anywhere	 on	 a	 worksheet.
Remember	the	following	points	while	setting	up	your	table:

The	top	left	cell	in	the	table	is	to	be	kept	blank.



The	left	column	in	the	table	is	to	contain	the	different	values	for	a	single	input	cell.

The	 top	 row	 in	 the	 table	 is	 to	contain	 the	 references	 to	 the	 formulas	 that	may	be
located	anywhere	in	the	worksheet.

Figure	32.8	shows	a	skeleton	structure	of	a	data	 table.	Follow	 this	 figure	 to	set	up	your
data	table.

Figure	32.8	-	Structure	of	a	Table	for	Creating	a	One-Variable	Data	Table

In	Figure	32.8,	the	cells	enclosed	in	red	border	are	to	carry	the	various	values	for	a	single
input	 cell.	 The	 top	 row	 enclosed	 in	 blue	 border	 should	 contain	 the	 references	 to	 the
formulas.	The	top	left	cell	must	be	kept	blank.

The	cells	in	between	the	top	row	and	left	column	(grey	shaded)	are	where	Excel	returns
the	resulting	values	for	different	input	values.	For	example,	when	calculating	the	resulting
value	 in	 Cell	 C5	 (enclosed	 in	 purple	 box),	 Excel	 takes	 the	 formula	 in	 the	 top	 cell	 in
column	C	and	uses	the	input	value	in	the	first	cell	in	Row	5	(as	indicated	by	purple	arrows
in	Figure	32.8).	Likewise,	Excel	calculates	all	the	values	using	the	corresponding	formulas
and	input	values.

After	setting	up	your	 table	on	 the	worksheet,	 follow	 these	steps	 to	create	a	one-variable
data	table:

1.	 Select	the	data	table	range.

2.	 Click	Data	tab	>	What-If	Analysis	>	Data	Table.	This	will	open	the	Data	Table
dialog	box.

3.	 Do	not	enter	anything	in	the	Row	Input	Cell	text	box.	Keep	it	blank.	In	the	Column
Input	Cell	text	box,	specify	the	cell	containing	the	underlying	input	value.



4.	 Click	OK	once	done.

One	you	click	OK,	Excel	calculates	the	resulting	values,	each	with	a	different	input	value
and	returns	the	answer	under	the	respective	formula	reference.

The	 above	 process	 creates	 a	 vertical	 data	 table.	 To	 create	 a
horizontal	data	table,	switch	the	values	between	the	top	row	and	the
left	column.	Enter	the	input	values	in	the	top	row	and	the	formula
references	 in	 the	 column.	When	 creating	 a	 horizontal	 data	 table,
leave	 the	 Column	 Input	 Cell	 text	 box	 blank	 in	 the	 Data	 Table
dialog	 box.	 	 Specify	 the	 input	 cell	 address	 in	 the	Row	 Input	Cell
text	box.			

	

Generating	a	Two-Variable	Data	Table

A	two-variable	data	table	enables	you	to	see	the	effect	of	two	variables	on	the	bottom	line.
In	 other	 words,	 this	 table	 is	 capable	 of	 dealing	 with	 two	 input	 cells	 at	 the	 same	 time.
However,	unlike	a	one-variable	data	table,	a	two-variable	data	table	shows	the	results	of
one	formula	only.		

When	creating	a	two-variable	data	table,	you	need	to	first	set	up	the	table	manually.	You
can	 place	 the	 table	 anywhere	 on	 a	 worksheet.	 Remember	 the	 following	 points	 while
setting	up	your	table:

The	top	left	cell	in	the	table	is	to	contain	the	formula	reference.

The	left	column	in	the	table	is	to	contain	the	different	values	for	the	first	input	cell.

The	top	row	in	the	table	is	to	contain	the	different	values	for	the	second	input	cell.

Figure	32.9	shows	a	skeleton	structure	of	a	data	 table.	Follow	 this	 figure	 to	set	up	your
data	table.

In	Figure	32.9,	the	cells	enclosed	in	red	border	are	to	home	the	various	values	for	the	first
input	cell.	The	top	row	enclosed	in	blue	border	are	to	contain	the	different	values	for	the
second	input	cell.	The	top	left	cell	is	to	contain	the	formula	reference.



Figure	32.	9	Structure	of	the	Data	Table	for	Creating	a	Two-Variable	Data	Table

The	cells	in	between	the	top	row	and	left	column	(grey	shaded)	are	where	Excel	returns
the	 resulting	 values	 for	 the	 different	 input	 values.	 For	 example,	 when	 calculating	 the
resulting	value	in	Cell	C5	(enclosed	in	purple	box),	Excel	takes	the	formula	in	the	top	left
cell	and	uses	the	input	value	in	the	first	cell	in	Row	5	and	the	second	input	value	in	the	top
cell	 in	 Column	 C	 (as	 indicated	 by	 purple	 arrows	 in	 Figure	 32.8).	 Likewise,	 Excel
calculates	all	the	values	using	the	corresponding	formulas	and	two	input	values.

After	setting	up	your	 table	on	 the	worksheet,	 follow	these	steps	 to	create	a	 two-variable
data	table:

1.	 Select	the	data	table	range.

2.	 Click	Data	tab	>	What-If	Analysis	>	Data	Table.	This	will	open	the	Data	Table
dialog	box.	

3.	 In	the	Column	Input	Cell	text	box,	specify	the	first	input	cell	(the	values	of	which
are	entered	in	the	column	in	the	table).	In	the	Row	Input	Cell	text	box,	specify	the
second	input	cell	(the	values	of	which	are	entered	in	the	row	in	the	table)

4.	 Click	OK	once	done.

One	 you	 click	 OK,	 Excel	 calculates	 the	 resulting	 values,	 each	 with	 a	 different
combination	of	two	input	values	and	returns	the	answer	under	the	intersecting	cell	in	the
table.

Get	To	Know	the	Excel	Solver

Although	 the	 Goal	 Seek	 and	 Data	 Table	 tools	 help	 you	 to	 solve	 almost	 every	 kind	 of



problems,	 both	 have	 their	 own	 limitations.	 These	 are	 quite	 an	 effective	 data	 analysis
features	 yet	 at	 times	you	may	need	 something	more	 advanced	 and	powerful,	 something
that	 enables	 you	 to	 work	 with	 multiple	 input	 values,	 formulas,	 constraints	 and
assumptions.

The	 Solver	 add-in	 in	 Excel	 is	 what	 you	 probably	 need	 to	 solve	 complex	 data	 analysis
problems.	It	is	capable	of	performing	the	following	operations	in	Excel:

Enables	you	to	specify	several	changing	cells	and	constraints.	

Applies	 iterative	methods	 to	 calculate	 the	most	 precise	 solution,	 given	 the	 input
values,	formulas,	constraints	and	assumptions.

Keeps	 on	 performing	 iterations	 (trial	 and	 error)	 till	 it	 reaches	 an	 answer	 that	 is
closest	to	the	optimum	result.

Returns	multiple	solutions,	at	times,	to	a	problem.

Returns	a	solution	that	optimizes	the	value	in	the	specified	result	cell.

The	Solver	feature	is	very	powerful	and	handy,	however	it	is	a	bit	complicated	to	use.	You
need	to	put	in	a	little	more	efforts	to	learn	its	usage	and	mechanism.	Make	sure	you	read
this	section	very	carefully	and	then	practice	all	that	is	mentioned	here	with	a	few	of	your
own	data	analysis	problems,	if	any,	or	create	a	few	for	practice	purpose.	

Adding	the	Solver	Add-In

The	Solver	command	is	located	in	the	Analysis	group	on	the	Data	tab.	However,	since	it	is
an	add-in	program,	you	may	not	find	it	in	your	Ribbon	the	first	time	you	use	Excel.

So	if	you	are	unable	to	find	the	Solver	button	in	the	Data	tab,	it	means	you	need	to	load	it
first	in	order	to	use	it.	Here	is	how	you	can	do	this:

1.	 Select	File	>	Options	>	Add-Ins.	This	will	open	the	Add-Ins	category	in	the	Excel
Options	dialog	box.

2.	 At	 the	bottom	of	 this	window	is	a	Manage	drop-down	 list.	The	Excel	Add-Ins	 is
selected	by	default.	Let	it	stay	default	and	click	Go.

3.	 This	will	open	the	Add-Ins	dialog	box.

4.	 Click	the	checkbox	labeled	Solver	Add-In,	then	click	OK.

Excel	adds	the	Solver	add-in	in	the	Data	tab	on	the	Ribbon.



Learn	to	Use	Solver

Remember	 that	 at	 times	 Solver	 returns	 more	 than	 one	 solution,
especially	 when	 dealing	 with	 complex	 problems.	 Though	 it
recommends	one	optimum	solution	as	well,	it	is	not	often	the	only
possible	 outcome,	 needless	 to	 say	 that	 it	 may	 not	 be	 the	 best
solution	 for	 you.	 To	 make	 sure	 you	 get	 the	 best	 solution,	 it	 is
highly	 recommended	 that	 you	 run	Solver	more	 than	once,	 every
time	with	different	initial	underlying	value(s).

	

Before	you	start	using	Solver,	you	need	to	define	the	problem	for	which	you	actually	want
to	use	the	Solver.	To	do	so,	you	need	to	create	a	worksheet	model	that	contains	the	target
cell,	the	changing	cells	and	the	constraint	cells.

Target	Cell:	Also	known	as	the	Objective	Cell,	it	contains	the	value	that	is	to	be	optimized.
It	 is	 the	 value	 that	 you	may	want	 to	minimize,	maximize	 or	 set	 it	 equal	 to	 some	 other
value.	

Changing	Cells:	Also	known	as	Variable	Cells,	 these	cells	 contain	values	 that	 are	 to	be
adjusted	to	reach	the	target	value.		

Constraint	Cells:	These	cells	contain	the	limitations	that	the	Solver	must	take	into	account
while	adjusting	the	changing	values.	

Once	 you	 define	 the	 Target,	 Changing	 and	 Constraint	 cells	 in	 your	worksheet,	 	 follow
these	steps	to	solve	the	problem	with	the	Solver:

1.	 Click	the	Solver	button	located	at	the	extreme	right	in	the	Data	tab.	This	will	open
the	Solver	Parameters	dialog	box,	as	shown	in	Figure	32.10



Figure	32.10	-	Exploring	the	Solver	Parameters	Dialog	Box

2.	 In	the	Set	Objective	text	box,	specify	the	target	cell	by	clicking	it	in	the	worksheet
or	by	typing	it	manually	in	the	Set	Objective	text	box.

3.	 Just	below	the	Set	Objective	text	box	are	three	check	circles;	namely,	Max,	Min	and
Value	of.	Click	the	Max	check	circle	if	you	want	to	maximize	the	value	in	the	target
cell;	or	click	the	Min	check	circle	if	you	want	to	minimize	the	value	in	the	target
cell;	or	 click	 the	Value	of	 check	 circle	 if	 you	want	 the	 target	 value	 to	 reach	 any
other	value.	 If	you	are	checking	 the	Value	of	option,	enter	 the	prospective	 target
value	in	the	accompanying	text	box.

4.	 In	 the	By	Changing	Variable	Cells	 text	box,	specify	 the	cell	 range	containing	 the
changing	 values.	 You	 can	 do	 so	 by	 clicking	 the	 particular	 cell	 range	 in	 the
worksheet	 or	 by	 typing	 the	 range	 address	manually	 in	 the	By	Changing	Variable
Cells	 text	 box.	 If	 the	Changing	Cells	 are	 spread	 apart	 non-adjacently,	 press	 and
hold	Ctrl	while	clicking	the	cells	in	the	worksheet.

	

5.	 The	Subject	to	the	Constraints	 text	box	displays	 the	constraints	 that	you	want	 the
Solver	 to	 follow	while	performing	 the	 iterations.	To	add	any	constraint,	 click	 the
Add	 button.	 This	 will	 open	 the	Add	Constraint	 dialog	 box,	 as	 shown	 in	 Figure
32.11

6.	 In	the	Cell	Reference	text	box,	specify	the	cell	upon	whose	value	you	want	to	apply



the	constraint.	Next	 to	 the	Cell	Reference	 text	box	 is	a	drop	down	 list	containing
several	limitations	(<=,	+,	>=,	int,	bin,	dif).	Select	the	required	limitation	from	this
drop	down	list,	and	then	enter	the	appropriate	corresponding	value	or	cell	reference
in	the	Constraint	text	box.			

You	don’t	need	to	enter	a	value	in	the	Constraint	 text	box	if	you	are
choosing	int	(integer)	or	bin	(binary)	in	the	drop	down	list.

	

Figure	32.11	-	Adding	Constraints

7.	 You	 can	 add	 many	 constraints	 as	 you	 want.	 Click	 the	Add	 button	 to	 save	 the
current	constraint	and	clear	 the	 text	boxes	for	 the	next	one.	After	entering	details
for	the	last	constraint,	click	OK	to	close	the	Add	Constraint	dialog	box	and	return
to	the	Solver	Parameters	dialog	box.	All	 the	constraints	will	now	be	displayed	in
the	Subject	to	the	Constraints	text	box.

8.	 Just	 below	 the	 Subject	 to	 the	 Constraints	 text	 box	 is	 a	 checkbox	 labeled	Make
Unconstrained	Variables	Non-Negative.	This	option	is	check	marked	by	default.
You	can	deselect	it	if	you	want	to	allow	the	negative	values,	provided	the	changing
cells	are	not	subject	to	any	limitations.	This	step	is	optional.

9.	 Next	in	line	is	the	Select	a	Solving	Method	option	accompanied	by	a	drop	down
list.	 By	 default,	 the	 GRG	 Nonlinear	 method	 is	 selected.	 Other	 than	 the	 GRG
method,	 this	 drop	 down	 list	 contains	 two	more	 options;	 namely	Simplex	 LP	 and
Evolutionary.

							Select	the	GRG	(Generalized	Reduced	Gradient)	Nonlinear	method	if	the
underlying	problem	is	smooth	and	non-linear.

	 	 	 	 	 	 	Select	the	Simplex	LP	(Linear	Programming)	method	 if	 the	underlying
problem	is	linear.

							Select	the	Evolutionary	method	if	the	underlying	problem	is	non-smooth.



10.																			Finally,	recheck	all	the	entries	and	hit	the	Solve	button.

Managing	the	Solver’s	Solution

After	you	click	the	Solve	button,	the	Solver	Parameters	dialog	box	disappears.	The	status
bar	 in	Excel	 keeps	 you	 informed	 of	 the	 Solver’s	 progress.	 It	 shows	 you	 the	 number	 of
iterations	being	performed	by	Excel.	 If	at	any	time	during	this	process	you	want	 to	stop
the	Solver,	hit	the	Esc	key	on	your	keyboard.

After	you	stop	the	solver,	the	Show	Trial	Solution	dialog	box	appears	alerting	you	that	the
operation	 has	 been	 halted.	 To	 continue	 from	 it	 left	 off,	 hit	 the	 Continue	 button.	 To
terminate	the	solver’s	operation	entirely,	click	the	Stop	button.

If	the	Solver	is	not	interrupted	in	between,	it	completes	the	process	and	shows	the	results
in	the	Solver	Results	dialog	box.

First,	the	Solver	Results	dialog	box	informs	you	if	the	solver	was	able	to	find	a	solution.	If
not,	it	poses	an	error	as	shown	in	Figure	32.12.	Next,	it	gives	you	two	options	regarding
whether	you	want	 to	keep	 the	solver	solution	or	 restore	 the	original	values.	Put	a	check
mark	in	the	appropriate	check	circle.	

If	you	currently	want	to	restore	the	original	values	on	the	worksheet	but	need	to	save	the
solution	as	well	for	 later	use,	you	can	do	so	by	clicking	the	Save	Scenario	button.	This
will	open	the	Save	Scenario	dialog	box,	where	you	need	to	enter	a	name	for	the	scenario.
Click	OK	to	save	the	scenario	and	return	to	the	Solver	Results	dialog	box.

Figure	32.12	-	Showing	the	Error	in	the	Solver	Results	Dialog	Box

	

	



Unlike	 the	 provision	 of	 Redo	 and	Undo	 in	 goal	 seeking	 operation,
you	cannot	move	back	and	forth	between	the	original	values	and	the
ones	suggested	by	the	Solver.	If	you	select	the	Keep	Solver	Solution
option	in	the	Solver	Results	dialog	box	and	click	OK,	these	changes
will	 be	 made	 permanent.	 You	 won’t	 be	 able	 to	 view	 the	 original
values	by	pressing	Ctrl	+	Z	and	vice	versa.	The	only	way	of	saving
both,	 the	original	and	 the	new	values,	 is	by	 saving	 the	 scenario	 (by
clicking	 the	Save	 Scenario	 button)	 and	 then	 selecting	 the	Restore
Original	Values	option	in	the	Solver	Results	dialog	box

	

Modifying	the	Solver	Settings

Normally,	 the	default	 solver	 settings	work	 just	 fine.	You	won’t	 really	need	 to	make	any
changes	in	them,	most	of	the	times.	However,	in	some	cases,	you	may	need	to	modify	the
settings	a	bit.

To	 change	 the	 Solver	 settings,	 open	 the	 Solver	 Parameters	 dialog	 box	 and	 click	 the
Options	button.	This	will	open	the	Options	dialog	box,	as	shown	in	Figure	32.13.

Once	you	are	done	making	changes,	click	OK	 to	return	to	the	Solver	Parameters	dialog
box	and	then	hit	the	Solve	button	to	start	the	solver’s	operation	with	the	modified	settings.

	



Figure	32.13	-	Solver	Settings	in	the	Options	Dialog	Box

Following	is	a	brief	description	about	each	option	in	the	Options	dialog	box.

Constraint	Precision:	As	the	name	implies,	this	option	allows	you	to	specify	the	precision
level	of	the	constraints.	The	value	in	the	Constraint	Precision	text	box	specifies	how	close
you	 want	 the	 Cell	 Reference	 and	 the	 Constraint	 formulas	 to	 satisfy	 the	 specified
limitations.

The	 lower	 the	 precision,	 the	 lesser	 time	 is	 taken	 by	 the	 Solver	 to
return	the	results.	So	if	there	are	no	constraints	in	your	problem	or
constraint	precision	does	not	matter	much	in	the	particular	problem,
it	is	recommended	to	keep	the	precision	as	low	as	possible.			

	

Use	Automatic	Scaling:	Click	this	checkbox	if	you	want	the	Solver	to	automatically	scale
the	resulting	values	while	performing	the	operation.	

Show	Iteration	Results:	Clicking	this	checkbox	will	instruct	Solver	to	halt	and	show	the
results	after	each	successive	iteration.		



Ignore	Integer	Constraints:	Clicking	this	checkbox	will	instruct	the	Solver	to	ignore	any
constraints	that	requires	a	particular	cell	to	be	an	integer.	

Integer	 Optimality:	 The	 value	 in	 this	 text	 box	 indicates	 the	 percentage	 of	 integer
optimality	criteria	that	you	want	the	Solver	to	follow	while	performing	the	operation.

Max	 Time	 (Seconds):	 As	 the	 name	 suggests,	 the	 value	 in	 this	 text	 box	 specifies	 the
maximum	number	of	seconds	that	you	want	the	Solver	to	spend	in	solving	the	problem.

Iterations:	The	value	in	this	text	box	specifies	the	maximum	number	of	iterations	that	you
want	the	Solver	to	perform	while	finding	the	solution.

Max	Subproblems:	When	using	 the	Evolutionary	method	 to	solve	 the	problem,	you	can
specify	the	maximum	number	of	subproblems	that	you	want	the	Solver	to	take	on.		

Max	Feasible	Solutions:	When	using	the	Evolutionary	method	to	solve	the	problem,	you
can	specify	the	maximum	number	of	feasible	solutions	that	you	want	the	Solver	to	explore
while	solving	the	problem.
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BOOK	VI:	MACROS	AND	VBA

PROGRAMMING

f	you	are	bored	or	tired	of	performing	the	same	tasks	repetitively	and	manually,	or	by
using	the	same	boring	tools,	 this	part	and	next	one	is	a	must	read	for	you.	Talking
about	 this	 part,	 here	 you	 will	 get	 to	 know	 about	 Excel’s	 one	 of	 the	 two	 most

advanced	features;	 that	 is,	Macros.	The	other	advanced	 thing	 is	 talked	about	 in	 the	next
part.

A	macro	is	like	a	program	in	Excel	that	enables	you	to	automate	boring	or	repetitive	tasks.
By	 using	 the	 macro	 recorder	 in	 Excel,	 you	 can	 record	 the	 activities	 that	 you	 perform
frequently	 in	Excel.	This	 not	 only	 saves	 times	 that	 you	would	 have	 otherwise	 spent	 on
performing	the	entire	 task	all	over	again,	 it	ensures	that	 the	particular	 task	is	carried	out
the	same	way	every	time.	

Visual	 Basic	 for	 Applications,	 commonly	 known	 as	 VBA,	 is	 the	 official	 programming
language	of	Excel.	You	can	use	it	to	create	and	edit	macros,	define	custom	functions	and
much	more.

VBA	is	an	entire	new	subject	in	itself,	the	study	of	which	is	well	beyond	the	scope	of	this
book.	However,	 this	part	does	 tell	you	 the	basic	and	common	applications	of	 the	Visual
Basic	language.



This	part	introduces	you	to	the	Macro	recording	tool	of	Excel,	along	with	its	mechanism
and	applications.	You	will	also	learn	some	macro	assigning	techniques	that	will	make	the
use	of	Macro	easier.

Furthermore,	 this	 book	 entails	 the	 process	 and	 tips	 to	 create	 macros	 using	 VBA.	 It
introduces	you	to	the	Visual	Basic	editor	and	its	different	components.	You	will	also	learn
how	to	use	the	VB	editor	to	edit	your	macros.

The	final	chapter	in	this	part	contains	a	detailed	explanation	on	how	you	can	use	the	VB
language	to	create	user	defined	functions	in	Excel.	

AT	A	GLANCE

Chapter	33:	Learning	the	Basics

Chapter	34:	Assigning	Macros															

Chapter	35:	Introducing	the	VB	Editor

Chapter	36:	Creating	User	Defined	Functions	in	Excel
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Chapter	33:	Learning	the	Basics

n	this	chapter,	you	will	learn	how	to	record	macros	in	Excel,	and	then	run	back	the
macros	to	use	the	recorded	procedure	to	perform	repetitive	tasks.	But	first	let’s	see
what	macro	actually	is.

A	macro	is	a	set	of	instructions	that	you	can	record	to	reapply	repetitively.	After	a	macro	is
saved,	you	just	need	to	hit	a	single	macro	button	to	perform	all	the	tasks	that	are	recorded
in	the	particular	macro.	

A	 macro	 is	 recorded	 in	 a	 programming	 language	 called	 Visual	 Basic	 for	 Applications
(VBA).	 It	 is	 a	 special	 type	 of	 programming	 language	 that	 can	 be	 used	 with	 all	 the
Microsoft	Office	 applications.	While	 the	 next	 part	 talks	more	 about	VBA,	 for	 now	you
need	to	know	that	it	 is	the	Excel’s	Visual	Basic	Editor	that	enables	you	to	view	and	edit
the	recorded	macros.

There	are	two	ways	of	recording	macros;	you	can	use	the	Excel’s	macro	recorder	to	record
the	entire	procedure	while	you	perform	it	on	a	worksheet,	or	you	can	enter	the	macro	VBA
code	in	the	Visual	Basic	Editor.

The	 first	way	of	 recording	macros	 is	 comparatively	easier;	 also	 it	 is	 the	macro	 recorder
process	that	we	have	explained	in	the	next	section.

How	to	Record	Macros

Before	you	set	on	 to	 record	macros,	make	sure	you	have	 the	Developer	 tab	revealed	on
your	Ribbon	in	Excel.	The	Developer	tab,	that	contains	several	Macro	related	commands,
is	hidden	by	default.	Here	is	you	can	make	it	visible	on	the	Ribbon.		

1.	 Select	File	>	Options	>	Customize	Ribbon.

2.	 Click	the	Developer	check	box	located	in	the	right	side	Main	tabs	list.

3.	 Click	OK	once	done.

The	Developer	tab	is	added	to	your	Ribbon.

Now	 that	 you	have	 revealed	 the	Developer	 tab,	 let’s	 see	 how	you	 can	 actually	 create	 a
macro	in	Excel.

For	the	sake	of	understanding,	suppose	the	repetitive	task	is	entering	“Bill	Harper	LLB”	in
14	Times	Roman,	bold,	italic	and	centralized.	Follow	these	steps	to	record	a	macro	for	this
process.



1.	 First	you	need	 to	open	 the	Record	Macro	dialog	box.	There	are	 three	ways	 to	do
that:

1.	 Select	View	tab	>	Macros	drop	down	list	>	Record	Macros.

2.	 Select	Developer	tab	>	Record	Macro.

3.	 Click	the	Record	Macro	button	in	the	status	bar.

Either	ways,	the	Record	Macro	dialog	box	opens	up,	as	shown	in	figure	33.1.

2.	 In	the	Macro	name	text	box,	enter	a	name	for	your	macro.	

Figure	33.1	-	Entering	Details	in	the	Record	Macro	Dialog	Box

3.	 Just	below	the	Macro	name	text	box	is	the	Shortcut	key	option,	where	you	need	to
specify	 a	 shortcut	 key	 to	 run	 the	particular	macro.	The	Ctrl	 key	 is	 already	 there,
you	 are	 to	 complete	 the	 shortcut	 combination	 by	 entering	 a	 letter	 in	 the
accompanying	text	box.

	

While	assigning	a	shortcut	key,	you	can	specify	any	letter	from	A	to
Z,	 or	 you	 can	 also	 enter	 “Shift+	 (any	 letter	 from	 A	 to	 Z)”.	 You
cannot,	 however,	 assign	 a	 number	 or	 any	 other	 punctuation	 key.
Ctrl+4	 and	 Ctrl+!	 are	 examples	 of	 invalid	 macro	 shortcut	 key
combinations.

	

While	assigning	a	keyboard	shortcut	to	your	macro,	make	sure	you
assign	 an	 unused	 shortcut.	 For	 example,	 Ctrl+C	 is	 already	 a



shortcut	used	to	copy	cells	in	Excels.	If	you	assign	the	same	shortcut
to	any	macro,	the	latter	will	override	the	former,	hence	you	won’t	be
able	 to	 use	 the	 same	 shortcut	 for	 copying	 cells	 and	 data	 in	 the
particular	workbook.

4.	 Next	 in	 line	is	 the	Store	macro	in	drop	down	list,	containing	 the	following	 three
options.

1.	 Click	Personal	Macro	Workbook	to	be	able	to	use	the	particular	macro	in
any	Excel	workbook.

2.	 Click	 This	 Workbook	 if	 you	 plan	 to	 use	 to	 this	 macro	 in	 the	 current
workbook	only.

3.	 Click	New	Workbook	if	you	want	 to	open	a	new	workbook	to	record	and
save	this	macro.

5.	 In	 the	 Description	 text	 box,	 enter	 a	 description	 about	 the	 macro.	 This	 step	 is
optional;	 however	 it	 is	 recommended	 that	 you	 enter	 a	 brief	 description	 to	 keep
record	of	what	 the	particular	macro	entails,	especially	when	working	with	quite	a
number	of	macros.	

6.	 Click	OK	once	done.

7.	 As	soon	as	you	click	the	OK	button,	 the	Record	Macro	dialog	box	disappears.	 In
the	status	bar,	 the	Record	Macro	button	is	replaced	with	a	solid	square.	This	icon
indicates	that	a	macro	is	currently	recording;	and	that	you	can	stop	the	recording	by
clicking	this	square	icon.

8.	 Select	View	 tab	 >	Macros	 drop	 down	 list	 >	Use	 Relative	 References;	 or	 click
Developer	 tab	 >	Use	 Relative	 References.	 This	 step	 is	 optional	 however	 it	 is
highly	 recommended	 that	you	keep	 the	 relative	 references	 command	activated	 as
this	would	enable	you	to	run	the	macros	anywhere	on	the	worksheet.

9.	 Start	entering	data	and	do	whatever	you	want	the	macro	the	record.	In	this	example,
select	a	cell,	enter	“Bill	Harper	LLB”,	then	in	the	Font	group	on	the	Home	tab,	set
the	font	to	14	size	Times	Roman.	Make	it	bold,	italic	and	centralized.

10.																			Once	you	are	done	entering	all	that	you	want	to	record	in	the	macro,	hit
the	 Stop	 Recording	 button	 on	 the	 status	 bar.	 After	 you	 stop	 a	 macro,	 the	 Stop
Recording	icon	is	replaced	by	the	Record	Macro	icon,	indicating	that	the	recording



has	been	stopped.

How	to	Run	Macros

There	are	several	ways	of	running	a	macro,	as	stated	below:

1.	 Select	View	tab	>	Macros	drop	down	list	>	View	Macros.

2.	 Select	Developer	tab	>	Macros.

Either	ways,	Excel	opens	the	Macro	dialog	box,	as	shown	in	Figure	33.2.	Select	the	name
of	the	macro	you	want	to	run	and	hit	the	Run	button.

For	keyboard	users,	hit	Alt	+	F8	to	open	the	Macro	dialog	box.

	

If	you	have	assigned	any	shortcut	key	to	a	macro,	then	you	don’t	need	to	follow	the	above
steps.	Just	hit	the	shortcut	combination	and	it	will	run	the	particular	macro.		

	

Figure	33.2	-	The	Macro	Dialog	Box

	

Before	 running	 a	macro,	make	 sure	 to	 select	 a	blank	 cell	where	you
want	 the	macro	 to	perform	 the	 recorded	 task,	or	else	 the	macro	may
override	 the	 existing	 data.	To	 revert	 a	macro’s	 actions,	 hit	 the	Undo
button	 on	 the	 Quick	 Access	 toolbar.	 If	 a	 particular	 macro	 performs
series	of	tasks,	you	may	have	to	Undo	several	times	in	order	to	nullify
the	macro’s	effects.



	

How	to	Save	Workbooks	Containing	Macros?

The	first	time	you	record	a	macro	in	a	workbook,	you	may	need	to	change	the	file	type	in
order	to	save	it.	Clicking	Ctrl	+	S	or	the	simple	Save	button	 in	 the	quick	access	 toolbar
may	not	 store	a	macro,	 in	 fact,	 it	may	make	you	 lose	your	macro	 if	you	 ignore	Excel’s
warning	and	close	the	file	without	saving	it	in	the	right	format.

By	default,	an	Excel	file	is	saved	.xlsx	file	format.	When	storing	macros	in	a	workbook,
you	need	to	save	it	as	.xlsm	(Excel	Macro-Enabled	Workbook).

	

You	can	also	save	the	workbook	as	.xls	(Excel	97–2003	format)	or
the	.xlbs	(Excel	binary	format),	both	of	these	file	types	can	contain
macros.

	

Modifying	the	Macro	Security	Settings

Figure	33.3	shows	Macro	Settings	tab	in	the	Trust	Center	dialog	box.	There	are	two	ways
to	open	it:

1.	 Click	Macro	Security	in	Code	group	on	the	Developer	tab.

2.	 Select	File	>	Options	>	Trust	Center.	Hit	the	Trust	Center	Settings	button.	

Figure	33.3	-	The	Macro	Security	Settings	in	the	Trust	Center	Dialog	Box

Following	 is	a	brief	description	about	 the	options	 in	 the	Macro	Settings	 tab	of	 the	Trust
Center	dialog	box.

Disable	all	macros	without	notification:	Clicking	 this	option	deactivates	all	 the	macros



that	are	not	saved	in	your	computer’s	trusted	locations.	This	option	prevents	all	the	users
including	you,	to	run	any	macros	in	the	current	worksheet.	You	can	activate	this	security
setting	when	your	computer	is	shared	by	other	users	whom	you	don’t	want	to	run	a	macro,
as	some	macros	may	carry	harmful	computer	virus.

Disable	all	macros	with	notification:	This	option	is	selected	by	default.	It	is	the	opposite
of	 the	 previous	 security	 setting;	 that	 is,	 it	 gives	 you	 control	 over	 the	 deactivation	 of
macros	that	are	not	saved	in	your	computer.	This	security	option	is	most	recommended	as
it	gives	you	control	over	the	running	of	potentially	harmful	macros.

Disable	all	macros	except	digitally	signed	macros:	Excel	allows	you	to	specify	publishers
that	can	be	trusted.	Selecting	this	option	automatically	enables	the	digitally	signed	macros
from	 trusted	 publishers,	 and	 disallows	 the	 ones	 that	 are	 not	 digitally	 signed.	 If	 after
activating	this	security	option,	you	try	to	a	run	a	macro	that	is	digitally	signed	but	not	from
a	trusted	publisher,	Excel	displays	an	alert	window	that	contains	a	Trust	All	Documents
from	this	Publisher	button.	Clicking	this	button	will	add	the	particular	publisher	to	your
trusted	list.		

Enable	all	macros	(not	recommended;	potentially	dangerous	code	can	run):	As	already
mentioned,	 this	 is	 the	 least	 recommended	option	 as	 it	 opens	doors	 to	 all	 publishers	 and
macros.	This	option	can	cause	real	damage	to	your	system	as	anyone	at	anytime	can	run	a
macro	in	any	of	the	opened	worksheet.	This	even	includes	the	macros	containing	deadly
computer	viruses	and	malware.

Apart	 from	 the	 above	 explained	 four	 options,	 the	Trusted	 Locations	 tab	 in	 the	 Trust
Center	 dialog	 box	 contains	 some	 options	 that	 you	 should	 know	 about,	 with	 regards	 to
Macro	security.

Add	New	Location:	Clicking	this	button	opens	up	the	Microsoft	Office	Trusted	Location
dialog	box	where	you	can	specify	any	folder	on	your	computer	as	a	trusted	location.	You
can	either	type	in	the	folder’s	directory	path	or	can	hit	the	Browse	button	and	then	explore
it	 in	 your	 computer.	 If	 you	 want	 to	 designate	 the	 subfolders	 of	 the	 selected	 folder	 as
trusted	 locations,	 click	 the	Subfolders	 of	This	Location	Are	Also	Trusted	 check	 box.
Click	OK	once	done.

Allow	Trusted	Locations	 on	My	Network	 (Not	Recommended):	The	 locations	 that	 you
add	by	clicking	the	Add	New	Location	button	will	only	be	considered	as	trusted	after	you
select	this	checkbox.	

Disable	All	Trusted	Locations:	Selecting	 this	option	disables	all	 the	 locations	 that	 	you



add	by	clicking	the	Add	New	Location	button,	only	the	macros	from	trusted	publishers	will
be	allowed	to	run	in	excel.
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Chapter	34:	Assigning	Macros

acros	 are	 so	handy	 that	 you	may	get	 addicted	 to	 them	once	you	 learn	 to	use
them	 properly;	 and	 when	 that	 happens,	 it	 is	 recommended	 that	 you	 add	 the
frequently	needed	macros	to	your	quick	access	toolbar	or	to	a	customized	tab	in

your	ribbon.	This	would	make	the	use	of	macro	quicker	and	easier.	

This	chapter	talks	about	the	macro	assigning	techniques.	The	first	section	entails	a	step	by
step	process	of	adding	macros	to	the	quick	access	toolbar.	The	second	section	explains	the
process	of	assigning	macros	to	your	ribbon.

How	to	Add	Macros	to	the	Quick	Access	Toolbar

Follows	these	steps	to	add	a	macro	button	to	your	quick	access	toolbar:

1.	 Click	the	Customize	Quick	Access	Toolbar	button	>	More	Commands.	This	will
open	the	Quick	Access	Toolbar	tab	in	the	Excel	Options	dialog	box.

2.	 Click	 the	Choose	Commands	 From	 drop-down	 list	 and	 select	Macros.	 All	 the
macros	that	are	saved	in	the	current	workbook	as	well	as	those	saved	as	Personal
Macro	Workbook	will	be	 listed	 in	 the	box	 located	below	the	Choose	Commands
From	drop-down	list.

3.	 Select	 the	macro	 that	 you	want	 to	 add	 to	 your	Quick	Access	 toolbar	 and	 hit	 the
Add	button.	Likewise,	you	can	select	and	add	any	number	of	macros	you	want.

4.	 After	adding	all	the	desired	macros,	click	the	OK	button	to	close	the	Excel	Options
dialog	box.

Once	you	are	back	 to	 the	worksheet,	you	will	notice	 that	a	new	button	 is	added	 to	your
Quick	Access	toolbar.	The	macro	button	resembles	a	typical	flowchart	icon,	which	should
not	be	a	problem	unless	you	add	more	than	one	macro	to	your	Quick	Access	 toolbar,	 in
which	case	it	would	be	difficult	for	you	to	distinguish	between	different	macro	buttons,	all
having	the	same	flowchart	icon.

One	way	to	find	out	the	required	macro	button	is	by	taking	the	mouse	cursor	over	to	each
macro	icon	and	seeing	the	name	of	the	corresponding	macro	in	the	form	of	a	ScreenTip.
This	method	however,	may	take	up	a	lot	of	time,	and	is	not	at	all	recommended	when	you
have	quite	a	number	of	macro	icons	on	the	quick	access	toolbar.		

A	better	 approach	of	 telling	 apart	 between	different	macro	 icons	 is	 to	 put	 a	 customized



button	for	each	one	of	them	on	a	worksheet.	You	can	assign	different	images,	clip	arts	and
shapes	to	the	macro	icons.	

To	assign	any	graphical	object	to	a	macro,	first	you	need	to	insert	the	particular	graphical
object	 on	 a	 worksheet;	 then	 right	 click	 the	 image	 and	 select	Assign	 Macro	 from	 the
shortcut	menu,	as	shown	in	Figure	34.1

This	will	open	the	Assign	Macro	dialog	box.	Enter	a	name	for	your	macro	button	and	click
OK.	You	can	place	this	image	anywhere	on	the	worksheet.	It	is	now	the	Run	button	for	the
corresponding	macro.	Just	click	the	image	to	run	the	particular	macro.

	

Figure	34.1	-	Assigning	Macro	to	a	Graphical	Object

How	to	Add	Macros	to	the	Ribbon

If	 you	 don’t	 like	 to	 cramp	 your	Quick	Access	 toolbar	with	 extra	 buttons,	 you	 can	 add
macros	to	a	custom	tab	on	the	Ribbon.	Here	is	how	you	can	do	that:

1.	 Select	File	 >	Options	 >	Customize	Ribbon.	 This	 will	 open	 the	Customize	 the
Ribbon	tab	in	the	Excel	Options	dialog	box.

2.	 On	the	left	side,	you	will	find	the	Choose	Commands	From	drop-down	list.	Click
this	drop	down	list	and	select	Macros.	All	the	macros	that	are	saved	in	the	current
workbook	as	well	as	those	saved	as	Personal	Macro	Workbook	will	be	listed	in	the
box	located	below	the	Choose	Commands	From	drop-down	list.

3.	 In	the	Main	Tabs	list	box	on	the	right,	select	the	name	of	the	custom	tab	to	which



you	want	to	add	the	macro	buttons.	If	you	have	not	yet	created	a	custom	tab,	follow
these	steps	to	do	so:

1.	 Hit	the	New	Tab	button	located	just	below	the	Main	Tabs	list	box.	This	will
add	a	New	Tab	 (Custom)	 and	a	New	Group	 (Custom)	 to	 the	Main	 Tabs
list.

2.	 Click	New	Tab	(Custom)	and	hit	the	Rename	button.

3.	 Specify	a	name	for	your	new	tab;	you	can	name	it	Macro	if	you	are	planning
to	 dedicate	 this	 tab	 solely	 to	 the	macros.	 Click	OK	 to	 close	 the	Rename
dialog	box.

4.	 Now	 select	New	Group	 (Custom)	and	 hit	 the	Rename	 button.	 Specify	 a
name	for	the	new	group	and	click	OK.

	

You	can	segregate	 the	groups	on	 the	basis	of	 the	nature	of	Macros.
For	 example,	 if	 you	have	named	 the	New	Tab	 (Custom)	as	Macro,
you	can	create	different	groups	and	name	 them	as	Finance	Macros,
Depreciation	Macros	and	so	on.

	

4.	 After	 selecting	 the	 name	of	 the	 custom	 tab	 and	group	 in	 the	Main	Tabs	 list	 box,
select	 the	macro	 that	you	want	 to	add	 to	 this	particular	 tab	and	 then	hit	 the	Add
button.	Likewise,	you	can	select	and	add	any	number	of	macros	you	want.

5.	 After	adding	all	the	desired	macros,	click	the	OK	button	to	close	the	Excel	Options
dialog	box.

Once	you	are	back	to	the	worksheet,	you	will	find	the	newly	added	macros	in	the	custom
tab.	Just	click	the	macro	command	button	on	the	Ribbon	to	run	the	particular	macro.
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Chapter	35:	Working	With	the	VB	Editor

his	chapter	starts	with	an	introduction	of	the	Visual	Basic	editor	in	Excel.	Then	it
entails	 the	 step	 by	 step	 process	 of	 editing	 and	 creating	macros	 using	 the	VBA
language.	You	will	also	discover	some	handy	tips	regarding	the	use	of	Excel’s	VB

editor.

Introducing	the	VB	Editor

Figure	35.1	shows	a	Visual	Basic	Editor	in	Excel.	You	can	open	the	VB	editor	by	clicking
the	Visual	Basic	button	in	the	Developer	tab.

	

For	keyboard	users,	press	Alt	+	F11	to	open	the	Visual	Basic	Editor

	

Figure	35.1	-	Exploring	the	Visual	Basic	Editor	in	Excel

In	Figure	35.1,	different	areas	have	been	highlighted.	The	buttons	enclosed	in	the	red	box
make	up	the	Visual	Basic	Editor	Standard	toolbar.	It	contains	several	commands	that	you
may	need	to	use	while	creating	and	editing	VBA	codes.	Just	hover	your	mouse	cursor	over
a	button	to	reveal	the	name	of	the	corresponding	command.		

Just	below	the	Standard	toolbar,	there	are	three	tiled	windows.	The	one	enclosed	in	green
borders	is	the	Project	Explorer	window.	It	contains	all	 the	sheets	and	projects	opened	in
the	Visual	Basic	Editor.	You	can	click	a	project	in	this	window	to	explore	and	work	on	its
components	and	user	forms.

	



In	VBA	 terminology,	 a	Project	 consists	 of	 all	 the	 worksheets,	 codes
and	user	forms,	that	are	part	of	a	particular	workbook.

	

The	second	window	in	the	VB	editor	is	the	Code	window	(highlighted	in	purple	in	Figure
35.1).	When	you	select	any	project	or	module	in	the	Project	Explorer	window,	the	Code
window	displays	the	VBA	programming	code	for	the	macro	stored	in	the	selected	project.

Just	 beneath	 the	 Project	 Explorer	 window	 is	 another	 tiled	 window	 that	 shows	 the
properties	of	the	project	or	module	selected	in	the	Project	Explorer	window.				

When	you	first	open	the	Visual	Basic	Editor,	it	shows	three	tiled	windows;	one	containing
the	 list	of	open	projects	and	modules,	 the	other	displaying	 the	properties	of	 the	selected
project	and	the	third	one	showing	the	VBA	programming	code	of	the	selected	module.

Apart	from	these,	you	can	open	as	many	Code	windows	as	you	want.	Just	double	click	a
module	in	the	Project	Explorer	window	to	open	 its	corresponding	Code	window,	or	you
can	right	click	the	module	you	want	to	view	the	code	of	and	then	click	View	Code	in	the
shortcut	menu.

Renaming	Items	in	the	VB	Editor

Sheet1,	 Sheet2,	Module1,	Module2,	 and	 so	 on…this	 is	 how,	 by	 default,	 the	 names	 of
sheets	 and	modules	 appear	 in	 the	VB	Editor.	You	may	want	 to	 give	 a	more	 descriptive
name	to	your	projects,	especially	when	there	are	lots	of	them	or	when	you	need	to	present
them	to	other	users.

Naming	 a	module	 or	worksheet	 in	 the	VB	Editor	makes	 it	 easier	 to	 remember	what	 it
contains.	And	it	is	very	simple!	Suppose	you	want	to	rename	Module1.	All	you	have	to	do
is	click	Module1	in	the	Project	Explorer	window,	then	specify	a	name	for	it	in	the	text	box
attached	to	the	(Name)	tab	in	the	Properties	window.



Figure	35.2	-	Renaming	Module1	in	the	Properties	Window	in	the	VB	Editor

	

When	specifying	a	name	for	a	module	or	sheet	 in	 the	VB	editor,	 it	 is
mandatory	 that	you	start	 the	name	with	a	 letter.	Moreover,	make	sure
the	name	does	not	contain	any	spaces	between	words;	instead	you	can
put	underscore.

	

How	to	Edit	Macros	Using	VBA?

In	 Part	 VI	 of	 this	 book,	 you	 learned	 how	 to	 create	 macros	 using	 the	 Excel’s	 macro
recorder.	What	if	you	mistakenly	skipped	something	while	recording	a	macro	or	you	need
to	 add/delete	 any	 activity	 from	 a	 recorded	macro.	Well,	 you	 can	 definitely	 recreate	 the
entire	 macro,	 however,	 this	 may	 take	 up	 a	 lot	 of	 your	 time	 especially	 when	 a	 macro
contains	a	lengthy	task.	In	such	cases,	it	is	more	convenient	and	recommended	to	edit	the
macro	rather	than	recreating	it	from	scratch.	This	section	tells	you	how	to	do	that.

	

If	the	macro	you	want	to	edit	is	stored	in	a	Personal	Macro	Workbook,
than	you	would	have	to	unhide	this	workbook	first	before	making	any
changes	in	it.	To	unhide	a	Personal	Macro	Workbook,	click	the	Unhide
button	in	the	View	tab	on	the	Ribbon.	This	will	open	the	Unhide	dialog
box.	 Select	 the	 name	 of	 the	 personal	 workbook	 in	 the	 Unhide
Workbook	list	box	and	click	OK.

	



Follow	these	steps	to	edit	the	contents	of	a	macro	in	the	Visual	Basic	Editor:

1.	 Select	View	tab	>	Macros	drop	down	list	>	View	Macros,	or	hit	Alt	+	F8	on	your
keyboard.	This	will	open	the	Macro	dialog	box,	displaying	names	of	all	the	macros
created	in	the	book	as	well	as	those	saved	in	your	Personal	Macro	Workbook.

2.	 Select	the	name	of	the	macro	that	you	want	to	edit	and	then	click	the	Edit	button.
This	will	open	the	Visual	Basic	Editor	with	the	Code	window	displaying	the	VBA
code	for	the	selected	macro.	

3.	 Edit	the	VBA	code	in	the	VB	editor	as	desired.

	

While	 editing	 a	 macro’s	 code	 in	 the	 VB	 editor,	 you	 can	 use	 the
Excel’s	traditional	Ctrl	+	Z	and	Ctrl	+	Y	to	undo	or	redo	any	action,
respectively.	 These	 commands	 are	 also	 located	 in	 the	Visual	 Basic
Editor	Standard	Toolbar.

	

4.	 Once	you	are	done	editing	the	macro,	you	can	return	to	the	worksheet	and	run	your
modified	macro.	To	do	so,	click	the	View	Microsoft	Excel	command,	it	is	the	first
button	 on	 the	 Standard	 toolbar,	 or	 you	 can	 also	Alt	 +	 F11.	 Either	 ways,	 Excel
minimizes	the	VB	editor	and	shows	the	corresponding	worksheet.

5.	 Once	you	are	on	 the	worksheet,	select	any	blank	unneeded	cell	and	 test-run	your
modified	macro.	If	it	does	not	run	as	it	should,	go	back	to	the	VB	editor	and	rectify
the	mistakes	in	the	VBA	code.

6.	 Once	 the	modified	macro	 is	correctly	edited;	 that	 is,	 it	 runs	 the	 intended	 task,	hit
the	Save	 command	 on	 the	 Quick	 Access	 toolbar	 to	 the	 save	 the	 changes	 in	 the
particular	macro.

	

It	is	highly	recommended	that	you	test	a	modified	macro	by	running	it
immediately	after	editing	it.	This	is	to	ensure	that	you	have	not	added
any	 invalid	 code	 or	made	 any	 incorrect	 changes	 in	 the	VBA	 code;	 if
yes,	go	back	to	the	VB	editor	and	undo	your	last	actions.	If	you	close	a
worksheet	without	 testing	 the	modified	macro	and	 later	on	 if	 it	poses



any	error	while	running,	you	would	not	be	able	to	undo	the	edits	just	by
hitting	Ctrl	+	Z.

If	you	edit	a	macro	that	is	stored	in	your	Personal	Macro	Workbook,	you	need	to	unhide	it
first,	 this	 has	 already	 been	 mentioned.	 Once	 you	 make	 the	 changes	 to	 this	 particular
macro,	save	it	and	then	exit	Excel,	it	will	be	automatically	hidden.	You	won’t	have	to	click
the	Hide	command	on	the	View	tab.	So	next	when	you	need	to	edit	the	same	macro,	you
would	have	to	unhide	the	workbook	again	before	making	any	changes	in	it.

How	to	Record	New	Macros	Using	VBA?

As	already	mentioned	in	the	previous	chapters,	there	are	two	ways	of	creating	a	macro	in
Excel;	you	can	record	 it	using	 the	Excel’s	macro	recorder	or	you	can	create	 it	using	 the
Visual	Basic	Editor.	You	 have	 already	 learned	 the	 former;	 following	 entails	 the	 step	 by
step	process	to	perform	the	latter.

Here	is	how	you	can	create	a	macro	in	the	VB	Editor:

1.	 Open	the	VB	editor	by	clicking	the	Visual	Basic	button	in	the	Developer	tab,	or	by
pressing	Alt	+	F11	on	your	keyboard.

2.	 In	the	Project	Explorer	window,	select	the	name	of	the	project	in	which	you	want
to	create	the	new	macro.

3.	 Select	Insert	 >	Module.	 This	will	 open	 a	 blank	 code	window	 in	 the	VB	Editor.
Also,	you	will	see	that	a	new	module	icon	is	added	in	the	Project	Explorer	window,
under	the	name	the	particular	VBA	Project.

4.	 In	the	blank	Code	window,	type	sub	and	then	hit	the	space	bar.

5.	 Type	a	name	for	your	new	macro,	then	hit	the	Enter	key.	As	soon	as	you	specify
the	 name	 and	 hit	Enter,	 a	 closed	 pair	 of	 parentheses	 is	 added	 after	 the	macro’s
name,	followed	by	a	blank	line	and	then	the	End	Sub	statement.	The	insertion	point
rests	on	the	blank	line.

	

While	naming	your	new	macro,	make	sure	the	name	does	not	contain
any	spaces	between	words,	instead	you	can	put	underscore.	Moreover,
the	name	should	start	with	a	letter.

	



6.	 Start	typing	the	VBA	code	for	your	macro.	The	code	must	start	from	the	blank	line
that	is	inserted	by	Excel	in	between	the	macro	name	and	the	End	Sub	statement.

7.	 Once	you	are	done	entering	the	code,	click	File	>	Save	or	hit	Ctrl	+	S	to	save	your
new	macro.

8.	 Now	click	the	View	Microsoft	Excel	command	on	the	Standard	toolbar,	or	you	can
also	 Alt	 +	 F11.	 Either	 ways,	 Excel	 minimizes	 the	 VB	 editor	 and	 shows	 the
appropriate	worksheet.

9.	 Once	you	are	on	the	worksheet,	select	View	tab	>	Macros	or	hit	Alt	+	F8	to	open
the	Macro	 dialog	 box.	 Select	 the	macro	 that	 you	 just	 created	 and	 click	 the	Run
button.	 If	 the	macro	 runs	 correctly	 and	 yields	 the	 intended	 results,	 your	work	 is
done	then.

10.		 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	If,	however,	Excel	faces	any	error	while	running	your	new	macro,	it
takes	you	back	 to	 the	Visual	Basic	Editor.	There	you	will	 see	 an	Alert	Microsoft
Visual	Basic	dialog	box	specifying	the	nature	of	the	particular	error.	If	you	are	still
unable	 to	 figure	 out	 the	 error	 yourself,	 click	 the	 Debug	 button	 in	 the	 Alert
Microsoft	Visual	Basic	dialog	box.	This	will	have	Excel	highlight	the	line	of	code
that	contains	any	invalid	entry.

11.		 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	Once	you	are	done	 rectifying	 the	 incorrect	 line	of	 code,	 click	 the
Continue	button	which	replaces	the	Run	button	on	the	standard	toolbar	while	 the
VB	Editor	is	the	debug	mode.	





T
Chapter	36:	Creating	User	Defined	Functions	in	Excel

his	chapter	talks	about	yet	another	exciting	feature	of	VBA;	that	is,	it	allows	you
to	create	your	own	functions	in	Excel.

User	Defined	Functions,	shortly	read	as	UDFs,	works	 just	 like	any	other	 functions.	You
can	 enter	 them	 into	 worksheets	 just	 like	 you	 do	 any	 other	 built-in	 Excel	 function.
However,	 UDFs	 are	 customized	 functions;	 that	 is,	 you	 can	 create	 them	 as	 per	 your
requirements.		

How	to	Create	a	User	Defined	Function	in	Excel	

Following	is	the	simple	generic	process	to	create	a	user	defined	function	in	Excel:

1.	 Open	the	VB	editor	by	clicking	the	Visual	Basic	button	on	the	Developer	tab,	or
by	pressing	Alt	+	F11	on	your	keyboard.

2.	 In	the	Project	Explorer	window,	select	the	name	of	the	project	for	which	you	want
to	create	the	particular	user	defined	function.

	

If	you	want	to	use	a	user	defined	function	in	any	worksheet	of	Excel,
select	VBAProject	(personal.xlsb)	in	the	Project	Explorer	window.

	

3.	 Select	Insert	>	Module.	This	will	 open	a	blank	Code	window	 in	 the	VB	Editor.
Also,	you	will	see	that	a	new	module	icon	is	added	in	the	Project	Explorer	window,
under	the	name	the	particular	VBA	Project.

4.	 In	 the	 first	 line	 of	 the	 blank	 Code	 window,	 specify	 a	 name	 for	 your	 custom
function,	 then	 enter	 the	 names	 of	 the	 arguments	 that	 you	want	 to	 include	 in	 this
particular	function.

	

While	specifying	a	name	for	your	custom	function,	you	cannot	use	the
name	of	any	built-in	function.	You	must	come	up	with	a	unique	name.
Moreover,	 the	 arguments	 that	 you	 enter	 must	 be	 listed	 in	 order	 in
which	they	are	to	be	applied	and	enclosed	in	parentheses.

	



5.	 Now,	using	the	arguments	listed	in	the	first	 line	of	code,	enter	the	formula(s)	that
you	want	 this	particular	user	defined	function	 to	perform.	You	can	use	arithmetic
operators	 and	 other	 built-in	 functions	 to	 make	 up	 the	 formula	 that	 is	 to	 be
performed	by	your	user	defined	function	to	return	the	required	result.		

6.	 Once	you	are	done	defining	the	user	defined	function,	type	the	End	command	on
the	last	line	in	the	Code	window.

How	to	Use	a	User	Defined	Function	in	Your	Worksheet	

As	already	mentioned,	you	can	work	with	a	user	defined	function	just	like	you	work	with
any	 other	 built-in	 function	 in	 Excel.	 First,	 select	 the	 cell	 where	 you	 want	 to	 enter	 the
particular	user	defined	function,	then	open	the	Insert	Function	dialog	box	by	clicking	the
fx	icon	on	the	formula	bar.	The	Insert	Function	dialog	box	is	shown	in	Figure	36.1

1.	 Click	 the	 ‘Or	 Select	 a	 Category’	 drop	 down	 list,	 scroll	 down	 and	 select	User
defined.	 Doing	 so	 will	 display	 all	 your	 user	 defined	 functions	 in	 the	 ‘Select	 a
function’	list	box.

2.	 Select	the	function	you	want	to	enter	and	click	OK.

3.	 Now	enter	the	appropriate	arguments	to	complete	the	operation.

Figure	36.1	-	Browsing	the	User	Defined	Functions	in	the	Insert	Function	Dialog	Box

How	To	Add	Description	With	A	User	Defined	Function?

As	you	can	see	in	Figure	36.1,	the	area	below	the	‘Select	a	function’	list	shows	“No	help
available”.	 Normally,	 this	 part	 of	 the	 Insert	 Function	 dialog	 box	 contains	 a	 brief
description	about	the	selected	function,	but	in	case	of	a	user	defined	function,	there	is	no
such	thing.

This	 is	because	a	user	defined	function	is	created	by	you	and	therefore	you	are	the	only



one	who	can	add	a	description	to	your	creation.

Follow	 these	 steps	 to	 add	 description	 about	 your	 user	 defined	 function	 in	 the	 Insert
Function	dialog	box:

1.	 Click	 the	Visual	 Basic	 button	 on	 the	Developer	 tab	 or	 hit	Alt	 +	 F11	 on	 your
keyboard,	to	open	the	Visual	Basic	Editor.

2.	 Select	View	>	Object	Browser.	This	will	open	the	Object	Browser	dialog	box,	as
shown	in	36.2

Figure	36.2	-	The	Object	Browser	Dialog	Box

	

For	keyboard	users,	open	the 	Visual	Basic	Editor	and	then	hit	the
F2	key	on	your	keyboard	to	launch	the	Object	Browser	dialog	box.

3.	 In	the	Object	Browser	dialog	box,	click	the	value	<All	Libraries>	and	then	select
VBAProject.	This	will	list	all	your	user	defined	functions	in	one	of	the	classes	in
the	left	pane	of	the	Object	Browser	dialog	box.

4.	 Right	click	the	user	defined	function,	for	which	you	want	to	add	the	description	and
select	Properties	 in	 the	 shortcut	 menu.	 This	 action	 opens	 the	Member	 Options
dialog	 box	 where	 you	 can	 enter	 your	 description	 of	 the	 selected	 user	 defined
function.

5.	 Type	in	the	description	and	click	OK	to	save	the	description	and	close	the	Member
Options	dialog	box.

6.	 Close	the	Object	Browser	dialog	box	to	return	to	the	VB	Editor.



7.	 In	the	VB	Editor,	select	File	>	Save	or	hit	Ctrl	+	S	on	your	keyboard.

The	added	description	will	now	appear	in	the	Insert	Function	dialog	box,	upon	selecting
the	particular	user	defined	function	in	it.		

Entering	a	User	Defined	Function	Directly	Into	a	Cell

In	the	previous	section,	we	narrated	the	process	of	entering	a	user	defined	function	via	the
Insert	Function	Dialog	Box.	But	as	you	already	know,	you	can	enter	a	 function	directly
into	a	cell	too;	that	is,	by	preceding	it	with	an	equal	to	(=)	sign.	Unfortunately,	the	direct
method	of	entering	a	function	is	not	the	same	for	a	user	defined	function	as	it	is	for	other
built-in	functions.

Suppose	you	created	a	user	defined	function	by	 the	name	of	RATIO.	 If	 it	was	a	normal
built-in	function,	you	could	have	entered	it	as	follows:

=RATIO	(E1/E2)

where	E1	and	E2	are	cell	references	pertaining	to	the	function’s	arguments.

However,	since	RATIO	is	a	user	defined	function,	you	cannot	just	enter	it	as	shown	just
now.	If	you	do	so,	Excel	would	return	the	#NAME?	error	value	in	the	cell.

To	 enter	 a	 user	 defined	 function	 directly	 into	 a	 cell,	 you	 must	 enter	 the	 name	 of	 the
appropriate	 workbook	 along	 with	 the	 function.	 For	 example,	 if	 the	 RATIO	 function	 is
created	in	a	Personal	Macro	Workbook,	you	need	to	enter	this	function	as	follows:

=PERSONAL.XLSB!RATIO(E1/E2)

Entering	the	workbook’s	name	may	get	annoying	and	time	consuming	as	well,	especially
if	the	particular	workbook’s	name	is	lengthy.	Well,	there	is	a	way	to	enter	a	user	defined
function	directly	into	a	cell,	without	having	to	enter	the	appropriate	workbook’s	name.	To
do	so,	you	need	to	save	the	workbook	containing	the	user	defined	functions,	as	an	add-in
file.

Follow	these	steps	to	save	a	file	containing	user	defined	functions	as	an	add-in	file,	so	that
you	 can	 enter	 these	 functions	 directly	 into	 the	 cells	 without	 the	 need	 to	 enter	 their
respective	filenames:

1.	 First	you	need	to	unhide	the	Personal	Macro	Workbook	that	you	want	to	save	as	a
special	add-in	file.	Here	is	how	you	can	do	that:

1.	 Click	the	Unhide	button	in	the	View	tab	on	the	Ribbon.	This	will	open	the



Unhide	dialog	box.

2.	 Select	the	name	of	the	personal	workbook	in	the	Unhide	Workbook	list	box
and	click	OK.

2.	 Now	click	the	Visual	Basic	button	on	the	Developer	tab	or	hit	Alt	+	F11	on	your
keyboard,	 to	 open	 the	 Visual	 Basic	 Editor.	 You	 will	 see	 that	 the	 workbook
containing	the	user	defined	functions	is	selected	in	the	Project	Explorer	window.

3.	 Now	select	the	Tools	>	VBAProject	Properties.	This	will	open	the	VBAProject	 -
Project	Properties	dialog	box,	as	shown	 in	Figure	36.3.	This	dialog	box	contains
two	tabs,	General	and	Protection.

Figure	36.3	-	The	VBAProject	-	Project	Properties	Dialog	Box

4.	 Click	the	Protection	tab.	There,	put	a	tick	mark	in	the	Lock	Project	for	Viewing
check	box.	Doing	so	will	prevent	others	from	viewing	your	user	defined	functions.
Needless	to	say	that	if	they	won’t	be	able	to	view	it,	they	won’t	be	able	to	modify	it
as	well.

5.	 Next,	enter	a	password	in	the	Password	text	box.	Renter	the	same	password	in	the
Confirm	Password	text	box	and	then	click	OK.	This	action	will	prevent	others	from
un-checking	the	Lock	Project	for	Viewing	check	box.

6.	 Now	click	the	View	Microsoft	Excel	in	the	VB	Editor’s	Standard	toolbar.	This	will
take	you	back	to	the	worksheet.

7.	 Before	saving	this	workbook	as	an	add-in	file,	you	need	to	give	it	a	title.	To	do	so,



select	File	>	Info.	This	will	take	you	to	the	Info	tab	in	the	Backstage	view.	Enter	a
name	 for	 the	 add-in	 file	 in	 the	Title	 field.	 If	 you	want,	 you	 can	 also	 add	 a	 brief
description	 about	 the	user	 defined	 functions	 that	would	be	 there	 in	 the	particular
add-in	file.		

8.	 After	entering	the	title	and	description,	click	the	Save	As	command.	This	will	open
the	Save	As	screen	in	the	Backstage	view.

9.	 Click	XLSTART	located	under	the	Current	Folder	heading	on	the	right	hand	side
of	the	Save	As	screen.	This	will	open	the	Save	As	dialog	box.

10.																			Specify	a	filename	for	the	particular	add-in	file	and	select	Excel	Add-In
(*.xlam)	in	the	Save	as	type	drop	down	list.

11.																			After	entering	the	filename	and	changing	the	file	type	to	.xlam,	hit	the
Save	button.

12.		 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	Now	it	is	time	to	activate	your	user	defined	functions	contained	in	the
add-in	file.	To	do	so,	click	File	>	Options	>	Add-Ins.	This	will	open	the	Add-Ins
tab	in	the	Excel	Options	dialog	box.

13.																			At	the	bottom	of	this	window	is	a	Manage	drop-down	list	with	the	Excel
Add-Ins	selected	 in	 it.	Hit	 the	Go	 button	 located	 right	 next	 to	 the	Manage	 drop-
down	list.	This	will	open	 the	Add-Ins	dialog	box,	containing	 the	names	of	all	 the
available	add-ins.

14.																			To	activate	your	user	defined	functions,	you	need	to	include	the	name	of
the	 add-in	 file	 in	 the	Add-Ins	available	 list	 in	 the	Add-Ins	 dialog	 box.	To	do	 so,
click	the	Browse	button	and	then	select	the	name	of	your	add-in	file	in	the	Browse
dialog	box.	Click	OK	once	done.

15.		 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	The	last	step	closes	the	Browse	dialog	box	and	brings	you	back	to	the
Add-Ins	dialog	box.	You	will	see	that	the	name	of	your	new	add-in	is	now	listed	in
the	Add-Ins	dialog	box.	Make	sure	the	check	box	carrying	the	name	of	your	add-in
is	check-marked.	Click	OK	once	done.

16.																			Once	you	click	OK,	Excel	closes	the	Add-Ins	dialog	box	and	brings	you
back	to	the	Visual	Basic	Editor.	Hit	the	Save	button	on	the	Standard	toolbar	or	click
Ctrl	+	S	on	your	keyboard.	

17.		 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	Click	 the	View	Microsoft	Excel	button,	or	hit	Alt	+	F11	 on	your



keyboard,	to	return	to	the	workbook.

18.																			Hide	back	the	personal	macro	workbook	by	clicking	the	hide	button	in
the	View	tab	on	the	Ribbon.

Now	you	can	enter	the	user	defined	functions	directly	into	a	cell,	without	having	to	enter
the	respective	workbook’s	name.	





BOOK	VII:	SHORTCUTS	AND	FUNCTION	LIST

Shortcuts	for	Using	Microsoft	Excel	Help

Keyboard	Shortcut Description

F1 Open	the	Microsoft	Excel	Help	Dialog	Box

Tab Select	the	next	help	topic	or	hyperlink

Shift	+	Tab Select	the	previous	help	topic	or	hyperlink

Enter Open	the	selected	help	topic	or	hyperlink

Alt	+	F4 Close	the	Microsoft	Excel	Help	Dialog	Box

Alt	+	Left	Arrow Go	to	the	previous	Help	topic

Alt	+	Right	Arrow Go	to	the	next	Help	topic

Ctrl	+	P Print	the	currently	opened	Help	topic

Ctrl	+	A Select	the	entire	Help	topic

Ctrl	+	C Copy	the	selected	items	to	the	Clipboard

Up	Arrow Scroll	to	the	beginning	of	a	Help	topic

Down	Arrow Scroll	to	the	end	of	a	Help	topic

Page	Up Scroll	toward	the	top	of	the	current	page	of	a	Help	topic

Page	Down Scroll	toward	the	bottom	of	the	current	page	of	a	Help	topic

Home Go	to	the	beginning	of	a	Help	topic

End Go	to	the	end	of	a	Help	topic

	

Shortcuts	for	Navigating	Worksheet

Keyboard	Shortcut Description

Arrow	keys	(↑,	↓,	←,	→) Move	one	cell	up,	down,	left	or	right	respectively

Arrow	keys*	(↑,	↓) Scroll	one	row	up	or	down	respectively

Arrow	keys*	(←,	→) Scroll	one	column	left	or	right	respectively



Home Move	to	the	first	cell	of	the	current	row

Home* Move	to	the	top	left	cell	of	the	current	display	of	the	worksheet

End* Move	to	the	bottom	right	cell	of	the	current	display	of	the	worksheet

Page	Up Move	up	one	screen

Page	Down Move	down	one	screen

Ctrl	+	Page	Up Move	to	the	previous	sheet	in	the	workbook

Ctrl	+	Page	Down Move	to	the	next	sheet	in	the	workbook

Alt	+	Page	Up Move	one	screen	to	the	left

Alt	+	Page	Down Move	one	screen	to	the	right

Ctrl	+	Home Move	to	cell	A1	(the	first	cell	of	the	worksheet)

Ctrl	+	End Move	to	the	last	blank	cell	of	the	active	region	of	the	worksheet

Ctrl	+		Arrows	keys Move	to	the	edge	of	the	active	region	.	If	the	current	cell	is	blank,	move
to	the	last	blank	cell	in	the	corresponding	direction

Ctrl	+	Backspace Scroll	to	the	active	cell

End	+	Home Move	to	the	last	cell	of	the	active	data	block

Ctrl	+	Tab Go	to	next	window

Ctrl	+	Shift	+	Tab Go	to	the	previous	window

Ctrl	+	F6 Move	to	the	next	open	workbook

Ctrl	+	Shift	+	F6 Move	to	previous	open	window

*	With	Scroll	Lock	on 	

	

Shortcuts	for	Selecting	Cell(s)

Keyboard	Shortcut Description

Home Select	the	first	cell	in	the	row.

F8 Switch	On/Off	the	Extend	Selection	mode.	In	this	mode	is	On,	you	can
select	cells	just	moving	the	navigation	keys



Shift	+	Spacebar Select	the	entire	row(s)

Ctrl	+	Spacebar Select	the	entire	column(s)

Shift	+	F8

Turn	On/Off	the	“Add	to	Selection”	mode.	If	this	mode	is	on,	it
eliminates	the	need	of	holding	Ctrl	while	selecting	a	range	of	cells.	Just
click	on	the	cell(s)	you	want	to	select.	Turn	off	this	mode	once	you	are
done	selecting.

Shift	+	Navigation	key Extend	the	selection	by	one	cell	in	the	corresponding	direction

Ctrl	+	Shift	+	Spacebar
Hit	this	combination	once	to	select	the	active	table	without	the	header
row;	Hit	it	twice	to	select	the	entire	table;	Hit	it	thrice	to	select	the	entire
worksheet

Ctrl	+	Shift	+	Navigation	key Extend	the	selection	up	to	the	last	nonblank	cell	in	the	corresponding
row	or	column

Ctrl	+	A Select	the	entire	worksheet

Shift	+	Home Extend	the	selection	to	the	beginning	of	the	active	row

Scroll	Lock	+	Shift	+	Home Extend	the	selection	to	the	cell	in	the	top	left	corner	of	the	current
window

Ctrl		+	Shift		+	Home Extend	the	selection	to	the	beginning	of	the	active	worksheet

Ctrl		+	* Select	the	range	of	cells	surrounding	the	active	cell

Ctrl		+	Shift		+	End Extend	the	selection	to	the	last	nonblank	cell	on	the	worksheet

End	+	Shift	+	Home Extend	the	selection	to	the	last	blank/nonblank	cell	on	the	worksheet

Shift	+	Page	Up Extend	the	selection	up	one	screen	in	the	active	row

Shift	+	Page	Down Extend	the	selection	down	one	screen	in	the	active	row

F5	or	Ctrl	+	G Open	the	Go	To	dialog	box	for	selecting	cells	by	name

Shift	+	Backspace Cancel	the	current	range	selection	and	select	the	active	cell

End	+	Shift	+	arrow	key Extend	the	selection	in	the	direction	of	the	navigation	key	to	the	last
nonblank	cell	in	the	current	region

Ctrl	+	Home Select	the	first	cell	in	the	current	window	or	pane

Ctrl	+	Down	Arrow Select	the	last	cell	down	in	the	region

Scroll	Lock	+	Shift	+	End Extend	the	selection	to	the	cell	in	the	bottom	right	corner	of	the	current
window

Ctrl		+		6 Toggle	the	visibility	of	objects



Shift	+	Alt	+	Page	Down Extend	the	selection	one	page	to	the	right

Shift	+	Ctrl	+	Page	Up Extend	the	selection	one	worksheet	up

Shift	+	Alt	+	Page	Up Extend	the	selection	one	page	to	the	left

Shift	+	Ctrl	+	Page	Down Extend	the	selection	one	worksheet	down

	

Shortcuts	for	“Go	To	Special”	Commands

Keyboard	Shortcut Description

Ctrl	+	Shift	+	O Select	the	Comments	command

Ctrl	+	Shift	+	* Select	the	current	region	command

Ctrl	+	/ Select	the	current	array	command

Ctrl	+	\ Select	Row	Differences

Ctrl	+	Shift	+	| Select	Column	Differences

Ctrl	+	[ Select	precedents	(Direct)

Ctrl	+	Shift	+	{ Select	precedents	(All)

Ctrl	+	] Select	dependents	(Direct)

Ctrl	+	Shift	+	} Select	dependents	(All)

Alt	+	; Select	visible	cells	only

	

Shortcuts	for	Data	Entry

Keyboard	Shortcut Description

Enter Accept	the	cell	entry	and	moves	below

Alt	+	Enter Start	a	new	line	in	the	selected	cell

Ctrl	+	Enter Copy	the	current	entry	in	all	the	cells	in	the	selected		range

Shift	+	Enter Accept	the	cell	entry	and	moves	up	one	cell

Tab Accept	the	cell	entry	and	moves	one	cell	to	the	right



Shift	+	Tab Accept	the	cell	entry	and	moves	one	cell	to	the	left

Esc Cancel	an	entry	or	any	changes	made	in	the	cell	while	it	is	still	in	the	edit	mode

F4 Repeat	the	last	command	or	activity

Ctrl	+	D Fill	down	the	cells	in	the	selected	range

Ctrl	+	Shift	+	: Enters	the	current	time

Ctrl	+	; Enters	the	current	date

	

Shortcuts	for	Number	Formatting

Keyboard	Shortcut Description

Ctrl	+	Shift	+	~ Apply	the	General	number	format

Ctrl	+	Shift	+	$ Apply	the	Currency	format	with	two	decimal	places	(put	negative	numbers	in
parentheses)

Ctrl	+	Shift	+	% Apply	the	Percentage	format	with	no	decimal	places

Ctrl	+	Shift	+	^ Apply	the	Scientific	(Exponential)	number	format	with	two	decimal	places

Ctrl	+	Shift	+	# Apply	the	Date	format	(Day-Month-Year)

Ctrl	+	Shift	+	@ Apply	the	Time	format	(Hour:Minute	AM/PM)

Ctrl	+	Shift	+	! Add	two	decimal	places,	thousands	separator,	and	hyphen	(-)	for	negative
values

Shortcuts	for	Text	Formatting	and	Editing	Worksheets

Keyboard	Shortcut Description

Alt	+	’	(apostrophe) Display	the	Style	dialog	box

Ctrl	+	1* Display	the	Format	Cells	dialog	box

Ctrl	+	B	or	Ctrl	+	2* Apply	or	remove	bold	formatting

Ctrl	+	I	or	Ctrl	+	3* Apply	or	remove	italic	formatting

Ctrl	+	U	or	Ctrl	+	4* Apply	or	remove	underline

Ctrl	+	5* Apply	or	remove	strikethrough



Ctrl	+	9* Hide	the	selected	rows

Ctrl	+	0* Hide	the	selected	columns

Ctrl	+	Shift	+	( Unhide	the	hidden	rows	within	the	selection

Ctrl	+	Shift	+	& Apply	the	outside	border	to	the	selection

Ctrl	+	Shift	+_	(underscore) Remove	the	outside	border	from	the	selection

*	Use	the	numeric	key	on	the	keyboard,	not	on	the	keypad

	

Shortcuts	for	Working	with	Charts	and	Borders

Keyboard	Shortcut Description

F11 Create	a	chart	of	the	selected	data	on	a	new	worksheet.

Alt	+	F1 Create	an	embedded	chart	of	the	selected	data	on	the	current	worksheet.

Down	Arrow Select	the	previous	group	of	elements	in	the	selected	chart.

Up	Arrow Select	the	next	group	of	elements	in	the	selected	chart.

Right	Arrow Select	the	next	element	within	the	selected	group	in	a	chart.

Left	Arrow Select	the	previous	element	within	the	selected	group	in	a	chart.

Alt	+	T Draw	or	erase	the	top	border.

Alt	+	B Draw	or	erase	the	bottom	border.

Alt	+	L Draw	or	erase	the	left	border.

Alt	+	R Draw	or	erase	the	right	border.

Alt	+	U Draw	or	erase	the	upward	diagonal	border.

Alt	+	D Draw	or	erase	the	downward	diagonal	border.

Alt	+	H Apply	or	delete	the	horizontal	divider,	if	cells	in	multiple	rows	are	selected.

Alt	+	V Apply	or	delete	the	vertical	divider,	if	cells	in	multiple	rows	are	selected.

	

Shortcuts	for	Working	with	Formulas	



Keyboard	Shortcut Description

=	(equals	to) Start	a	formula.

Enter Complete	a	cell	entry	in	the	cell	or	formula	bar	and	move	one	cell	down.

F2 When	a	cell	is	not	in	the	editing	mode,	this	key	moves	the	insertion	point
into	the	formula	bar.

Backspace Delete	one	character	to	the	left	of	the	cursor,	in	the	formula	bar.

Delete Delete	one	character	to	the	right	of	the	cursor,	in	the	formula	bar.

Home Move	the	insertion	point	to	the	beginning	of	the	line,	in	the	formula	bar.

End Move	the	insertion	point	to	the	end	of	the	line,	in	the	formula	bar.

Ctrl	+	Delete Delete	all	characters	from	the	insertion	point	to	the	end	of	the	line.

Alt	+	=	(equal	sign) Insert	an	AutoSum	formula.

Ctrl	+	Shift	+	“ Copy	the	displayed	value	from	the	cell	located	above	the	active	cell	and	then
select	it	for	editing.

Ctrl	+	Shift	+	Enter Enter	a	formula	as	an	array	formula.

Ctrl	+	’	(apostrophe) Copy	the	underlying	value	from	the	cell	located	above	the	active	cell	into	the
active	cell.

Ctrl	+	A Open	the	Function	Arguments	dialog	box,	when	the	insertion	point	is	to	the
right	of	a	function	name	in	a	formula.

Ctrl	+	Shift	+	A Insert	the	argument	names	and	parentheses,	when	the	insertion	point	is	to	the
right	of	a	function	name	in	a	formula.

Esc Cancel	an	entry	in	the	cell	or	formula	bar,	or	take	the	selected	cell	out	of	the
editing	mode.

F3 Open	the	Paste	Name	dialog	box.

Shift	+	F9 Calculate	the	active	worksheet.

Ctrl	+	`	(accent	grave) Toggle	between	displaying	cell	values	and	formulas.

Shift	+	F3 Open	the	Insert	Function	dialog	box.

F9 When	a	part	of	a	formula	is	selected,	calculate	the	selected	part;	or	else
calculate	all	worksheets	in	all	open	workbooks.

Ctrl	+	Alt	+	F9 Calculate	all	worksheets	in	all	the	open	workbooks,	regardless	of	whether
and	how	much	have	they	been	modified	since	the	last	calculation.



	

Some	More	Keyboard	Shortcuts

Keyboard	Shortcut Description

Alt	+	F8 Open	the	Macro	dialog	box.

Alt	+	F11
Open	the	Visual	Basic	Editor;	if	the	editor	is	already	opened,	this
shortcut	key	acts	as	a	toggle	between	displaying	the	main	Excel	window
and	the	editor.

Ctrl	+	F11 Insert	a	Microsoft	Excel	4	macro	worksheet.

Ctrl	+	6 Cycles	among	different	ways	of	displaying	objects	on	a	worksheet

Ctrl	+	P	or	Ctrl	+	Shift	+	F12 Open	the	Print	dialog	box.

Shift	+	F10 Open	the	shortcut	menu	for	the	selected	item.

Alt	+	Spacebar Open	the	control	menu	for	Excel	window.

Ctrl	+	Shift	+	L Toggle	the	AutoFilter	controls	in	a	table

Ctrl	+	Alt	+	V Open	the	Paste	Special	dialog	box.

Alt	+	F,	then	press	P Open	the	Print/Print	Preview	screen	in	the	Backstage	view.

Ctrl	+	8 Act	a	as	a	toggle	to	display	the	outline	symbols.

Ctrl		+		F Open	the	Find	tab	in	the	Find	and	Replace	dialog	box.

Ctrl	+	H Open	the	Replace	tab	in	the	Find	and	Replace	dialog	box.

Ctrl	+	F1 Act	a	as	a	toggle	to	display	and	hide	the	Ribbon.

Alt	+	Backspace Undo	the	last	action.

Ctrl	+	K Open	the	Insert	Hyperlink	dialog	box.

Ctrl	+	R Fill	Right

Ctrl	+	N Open	a	new	workbook.

Ctrl	+	O Open	the	Open	screen	in	the	Backstage	view.

Ctrl	+	T Open	the	Create	Table	dialog	box.

Ctrl	+	Shift	+	T Toggle	the	Total	row	in	a	table



List	of	the	Functions	in	Alphabetical	Order

Function Description

ABS Returns	the	absolute	value	of	a	number;	that	is	a	number	without	it	sign.

ACCRINT Returns	the	interest	accrued	by	a	security	that	pays	periodic	interest.

ACCRINTM Returns	the	interest	accrued	by	a	security	that	pays	interest	at	maturity.

ACOS Returns	the	arccosine	(inverse	cosine)	of	a	number.

ACOSH Returns	the	inverse	hyperbolic	cosine	of	a	number.

ACOT Returns	the	arccotangent	(inverse	cotangent)	of	a	number

ACOTH Returns	the	inverse	hyperbolic	arccotangent	of	a	number

ADDRESS Creates	the	cell	reference	as	text,	given	the	specified	row	and	column
numbers

AGGREGATE Returns	an	aggregate	of	a	range	of	array,	in	a	list	or	database.

AMORDEGRC Returns	the	prorated	linear	depreciation	for	each	accounting	period

AMORLINC Returns	the	prorated	linear	depreciation	for	each	accounting	period
(The		coefficient	of	depreciation	depends	upon	the	life	of	the	asset)

AND Tests	whether	the	specified	arguments	are	true;	Returns	TRUE	if	all	the
arguments	are	TRUE

ARABIC Converts	a	Roman	numeral	to	an	Arabic	numeral

AREAS Returns	the	number	of	areas	in	a	reference,	where	Area	is	an	adjacent
range	or	a	single	cell

ASIN Returns	the	arcsine	of	a	number	in	radians

ASINH Returns	the	inverse	hyperbolic	sine	of	a	number

ATAN Returns	the	arctangent	of	a	number	in	radians

ATAN2 Returns	the	arctangent	of	the	specified	x	and	y	coordinates,	in	radians

ATANH Returns	the	inverse	hyperbolic	tangent	of	a	number

AVEDEV Returns	the	average	of	the	absolute	deviations	of	data	points	from	their
mean



AVERAGE Returns	the	arithmetic	of	the	numbers	specified	in	the	arguments

AVERAGEA Computes	the	average	of	the	values	specified	in	the	arguments,	where
values	include	text	and	logical	values	as	well

AVERAGEIF Returns	the	average	of	the	values	in	the	specified		range,	that	meets	the
given	criterion

AVERAGEIFS Computes	the	average	for	the	cells	specified	by	multiple	criteria

BAHTTEXT Converts	a	number	to	Thai	(Baht)	text

BASE Converts	a	number	into	a	text	representation	with	the	given	radix	(base)

BESSELI Returns	the	modified	Bessel	function	In(x)

BESSELJ Returns	the	Bessel	function	Jn(x)

BESSELK Returns	the	modified	Bessel	function	Kn(x)

BESSELY Returns	the	Bessel	function	Yn(x)

BETA.DIST Calculates	the	beta	cumulative	distribution	function

BETA.INV Returns	the	inverse	of	the	beta	cumulative	distribution	function
(BETA.DIST)

BETADIST* Calculates	the	beta	cumulative	distribution	function.	This	function	is	the
compatibility	version	of	BETA.DIST	function.

BETAINV* Returns	the	inverse	of	the	cumulative	beta	probability	density	function.
This	function	is	the	compatibility	version	of	BETA.INV	function.

BIN2DEC Converts	a	binary	number	to	a	decimal	number

BIN2HEX Converts	a	binary	number	to	hexadecimal

BIN2OCT Converts	a	binary	number	to	octal.

BINOM.DIST Returns	the	individual	term	binomial	distribution	probability.

BINOM.DIST.	RANGE Returns	the	probability	of	a	trial	result	using	a	binomial	distribution.

BINOM.INV Returns	the	smallest	value	for	which	the	cumulative	binomial
distribution	is	greater	than	or	equal	to	a	criterion	value.

BINOMDIST*
Returns	the	individual	term	binomial	distribution	probability.	This
function	is	the	compatibility	version	of	BINOM.DIST	function.

BITAND
Compares	two	numbers	in	binary	form,	and		then	returns	the	one
indicating	the	bit	positions	that	do	not	match.	In	other	words,	it	returns	a
bitwise	‘AND’	of	two	numbers.



BITLSHIFT
Returns	a	number	that	has	been	shifted	to	the	left	by	shift_amount	bits,
by	adding	zeros	to	the	right	of	the	number.

BITOR
Compares	two	numbers	in	binary	form,	and	then	returns	the	one
indicating	the	bit	positions	that	match.	In	other	words,	it	returns	a
bitwise	‘OR’	of	two	numbers.

BITRSHIFT Returns	a		number		that	has	been	shifted		to	the	right	by	shift_amount
bits,	by	removing	digits	to	the	right	of	the	number

BITXOR
Compares	the	two	numbers	and	then	returns	the	one	that	indicates	the
result	of	an	‘Exclusive	OR’	of	its	arguments.	In	other	words,	it	returns	a
bitwise	Exclusive	OR	of	two	numbers.

CEILING* Rounds	a	number	to	the	nearest	integer	or	to	the	nearest	multiple	of
significance.

CEILING.MATH Rounds	a	number	up,	to	the	nearest	multiple	of	significance.

CELL Returns	information	about	the	formatting,	location	and	contents	of	a
cell.

CHAR Returns	the	character	specified	by	the	code	number	from	the	character
set	for	your	computer.	It	mostly	corresponds	to	the	ASCII	code

CHIDIST* Returns	the	right-tailed	probability	of	the	chi-squared	distribution.		This
function	is	the	compatibility	version	of	CHISQ.DIST.RT	function.

CHIINV*
Returns	the	inverse	of	the	right	tailed	probability	of	the	chi-squared
distribution.	This	function	is	the	compatibility	version	of
CHISQ.INV.RT	function.

CHISQ.DIST Returns	the	chi-square	distribution.

CHISQ.DIST.RT Returns	the	right-tailed	probability	of	the	chi-squared	distribution.

CHISQ.INV Returns	the	inverse	of	the	left-tailed	probability	of	the	chi-squared
distribution.	

CHISQ.INV.RT Returns	the	inverse	of	the	right-tailed	probability	of	the	chi-squared
distribution.

CHISQ.TEST Returns	the	test	for	independence:	the	value	from	the	chi-squared
distribution	for	the	statistic	appropriate	degrees	of	freedom.	

CHITEST* Returns	the	test	for	independence.	This	function	is	the	compatibility
version	of	CHISQ.TEST	function.

CHOOSE Chooses	a	value	or	action	from	a	list	of	values.

CLEAN Deletes	all	the	nonprintable	characters	from	text.

CODE Returns	a	numeric	code	for	the	first	character	in	a	text	string,	according
to	the	character	set	installed	in	your	computer



COLUMN Returns	the	column	number	of	a	reference.

COLUMNS Returns	the	number	of	columns	in	a	reference	or	array

COMBIN Returns	the	number	of	combinations	for	a	given	number	of	objects

COMBINA Returns	the	number	of	combinations	for	a	given	number	of	items.

COMPLEX Converts	real	and	imaginary	coefficients	into	a	complex	number.

CONCATENATE Combines	multiple	text	values	into	one	text	value.

CONFIDENCE*
Computes	the	confidence	interval	for	a	population	mean,	assuming	a
normal	distribution.	This	function	is	the	compatibility	version	of
CONFIDENCE.NORM	function.	

CONFIDENCE.NORM Computes	the	confidence	interval	for	a	population	mean,	assuming	a
normal	distribution

CONFIDENCE.T Returns	the	confidence	interval	for	a	population	mean.	This	function
uses	the	Student’s	T-distribution.

CONVERT Converts	a	numeric	value	from	one	measurement	system	to	another.

CORREL Computes	the	correlation	coefficient	between	the	two	given	data	sets.

COS Returns	the	cosine	of	a	number.	It	is	the	complement	of	the	SIN
function.

COSH Returns	the	hyperbolic	cosine	of	a	number.

COT Returns	the	cotangent	of	an	angle	in	radians.

COTH Returns	the	hyperbolic	cotangent	of	an	angle	in	radians.

COUNT Returns	the	number	of	numerical	values	in	a	given	range.

COUNTA Returns	the	number	of		values	in	a	given	range,	including	the	text	and
logical	values.

COUNTBLANK Returns	the	number	blank	cells	in	the	given	range.

COUNTIF Counts	and	returns	the	number	of	cells	that	meet	the	specified	criteria.

COUNTIFS Counts	and	returns	the	number	of	cells	that	meet	multiple	criteria.

COUPDAYBS Computes	the	number	of	days	from	the	beginning	of	the	coupon	period
to	the	settlement	date.

COUPDAYS Computes	the	number	of	days	in	the	coupon	period	that	contains	the
settlement	date.



COUPDAYSNC Computes	the	number	of	days	from	the	settlement	date	to	the	next
coupon	date.

COUPNCD Returns	the	next	coupon	date	after	the	settlement	date.

COUPNUM Computes	the	number	of	coupons	payable	between	the	settlement	date
and	the	maturity	date.

COUPPCD Returns	the	coupon	date	previous	to	the	settlement	date.

COVAR*
Computes	the	covariance,	the	average	of	the	products	of	deviations	for
each	data	point	pair	in	two	data	sets.	This	function	is	the	compatibility
version	of	COVARIANCE.P	function.	

COVARIANCE.P Computes	the	covariance,	the	average	of	the	products	of	deviations	for
each	data	point	pair	in	two	data	sets.

COVARIANCE.S Computes	the	sample	covariance,	the	average	of	the	products	deviations
for	each	data	point	pair	in	two	data	sets.

CRITBINOM*
Returns	the	smallest	value	for	which	the	cumulative	binomial
distribution	is	less	than	or	equal	to	a	criterion	value.	This	function	is	the
compatibility	version	of	BINOM.INV	function.	

CSC Returns	the	cosecant	of	an	angle.

CSCH Returns	the	hyperbolic	cosecant	of	an	angle.

CUBEKPIMEMBER Returns	a	key	performance	indicator	name	(KPI)	property	and	displays
the	name	and	property	in	the	cell.

CUBEMEMBER Returns	a	member	or	tuple	in	a	cube	hierarchy.

CUBEMEMBERPROPERTY Returns	the	value	of	a	member	property	in	the	cube.

CUBERANKEDMEMBER Returns	the	nth	or	ranked	member	in	a	set.

CUBESET Returns	a	calculated	set	of	members	or	tuples	by	sending	a	set
expression	to	the	cube	on	the	server’s	database.

CUBESETCOUNT Returns	the	number	of	items	in	a	set.

CUBEVALUE Returns	an	aggregated	value	from	a	cube.

CUMIPMT Returns	the	cumulative	interest	paid	between	two	periods,	the
start_period	and	the	end_period.

CUMPRINC Returns	the	cumulative	principal	paid	on	a	loan	between	two	periods,
the	start_period	and	the	end_period.

DATE Returns	the	serial	number	of	a	particular	date.

DATEVALUE Returns	the	serial	number	of	a	date	that	is	originally	entered	in	the	form



of	text.

DAVERAGE Returns	the	average	of	the	values	in	a	column	of	a	list	or	database	that
match	the	specified	conditions.

DAY Converts	a	serial	number	to	day	of	the	month,	a	number	between	1	and
31.

DAYS Counts	and	returns	the	number	of	days	between	the	two	dates	specified
in	the	arguments.

DAYS360 Counts	and	returns	the	number	of	days	between	two	dates,	based	on	a
360-day	year.

DB Calculates	the	depreciation	of	an	asset	for	a	given	period,	using	the
fixed	declining-balance	method.

DCOUNT Counts	and	returns	the	cells	that	contain	numerical	values	in	a	column
of	a	list	or	database	that	match	the	specified	conditions.

DCOUNTA
Counts	and	returns	the	cells	that	contain	values	(including	text	and
logical	values)	in	a	column	of	a	list	or	database	that	match	the	specified
conditions.

DDB Calculates	the	depreciation	of	an	asset	for	a	specified	period,	using	the
double	declining-balance	method	or	any	other	specified	method.

DEC2BIN Converts	a	decimal	number	into	binary.

DEC2HEX Converts	a	decimal	number	to	hexadecimal.

DEC2OCT Converts	a	decimal	number	to	octal.

DECIMAL Converts	a	text	representation	of	a	number	in	a	given	base	into	a
decimal	number.

DEGREES Converts	radians	to	degrees.

DELTA Performs	a	test	to	check	whether	two	values	are	equal.

DEVSQ Returns	the	sum	of	squares	of	deviations	of	data	points	from	their
sample	mean.

DGET Extracts	a	single	value	from	a	column	in	a	table	or	database	that
matches	the	specified	conditions.

DISC Computes	and	returns	the	discount	rate	for	a	security.

DMAX Returns	the	largest	numeric	value	in	a	column	in	a	table	or	database	that
matches	the	specified	conditions.

DMIN Returns	the	smallest	numeric	value	in	a	column	in	a	table	or	database
that	matches	the	specified	conditions.



DOLLAR
Converts	a	numeric	value	to	text,	using	the	currency	format,	with	the
specified	number	of	decimal	places.

DOLLARDE Converts	a	dollar	price	that	was	originally	displayed	in	fraction	form
into	a	dollar	price	displayed	in	decimal	form.

DOLLARFR Converts	a	dollar	price	expressed	as	a	decimal	number	into	a	dollar
price	expressed	as	a	fraction.

DPRODUCT Multiplies	the	values	in	a	column	in	a	table	or	database	that	matches	the
specified	conditions.

DSTDEV Returns	the	estimated	standard	deviation	based	on	a	sample	population
from	the	selected	table	or	database.

DSTDEVP Returns	the	estimated	standard	deviation	based	on	the	entire	population
from	the	selected	table	or	database.

DSUM
This	function	performs	Conditional	Summation.	It	totals	the	numeric
values	in	a	column	in	a	table	or	database	that	matches	the	specified
conditions.

DURATION Calculates	the	annual	duration	of	a	security	with	periodic	interest
payments.

DVAR Returns	the	estimated	variance	based	on	a	sample	population	from	the
selected	table	or	database.

DVARP Returns	the	estimated	variance	based	on	the	entire	population	from	the
selected	table	or	database.

EDATE Returns	the	serial	number	of	the	date	that	is	the	indicated	number	of
months	before	or	after	a	given	date.

EFFECT Computes	the	effective	annual	interest	rate.

ENCODEURL Returns	a	URL	encoded	string;	that	is,	a	Universal	Resource	Locator
encoded	string	for	web	use.

EOMONTH Returns	the	serial	number	of	the	last	day	of	the	month	before	or	after	a
specified	number	of	months.

ERF Returns	the	error	function	integrated	between	lower_limit	and
upper_limit.

ERF.PRECISE Returns	the	error	function.

ERFC Returns	the	complementary	error	function	integrated	between	x	and
infinity.

ERFC.PRECISE Returns	the	precise	complementary	error	function	integrated	between	x
and	infinity.

ERROR.TYPE Returns	a	number	matching	an	error	value.



EVEN Rounds	a	number	up	to	the	nearest	even	integer.

EXACT Performs	a	case	sensitive	test	to	see	whether	two	text	values	are
identical.

EXP Computes	the	value	of	the	constant	e	raised	to	the	power	of	a	given
number.

EXPON.DIST Returns	the	exponential	distribution.

EXPONDIST* Returns	the	exponential	distribution.	This	function	is	the	compatibility
version	of	EXPON.DIST	function.	

F.DIST Returns	the	left	tailed	F	probability	distribution	for	two	data	sets.

F.DIST.RT Returns	the	right-tailed	F	probability	distribution	for	two	data	sets.

F.INV Returns	the	inverse	of	the	left-tailed	F	probability	distribution.

F.INV.RT Returns	the	inverse	of	the	right-tailed	F	probability	distribution.

F.TEST Returns	the	result	of	an	F-test,	the	two-tailed	probability	that	the
variances	in	Array1	and	Array2	are	significantly	different.

FACT Returns	the	factorial	of	a	number.

FACTDOUBLE Returns	the	double	factorial	of	a	number.

FALSE Returns	the	logical	value	FALSE.

FDIST* Returns	the	right-tailed	F	probability	distribution	for	two	data	sets.	This
function	is	the	compatibility	version	of	F.DIST.RT	function.	

FILTERXML Returns	specific	data	from	the	XML	content	by	using	the	specified
Xpath.

FIND Returns	the	starting	position	of	one	text	string	within	another	text	string.
This	function	performs	a	case	sensitive	operation.

FINV* Returns	the	inverse	of	the	right-tailed	F	probability	distribution.	This
function	is	the	compatibility	version	of	F.INV.RT	function.

FISHER Returns	the	Fisher	transformation.

FISHERINV Returns	the	inverse	of	the	Fisher	transformation.

FIXED Rounds	a	number	to	the	specified	number	of	decimals	and	returns	the
result	as	text,	with	or	without	commas.

FLOOR* Rounds	a	number	down,	to	the	nearest	multiple	of	significance.

FLOOR.MATH Rounds	a	number	down,	to	the	nearest	integer	or	to	the	nearest	multiple



of	significance.

FORECAST Calculates,	or	predicts	a	future	value	based	on	the	existing	values.	This
function	uses	the	linear	regression	method	to	perform	the	calculation.

FORMULATEXT Returns	the	formula	in	the	formula	bar,	as	a	text	value.

FREQUENCY Calculates	the	number	of	times	the	values	occur	within	a	specified	range
and	then	returns	a	vertical	array	of	numbers.

FTEST*
Returns	the	result	of	an	F-test,	the	two-tailed	probability	that	the
variances	in	Array1	and	Array2	are	significantly	different.	This	function
is	the	compatibility	version	of	F.TEST	function.	

FV Calculates	the	future	value	of	an	investment,	based	on	a	constant
interest	rate	and	constant	periodic	payments.

FVSCHEDULE Returns	the	future	value	of	an	initial	principal	after	applying	a	series	of
compound	interest	rates.

GAMMA Returns	the	Gamma	function	value

GAMMA.DIST Returns	the	gamma	distribution

GAMMA.INV Returns	the	inverse	of	the	gamma	cumulative	distribution

GAMMADIST* Returns	the	gamma	distribution.	This	function	is	the	compatibility
version	of	GAMMA.DIST	function.	

GAMMAINV* Returns	the	inverse	of	the	gamma	cumulative	distribution.	This	function
is	the	compatibility	version	of	GAMMA.INV	function.	

GAMMALN Returns	the	natural	logarithm	of	the	gamma	function,	G(x).

GAMMALN.PRECISE Returns	the	natural	logarithm	of	the	gamma	function,	G(x).

GAUSS Returns	0.5	less	than	the	standard	normal	cumulative	distribution.

GCD Returns	the	greatest	common	divisor.

GEOMEAN Computes	the	geometric	mean	of	an	array,	or	a	range	of	cells	containing
positive	numeric	data.

GESTEP Performs	a	test	to	check	whether	a	number	is	greater	than	a	threshold
value.

GETPIVOTDATA Returns	data	stored	in	a	Pivot	Table.

GROWTH Returns	values	in	an	exponential	growth	trend	matching	known	data
points.

HARMEAN Returns	the	harmonic	mean	of	a	data	containing	positive	numbers.



HEX2BIN Converts	a	hexadecimal	number	to	binary.

HEX2DEC Converts	a	hexadecimal	number	to	decimal.

HEX2OCT Converts	a	hexadecimal	number	to	octal.

HLOOKUP Searches	for	a	value	in	the	top	row	of	a	table	and	then	returns	a	value	in
the	same	column	from	a	row	you	specify	in	the	table.

HOUR Returns	the	hour	part	of	a	serial	number	as	a	number	between	0	-	23.

HYPERLINK Creates	a	shortcut	that	opens	a	document	saved	on	a	hard	drive,	network
server	or	the	Internet.

HYPGEOM.DIST Returns	the	hypergeometric	distribution.

HYPGEOMDIST* Returns	the	hypergeometric	distribution.	This	function	is	the
compatibility	version	of	HYPGEOM.DIST	function.	

IF Performs	a	logical	test	to	check	if	the	specified	conditions	are	met,	then
returns	one	specified	value	if	TRUE,	returns	another	value	if	FALSE.

IFERROR Returns	a	different	value	if	the	first	argument	evaluates	to	an	error,
otherwise	returns	the	value	of	the	expression	itself.

IFNA Returns	the	specified	value	if	the	expression	evaluates	to	#N/A	error,
otherwise	returns	the	value	of	the	expression	itself.

IMABS Returns	the	absolute	value	(modulus)	of	a	complex	number.

IMAGINARY Returns	the	imaginary	coefficient	of	a	complex	number.

IMARGUMENT Returns	the	argument	theta,	an	angle	that	is	expressed	in	radians.

IMCONJUGATE Returns	the	complex	conjugate	of	a	complex	number.

IMCOS Returns	the	cosine	of	a	complex	number.

IMCOSH Returns	the	hyperbolic	cosine	of	a	complex	number.

IMCOT Computes	and	returns	the	cotangent	of	a	complex	number.

IMCSC Computes	and	returns	the	cosecant	of	a	complex	number.

IMDIV Computes	and	returns	the	quotient	of	two	complex	numbers.

IMEXP Returns	the	exponential	of	a	complex	number.

IMLN Returns	the	natural	logarithm	of	a	complex	number.

IMLOG10 Returns	the	base-10	logarithm	of	a	complex	number.



IMLOG2 Returns	the	base-2	logarithm	of	a	complex	number.

IMPOWER Returns	a	complex	number	raised	to	an	integer	power.

IMPRODUCT Computes	and	returns	the	product	of	complex	numbers.

IMREAL Returns	the	real	coefficient	of	a	complex	number.

IMSEC Returns	the	secant	of	a	complex	number

IMSECH Returns	the	hyperbolic	secant	of	a	complex	number

IMSIN Returns	the	sine	of	a	complex	number.

IMSINH Returns	the	hyperbolic	sine	of	a	complex	number.

IMSQRT Computes	the	square	root	of	a	complex	number.

IMSUB Computes	the	difference	of	two	complex	numbers.

IMSUM Computes	the	sum	of	complex	numbers.

IMTAN Returns	the	tangent	of	a	complex	number.

INDEX Returns	a	value(s)	or	cell	reference(s)	at	the	intersecting	point	of	a
particular	row	and	column	in	the	specified	range.

INDIRECT Returns	a	reference	indicated	by	a	text	string.

INFO Returns	information	about	the	current	operating	environment.

INT Rounds	a	number	down	to	the	nearest	integer.

INTERCEPT Returns	point	at	which	a	line	intersects	the	y	axis	by	using	existing	x
values	and	y	values.

INTRATE Returns	the	interest	rate	for	a	fully	invested	security.

IPMT Returns	the	interest	payment	for	an	investment	for	a	given	period,
assuming	constant	and	periodic	payments	and	constant	interest	rate

IRR Computes	the	internal	rate	of	return	for	a	series	of	cash	flows.

ISBLANK Performs	a	test	to	check	whether	the	referenced	cell	is	empty;	and
returns	TRUE	if	the	cell	is	blank,	otherwise	FALSE.

ISERR Returns	TRUE	if	the	value	is	any	error	value	except	#N/A.

ISERROR Performs	a	test	to	check	whether	the	referenced	cell	contains	any	error
value;	and	returns	TRUE	if	the	value	is	any	error	value.

ISEVEN Returns	TRUE	if	the	number	is	even,	otherwise	FALSE.



ISFORMULA
Returns	TRUE	if	the	referenced	cell	contains	a	formula,	otherwise
FALSE.

ISLOGICAL Returns	TRUE	if	the	value	in	the	referenced	cell	is	a	logical	value,
otherwise	FALSE.

ISNA Returns	TRUE	if	the	referenced	cell	contains	#N/A	error	value,
otherwise	FALSE.

ISNONTEXT Performs	a	test	to	check	whether	the	referenced	value	is	a	text	value;
and	returns	TRUE	if	the	value	is	not	text,	otherwise	FALSE.

ISNUMBER Performs	a	test	to	check	whether	the	referenced	value	is	a	numeric
value;	and	returns	TRUE	if	the	value	is	a	number,	otherwise	FALSE.

ISODD Returns	TRUE	if	the	referenced	value	is	an	odd	number,	otherwise
FALSE.

ISOWEEKNUM Returns	the	number	of	the	European	ISO	week	number	of	the	year	for	a
given	date

ISPMT Computes	and	returns	the	amount	of	interest	paid	during	a	specific
period	of	an	investment.

ISREF Returns	TRUE	if	the	value	is	a	reference,	otherwise	FALSE.

ISTEXT This	function	performs	the	opposite	of	the	ISNONTEXT	function.	It
returns	TRUE	if	the	value	is	text,	otherwise	FALSE.

KURT Returns	the	kurtosis	of	a	data	set.

LARGE Returns	the	kth	largest	value	in	a	data	set,	where	k	is	the	position	from
the	largest	value	in	the	data	range	you	want	to	find.

LCM Returns	the	least	common	multiple.

LEFT Returns	the	leftmost	characters	from	a	text	value.

LEN Returns	the	number	of	characters	in	a	text	value

LINEST
Calculates	the	statistics	that	defines	a	linear	trend	matching	known	data
points.	This	function	follows	the	least	squares	method	to	perform	the
operation.

LN Returns	the	natural	logarithm	of	a	number.

LOG Returns	the	logarithm	of	a	number	to	the	base	you	specify	in	the
argument.

LOG10 Returns	the	base-10	logarithm	of	a	number.

LOGEST Calculates	the	statistics	that	defines	an	exponential	curve	matching
known	data	points.



LOGINV*

Returns	the	inverse	of	the	lognormal	cumulative	distribution	function	of
x,	where	ln(x)	is	normally	distributed	with	arguments	mean	and
standard_dev.		This	function	is	the	compatibility	version	of
LOGNORM.INV	function.	

LOGNORM.DIST Returns	the	lognormal	cumulative	distribution	function	of	x,	where	ln(x)
is	normally	distributed	with	arguments	mean	and	standard_dev.

LOGNORM.INV

This	function	performs	the	opposite	of	LOGNORM.DIST	function;	that
is,	it	returns	the	inverse	of	the	lognormal	cumulative	distribution
function	of	x,	where	ln(x)	is	normally	distributed	with	arguments	mean
and	standard_dev.	

LOGNORMDIST*
Returns	the	lognormal	cumulative	distribution	function	of	x,	where	ln(x)
is	normally	distributed	with	arguments	mean	and	standard_dev.		This
function	is	the	compatibility	version	of	LOGNORM.DIST	function.	

LOOKUP Lookup	a	value	from	either	a	one-row	or	one-column	range	or	from	an
array.

LOWER Converts	all	letters	in	the	specified	text	value	to	lowercase.

MATCH Returns	the	relative	position	of	an	item	in	an	array,	that	matches	the
specified	lookup	value.

MAX Returns	the	largest	value	in	the	specified	data	range.	This	function	does
not	take	into	account	the	logical	values	and	text.

MAXA Returns	the	largest	value	in	the	specified	data	range.	This	function	does
not	ignore	the	logical	values	and	text.

MDETERM Returns	the	matrix	determinant	of	an	array.

MDURATION Returns	the	Macauley	modified	duration	for	a	security	with	an	assumed
par	value	of	$	100.

MEDIAN Computes	the	median,	or	the	middle	number	in	a	set	of	given	numbers.

MID Returns	a	specific	number	of	characters	from	a	text	string,	starting	at	the
position	you	specify.

MIN Returns	the	smallest	numeric	value	in	the	specified	set	of	data.	This
function	does	not	take	into	account	the	logical	and	text	values.

MINA Returns	the	smallest	value	in	the	specified	set	of	data,	including	the
logical	and	text	values.

MINUTE Converts	the	minute	part	in	a	date/time	serial	number	and	returns	the
minute	value	(0	-	59)

MINVERSE Returns	the	inverse	matrix	for	the	matrix	stored	in	an	array.

MIRR
Returns	the	Modified	Internal	Rate	of	Return	of	an	investment;	that	is,
the	internal	rate	of	return	for	a	series	of	periodic	cash	flows,	taking	into



account	both	cost	of	investment	and		interest	on	reinvestment	on	cash.

MMULT Returns	the	matrix	product	of	two	arrays,	an	array	with	the	same
number	of	rows	as	array1	and	as	columns	in	array2.

MOD Returns	the	remainder	after	the	specified	value	is	divided	by	a	specified
divisor.

MODE* Returns	the	most	common	value	in	a	data	set.	This	function	is	the
compatibility	version	of	MODE.SNGL	function.

MODE.MULT Returns	a	vertical	array	of	the	most	frequently	occurring	or	repetitive
values	in	an	array	or	range	of	data.

MODE.SNGL Returns	the	most	frequently	occurring	or	repetitive	value	in	the
specified	array	or	range	of	data.

MONTH Converts	the	month	part	in	a	date	serial	number	and	returns	the
corresponding	month	value	(1	-	12)

MROUND Returns	a	numeric	value	rounded	to	the	specified	multiple.

MULTINOMIAL Returns	the	multinomial	of	a	set	of	numbers.

MUNIT Returns	the	unit	matrix	for	the	desired	specified	dimension.

N Converts	a	non-numeric	value	to	a	numeric	value,	dates	to	serial
numbers,	TRUE	value	to	1	and	any	other	value	or	error	to	0	(zero).

NA Returns	the	error	value	#N/A	(value	unavailable).

NEGBINOM.DIST
Returns	the	negative	binomial	distribution,	the	probability	that	there
will	be	number_f	failures	before	the	number_s-th	success,	with	the
specified	probability_s	probability	of	success.

NEGBINOMDIST*

Returns	the	negative	binomial	distribution,	the	probability	that	there
will	be	number_f	failures	before	the	number_s-th	success,	with	the
specified	probability_s	probability	of	success.	This	function	is	the
compatibility	version	of	NEGBINOM.DIST	function.

NETWORKDAYS Returns	the	number	of	whole	workdays	between	the	two	specified
dates.

NETWORKDAYS.INTL Returns	the	number	of	whole	workdays	between	two	dates,	with	the
desired	specified	weekend	parameters.

NOMINAL Returns	the	annual	nominal	interest	rate.

NORM.DIST Returns	the	normal	cumulative	distribution,	for	the	specified	mean	and
standard	deviation.

NORM.INV
This	function	performs	the	inverse	of	the	NORM.DIST	function;	that	is,
it	returns	the	inverse	of	the	normal	cumulative	distribution,	for	the
specified	mean	and	standard	deviation.



NORM.S.DIST Returns	the	standard	normal	cumulative	distribution,	that	assumes	a
mean	of	0	(zero)	and	standard	deviation	of	1.

NORM.S.INV
This	function	performs	the	inverse	of	the	NORM.S.DIST	function;	that
is,	returns	the	inverse	of	the	standard	normal	cumulative	distribution,
that	assumes	a	mean	of	0	(zero)	and	standard	deviation	of	1.

NORMDIST*
Returns	the	normal	cumulative	distribution,	for	the	specified	mean	and
standard	deviation.	This	function	is	the	compatibility	version	of
NORM.DIST	function.

NORMINV*

This	function	performs	the	inverse	of	the	NORM.DIST	function;	that	is,
it	returns	the	inverse	of	the	normal	cumulative	distribution,	for	the
specified	mean	and	standard	deviation.	This	function	is	the
compatibility	version	of	NORM.INV	function.

NORMSDIST*
Returns	the	standard	normal	cumulative	distribution,	that	assumes	a
mean	of	0	(zero)	and	standard	deviation	of	1.	This	function	is	the
compatibility	version	of	NORM.S.DIST	function.

NORMSINV*
Returns	the	inverse	of	the	standard	normal	cumulative	distribution,	that
assumes	a	mean	of	0	(zero)	and	standard	deviation	of	1.	This	function	is
the	compatibility	version	of	NORM.S.INV	function.

NOT Reverses	the	logic	of	the	specified	argument;	that	is,	changes	TRUE	to
FALSE	and	vice	versa.

NOW
Returns	the	current	date	and	time	formatted	as	date	and	time
respectively.

NPER Returns	the	number	of	periods	for	an	investment	assuming	constant
periodic	payments	and	a	constant	interest	rate.

NPV
Returns	the	net	present	value	of	an	investment	based	on	the	specified
discount	rate	and	a	series	of	future	cash	flows,	both	negative	(cost)	and
positive	(income)	cash	flows.

NUMBERVALUE Converts	text	to	number	in	a	locale-independent	manner.

OCT2BIN Converts	an	octal	numeric	value	to	binary.

OCT2DEC Converts	an	octal	numeric	value	to	decimal.

OCT2HEX Converts	an	octal	numeric	value	to	hexadecimal.

ODD Rounds	up	a	positive	number	to	the	nearest	odd	integer;	if	the	specified
value	is	a	negative	number,	it	rounds	down	to	the	nearest	odd	integer.

ODDFPRICE Computes	the	price	per	$	100	face	value	of	a	security	with	an	odd	first
period.

ODDFYIELD Computes	the	yield	of	a	security	with	an	odd	first	period.



ODDLPRICE Computes	the	price	per	$	100	face	value	of	a	security	with	an	odd	last
period.

ODDLYIELD Computes	the	yield	of	a	security	with	an	odd	last	period.

OFFSET Returns	a	reference	to	a	range	that	is	a	specified	number	of	rows	and
columns	from	a	particular	cell	reference.

OR Performs	a	test	to	check	if	any	of	the	arguments	are	TRUE;	returns
FALSE	only	is	all	the	arguments	are	false.

PDURATION Returns	the	number	of	periods	required	by	an	investment	to	reach	a
specified	value.

PEARSON Returns	the	Pearson	product	moment	correlation	coefficient.

PERCENTILE* Returns	the	kth	percentile	of	values	in	a	range.	This	function	is	the
compatibility	version	of	PERCENTILE.INC	function.

PERCENTILE.EXC Returns	the	kth	percentile	of	values	in	a	range,	where	k	is	in	the	range
(0	-	1,	exclusive).

PERCENTILE.INC Returns	the	kth	percentile	of	values	in	a	range,	where	k	is	in	the	range
(0	-	1,	inclusive

PERCENTRANK* Returns	the	percentage	rank	of	a	value	in	a	data	set.	This	function	is	the
compatibility	version	of	PERCENTRANK.INC	function.

PERCENTRANK.EXC Returns	the	rank	of	a	value	in	a	data	set	as	a	percentage	(0..1	exclusive)
of	the	data	set.

PERCENTRANK.INC Returns	the	rank	of	a	value	in	a	data	set	as	a	percentage	(0..1	inclusive)
of	the	data	set.

PERMUT Returns	the	number	of	permutations	for	a	given	number	of	items	that
can	be	selected	from	the	total	number	of	items.

PERMUTATIONA Returns	the	number	of	permutations	for	a	specified	number	of	items
(with	repetitions)	that	can	be	selected	from	the	total	items

PHI Returns	the	value	of	the	density	function	for	a	standard	normal
distribution.

PI Returns	the	value	of	pi,	precise	up	to	15	digits.

PMT Returns	the	periodic	constant	payment	for	loan,	assuming	a	constant
interest	rate.

POISSON* Returns	the	Poisson	distribution.		This	function	is	the	compatibility
version	of	POISSON.DIST	function.

POISSON.DIST Returns	the	Poisson	distribution.

POWER Returns	the	result	of	a	number	raised	to	a	power.



PPMT Returns	the	payment	on	the	principal	for	the	specified	investment,
assuming	constant	periodic	payments	and	a	constant	interest	rate.

PRICE Returns	the	price	per	$100	face	value	of	a	security	that	pays	interest	on
periodic	basis.

PRICEDISC Returns	the	price	per	$100	face	value	of	a	discounted	security.

PRICEMAT Returns	the	price	per	$100	face	value	of	a	security	that	pays	interest	at
maturity.

PROB Returns	the	probability	that	values	in	a	range	are	between	two	limits	or
equal	to	the	specified	lower	limit.

PRODUCT Multiplies	all	the	values	specified	in	the	arguments.

PROPER Coverts	a	text	string	to	Proper	case;	that	is,	capitalizes	the	first	letter	in
each	word	of	a	text	value.

PV Computes	the	present	value	of	an	investment;	that	is,	the	present	worth
of	a	series	of	future	cash	flows.

QUARTILE* Returns	the	quartile	of	a	data	set.	This	function	is	the	compatibility
version	of	QUARTILE.INC	function.

QUARTILE.EXC Returns	the	quartile	of	the	data	set,	based	on	percentile	values	from	0
..1,	exclusive.

QUARTILE.INC Returns	the	quartile	of	a	data	set,	based	on	percentile	values	from	0	..1,
inclusive.

QUOTIENT Returns	the	integer	portion	after	a	division	operation.

RADIANS Converts	degrees	to	radians.

RAND Returns	a	random	number	between	0	and	1,	evenly	distributed.

RANDBETWEEN Returns	a	random	number	between	the	specified	numbers.

RANK* Returns	the	rank	of	a	number	in	a	list	of	numbers,	its	size	relative	to
other	values	in	the	specified	list.

RANK.AVG
Returns	the	rank	of	a	number	in	a	list	of	numbers,	its	size	relative	to
other	values	in	the	specified	list;	if	more	than	one	value	in	the	list	has
the	same	rank,	the	function	returns	average	rank.

RANK.EQ
Returns	the	rank	of	a	number	in	a	list	of	numbers,	its	size	relative	to
other	values	in	the	specified	list;	if	more	than	one	value	in	the	list	has
the	same	rank,	it	returns	the	top	rank.

RATE Computes	the	interest	rate	per	period	of	an	investment.

RECEIVED Computes	the	amount	received	at	maturity	for	a	fully	invested	security.



REPLACE Replaces	a	specified	string	of	characters	in	a	text	value	with	another
string.

REPT Repeats	a	specified	text	value	a	given	number	of	times.

RIGHT Returns	the	specified	number	of	characters	from	the	right	end	of	text
string.

ROMAN Converts	an	Arabic	numeral	to	Roman,	as	text.

ROUND Rounds	a	numeric	value	to	a	specified	number	of	digits.

ROUNDDOWN Rounds	down	a	numeric	value,	toward	zero.

ROUNDUP Rounds	up	a	numeric	value,	away	from	zero.

ROW Returns	the	row	number	of	a	reference.

ROWS Counts	and	returns	the	number	of	rows	in	the	specified	reference.

RRI Returns	an	equivalent	interest	rate	for	the	growth	of	an	investment.

RSQ Returns	the	square	of	the	Pearson	product	moment	correlation
coefficient,	through	the	given	data	points.

RTD Returns	real-time	data	from	a	program	that	supports	COM	automation.

SEARCH Returns	the	position	of	a	character	within	a	text	string,	it	starts	reading
from	left	to	right	and	is	not	case	sensitive.

SEC Returns	the	secant	of	an	angle.

SECH Returns	the	hyperbolic	secant	of	an	angle.

SECOND Converts	the	second	part	in	a	date/time	serial	number	and	returns	the
corresponding	second	value	(0	-	59)

SERIESSUM Returns	the	sum	of	a	power	series	based	on	the	formula.

SHEET Returns	the	sheet	number	of	the	referenced	sheet.

SHEETS Returns	the	number	of	sheets	in	a	reference.

SIGN Returns	the	sign	of	the	number	in	the	argument:	1	if	the	number	is
positive,	zero	(0)	if	the	number	is	0,	and	–1	if	the	number	is	negative.

SIN Returns	the	sine	of	the	given	angle.

SINH Returns	the	hyperbolic	sine	of	the	number	specified	in	the	argument.

SKEW Returns	the	skewness	of	a	distribution:	a	characterization	of	the	degree



of	asymmetry	of	a	distribution	around	its	mean.

SKEW.P
Returns	the	skewness	of	a	distribution	based	on	a	population:	a
characterization	of	the	degree	of	asymmetry	of	a	distribution	around	its
mean.

SLN Computes	the	straight-line	depreciation	of	an	asset	for	one	period.

SLOPE Computes	the	slope	of	the	linear	regression	line	through	the	given	data
points.

SMALL Returns	the	kth	smallest	value	in	a	data	set,	where	k	is	the	position	from
the	smallest	value	in	the	data	range	you	want	to	find.

SQRT Calculates	the	positive	square	root	of	the	number	specified	in	the
argument.

SQRTPI Returns	the	square	root	of	(Number	*	pi).

STANDARDIZE Returns	a	normalized	value	from	a	distribution	characterized	by	mean
and	standard_dev.

STDEV*
Estimates	the	standard	deviation	based	on	a	sample	population,	ignoring
the	text	and	logical	values	in	the	specified	data	range.	This	function	is
the	compatibility	version	of	STDEV.S	function.

STDEV.P Calculates	standard	deviation	based	on	the	entire	population	specified	in
the	arguments,	ignoring	the	text	and	logical	values

STDEV.S Estimates	the	standard	deviation	based	on	a	sample	population,	ignoring
the	text	and	logical	values	in	the	specified	data	range.

STDEVA Returns	the	standard	deviation	based	on	a	sample	population,	including
text	and	logical	values	in	the	specified	data	range.

STDEVP*
Calculates	standard	deviation	based	on	the	entire	population	specified	in
the	argument,	ignoring	the	text	and	logical	values.	This	function	is	the
compatibility	version	of	STDEV.P	function.

STDEVPA Returns	the	standard	deviation	based	on	the	entire	population	specified
in	the	argument,	including	text	and	logical	values.

STEYX Returns	the	standard	error	of	the	predicted	y-value	for	each	x	in	the
regression.

SUBSTITUTE Replaces	the	existing	text	value	with	the	new	specified	text	in	a	text
string.

SUBTOTAL Returns	a	subtotal	in	a	list	or	database.

SUM Returns	the	sum	of	all	the	numeric	values	in	its	arguments.

SUMIF This	function	commands	Excel	to	total	the	values	that	fit	in	the



specified	criteria.

SUMIFS This	function	commands	Excel	to	total	the	values	that	fit	in	the
specified	multiple	criteria.

SUMPRODUCT Returns	the	sum	of	the	products	of	the	corresponding	array	or	data
ranges.

SUMSQ Returns	the	sum	of	the	squares	of	the	arguments.

SUMX2MY2 Computes	the	sum	of	the	difference	between	the	squares	of
corresponding	data	ranges	or	arrays.

SUMX2PY2 Computes	the	sum	total	of	sum	of	squares	of	values	in	two
corresponding	data	ranges	or	arrays.

SUMXMY2 Computes	the	sum	of	squares	of	differences	in	two	corresponding	data
ranges	or	arrays.

SYD Returns	the	depreciation	of	an	asset	for	a	specified	period,	using	the
sum-of-years’	digits	depreciation	method.

T Performs	a	test	to	check	whether	the	given	value	is	text;	returns	the	text
if	it	is,	or	returns	double	quotes	if	it	is	not.

T.DIST Returns	the	left-tailed	student’s	T-distribution.

T.DIST.2T Returns	the	two-tailed	student’s	T-distribution.

T.DIST.RT Returns	the	right-tailed	student’s	T-distribution.

T.INV Returns	the	left-tailed	inverse	of	the	student’s	T-distribution.

T.INV.2T Returns	the	two-tailed	inverse	of	the	student’s	T-distribution.

T.TEST Returns	the	probability	associated	with	a	student’s	T-test.

TAN Returns	the	tangent	of	the	given	angle.

TANH Returns	the	hyperbolic	tangent	of	the	number	specified	in	the	argument.

TBILLEQ Returns	the	bond-equivalent	yield	for	a	Treasury	bill.

TBILLPRICE Calculates	the	price	per	$	100	face	value	for	a	Treasury	bill.

TBILLYIELD Calculates	the	yield	for	a	Treasury	bill.

TDIST* Returns	the	left-tailed	student’s	T-distribution.	This	function	is	the
compatibility	version	of	T.DIST	function.

TEXT Converts	a	value	to	text	using	the	specified	format.

TIME Converts	a	time	value	to	its	corresponding	serial	number.



TIMEVALUE Converts	a	time	originally	entered	as	text	to	a	serial	number,	and	then
formats	it	with	the	time	format.

TINV* Returns	the	left-tailed	inverse	of	the	student’s	T-distribution.	This
function	is	the	compatibility	version	of	T.INV	function.

TODAY Returns	the	serial	number	of	current	date,	formatted	as	date.

TRANSPOSE Transposes	a	vertical	array	of	cells	to	horizontal,	and	vice	versa.

TREND Return	numeric	values	in	a	linear	trend	matching	known	data	points,
using	the	least	squares	method.	

TRIM Removes	all	spaces	from	a	text	string,	leaving	just	single	spaces
between	words.

TRIMMEAN Returns	the	mean	of	the	interior	position	of	the	specified	data	set.

TRUE Returns	the	logical	value	TRUE.

TRUNC Shortens	a	number,	following	the	specified	precision;	that	is,	truncates	a
numeric	value	by	removing	the	decimal	or	fractional	part	of	it.	

TTEST* Returns	the	probability	associated	with	a	Student’s	t-Test.	This	function
is	the	compatibility	version	of	T.TEST	function.

TYPE
Specifies	the	type	of	value	contained	in	the	cell	reference;	returns	1	for
a	numeric	value,	2	for	a	text	value,	4	for	a	logical	value,	16	for	error
value	and	64	for	array.

UNICHAR Returns	the	Unicode	character	referenced	by	the	given	numeric	value.

UNICODE Returns	the	number	(code	point)	corresponding	to	the	first	character	in
the	given	text	string.

UPPER Converts	text	in	a	text	string	to	uppercase;	that	is,	capitalizes	all	the
letters.

VALUE Converts	a	text	argument	that	represents	a	number	to	a	number.

VAR*

Estimates	the	variance	based	on	sample	population,	this	function	does
not	take	into	account	the	logical	and	text	values,	if	there	are	any	in	the
data	range.	This	function	is	the	compatibility	version	of	VAR.S
function.

VAR.P
Returns	the	variance	based	on	entire	population,	this	function	does	not
take	into	account	the	logical	and	text	values,	if	there	are	any	in	the	data
range.

VAR.S
Estimates	the	variance	based	on	sample	population,	this	function	does
not	take	into	account	the	logical	and	text	values,	if	there	are	any	in	the
data	range.



VARA Computes	the	variance	of	the	selected	data,	including	text	and	logical
values.	It	assumes	that	the	data	set	represents	sample	population

VARP*

Computes	the	variance	based	on	entire	population,	this	function	does
not	take	into	account	the	logical	and	text	values,	if	there	are	any	in	the
data	range.	This	function	is	the	compatibility	version	of	VAR.S
function.

VARPA It	is	similar	to	the	VARA	function,	except	that	it	assumes	that	the
selected	data	set	represents	the	entire	population

VDB

Calculates	the	depreciation	of	an	asset	for	a	specified	period	(which	can
include	partial	periods	as	well),	this	function	uses	the	double	declining-
balance	method	or	any	other	method	you	specify	to	calculate	the
depreciation.

VLOOKUP Searches	the	lookup	value	in	the	left	most	column	of	the	selected	table
and	returns	the	corresponding	value	from	the	specified	column

WEBSERVICE Returns	data	from	a	web	service.

WEEKDAY Converts	a	serial	number	to	a	day	of	the	week.

WEEKNUM Returns	the	week	number	(1	-	7)	in	a	date.

WEIBULL* Returns	the	Weibull	distribution.	This	function	is	the	compatibility
version	of	WEIBULL.DIST	function.

WEIBULL.DIST Returns	the	Weibull	distribution.

WORKDAY Returns	the	serial	number	of	a	date	before	or	after	a	specified	number	of
workdays.

WORKDAY.INTL Returns	the	serial	number	of	a	date	before	or	after	a	specified	number	of
workdays,	with	the	desired	specified	weekend	parameters.

XIRR Returns	the	internal	rate	of	return	for	a	schedule	of	cash	flows,	that	does
not	necessarily	have	to	be	periodic.

XNPV Returns	the	net	present	value	for	a	schedule	of	cash	flows,	that	does	not
necessarily	have	to	be	periodic.

XOR Returns	a	logical	‘Exclusive	OR’	of	all	arguments.

YEAR Converts	the	year	part	in	a	date/time	serial	number	and	returns	the
corresponding	year	value	(1900	-	9999)

YEARFRAC Returns	the	year	fraction	representing	the	number	of	whole	days
between	the	two	specified	dates	(start_date	and	end_date).

YIELD Computes	the	yield	on	a	security	that	pays	periodic	interest.

YIELDDISC Computes	the	annual	yield	for	a	discounted	security,	a	Treasury	bill,	for
example.



YIELDMAT Computes	the	annual	yield	of	a	security	that	pays	interest	at	maturity.

Z.TEST Returns	the	one-tailed	P-value	of	a	Z-test.

ZTEST* Returns	the	one-tailed	P-value	of	a	Z-test.	This	function	is	the
compatibility	version	of	Z.TEST	function.
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